invitrogen

Vector NTI" Express Designer Software
USER GUIDE

Publication Number MANO0007445

Revision C

ThermoFisher

For Research Use Only. Not for use in diagnostic procedures. SCIENTIFIC



The information in this guide is subject to change without notice.
DISCLAIMER

TO THE EXTENT ALLOWED BY LAW, LIFE TECHNOLOGIES AND/OR ITS AFFILIATE(S) WILL NOT BE LIABLE FOR SPECIAL, INCIDENTAL, INDIRECT,
PUNITIVE, MULTIPLE, OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH OR ARISING FROM THIS DOCUMENT, INCLUDING YOUR USE OF IT.

Corporate entity
Life Technologies | Carlsbad, CA 92008 USA | Toll Free in USA 1.800.955.6288
NOTICE TO PURCHASER: DISCLAIMER OF LICENSE

Purchase of this software product alone does not imply any license under any process, instrument or other apparatus, system, composition, reagent
or kit rights under patent claims owned or otherwise controlled by Life Technologies Corporation, either expressly, or by estoppel.

TRADEMARKS

All trademarks are the property of Thermo Fisher Scientific and its subsidiaries unless otherwise specified.

©2016 Thermo Fisher Scientific Inc. All rights reserved.



Contents

About ThisGuide ....... ..ot i i i e e eans 15
Purpose of the guide . ... 15
NOtE 0N SCIrEEN CAPTUIMES . . o oot 15
ReVISION NistOry . o 15
CHAPTER 1 Database Explorer ........ ..ottt 17
0= T 17
Migrate data from previous versions of Vector NTI™ software ............................... 17
Description of object types .. ... 18
ATCNIVES 19
Open the Database EXplorer ... ... 19
Components of the Database Explorer ... ... ... e 20
Types of databases . . ... 20

SUB S . .t 21
OPEN fIleS . o oot 21
Database Explorer operations . ... ... 22
Create DNA/RNA and protein molecules .. .......oi it 22
Create a DNA/RNA MOLECULE ...\t e 23
Create a DNA/RNA molecule based on an existing DNA/RNA molecule ................. 23
Createa Proteinmolecule .. ... ... 23
Create gel markers, oligos, and enzymes ....... ... 23
Create agelmarker ... .o o e 23
Create an 0ligo .. ... oot e 24
CrEate AN BNMZYMIE . ottt 24
Create new Hosts, Assays, Parts, Devices, or Designer Projects ........... ..., 25
Createanew HoSt . . ... oo 25
Create @ MEW ASSaY ..ottt 25
Create anew Part .. ..o 26
Create a new DeviCe . ... 26
Create a new Designer Project .. ... .. o e 26
Importdata . ... ... 26
IMpPOort MOLECULES . . e 26

File formats ... ..o 27
IMPOrt files . .o 27
Manage data . ... ..o 28
Manage database objects ...... ... 28

Vector NTI" Express Designer Software User Guide 3



Contents

Database subsets .. ... ... 30
Editdata ..o 32
Edit enzyme properties .. ... e 32
Edit gel marker properties . ... ... e 33
Edit assay properties . ... ..o e 34
Edit host properties . ... ..o 34
Search localdatabase .. ... ... 35
Basic search ... 35
Advanced search— Parts, Devices, or Circuits .. ....... ..o 35
Advanced search- DNA/RNA or protein molecules ... ... 36
My Freezer oo e 36
Open My Freezer . . ..o o e 36
Add anitem to My Freezer ... ... o e 36
Enter or edititem information ....... ... . 37
REMOVE HEMIS ..o 37
Filteritem List .. ..o 37
IMPOrt/eXPOrt M . et e e 37
Add My Freezer components to Vector NTI™ Express Designer Canvas .................. 37
Open other applications . ... ... i e 37
Copy, save, and print molecules . ... ... e 38
Copy @amolecule ... ... 38
Save @amMOleCUle ... . 39
Printmolecule data . ... o 40
Manage the Projects database ...... ... 40
Create a ProjeCt . ... 40
OPEN @ PrOJECE ettt ettt et 40
Manage Projects subsets . ... ... e 40
Delete Projects subsets . ... ..o o e 40
Manage the Results database . ... 41
VIEW TESUIES 41
Manage Results subsets ... 41
Workgroup Shared Database .. ... ... e 41
About workgroup shared databases ............. . 41
Connect to a workgroup shared database ............ ... .. . . . . i 42
Add users to a workgroup shared database ............. ... 43
Edit users in a workgroup shared database ............... . i 43
Delete users from a workgroup shared database ................ L. 43
Upload data to a workgroup shared database .............. .. i 44
Download data from a workgroup shared database ............... ... ... ... ... ..., 44
Disconnect from a workgroup shared database ........ ... ... .. L. A
St PrefrENCES o 44
Set display preferences for molecules ... 4b
Set display preferences for SEQUENCES ... ... A
Registerwiththe NCBI .. ... o e 45

4 Vector NTI™ Express Designer Software User Guide



Contents

CHAPTER 2 Molecule Editor ........coiiiiiii i ae e 47
Create oropen amolecule . ... .. o e 47
Createanew molecule ... ... ... ..o 47
Openanexistingmolecule . ..... ... i 47
Open a molecule with Display Settings ... ... s 47
Molecule Editor WiNAOW . .. oot e e e e 48
Display Profile . . ..o o 50
Edit a display profile atasystem level . ... 51

Edit a display profile for a specificmolecule ........ ... .. i 52
Display Profile setup Options . ... . 54
Feature Map .. ..o e 54

S UEBNCE . . e 55
RestriCtioN Map . .o o e 56
DR S e 57
Auto Load Analysis ... ..o 58
MOtifs StUD . . . oo 60
Graphic Display . .. ..o 63
PICtUrE By P oo o 71
Enteroredita sequUenCe . .. ... o 72
Entera seqUeNCe ... o e 72
Select @ SBQUENCE . . ..t 72

0T} o] it oo o) VA= JE=T<Te [V o T 72
Paste @ SBgUENCE ... e 72
Replace @ SBqUENCE ... o e 72
Delete @ SEQUENCE .. ittt 72
REVEIrSE @ SBQUENCE . . ittt 72
Molecule features ... ... 73
Create amolecule feature .. ... ... i 73
Select afeature ... 73

Hide ordisplay afeature ......... .. 74
Editordeleteafeature ... ... e 74
Create Vector NTI™ Express Designer Parts frommolecules . ........... ... ...t 74
Create Part from selection . ... ... 74
Extract Parts from features . .. ... ... 74
ReStriCtion ANalysSis . ..o oo 75
Selecting enzymes foranalysis ........ ... e 76
Configuring the enzyme list .. ... .. 76
Filterthe analysis results . ...... ...ttt e 77
Perform the analysis . ...... .. i 78

ORF FINder 78
Define start and stop coOdONS ... ... e 78

ORF TYPeS 78
Performthe analysis ... 79
MOt fINEr o 80

Vector NTI" Express Designer Software User Guide 5



Contents

Perform the analysis .. ... ..o i e 81
Translation tool .. ... 81
Translation results .. ... ..o 82
Oligo DUplex ANalysis ... ..ot 83
Entering or selecting oligos .. ... .. o o e 83
Analysis parameters ... ... 83
Runthe analysis ... e 84
Silent Mutation Analysis . .. ... 84
Wb analyses .. oo e 85
Back Translation .. ... 86
Protein Domain and Motif Finder Analyses . . ... 87
Protein Domain Analysis—PROSITE and PRINTS databases ........................... 87
Motif Finder—InterProScan sequence search ... ... ... .. i 89
CHAPTER 3 Vector NTI™ Express Designer:
Parts, Devices, and Circuits .........cciiriiiiii e iineennnenns 91
Vector NTI™ Express Designer Project Window . ....... ... i 91
Create a new, empty Designer Project .. ... 91
Save a Project .. ... 91
Open an existing Project .. ... e 92
Project window features . ... ... . 92
Design Canvas . . ..o oot 93
Components INUse tree .. ..o oo e 95
SEQUENCE VIBW PANE oottt e e 96
Vector NTI™ Express Designer Project properties ...t 98
Vector NTI™ Express Designer Parts .. ... ... 99
Create a Part ... 100
SaVE @ Part . . 101
Openanexisting Part ... ... 102
Features of @ Part ... ... 103
Vector NTI™ Express Designer DeviCes . ... ... e 105
Create @ Device ... 105
Add PartstoaDevice . ... 107
SaVe @ DEVICE . o oo 108
Openan existing DevICe . . ... .o 108
Features of @a Device ... ... 110
Vector NTI™ Express Designer CircUits ... ...t e 112
Rules for creating a Circuit .. ... e 112
Create @ CirCUIL . ... e 112
SaVE @ CIrCUIt . . oot 113
Openan existing CircUit . .. .. ..ottt 14
Features of @ CirCUIt . .. ...t 115
Small MolecUles .. ... 117

Vector NTI™ Express Designer Software User Guide



Contents

Information about Parts, Devices, and CircUits . . .. .. ..ot e 118
PrOPEItES oo 118
Characterization ... ... .. ... 120
Truth Table . ..o 121
RULES/ AULO DESIGN . .o vt ettt e ettt e e e e 121
VM AN o 123
JOb 124

CHAPTER 4 Vector NTI™ Express Designer: Analysis Tools ............ 125

Restriction @nalysis ... ...t 125
Select enzymes foranalysis . .......... . 125
Configure the enzyme list . ... ... . 125
Filter the analysis results . ....... ...t i 126
Perform the analysis . ........ 126

GeneArt™ Project Manager portal . ...t 126
Set your GeneArt™ Integration login IDand password ............... ... ... ...l 127

GeneArt™ Gene Optimization . ....... ...ttt 128
Open GeneArt™ Gene Optimization tool .. ............ i it 128
ORF LSt .o 129
Define ORFSs ..o 130
Select ORFs for optimization . ... 130
Optional: Select restriction sites and custom motif(s) toavoid ......................... 131
Select protected regions ... ... 132
Select parametersand optimize ....... ... 133
Viewing, saving, and resetting theresults ......... ... . 133
Saving and loading the optimization profile .......... ... ... . . . . 134
Sending the optimized result for synthesis ......... ... ... ... 134

GeneArt™ Gene SYNthesiS ... ... i 134
Open the GeneArt™ Gene Synthesistool ......... ... ..ot 134
Select synthesis Options . ... . i 135
SUBCLONING v 136
Submitthe sequence . ... 138

RBS Calculator . ... 139
RBS Calculator Analysis .. ... ... 139
RBS Calculator Design . ... ..ot e e e 141

AN A = = 143
Analyze @ SEBQUENCE .. ... i 143
Minimum energy value ... ... ... 144
Editthe seqUeNCe .. ... o 144
View the secondary structure ... ... .. 144
Generate Dot Plot .. ..o 145
Save the seqUENCE . ... 145

Terminator Calculator . .. ... 146

Vector NTI" Express Designer Software User Guide 7



Contents

CHAPTER 5 Vector NTI™ Express Designer:

Assembly Compatibility Check ......... ..o 149
Configuration and assembly . ...... ... 150
Parts Assembler settings . ... ... e 152
Parameter profile .. ... 153
CUStOM SEHHINGS ..\ttt 153
Fragmentstoassemble . .. ... ..o 155
Complete the configuration ....... ... i 156
Gateway® Cloning settings ... ... o on it 156
Configure base parameters . ... ... 157
Configure PCR settings ... ...t 158
Configure pDONR VeCOrs . .. ..o 159
Configure Destination Vectors . ...... ... 160
Complete the configuration . ...... ... 160
Seamless/High Order assembly settings ......... ...t 161
Parameter profile . ... .. o e 161
CUSTOM SEHINGS ..ottt 161
Primer settings . ... ..o 162
Vector selection .. ... 162
Fragmentstoassemble . ... ... 163
Complete the configuration . ...... ... i 163
SLIC assembly Settings ... ...t 163
Parameter profile ... ... o 164
Custom settings .. ... 164
Primer settings . .. ..o 164
Vector selection . ... 165
Fragmentstoassemble . . ... ... . e 165
Complete the configuration ......... ... 165
CPEC assembly settings . . ...t 166
Parameter profile ... ..o o 166
Custom settings . ... .o 166
Primer settings . ... ..o 167
Vector selection .. ... 167
Fragmentstoassemble . . ... ... 167
Complete the configuration . ... .. ... 168
Exo/Fill In/Ligation assembly SEttings ... ..........iuinii i 168
Parameter profile ... ... o e 169
CUStOM SEtHINGS . ..ot 169
Primer settings . .. ... e 169
Vector selection .. ... 169
Fragmentstoassemble . ... ... 170
Complete the configuration . ... .. 170
Golden Braid assembly settings . ... o 170
Parameter profile ... ... 171

8 Vector NTI™ Express Designer Software User Guide



Contents

Custom SettingS . ... oo 171
Vector seleCtion . ..o 171
Fragmentstoassemble . ... ... . 171
Complete the configuration .. ... 172
Golden Gate assembly settings . ... ... oo 172
Parameter profile . ... ... 172
CUStOM SEtINGS .. oot e 173
Vector seleCtion . ..o 173
Fragmentstoassemble .. ... .. 173
Complete the configuration .. ... ... 173
CHAPTER 6 Primer Design ........ccoiiiiiiiiii it iiaeannnnns 175
Open the primer/probe design tools . . ... ... 175
Save and load settings . . .. ..o 176
Runthe design tool . ... ... 176
Primer/probe design results . ........ ... i 176
Save primer/probe designs . . .. .ottt 177

Find PCR Primers Inside Selection settings . ... 178
Amplify Selection settings .. ... oo 179
PCR Using Existing Oligos settings . . .. ...t 181
Sequencing Primers settings . . .. ... 182
Hybridization Probes ... ... e 183
Primer3 settings . ... . 184
Shared Advanced settings ... ...t 186
CHAPTER 7 BioAnnotator™ .........c..iiiiiiiiiii i iiiiiiieeenns 191
Selecting @an analysis . ... ... 191
Graph and SeqUENCE PaNES . ... ittt e 192
Highlight sequence regioninthegraph ...... ... ... i i i 192
Magnify the graph .. ... 192
Determine the value ata pointinthegraph ....... ... ... o i i i i, 192
ANalySis ParamEterS o 192
WINdow Size .. ..o 192
Analyses descriptions and parameters . ... 193
CHAPTER 8 Regenerator ..........coiiiiiiiiniii i i inninnnnnnns 195
Regenerator Workflow .. ... o 195
Open RegENErator . ... e 195
Regenerator tool features . ... ... 196
Create mutations in the input sequence ... ... . e 196
Clear MULAtiONS ... o 197

Vector NTI" Express Designer Software User Guide 9



Contents

View the mutated sequence ... ... .. e 197
Refresh the in silico DNA sequence . ... ... e 197
Optimize the expression system and geneticcode ......... ..., 197
Add attachments .. ... . 197
Clear attachments ... ... 198
Generate a new sequence and send for synthesis ........... ... . i i 198
CHAPTER 9 BLAST and Entrez Searches ...............cccoiviiunn. 201
BLAST S@arCh . .ttt 201
Openthe BLAST search tool . .. ... e 201
BLAST search settings .. ... oo i 201
Perform the BLAST search ... ..o e 204
BLAST Result Viewer . . ... 205
Entrez Search . ... 206
Open Entrez search tool . ... ... o 206
Entrez search settings . ... ... o 206
Entrez searchresults . .. ... o 207
Editing and deleting queries . ... 207
CHAPTER 10 GenomeBench™ ........ ... it 209
Download data from public DAS servers . ... 209
Data Loading Monitor ... o 21
Local GenomeBench™ Projects .. ... 211
GenomeBench™ Project ViewWer .. ... ... . 212
Map OVEIVIBW . .o 212
Feature Map ... o 212
Genome Features and Genome SeqUENCE . ... ... o ittt 213
Editing features . ... oo 213
CHAPTER 11 Align Multiple Sequences ............ccoviiiiiinnnnnnn. 215
0PN AlIGNX 215
ALGNX ™ WINAOW .« oot 215
Manage AlignX™ ProjECtS ... ...ttt 216
Save and rename @ ProjJeCt ... ... 216
OPEN @ ProJeCt . . oot 216
CloSE @ PrOJECt .ttt 216
SaVE CONSENSUS SEOUENCE . ..t v ettt ottt ettt ettt e ettt et ettt et e et 217
Select fragmentstoalign ... ... 217
Add fragments ..o 217
Remove fragments . . ... 218
Selectfragmentstoalign ... 218
Alignment settings . ..o oo e 219
DNA weight matrix programs . ... ... 220

10 Vector NTI™ Express Designer Software User Guide



Contents

Protein weight matrix programs . ... 220
MolECULE tY P . . oo 220
EratioNS . 220
Pairwise alignment . .. ... 221

Fast (approximate) alignment parameters . ................ i 221
Multiple Alignment OptioNs . . ... e 222
Phylogenetic Tree options .. ... . 223
Perform the alignment .. ... . 224
Grapns PaNe oo e 224
Similarity (Consensus) graph . ... 224
Absolute Complexity (Consensus) graph .............oouiiiiiniiiiiiii .. 224
Select aregion . ... 224
[dentify @ data point . ... ... oo 224
AlGNMENt PaNE .o 224
SelECt @ TEgION L o o 224
Alignment toolbar .. ... .. 224
CHAPTER 12 3D Molecule Viewer ..........coiiiiiiiiiiiiiinnnennns 227
Download 3D Structure Files .. ... ..o 227
Open amolecule in 3D Molecule Viewer . ... e 227
Elements of the 3D Molecule Viewer window . ... 228
Magnify and rotate the molecule . ... . 228
Highlight an amino acid orachain ........ . . . e 229
Additional MenU Operations . . ... ... 229
CHAPTER 13 Simé4 and Spidey Analysis ..........c.ccoiiiiiiiininnnn.. 231
SN L e 231
Launch Sim4 analysis tool . ... ..ot 231
Analysis Jobs settings .. ... . 232
Submitthe Job ... 232
View analysis resUltS ... ... 233
P Y o ot 233
Launch Spidey analysis tool . ........ ... 233
Analysis Jobs settings .. ... . e 234
Spidey Parameters . ... ... 234
Submitthe job ... 234
View analysis resUltS . ... oo e 234
CHAPTER 14 Clone2Seq™ ...ttt aaeeeans 237
Launch Clone2Seq ™ ..ttt 237
Clone2Seq™ WINOW . . ..ottt e e 237
Select MOLECULES . . .. 237
Molecule requUIrEMENES . . .. 238

Vector NTI" Express Designer Software User Guide 11



Contents

Show or hide restriction sitesinmolecules ....... ... ... 238
Generate molecule fragments . ... ... 239
Editthe Fragment List . ... ..o oo 240
Modify fragment ends . ... ... 240
Assemblethe molecule . ... ... . 241
Multiple fragment Cloning . . ... ..o oo e 242
CHAPTER 15 Gateway® Cloning ..........ccvviiiiiirnnnnnnnnnnns 243
For more information . ... ... ... e 243
Gateway® Cloning Workflow .. ... 243
Gateway® Cloning TOOL . ...ttt 244
Open the Gateway® Cloning Tool ... ... i e 244
Gateway® Project pane ... ...t 244
Task List Pane . ... 245
Current Task Pane .. ... 246
Create, save, and load projects . ... ... 246
Gateway® Cloning Workflow . .. ... i 247
............................................................................... 247
Amplify fragments to Use in BP reaction ...... ... ... i 247
Recombine Entry Clones by BP .. ... .. 249
Preview Entry Clones . .. ..o oo e 251
Create Expression Clones by LR . ... ..o 251
Preview EXpression Clones . ... ... o it 253
CHAPTER 16 TOPO® Cloning ... iiiiiieieeeeeennnnns 255
TOPO® Cloning in Vector NTI™ EXpress . ... 255
TOPO® Cloning TOOL . . ..ottt e e e e e 255
Open the TOPO® Cloning Tool . . ..o o oo i e 255
TOPO® Project pane . ... 256
Task LISt Pane ... 257
Current Task Pane ... ..o 257
Create, save, and l0ad Projects .. ... ...t 258
TOPO® Cloning Workflow ... ... ... .o e 258
Amplify fragments to Use in TOPO® reaction .. ...t 258
Create TOPO® Clones . . .t ottt ettt ettt e e e e e e e 261
CHAPTER 17 GeneArt® Cloning .........c.ceuiiniiiiiiiiiinnnnnnns 263
INtrOdUCHION .. 263
GeneArt® Seamless Cloning Overview . ...... ... .. i 263
GeneArt® High Order Assembly Overview . ........... .. i 263

How GeneArt™ Assembly Works . ... ... i 263
Open the GeneArt™ Assembly TOoL ... ... . e 264

12 Vector NTI™ Express Designer Software User Guide



Contents

From the molecule editor .. ... 264
From the main toolbar with no molecule selected ........ ... .. ... ... .. ... . ... 265
GeneArt™ Assembly Wizard . ... ... .. 265
Assembly settings . .. ..o oo 265

Add and organize fragments . ... ... 266
Design PCR primers to create end homology ......... ...t 267
Design stitching oligos (High Order Assemblyonly) ......... ... ... ... ... .. ... ...... 267
Create the assembled molecule . ... ... 268
CHAPTER 18 Parts Assembler ......... ... . it 271
Additional Information about Parts and Standards . ............ ... ..., 271
Using the Parts Assembler .. ... o 271
Selecting Parts .. ... 271
Restrictions on Parts ... ... 272
Assembly Settings . ... o o 272
Completing and previewing the assembly ............ .. . . 273
Viewing the assembly in Molecule Editor ... ... .. 274
CHAPTER 19 Contig Assembly using ContigExpress™ program ........ 275
Launch ContigEXpress™ program .. ... ...ttt e e 275
Open a Contig Assembly Project and add fragments to the project ......................... 276
Open the demo Contig Assembly Project ........ ... et 276
Open an existing Contig Assembly project ........ ... i 276
Create a new Contig Assembly Project ... ... ... e 277

Add the fragments .. ... o e 278
EXport Fragments .. ... o 280
Remove fragments . . ... 280
Rename fragments . . ... o 280
Examine the ContigExpress™ program Project Explorer Window . .......................... 281
Fragment VieWer .o 283
Viewing Fragments SUMMary . . ... i e 283
Viewing individual Fragment details ....... ... .. .. 284
Managing fragments in the Fragments list in the Contig Editor ... ..................... 287
Perform an assembly . ... ... 300
Assembly SEtUP . ..o oo e 300
Performthe assembly .. ... ... 300
Examine Assembly Results . ... ... 302
CONtIg VIBWET e e e 303
Viewing Assemblies summary . ... ... . 303
Viewing Assembly SUMMAry . ... ... e 304
Viewing Contig details . ... ... o 305
Assemble by Reference . ... ... . e 309
EXPOrt Contigs . ..o 310

Vector NTI" Express Designer Software User Guide 13



Contents

14

Save and close a Contig Assembly Project ........ ... .. i 311
Delete and rename CoNtigs . ...ttt e 3N
Delete a Contig Assembly . ... ... o e 31
Re-assemble contigs . ... ..o o i e 31
Display ORFs and translate the nucleotide sequence ....... ... ... . 312
Display ORFs for the Sequence ....... ... e 312
Translate the Nucleotide Sequence . . ... e 313
Edit the nucleotide sequence in the Sequence Pane .......... ... it 313
Edit a sequence in the Chromatogram Pane ....... ... ... . . i 314

APPENDIX A Symbols and Formats: IUB (IUPAC)

Ambiguity Codes and ASCIl Format ..................cciiinn... 315
Format for ASCII Sequence Files ... ... i e 315
IUB Formats recognized by Vector NTI™ Express ... ... ... s 375
APPENDIX B Primer Tm Calculations ................cciiiiiiin... 317
General Information ... ... 317
Usefulness of Thermodynamic TmVersus %GC Tm ............. ... ... ... ... ... 317
Effects of Primer (Probe) and Salt Concentration on Tm Calculations . ...................... 317
%GC Tm Calculation . ... . 317
Thermodynamic Tm Calculation .. ... ... e 318
EXamIple o 319
Oligos Containing IUB Ambiguity Characters .......... .o e 320
RNA OligOS . e ettt ettt et e e e e e 321
Primer/Probe Tm, Tagy and Similarity Calculations ............................... 321
Primer/Probe TMValUES ... ...ttt 321
Tagpr Values ... o 322
Primer/Probe Similarity Values . . . .. .. ..o 322
RE IS e 322
Documentationand Support ........... i 323
Technical resources ontheweb .. ... ... 323
Annual SUPPOrt CONtraCt . . ..o o 323
Other Thermo Fisher Scientific technical support ............ ... . 323
Limited Product Warranty ... ... o e 323
Vector NTI™ Express Designer Software and Support Product License Agreement............ 323
INdEX e 325

Vector NTI™ Express Designer Software User Guide



About This Guide

Purpose of the guide

This user guide provides reference information for Vector NTI™ Express Designer Software, a
Java-based cross-platform application that can run on computers using the following operating
systems:

+  Microsoft® Windows® XP (SP3) and Windows® 7
+ Mac™ OS X®

For installation and licensing information, see the Vector NTI"" Express Designer Installation
and Licensing Guide, available online at http://thermofisher/vectornti.

This guide uses conventions and terminology that assume a working knowledge of the your
operating system, the Internet, and Internet browsers.

Note on screen captures

This guide includes screen captures for the Microsoft® Windows® version of the software. For
Mac™ OS users, the screens will look slightly different but the commands and functions will be
the same.

Revision history

Revision Date Description

1.0 8 May 2013 New user guide based on the Vector
NTI™ Express User Guide

AQ 4 March 2014 Updated to includethe description of the
Display Profile feature.

B.0 31 March 2014 Updated to include additional details
about the ContigExpress™ program
feature

C.0 19 January 2016 Updated AlignX, Clone2Seq, and
additional miscellaneous features.
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Overview

Database Explorer

The Vector NTI™ Express Designer local database is a database file and associated folder that
by default are installed in the root directory of your local hard drive (e.g.,
C:\VntiExpressDesigner Database). Database Explorer is the tool in Vector NTI™ Express
Designer for managing all the data in the local database.

Migrate data from previous versions of Vector NTI™ software

If you have Vector NTI™ Advance and/or Vector NTI™ Express software installed on your
computer, you can migrate the existing data into Vector NTI'" Express Designer.

Note: This will copy data from the existing database, not move it.

Note: You are prompted to run data migration as part of the Vector NTI™ Express Designer
installation process; however, this will only migrate data from Vector NTI™ Advance, not

Vector NTI™ Express.

1. To run the data migration tool:

+  Windows™ operating system: Go to the Windows"" Start menu and select
Programs » Life Technologies » Vector NTI™ Express Designer. Then select either
Migrate Vector NTI"" Advance Database or Migrate Vector NTI'" Express

Database.

+  Mac™ OS: Click on the appropriate shortcut icon on your desktop.

Vector NTI™ Express Designer Software User Guide

Migrate Vector
NTI Advance
Database

Migrate Vector
MNTI Express
Database
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1 Database Explorer
Description of object types

* In the Data Migration Tool, click on the E] button to navigate to the appropriate
folder containing your database. The default selection will reflect the default folder
for standard installations of Vector NTI"™ Advance or Vector NTI™ Express
software.

F |

i | Data Migration Tool (v1.4.0) = | E |

The process may take some time to complete, depending upon the number of records in
your Vector Advance database.During the process, you may Cancel at any time and re-run
the migration tool.

Source database (Vector NTI Advance) B

Destination database (Vector NTI Express Designer) B

_) Overwrite molecules that have the same name in the Vector NTI Express Designer databas
@ Skip migration of molecules that have the same name in the Vector NTI Express Designer
_) Rename and migrate molecules that have the same name in the Vector NTI Express Desig

Auto rename and continue migration

Status:

MNew Mame:

Start data migration Continue Cance

%

2. Select the desired import options, and click on Start data migration. Depending on the

size of your database, migration may take several minutes.

Description of object types

Different types of objects are stored and organized in databases and subsets in the Vector NTI™
Express Designer local database:

18

Parts, Devices, and Circuits—these features of Vector NTI"" Express Designer
SoftwareVector NTI™ Express Designer Software are described in detail in Chapter 3,
“Vector NTI™ Express Designer: Parts, Devices, and Circuits” on page 91.

Assays—assays that you define within the database can be associated with Parts, Devices,
and Circuits, and include such information as targets, function, and technology.

Hosts—organisms with defined characteristics, that are used as hosts for DNA and RNA
sequences in Vector NTI™ Express Designer Software. You can define host compatibility/
incompatibility with specific Parts, Devices, and Circuits, as well as enzymes, assays, and
cloning technologies.

DNA/RNA molecules—contain a nucleic acid sequence as well as annotations, primers,
restriction sites, analysis results, and other molecule data. Upon import from other
sources, nucleic acid data are parsed and stored in an internal format. You can add
molecules to the database by importing or creating basic or constructed molecules.

Vector NTI™ Express Designer Software User Guide



Archives

Archives

Protein molecules—contain an amino acid sequence as well as annotations and other
features. Like DNA molecules, upon import from other sources, protein molecule data are
parsed and stored in an internal format. You can add molecules to the database by
importing or creating basic molecules.

Projects—include Designer, Alignment, Contig Assembly, Cloning, and GeneSynthesis
projects.
Restriction enzymes (RENs)—imported from the REBASE database. Data for restriction

enzymes are parsed and stored in an internal format. You can add other RENs from the
REBASE file included in the Vector NTI™ Express Designer Software.

Oligonucleotides—can be created by the user or generated by primer design tools in
Vector NTI™ Express Designer. Several example oligos are included in the software for
demonstration purposes.

Gel markers—can be created by the user. Commonly used gel markers are included with
the Vector NTI™ Express Designer installation.

BLAST results—are generated by BLAST searches run Vector NTI™™ Express Designer,
and can be stored as results files in the database.

Analysis results—such as PCR analysis or PFAM analysis of molecules, can be stored as
results files in the database.

Parent-descendant relationships (to keep track of your constructs), user fields, comments, and
keywords are kept for all molecules in the database.

All database molecules and other objects can be placed into “archives” — data files of special
format — that can be transferred to another computer (Mac™ OS or Windows'" operating
system) and read by Vector NTI™" Express Designer Software. Through archives, you can share
molecules, constructs, or other objects with your colleagues, or simultaneously use them on
several computers (for instance, at work and at home).

In Vector NTI™ Express Designer Software archives:

All DNA/RNA molecule information is written to, and read from, an archive file. This
information includes molecule component fragments (if the molecule is constructed from
other molecules) and parent-descendant connections between molecules.

Vector NTI™ Express Designer Software automatically checks the consistency of
molecule archive information, adding necessary parents (including DNA parents of
translated protein molecules) or disconnecting them if you neglected to transfer them to
the archives.

When the archive is loaded into a new database, Vector NTI™ Express Designer Software
checks the information consistency on any of database molecules and recalculates them if
necessary.

Open the Database Explorer

The Database Explorer can be opened two ways:

From the Windows™ Start menu, click Start » Programs (or All Programs) » Life
Technologies » Vector NTI"" Express Designer » Vector NTI"" Express Designer.
By default, Vector NTI™ Express Designer opens with the Database Explorer screen.
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Open the Database Explorer

In the main toolbar, click the Database Explorer button:
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The Database Explorer screen consists of the following components:

Three databases: Database, Projects, and Results.

An Explorer Viewer for navigating among three types of databases. The viewer contents
change when you click the Explorer buttons below the viewer.

Explorer bars for opening and navigating the Database, Projects, and Results databases.

A Records Viewer pane for viewing the data and records associated with the Database,
Projects, and Results.

A Summary Viewer for viewing a snapshot of a selected record.

Note: You can widen, narrow, lengthen, and shorten the size of viewers by clicking and
dragging the viewer frames.

7 Vector NTI Expross Designar - Databass Expleror
Curnie Dscover Demon Confrm Toos Het

O Sa@% & E %A

ODdOWw®D W

[ e G ==

Records
Viewer

Fage ACE e | |

| Summary
Viewer

488 Perts

Drag frames to resize viewers

Types of databases
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There are three types of databases in the Database Explorer:

Database includes data associated with DNA and RNA molecules; Vector NTI™ Express
Designer Parts, Devices, and Circuits; protein records; assays; hosts; and enzymes, oligos,
and gel markers.

Projects include data and results associated with Vector NTI™ Express Designer Projects,
GeneSynthesis projects, alignment projects, contig assembly projects, and cloning
projects.

Results include BLAST and analysis results.
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Subsets A subset is a group of objects organized by a specified criteria, such as common features. For
example, you might have one subset for each of your molecule families, and one for each
taxonomic group. Subsets are shown as folders |"_-| in the Database, Projects, and Results
panes. You can search for records by name and create and store data in subsets.

Open files

You can open assembly projects, molecules, and BLAST results. The following file formats are
recognized by Vector NTI™ Express Designer Software:

File

Format

DNA/RNA
molecules

Protein molecules

All nucleotide files (*.gb, *.gbwithparts, *.fasta, *.fas, *.fa, *.mpfa,
* fna, *.fsa, *.seq, *.embl, *.gcg, *.ma4, *.ddbj)

Genbank™ (*.gb, *.gbwithparts)

DDBJ (*.ddbj)

Fasta (*.fasta, *.fas, *.mpfa, *.fna, *.fsa, *.seq)

EMBL (*.embl]

GCG (*.gcg)

Vector NTI™ Archive (*ma4)

All protein files (*.fasta, *.fas, *.fa, *.mpfa, *.fna, *.fra, *.fsa, *.seq,
*.gp, *.gpwithparts, *.swp, *.pa4, *.trembl]

Fasta (*.fasta, *.fas, *.mpfa, *.fna, *.fsa, *.seq)

GenPept (*.gp, *.gpwithparts)

Swiss-Prot (*.swp)
TrEMBL/EMBL (*.trembl,*.embl)

Vector NTI™ Archive (*pa4)

3D molecules

* pdb

Assembly projects

Alignment projects

Contig Project (*.cepx, *.cep)

Alignment Project (*.apr, *.aprx, *.msf]

BLAST results

Vector NTI™ Archive (*.baé)

To open a file:

1. Click File » Open.

Vector NTI™ Express Designer Software User Guide
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In the Open File window, navigate to the file, select it, then click Open.

Database Explorer operations

In Database Explorer, you can:

Create DNA/RNA (this page), protein molecules, gel markers, oligos, and enzymes

(page 23), and projects (page 40).

Create a new Host, Assay, Part, Device, or Designer Project (page 25). For more
information on creating new Parts, Devices or Designer Projects see Chapter 3 on page 91.

Import data (page 26) and export data (page 29) (not available in the demonstration
version).

Manage your data by organizing your data into convenient groups (subsets), and sorting,
duplicating, and deleting data (page 28).

Edit data (page 32).
Open other applications (page 34).
Copy a molecule (page 38) save a molecule (page 39), and print molecule data (page 40).

Create DNA/RNA and protein molecules

22

There are five different ways to create DNA/RNA and protein molecules:

Import a molecule from DDBJ, EMBL, FASTA, GCG, GenBank™, GenPept,
SWISS-PROT, TrEMBL, and Vector NTI™ Archive formats, or from an ASCII file of
flexible format. The sequence and feature map are converted from the file, and the new
molecule becomes part of the Vector NTI™ Express Designer Software database.

Create molecules from nucleotide or amino acid sequences that you define. You can
manually enter these sequences or you can paste from a clipboard and enter the sequence
as a new molecule.

Translate a coding region of an existing DNA or RNA molecule to create protein
molecules.

Construct new DNA/RNA molecules from user-defined compatible component fragments
from other molecules.
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Create a DNA/RNA
molecule

Create a DNA/RNA
molecule based on
an existing DNA/
RNA molecule

Create a Protein
molecule

Create gel markers, oligos, and enzymes

*  Design DNA/RNA molecules from components in a user-defined fragment list, using the
built-in biological knowledge of Vector NTI"" Express Designer Software to design the
recombination process. All new molecules are integrated into the database and can be used
in all future operations and analyses.

To create a DNA/RNA molecule:
1. In the main menu, click File » New.

2. 1In the drop-down list, select DNA to open the New DNA Molecule window.

3. Enter a name, select the form, and enter a description, then click OK.

To create a DNA/RNA molecule based on an existing DNA/RNA molecule:
1. 1Inthe Explorer Viewer, click Local Database, then select DNA/RNA Molecules.
2. Inthe Records Viewer, right-click one or more entries, then select Create Parts.

3. In the Create parts window select the destination folder, under Options choose what to do
if a duplicate record is found.

4. 1In the review window, right-click anywhere over an entry then click Assign Part
Category, or click in the select a part category field and select a Part Category from the
drop-down list that appears.

5. Edit the part Name, then click Save.

To create a protein molecule:
1. In the main menu, click File » New.
2. In the drop-down list, select Protein in the New Protein Molecule window.

3. Enter a name and description, then click OK.

Create gel markers, oligos, and enzymes

Create a gel
marker

Gel marker, oligonucleotide, and enzyme objects can be created “from scratch” using editors in
Vector NTI™ Express Designer Software or by importing them from FASTA files, Vector
NTI™ Archive files, an oligo list, and a REBASE database.

To create a gel marker:

1. In the main menu, click File » New.

N

. In the drop-down list, select Gel Marker to open the Gel Marker window.

3. Enter a name. Click the browse button (...) to open the Choose Database Gel Marker
window, then click OK.

4. Select a gel marker type.

5. Click the Gel Marker tab, enter a fragment length, then click OK.
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Create an oligo

Create an enzyme
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To create an oligo:

1.

In the main menu, click File » New.

. In the drop-down list, select Oligo to open the Oligo window.

2
3.
4

In the General tab, enter a name, then click the Oligo tab.

. Enter the nucleotide sequence, then select the oligo type.

To replace the oligo with its complementary sequence, check the Reverse
Complementary box.

Enter a description, then click the User Fields tab.

Click a cell in the table, click Change Value to open a data entry window, then enter a
value.

To remove a value, click Remove Value.

After you have finshed entering values, click the Comments tab.
Enter comments about the oligo, then click the Keywords tab.

To add a keyword for the oligo, enter a new word or select an item in the list of existing
keywords.

To move the keyword into the keyword list, click < Add. To remove an item from the
keyword list, select it, then click > Remove.

To save your data, click OK. To close the Oligo window without saving your data, click
Cancel.

To create an enzyme:

1.
2.
3.

In the main menu, click File » New.

In the drop-down list, select Enzyme to open the Enzyme window.

In the General tab, enter a name, then click the Enzyme/Methylase tab.
Enter the recognition string of the enzyme.

In the Cleavage Point/Methylation Base field, enter the number of the nucleotide
immediately after the direct strand cleavage point. The following example demonstrates
how cleavage points of palindromic sites are defined.

Cleavage Point = 2

/

AIATATT
12 3 4 5 6
TTATA|A

In the Cleavage Point on Complementary Strand field, enter the number of the nucleotide
immediately after the complementary strand cleavage point. The following example
demonstrates how cleavage points are defined for non-palindromic sites on both direct and
complementary strands.
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Cleavage Point on Complementary Strand = 10

Cleavage Point = 8

\

AAGTNNN|NNN
1 2 3 4 5 6 7[8 9 10
TTCANNNNN|N

Cleavage Point on Complementary Strand = -4

Cleavage Point = -2

/

NNNNNNNAAGT
7 6 -5 2 11 2 3 4
NNNNNNNTTCA

6. Select the enzyme type, regular restriction enzyme or methylase, then click the User
Fields tab.

7. Click a cell in the table, click Change Value to open a data entry window, then enter a
value.

To remove a value, click Remove Value.

After you have finshed entering values, click the Comments tab.
8. Enter comments about the enzyme, then click the Keywords tab.

9. To add a keyword for the enzyme, enter a new word or select an item in the list of existing
keywords.

To move the keyword into the keyword list, click < Add. To remove an item from the
keyword list, select it, then click > Remove.

10. To save your data, click OK. To close the Enzyme window without saving your data, click
Cancel.

Create new Hosts, Assays, Parts, Devices, or Designer Projects

Create a new Host To create a new Host:
1. In the main menu, click File » New.
2. In the drop-down list, select Host to open the Host window.

3. In the General tab, select a Group/Class, then select a Host Organism from the drop-down
lists, then click OK.

4. In the Save As window enter a name, then select the destination folder. To save your data,
click OK. To close the Host window without saving your data, click Cancel.

Create a new Assay  To create a new Assay:
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1. In the main menu, click File » New.
In the drop-down list, select Assay to open the Assay window.

In the General tab, enter a name, then click OK.

M LD

In the Save As window select the destination folder, then click OK. To close the window
without saving your data, click Cancel.
To create a new Part:

1. In the main menu, click File » New.

2. In the drop-down list, select Part to open the Create New Part window.

3. Enter a name, select a Part/Category, then select a Part Type from the drop-down lists,
then click OK.

4. Enter sequence information for the Part into the Sequence field, then click OK. The Part
will be created from the sequence and will be displayed in a new, untitled or existing
Device and Project window.

1. In the main menu, click File » New.

2. In the drop-down list, select Device to open the Create New Device window.

3. Enter a name, select a Device Function, then click OK. The Device will be created and

will be displayed in a new, untitled or existing Project window.

1. In the main menu, click File » New.

N

In the drop-down list, select Designer Project to open a new Untitled Designer Project
Canvas. For more information see Chapter 3 on page 91.

You can import DNA/RNA and protein molecules; Parts and Devices; enzymes, oligos, and gel
markers; assembly projects; and BLAST results in the Vector NTI™ Express Designer Software
Local Database.

You can import molecules (including their feature tables) from DDBJ, EMBL, FASTA, GCG,

GenBank™, GenPept, SWISS-PROT, TrEMBL, and Vector NTI™ Advance Archive files. Two

types of DNA/RNA molecules can exist in the Vector NTI™ Express Designer Local Database:
* Circular DNA Molecules

* Linear DNA/RNA Molecules
Molecules are imported in the DNA/RNA Molecules subset and Protein Molecules subset

within the Local Database. The DNA/RNA Molecules and Protein Molecules subsets contain
descriptions of a molecule’s features.

You can also import nucleotide or amino acid sequences from an ASCII file of flexible format,
and Vector NTI™ Express Designer Software will automatically create the new database
molecule and assign the sequence to the molecule.
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File formats The following file formats can be imported into Vector NTI™ Express Designer:
File Format
DNA/RNA All nucleotide files (*.gb, *.gbwithparts, *.fasta, *.fas, *.fa, *.mpfa, *.fna,
molecule * fsa, *.seq, *.embl, *.gcg, *.ma4, *.ddbj)
Genbank™ (*.gb, *.gbwithparts)
DDBJ (*.ddbj)
Fasta (*fasta, *.fas, *.fa, *.mpfa, *.fna, *.fsa, *.seq)
EMBL (*.embl)
GCG (*.gcg)

Vector NTI<SP-Superscript>®<Default q Font><I-
Italics>Express<Default § Font> Designer Software User Guide Archive
(*mad)

Protein molecule | All protein files (*fasta, *fas, *fa, *mpfa, *.fna, *fsa, *seq, *.gp,
* gpwithparts, *.swp, *.pa4, *.trembl)

Fasta (*.fasta, *.fas, *.fa, *.mpfa, *.fna, *.fsa, *.seq)

GenPept (*.gp, *.gpwithparts)

Swiss-Prot (*.swp)
TrEMBL/EMBL (*.trembl,*.embl)
Vector NTI™ Archive (*pa4)

Part ' Synthetic biology open language (*.sbol), XML (*.xml), text (*.txt),
Genbank™ (*.gb, *.gbwithparts), Fasta (*.fasta, *.fas, *.fa, *.mpfa, *.fna,
* fsa, *.seq), Vector NTI™ Archive (*.ma4)

Device Synthetic biology open language (*.sbol), XML (*.xml), text (*.txt],
Genbank™ (*.gb, *.gbwithparts), Fasta (*.fasta, *.fas, *.fa, *.mpfa, *.fna,
* fsa, *.seq), Vector NTI™ Archive (*.ma4)

Enzyme REBASE (*.rebase), Vector NTI™ Archive (*.ga4)

Oligo " Vector NTI™ Archive (*oa4), Oligo List (*.txt), Fasta (*.fasta, *.fas, *.fa,
*mpfa, *.fna, *.fsa, *.seq)

Gel marker Vector NTI™ Archive (*.ga4)

Assembly Contig Project (*.cepx, *.cep)

Project

BLAST results ' Vector NTI™ Archive (*.baé)

Import files There are two ways to import files: by using the main menu in the Vector NTI™ Express
Designer Software or by dragging and dropping files in Windows™ Explorer.

Note: Drag and drop is not available for Parts, Devices, or MSA projects.

Drag and drop files into a subset
To drag and drop files into a subset:

Highlight the file names in Windows" Explorer. Select the files, then drag and drop them onto
a subset in the Local Database folder in the Explorer Viewer.
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Import files via the main menu
To import objects via the main menu:
1. Click File » Tmport.
2. 1In the drop-down list, select the type of file you want to import.

3. In the Import into Database window, navigate to the file, select it, then click Open.

Manage data in the Database, Projects, and Results databases by creating subsets of subsets
(subfolders of folders), grouping data within subsets, and organizing subsets. Subsets can be
hierarchically organized down to six levels.

You can:

» Create DNA and protein molecules, gel markers, oligos, enzymes, projects, hosts, assays,
Parts, Devices, and Designer projects.

* Open an assembly project; DNA, protein, and 3D molecules; and BLAST results.

» Import DNA and protein molecules, gel markers, enzymes, oligos, BLAST results,
assembly projects, Parts, and Devices.

+ Edit molecules by inserting, deleting, and replacing sequence fragments and features. You
can also modify the display format and general data of molecules.
To manage database objects:
1. In the Explorer Viewer, navigate to the database.

2. In the Records Viewer, right-click on a database object and select from the menu.

Sort database objects

To sort database objects in ascending or descending order, in the Records Viewer, click a
column header to sort by that column.

Rename an object

To rename an object:

1. In the Records Viewer, right-click an object, then select Rename to open the Rename
window.

2. Enter a new name, then click OK.

Delete an object
To permanently delete an object:
1. In the Records Viewer, right-click an object, select Delete from Database.

2. You will be prompted to confirm the deletion.
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Duplicate an object

To duplicate an object, in the Records Viewer, right-click an object or multiple objects, then
select Duplicate.

Duplicates of objects are created in the database and are included in any subsets that contain the
original object. The duplicate of an object is named Copy of, for example, Copy of EPAC.
Multiple duplicates are numbered, for example, Copy#2 of EPAC.

Note: Duplicates are separate objects; changes you make to the original object are not reflected
in the duplicate.

View object properties

To view object properties, in the Records Viewer, right-click an object, then select Properties
to open the properties window.

Note: If one object is selected, all the named object fields with their values are displayed.
Some object data (like sequence and comments) are not stored in named fields and are not
displayed in the properties window.

Export an object

You can export Parts, Devices, and Circuits; DNA/RNA and protein molecules; enzymes;
oligos; Contig Assembly projects; and BLAST results:

1. In the Records Viewer, open the Export Data window:
» Select an object, then click File » Export, or
* Right-click an object, then select Export.

2. Navigate to the export location.
3. (Optional) Rename the file and/or select a new file type, then click OK.

You can export data in the following file formats:

File Format
DNA/RNA Genbank™ (*.gb, *.gbwithparts)
molecule DDBJ (*.ddbj)
Fasta (*fasta, *.fas, *.fa, *.mpfa, *.fna, *.fsa, *.seq)
EMBL (*.embl)
GCG (*.gcg)
ASCII (*.txt)

Protein molecule | Fasta (*.fasta, *.fas, *.fa, *. mpfa, *.fna, *.fsa, *.seq)

GenPept (*.gp, *.gpwithparts]
SWISS-PROT (*.swp)
TrEMBL (*.trembl)
ASCII (*txt)

Part Synthetic biology open language (*.sbol]
Genbank™ (*.gb)

Fasta (*.fasta, *.fas, *.fa, *.mpfa, *.fna, *.fsa, *.seq)
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File Format

Device Synthetic biology open language (*.sbol), XML (*.xml), Text (*.txt)
Genbank™ (*.gb)
Fasta (*.fasta, *.fas, *.fa, *.mpfa, *.fna, *.fsa, *.seq)

Enzyme REBASE (*.rebase)

Oligo CSV (*.csv)

BLAST results Tab-delimited (*.txt)

Contig Assembly ' Contig Project (*.cepx]
Project

Show or hide columns
For all databases in the Local Database, you can show or hide columns in the Records Viewer.
To show or hide columns:

1. 1In the Explorer Viewer, click Local Database, then expand a database.

2. In the Records Viewer, right-click anywhere in the records table, then select Column.

3. In the drop-down list, check or uncheck the columns that you want shown or hidden.

In the Database Explorer, you can create subsets of objects in a local database. This provides a
way of grouping content.

Note: Adding an object to a subset or multiple subsets does not move it or copy it from the
main database. Rather, it creates a link to that object in the main database. Clearing or
dismissing a subset does not delete the objects in it from the database; they will continue to be
listed in the main folder.

Add a subset
To add a subset to a Local Database:
1. 1In the Explorer Viewer, click Local Database.
2. Right-click a database folder, then select Add subset to open the Create Subset window.

3. Enter a subset name and description, then click OK.

Add objects to a subset
To add database objects to a subset:
1. 1In the Explorer Viewer, click Local Database, then expand a database.
2. In the Records Viewer, select several objects using Ctrl+click and Shift+click.

3. Right-click the selected objects, and either:

— Select Add to subset to open the Subset Management window, select a subset, then
click OK, or

— Drag the selected objects into the subset in the Explorer Viewer.
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Note: Adding objects to a subset does not move or copy them from the main database.
Rather, it creates a link to the objects in the main database.

Remove an object from a subset

Removing an object from a subset does not delete it from the local database.

To remove an object from a subset:

1. 1Inthe Explorer Viewer, click Local Database, then expand a database and open a subset
folder.

2. Inthe Records Viewer, right-click an object in the subset and select Exclude from subset.

Edit the properties of a subset
To edit the properties of a subset:
1. 1In the Explorer Viewer, click Local Database, then expand a database.
2. Right-click a database, then select Edit properties to open the Edit Subset window.

3. Enter a new name for, and/or description of, the subset, then click OK.

Rename a subset
To rename a subset:
1. 1In the Explorer Viewer, click Local Database, then select a database.

2. In the Records Viewer, right-click an object, then select Rename to open the Rename
window.

3. Enter a new name, then click OK.

Clear a subset

Clearing a subset removes the objects in it from the subset, but does not delete the objects from
the local database.

To clear a subset of its contents:
1. 1In the Explorer Viewer, click Local Database, then expand a database.
2. Right-click a subset, select Clear subset to open the Subset Management window, then
click OK.
Dismiss a subset

Dismissing a subset deletes the subset folder, but does not delete the objects from the local
database.

To dismiss Local Database subsets:
1. In the Explorer Viewer, click Local Database, then expand a database.

2. Right-click a subset, then select Dismiss subsets to open the Subset Managment window,
then click OK.
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Note: Deleting the contents of a subset deletes the actual objects in the subset from the Local
Database.

To delete the contents of a Local Database subset:
1. In the Explorer Viewer, click Local Database, then expand a database.
2. Right-click a subset and select Delete Subset Contents. You will be prompted to confirm
the deletion of the objects from the database.
View a summary of a subset
To view a summary of a subset:
1. 1In the Explorer Viewer, click Local Database, then expand a database.

2. Right-click a subset, then select Subset Summary to open the Subset Summary window.

Edit data

Edit enzyme To edit an enzyme:

properties 1. 1Inthe Explorer Viewer, click Local Database, then select Enzymes.

2. In the Records Viewer, right-click an enzyme, then select Edit.

3. In the enzyme window, click the Enzyme/Methylase tab to edit the following properties:
Recognition String Enter a nucleotide string that can be recognized as
the enzyme.

Cleavage Point/Methylation Base | Enter the number of the nucleotide immediately
after the direct-strand cleavage point.

Description Enter or edit the enzyme’s description.

4. Click the User Fields tab to edit the values of the following fields:
* Commercial Sources *  Organism
* Freezer Position « WWW Source

5. Click the Comments tab to enter comments about the enzyme.

6. Click the Keywords tab to add or remove keywords that will improve database
searches.Edit oligo properties

To edit an oligo:
7. Inthe Explorer Viewer, click Local Database, then select Oligos.
8. In the Records Viewer, right-click an oligo, then select Edit.

9. In the oligo window, click the Oligo tab to edit the following properties:

Nucelotide Sequence Enter or edit the oligo’s nucleotide
sequence. Valid characters: ATUCG
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DNA/RNA Order Select a DNA or RNA sequence, then click
Order to open your browser and order
your primer sequence from Thermo
Fisher Scientific.

Reverse Complementary Check the box to replace the oligo
sequence with the complementary
sequence.

Description Enter or edit the oligo’s description.

10. Click the User Fields tab to edit the values of the following fields:
» Commercial Sources * Organism

* Freezer Position * WWW Source

11. Click the Comments tab to enter comments about the enzyme.

12. Click the Keywords tab to add or remove keywords that will improve database searches.

To edit a gel marker:
1. 1In the Explorer Viewer, click Local Database, then select Gel Markers.

2. 1In the Records Viewer, right-click a gel marker, then select Edit.

3. Inthe General tab of the gel marker window, click the ... button to select a name for the gel

marker.

4. Click the Gel Marker tab to edit the following properties:

Fragment Lists by length all the fragments making
up the marker.

Click Add or Delete to add a fragment to
the marker, or remove a fragment from
the marker.

Fragment (length in b.p.) Enter the length of the fragment in base
pair (bp), then click Add.

Description Enter or edit the gel marker’s description.
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To edit an assay:

1.

In the Explorer Viewer, click Local Database, then select Assays.

. In the Records Viewer, right-click an assay, then select Edit.

2
3.
4

In the General tab fill in the relevant data fields.

. In the Components tab click the Add button. A window will open displaying a list of

Parts. Highlight one or more parts, then click OK to return to the assay window. Remove
parts from the list by highlighting the part then clicking the Remove button.

To edit a host:

1.
2.
3.

In the Explorer Viewer, click Local Database, then select Hosts.
In the Records Viewer, right-click a host, then select Edit.

In the General tab of the host window edit the following properties:

Group/Class Select from the drop-down list of choices.

Host Organism Select from the drop-down list of choices.

Genome (URL to database) Enter URL to link to the organism’s genome
database.

Description Enter or edit the organism’s description.

Comments Enter or edit comments.

Click the Enzyme/Methylase to Avoid tab to select the restriction enzymes and
methylases to avoid when using the selected host.

Click the Components to Avoid tab to select the Parts, Devices or Circuits to avoid.
Select the radio button for either Part, Device or Circuit then click the Add button. A
window will open displaying a list of components. Highlight one or more components,
then click OK to return to the host window. Remove components from the list by
highlighting the component then clicking the Remove button.

— Assays to avoid are similarly selected in the list window at the bottom of the
host window.

— To avoid specific Cloning Technologies select the check box beside the
technology. Then click OK.

Click the Conserved Regions tab to add or remove conserved sequences. Click the Add
button to open the Add Sequence window, enter a Sequence Name, then enter the
conserved sequence, then click OK. Remove sequences from the list by highlighting the
sequence name then clicking the Remove button.
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Basic search To perform a basic search of the local database:

1.

In Database Explorer, click Local Database, then select the object type you want to
search.

2. Enter a search term into the Search Field, select the Exact Match Only check box to
limit your search results if desired, then click Search. Wildcard characters may be used to
broaden your search:

» *—any number of characters after the search string

» ?—one character after the search string.
o W

Advanced Search
I:‘ Exact Match Only Button
al Author Author Medified Order ~
trez NCBI Entrez 2008-08-26 11:54:35
Search field
3. When performing a basic search, the following attributes are searchable for each object
type:

For the following object types... Attributes searched are...

Parts Name, Part Category, Description

Devices Name, Device Function

Circuits Name, Circuit Function

DNA/RNA Molecules Name, Author, Accession, Description

Protein Molecules Name, Accession, Description
Advanced search— To perform an advanced search of Parts, Devices, or Circuits in the local database:
Pfa l'tS., Devices, or 1. In Database Explorer, click Local Database, then select the object type you want to
Circuits search.

2. Click the Advanced Search button to display the advanced search options window.

3. Inthe Look in field, click the E] button to select a subset database from the drop-down
menu if desired.

4. Select the check boxes for one or more filters (Attribute Filter, Text Filter, Assay Filter,
Ontology Filter) to limit your search results. Selecting a filter activates the respective filter
set up button.

5. Click on the filter set up button(s) to display the associated search conditions window.

Within each window define the variables you wish to limit your search by. To save search
results as a new database subset enter a subset name in the Subset Name field, then click
Search.
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6. To search by name, click the Exact Match Only button to activate the search field, enter
the name you want to search for, then click Search. Wildcard characters may be used to
broaden your search; *-any number of characters after the search string, ?-one character
after the search string, if desired.

Advanced search- To perform an advanced search of DNA/RNA or protein molecules in the local database:

DNA/ _RNA or 1. In Database Explorer , click Local Database, then select the object type you want to
protein molecules search.

2. Click the Advanced Search button to display the advanced search options window.

3. Select the check boxes for one or more Attribute Filters (Storage Type, Nucleic Acid,
Size, Form) and/or select keywords to limit your search results. To save search results as a
new database subset enter a subset name in the Subset Name field, then click Search.

My Freezer

My Freezer provides a convenient way to keep track of items and products in your laboratory
from within Vector NTI™ Express Designer Software. You can enter information such as
location, catalog number, quantity, and ordering information for Parts, Devices, Circuits, DNA/
RNA Molecules, Enzymes, Oligos, and Gel Markers.

Note: Adding or removing items from My Freezer does not move or delete them from the
database.
Open My Freezer To view the contents of My Freezer and add an item:

1. Click on the Freezer Inventory button i % ®  on the main toolbar or select
Confirm » Freezer Inventory from the menu.

2. The Freezer Inventory dialog will open.

® Freezer Inventory @

Import from file... Filter : Add from DE...
Exporttofile...

Name Desl:rlptmn Location Owner Quantity
Parts
BBa_BOD10 T1fromE. col... | Z/ Z/

Clig - :
DEI:ID:ES x ﬁ BBa_B0O11 ﬁ LuxlCOABEG (... [
Vectors
Enzymes
Circuits

GelMarkers

OK ] [ Cancel ]

3. Items in My Freezer are grouped into categories (Parts, Oligos, Devices, Vectors,
Enzymes, Circuits, or Gel Markers) in the left navigation pane. Click on a category to
view those items in the Freezer.

Add an item to My To add an item to the Freezer:
Freezer
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Enter or edit item
information

Remove items

Filter item List

Import/export
items

Add My Freezer
components to
Vector NTI™
Express Designer
Canvas

Open other applications

1. With the Freezer Inventory dialog open, select a category from the left navigation window,
then click Add from DB... to open the object database.

2. In the database window, select a component, then click OK.

1. In the Explorer Viewer, click Local Database, then select the object type.

2. In the Records Viewer, right-click on a component, then select Add to Freezer. Items
already in My Freezer will be grayed-out and unavailable to add to freezer.

For each item, click on a field in the appropriate column (Location, Owner, Quantity, etc.) and
begin typing to enter or edit the information. Some fields accept only certain types of characters
(e.g., the Quantity field accepts numbers)

Name Description Location Owner Quantity Catalo... Lot Nu... Sou|

* (&) sBa_pooz0 Terminator (... [ 2ndfloor freezer 52 & 20 = & 3

)

To remove an item from My Freezer, click on the red X next to the item name.

To filter the list of items in the Freezer, type the first few characters of the desired item name(s)
in the Filter field. Only items beginning with those characters will be listed.

To import a list of items into My Freezer from a Microsoft™ Excel™ spreadsheet, click on
Import from file and select the file by clicking on the [ ] button.

To export items from the Freezer into a a Microsoft™ Excel™ spreadsheet, click on Export to
file and enter the file name.

You can drag Parts, Devices, and Circuits from My Freezer directly into the Vector NTI™
Express Designer Design Canvas:
1. Open the Vector NTI™ Express Designer Project window.

2. Choose the Circuits, Devices, or Parts icon from the Elements bar, then select My Freezer
from the Collections Tab.

3. Drag the desired components onto the Design Canvas.

Open other applications

You can right-click on DNA/RNA and protein molecules in the database and open the following
applications:

*  Web Analyses (see page 85)

* Analysis Monitor (see Chapter 13 on page 231)
»  BLAST Search (see Chapter 9 on page 201

» BioAnnotator' (see Chapter 7 on page 191)

+ AlignX™ (see Chapter 11 on page 215)

To open other applications:
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1. 1In the Explorer Viewer, click Local Database, then select DNA/RNA Molecules or
Protein Molecules.

2. In the Records Viewer, right-click a molecule, then select an application.

Copy, save, and print molecules

Copy a molecule by taking a screenshot with the Camera tool. Save the screenshot as as an
image in your software of choice. Print the text or image.

Copy a molecule Use the Molecule Editor to copy molecules. In the Database Explorer, open the Molecule Editor
by opening a molecule:

1. 1In the Explorer Viewer, click the DNA/RNA Molecules folder or the Protein Molecules
folder in the Local Database folder to display the molecules in the Records Viewer.

2. In the Records Viewer, double-click a molecule to display a graphical map of a molecule
and its sequence.
The Explorer Viewer is replaced by the Properties Viewer. The Records Viewer is
replaced by the Molecule Editor. The Summary Viewer is replaced by the Sequence
Viewer.
Note: You can widen, narrow, lengthen, and shorten the size of the viewers and Molecule
Editor by clicking and dragging the viewer frames.

For more information about the Molecule Editor, see Chapter 2 on page 47.

< O8&% QE%EH 00 WO @aW

] i

— f xR 4T #—
i
5
o ’
Molecule
. « .
Properties : Editor
Viewer

Sequence Viewer
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Copy, save, and print molecules

Copy molecule properties, feature map, and analysis results
To copy molecule properties, feature map, and analysis results:

1. 1In the Explorer Viewer, click Local Database, then select DNA/RNA Molecules or
Protein Molecules.

2. 1In the Records Viewer, double-click a molecule to open it.

3. Right-click anywhere in the Properties, Feature Map, or Analysis Results viewers, then
select Camera to take a screenshot of the data. The data is copied to the clipboard and can
be pasted in other applications.

Copy molecule image
To copy an image of DNA/RNA molecules and protein molecules:

1. In the Explorer Viewer, click Local Database, then select DNA/RNA Molecules or
Protein Molecules.

2. In the Records Viewer, double-click a molecule to open the Molecule Editor.
3. Right-click the graphical depiction, then select Camera.

4. Click anywhere in the graphic to take a screenshot. The image is copied to the clipboard
and can be pasted in other applications.

Copy a sequence
To copy a sequence:

1. In the Explorer Viewer, click Local Database, then select DNA/RNA Molecules or
Protein Molecules.

2. In the Records Viewer, double-click a molecule to open the Molecule Editor.

3. Select a sequence:
* Click and drag across a sequence region in the molecule image, or
» Click and drag across the text in the Sequence Viewer.
Right-click, then select Copy
The data is copied to the clipboard and can be pasted in other applications.

Save a molecule Molecules you create can be saved to only to the Local Database. To save database molecules:

1. Click File » Save in the main menu, or
Click File » Save As to save the molecule with a different name and/or to a different
location:

a. Enter a new name for the molecule.

b. Select the destination folder for the molecule.
Optionally save the object as a file. Select the file type:

— For DNA/RNA molecules: Genbank™, Genbank ™ Old Format, EMBL, Fasta,
DDBJ, or ASCII text

— For protein molecules: ASCII text, GenPept, GenPept Old Format, Swiss-Prot,
Fasta, or TTEMBL
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2. Click OK.
Print molecule To print molecule data:
data 1. In the Explorer Viewer, click Local Database, then select DNA/RNA Molecules or

Protein Molecules.
2. In the Records Viewer, double-click a molecule to open it.

3. Right-click in the Properties Viewer, Molecule Editor, or Sequence Viewer, then select
Camera to take a screenshot.

4. Open a software application and paste the screenshot.

5. Print the data from the application.

Manage the Projects database

Create a project To create a project:
1. In the main menu, click File » New, then select the type of project you want to create.
Alignment + Gateway " Cloning
+ ContigExpress'" program +  Clone2Seq™
*  TOPO Cloning » Parts Assembler

* Designer project

2. In the project window, enter a project name and description, then click New.

Open a project To open a project:
1. Click the Projects bar.
2. Inthe Projects Viewer, expand the Local Database.
3. Select the folder containing the type of project you want to open.
4. 1Inthe Records Viewer, double-click a project to open the project application (for example,

Alignment) and view its properties.

Manage Projects To manage subsets in the Projects database:
subsets 1. Click the Projects bar.

2. 1Inthe Projects Viewer, expand the Local Database, then expand a project.

3. Select the subset you want to manage.

4. Right-click a subset, then select a managerial operation. For more information, see

“Database subsets” on page 30.

Delete Projects You can delete subsets of Alignment, Contig Assembly, or Cloning projects. You cannot delete
subsets the Alignment, Contig Assembly, and Cloning folders in the Local Database.
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To permanently delete the subset of an Alignment, Contig Assembly, or Cloning project from
the database:

1. Click the Projects bar.

2. 1In the Projects Viewer, expand the Local Database.

3. Select the folder containing the type of project you want to delete.
4

. Right-click, then select Dismiss subsets.

Manage the Results database

View results

Manage Results
subsets

You can view BLAST results and analysis results and manage the BLAST Results and Analysis
Results databases.
To view BLAST results and analysis results:

1. Click the Results bar.

2. Inthe Results Viewer, expand the Local Database, then select BLAST Results or
Analysis Results.

3. Inthe Records Viewer, double-click a result to open the BLAST Viewer or Molecule
Editor.
To manage subsets in the Results databasse:
1. Click the Results bar.
2. 1In the Projects Viewer, expand the Local Database.

3. Right-click a subset, then select a managerial operation. For more information, see
“Database subsets” on page 30

Workgroup Shared Database

About workgroup
shared databases

You can create special databases, repositories of DNA/RNA or protein molecules, enzymes,
oligonucleotides, and gel markers and share them among several Vector NTI™ Express
Designer Software users on a network. Workgroup shared databases are not a replacement for
local databases; each Vector NTI™ Express Designer Software application still must have its
own local database. The local database is used in all operations, for example, the construction,
design, and creation of viewers. The local database is also the place for storing private and
temporary data. The main purpose of the workgroup shared database is to store common data.

The only operations you can perform on workgroup shared databases are:

» Copying data to and from the local database. For instance, you can copy some of your
molecules and enzymes from your local database into the workgroup shared database. In
order to use them in the design process, your colleague must first copy them to his or her
local database.

* Performing various database management operations such as creating and deleting
subsets.
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* Running database searches.

In addition to biological data, each database contains information about its creator and
registered users. Only the creator and registered users can have access to database data. The
database creator can also change database properties, remove registered users, and define the
password required to become a register user.

Note: Vector NTI™ Express Designer workgroup shared databases can be located on a wide
range of file servers. Vector NTI™ Express Designer Software can use not only services native
to each supported operating system, but also various UNIX™ system and NetWare™ software
services.

The workgroup shared database capability is a purchased addition to Vector NTI™ Express
Designer Software. When you purchase the workgroup shared database capability, you are
issued a Vector NTI™ Express Designer workgroup shared database license that enables you to
create workgroup shared databases. A workgroup shared database license is a special type of
static license that enables you to create numerous workgroup shared databases. But the license
also limits the number of users for each database you create. You do not need a workgroup
shared database license to access workgroup shared databases.

Note: Workgroup shared databases can be accessed from Vector NTI™ Express Designer
Software using a license that is shared through a network server (Dynamic License).

You can connect to a workgroup shared database through only a hostname and IP address, not
via the World Wide Web.

When the network directory for a new workgroup shared database is arranged, connect to a
workgroup shared database. Before you can connect to a workgroup shared database, the
workgroup shared database server must be started.

Start the workgroup shared database server

In C:\Program Files\Life Technologies\Vector NTI Shared Database Admin\h2_setup, double-
click startSharedServer and open the cmd.exe window:

ot C:\WINDOWS\system32\cmd.exe HE u

C:\Progran Files\Life Technologies\Uector NTI Shared Database ndmin\hz,setup)rem!
set JAUA_HOME=C:“\Javarjdki.6.8_25 .

C: \qugxam FllEa\Lle Technologi \Uectm NI1 Shared Datahase ndmm\hz _‘Ei:l.lp
X te

C:\Progran
CLASSPATH= 2-1.3.159. jar

\Llfe Technologies~Uector NII Shared Database Adminh2_setup>jav
» —tcp —tcpAllowOthers —tecpPort 8882 -haseDir “G:/UntiExpres|

se
TCP server running at tcp:/-167.116.197.164:86082 {others can connectl

Note: The cmd.exe window automatically opens after the installation of Shared Database
Admin.

Connect to the workgroup share database server

1. Open Vector NTI™ Express Designer Software, then:
* In the main menu, click Tools » Connect to workgroup shared database, or

* Open the Database Explorer. In the Explorer Viewer, click Workgroup Shared
Database.
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Add users to a
workgroup shared
database

Edit users in a
workgroup shared
database

Delete users from
a workgroup
shared database

2.

Workgroup Shared Database

In the Connect to Workgroup Shared Database window, log on:
* Host Name: localhost
» User Name: Your user name

» Password Your user password

Note: (Host Name field) If the Workgroup Shared Database Admin application and
Vector NTI™ Express Designer Software are not installed on the same computer, enter the
IP address of the computer on which the Shared Database Admin application is installed.
The IP address is shown in the cmd.exe window:

TCP server running at tecp:/-s167.116_.197_164:8802 (others can connect? |

Click Connect.

Close the Connect to Workgroup Shared Database window. Your connection will not be
broken.

You must be an administrator to add users to a workgroup shared database.

To add users to a workgroup shared database:

1.

4,
5.

In C:\Program Files\Life Technologies\Vector NTI Shared Database Admin\h2_setup,
double-click startSharedServer to start the server.

Double-click the Shared Database Administration icon on your desktop to open the Login
window.

Log in:
» Database Hostname/IP: localhost
e Administrator username: admin

* Password: admin
Click Login to open the Shared Database Administrator window.

Click Add, then enter information in the Add User window.

Note: A user name should be one word without spaces.

To edit users in a workgroup shared database:

1.
2.

Open the Workgroup Shared Database Admin application and log in as an administrator.

In the Workgroup Shared Database Administrator window, double-click a user to open the
Edit User window.

Edit the user information, then click OK to save your edits.

To delete users from a workgroup shared database:

1.
2.

Open the Workgroup Shared Database Admin application and log in as an administrator.

In the Workgroup Shared Database Administrator window, select a user, click Delete, then
OK.
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Upload data to a
workgroup shared
database

Download data
from a workgroup
shared database

Disconnect from a
workgroup shared
database

To upload data from the Local Database to a workgroup shared database:
1. Connect to a workgroup shared database.
2. In the Explorer Viewer, click Local Database, then select a subset.
3. In the Records Viewer, right-click an object, then select Upload to workgroup shared
database.
To download data from a workgroup shared database to the Local Database:
1. Connect to a workgroup shared database.
2. In the Explorer Viewer, click Workgroup Shared Database, then select a subset.

3. In the Records Viewer, right-click an object, then select Upload to local database.

To disconnect from a workgroup shared database:
1. 1. Click Tools in the main menu, then Connect to workgroup shared database.

2. 2.1In the Connect to Workgroup Shared Database window, click Disconnect.

Set preferences

Set display
preferences for
molecules

Set display
preferences for
sequences

44

You can set preferences for displaying molecules and sequences and register your email address
with the National Center for Biotechnology Information (NCBI).
To set the display preferences for molecules:

1. In the main menu, click Tools » Preferences to open the Preferences window.

2. Inthe Display Preference view, click the background color and highlight color buttons to
open the Color palette.

3. Select background and highlight colors, then click OK.
4. To save your preferences, click Apply, or click Restore Defaults to keep the original
settings.
To set display preferences for sequences:
1. Expand Display Preference, then click Sequence Preference.

2. Click Sequence fill color and Sequence line color to open the Color palette and select
colors.

Enter values for the sequence width and sequence line width parameters.
To change the title font, click the Change button, then select and define a font.

To change the title font color, click the button to open the Color palette and select a color.

o o M v

Click Apply to save your preferences.
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Register with the To register your email address with the NCBI:
NCBI 1. Click NCBI Configuration.
2. Enter your email address, then click Register to open your email application.

3. Click OK to close the Preferences window.
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Molecule Editor

The Molecule Editor in Vector NTI™ Express Designer displays a graphical representation of a
DNA or protein molecule, the molecule sequence, information about the molecule, and the
results of any analysis performed on the molecule.

Using the Molecule Editor, you can:

* Create and edit a molecule sequence
» Annotate the molecule
* Analyze the molecule

— For DNA/RNA molecules, you can perform restriction analysis, design primers from
the sequence, find ORFs, translate the sequence into amino acids, and other
functions.

— For protein molecules, you can scan for motifs, perform web searches on the
sequence, perform back translation, and other functions.

— Molecule sequences may also be analyzed using a variety of web tools and publicly
available analysis engines

+ Display the analysis results

Create or open a molecule

Create a new
molecule

Open an existing
molecule

Open a molecule
with Display
Settings

1. To create a new molecule, click on File » New and select DNA or Protein as the molecule

type.
Note: For DNA or RNA molecules, specify Linear or Circular.

2. The blank molecule will be displayed in the Molecule Editor but will not yet be saved in
the database.

To open an existing molecule:

» For molecules in the database, double-click on the molecule name in the Database
Explorer window

* For molecules that are not in the database, select File » Open and select a molecule of the
appropriate file type (.gb, .fasta, etc.)

The molecule will be displayed in the Molecule Editor.

To open a DNA/RNA Document or Protein Document file:

1. Goto File » Open » DNA or Protein, and select the file.

Note: Ensure the file format being selected is DNA/RNA Document or Protein Document
(the default file format selection is DNA/RNA Document or Protein Document).

2. Double-click on the file.
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Molecule Editor window

Note: A DNA/RNA Document (*.gb) or Protein Document (*.gp) file saved from Vector
NTI Advance™ can be loaded using Vector NTI"™ Express Designer Software, however
the Display Setup in the file will not be saved.

To open a Molecule Shortcut file, go to File » Open Molecule Shortcut and double-click on
the file.

Note: We recommend that you avoid opening a Molecule shortcut file (¥.mq) that is created
using Vector NTI Advance™ Software with Vector NTI™ Express Designer Software as some
of the Display Profile settings are not supported. In Vector NTI™ Express Designer Software,
the current molecule shortcut file format is *.mqx).

Note: For more information on Display Profile settings, see “Display Profile” on page 50.

Molecule Editor window

The Molecule Editor window consists of five main panes as well as various tools and analysis
functions:

Graphics pane

/
e fde Curste Decover Oesgn Confirm Tosk vep
< OFSA#H QEYEH DO WO W
Properties Cepapcestn  Cives (Dl |,
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Display tools A L]
Analysis tools 4
) )
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Properties pane

Feature Map

Analysis Results

Sequence pane

* The Graphics pane displays a graphical representation of the molecule, including
features.

* The Sequence pane displays the molecule sequence, as well as the result

* The Properties pane displays information about the molecule.
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* The Feature Map displays a list of the defined features in the molecule.

Feature Map

= Feature Map

Misc. Recombination (2)

Primer (3}

Promoter Prokaryotic (1)

= chs(3)
ccdB [Complementary(508..813))
Cm(R} [Complementary(1158..1318))
[¥] Amp(R} (2791..3651)

Properties

Feature Map

* The Analysis Results displays analyses that have been performed on the molecule.

Analysis Results

= [W] Restriction Map

[J2a=I (caccTec): 0 sites
[Ja=tII (GRCETC): 1 sites
[JaccesI (GETACC): O sites
[JaceI (cTCGAC): 2 sites

[¥] 2ceIII (CRGCTC): 4 sites
[Jaciz iccec): 35 sites

[¥]2elI (ARCETT): 3 sites
[JacuI (cTeaaG): 2z sites
[Jaser (accecTi: 0 sites
[Jasi1T (CcTTAAG): 0O sites

Properties

Feature Map

Analysis Results

» The Display tools toolbar contains tools to magnify the molecule, or display a DNA
sequence as linear or circular.

R X R l[EE

— Use the tools at the top of the window to zoom in and out on the molecule, fit the
molecule within the window, or display DNA/RNA molecules as linear or circular.

* The Analysis tools toolbar contains analysis functions specific to the Molecule Editor.

Select... To...
ORF Finder = Identify ORFs in a DNA or RNA sequence
L
Translation " Translate a DNA or RNA sequence into
ATE amino acids.
Restriction Analysis Identify restriction sites in a DNA/RNA
A S
g sequence for hundreds of restriction
enzymes.
Primer Designer — Design PCR primers, sequencing primers
Lf—_g and hybridization probes. For a full
— description of this tool see Chapter 6,
“Primer Design” on page 175.

Vector NTITMEx,a/ess Designer Software User Guide 49



2 Molecule Editor
Display Profile

Select... To...

BioAnnotator™ Perform certain types of DNA/RNA sequence

E: analyses and display the results as linear
graphics. For a description of tools on this
submenu, see Chapter 7, “BioAnnotator™”
on page 191.

Sim4 Align expressed nucleic sequences wit

L=l genomic sequences in online databases. For
a full description of this tool see Chapter 13,
“Sim4 and Spidey Analysis” on page 231.

Spidey Align expressed nucleic sequences wit

=] genomic sequences in online databases. For
a full description of this tool see Chapter 13,
“Sim4 and Spidey Analysis” on page 231.

Perform analysis of the thermodynamic

Thermodynamics —
| l properties of DNA or RNA sequences.

Analyze one or more oligonucleotide
~M, | sequences for potential cross-reactivity or
dimer formation.

P Search for “silent mutations” in a DNA/RNA
mnn | sequence or selected region of a sequence
that do not affect amino acid translation but
result in the creation or disappearance of
one or more restriction sites.

Oligo Duplex Analysis

Silent Mutation Analysis

GeneArt Portal — For a description of tools on this submenu,
see the sections on the individual GeneArt™
tools in Chapter 4, “Vector NTI™ Express
Designer: Analysis Tools” on page 125.

o

RNA Analysis Invoke an analysis tool to display the RNA
secondary structure. For complete details

see “RNA Analysis” on page 143

G |

Create a new Part from a selection or
feature. “Create Vector NTI™ Express
Designer Parts from molecules” on page 74.

Create Parts

Display Profile

Vector NTI™ Express Designer Software uses Display Setup parameters to create the Molecule
Display window contents. You can edit the Display Setup parameters before or after a display
window is created, assign names to different settings and store them as a Display Profile, and
change the default Setup settings.

The Display Profile is a way of viewing a molecule. You needn’t bind a molecule with a
particular profile. Instead, you can create a molecule short cut by opening a molecule with a
desired profile.

The Vector NTI™ Express Designer Software has pre-defined display profiles. You can edit or
create your own display profile.
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Display Profile

You can edit a display profile in two ways:

* From Preferences, at a system level, that can be reused across molecules

* In the Molecule Editor, for a specific molecule

Edit a display To edit a display profile at a system level:
profile at a system 1
level

. Go to Tools » Preferences.

2. Seclect Display Setup.

Note: Select the Prompt for Display Setup on Opening Molecules check box to enable
accessing the display setup before opening a molecule in the Molecule Editor.

3. Expand the Display Setup preference. Select from:

+ DNA/RNA Molecules to view the DNA/RNA Molecules Display Setup
Configuration.

* Protein Molecules to view the Protein Molecules Display Setup Configuration.

4. Click one or more check boxes to include the respective Setup Options in the Display
Profile.

Note: Click on each of the setup options below for more information in editing that setup
option.
a. For DNA/RNA Molecules, you can choose from:
» Feature Map
* Sequence
* Restriction Map
* ORFs
* Auto Load Analysis
*  Motifs Setup
* Graphic Display
* Picture type
b. For Protein Molecules, you can choose from:
» Feature Map
* Sequence
* Auto Load Analysis
*  Motifs Setup
* Graphic Display

Note: Sequences and Graphic Display are mandatory setup items and cannot be
deselected.

5. Once you have made the desired edits in each of the Setup Options, click Save to file to
save the newly created display profile as an .xml file that can be accessed from anywhere.

Click Load from file... to retrieve this display profile from the location you saved the .xml
file.

Note: We recommend that you avoid opening a Display Profile Settings file (*.ms5)
saved from Vector NTI Advance" Software with Vector NTI™ Express Designer
Software.
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6. Click Save As to save the newly created display profile.

==

a. Enter a name in the Profile Name field in the Save as New Display Profile dialog
box.

b. Click OK.
The newly created display profile will then appear in the Display Profile drop-down menu.

7. Click OK to submit the change or Cancel to exit the Preferences dialog box.

Note: To remove a selected profile from the system, click Remove Saved Settings.

The Preferences dialog box for editing the display profile at the system level looks like this:

DA RIA Mokecukes Displyy Setup Configuration D -

Erapiey Frofle: | Serwit

g?
EEE

Edit a display To edit a display profile for a specific molecule:
profile for a 1

o . Open a DNA/RNA molecule or Protein molecule in the Molecule Editor.
specific molecule

2. In the Molecule Editor toolbar, click [=] - to open the DNA/RNA Molecules Display
Setup dialog box.

Note: If you are editing the display profile of a protein molecule, clicking on [=] - will
open the Protein Molecules Display Setup dialog box.

Note: Clicking on the drop-down arrow on the above icon will allow you to choose from
the existing system profiles:

e Default
*  Green

* C(lassic
* Orange
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3. You can also open the respective Display Setup dialog box by right-clicking on the
molecule in the Molecule Editor and selecting Display Setup... from the drop-down menu.

4. Edit the Setup Options. Click on the options you want to include.

Note: Click on each of the setup options for more information.

a. For DNA/RNA Molecules, you can choose from:
» Feature Map
* Sequence
* Restriction Map
*+ ORFs
* Auto Load Analysis
*  Motifs Setup
* Graphic Display
* Picture type
b. For Protein Molecules, you can choose from:
* Feature Map
* Sequence
* Auto Load Analysis
*  Motifs Setup
» Graphic Display

Note: Sequences and Graphic Display are mandatory setup items and cannot be
deselected.

5. Click Save to file to save the newly created display profile as an .xml file that can be
accessed from anywhere.

Click Load from file... to retrieve this display profile from the location you saved the .xml
file.

Note: Display Profile Settings file (*.ms5) saved from Vector NTI Advance™ cannot be
loaded using the Vector NTI™ Express Designer Software.

6. Click Save As to save the newly created display profile.

a. Enter a name in the Profile Name field in the Save as New Display Profile dialog
box.

b. Click OK.
The newly created display profile will then appear in the Display Profile drop-down menu.

7. Click OK to submit the change or Cancel to exit the Display Setup dialog box.
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The Display Setup dialog box for editing the display profile in the Molecule Editor looks like

this:

T DNA/RNA Molecules Display Setup

————————————— §

Customize DNAFeatures in Sequence Pane

Setup Opticns

Festure Map
Sequence
Restriction Map
[0 orrs

[ Motifs Setup
AutoLoad Analysis
Graphic Dizplay
PictureType

-10 Signal
-35 Signal
3 Clip
JUR

C-Region

CAAT Signal

CDs

Cellular
Centromere
Confiict

D-loop
D-Segment
Enhancer

Exon

GC-5ignal

Gap

Gene
Glycosylation Site
Homeodomain
Insertion

Intron
J-Segment

LTR

Leucine Zipper Domain
Lod

Mature Peptide
Misc. Binding Site
Misc. Difference
Misc, Feature
Misc, Marker
Misc, Recombination

Misc, Signal

~

Lozd from file. ] [ Savetofile

] [ Save Settings As

Display Profile setup options

Feature Map

54

1. Check the Feature Map check box.

2. Customize the DNA features/ Protein features in the Sequence Pane by including one or
more of the options available in the Customize DNA features in Sequence Pane (or
Customize Protein Features in Sequence Pane) list.

Note: The Feature Types available in the system are on the left side and the features you
would like to be annotate in the sequence pane will be available on the right side.

3. Click to add the DNA features and to remove the DNA features.

Note: Click to remove all the features in a single click.

4. Click OK to submit the Feature Map Setup Option edits or Cancel to exit the Preferences

dialog box.
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The Feature Map Setup dialog box looks like this:

Setup Options Customize DNA Featuresin Sequence Fane

| Feature M3, -10 Signal A
P i

Sequence 35 5ignal

Restriction Map ;S_“%

[ cres 5 Clp

[ Motits Setup SR

Auto Load Analysis Alele

Graphic Dizplay Attenuator

PictureType C-Region
CAAT Signal
@s
Cellular
Centromere
Conflict
D-oop
D-Segment
Enhancer
xon
GC-Signal =
<
Gene 5
Glycosylation Site .
Homeadomain
Insertion
Intron
J-Segment
LTR

Lewcine Zipper Domain

Lod

Mature Peptide

Misc. Binding Site

Misc. Difference

Misc. Feature

Misc. Marker

Misc. Recombination

Misc. Signal

Misc. Structure 3

Load fromfile, ] [ Savetofile... ] [ Save Settings As

1.

Check the Sequence check box.

2. Enter the Sequence details:

a. Length of block
b. Blocks per line
c. Track Separator Width
d. Track Separator Color: Double-click the color button to change the default display.
e. Check the Prefer single-stranded display check box if you want the single-stranded
display.
Select the Translation Code you want to include. You can choose from:

¢ 1-Letter AA Code
e 3-Letter AA Code

Set the Default Font:
* Select the Font name and size from the respective drop-down list.
» Select the color from the color palette.

» Select the respective check box for including the Bold, Italic, and Underline
Effects.

You can view the edits as you make them in the Sample pane in the lower half of the
Sequence Setup Option dialog box.

Click OK to submit the Sequence Setup Option edits or Cancel to exit the Preferences
dialog box.
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The Sequence Setup dialog box looks like this:

Setup Options

Featurs Map Sequence Translation
Length of block |10 () tdemer aacode
Restriction Map
[ ores Blocks per line 10 (3 3-Letter A Code
O] et Sewp TrackSeparator Width | 2
Auto Load Analysis. -
Graphic Display Track Separator Color E]
FictureType
[[] Prefersingle-stranded display
Defaultfont
Name siz2 Color
| courier New DEET]

Fffects: [[]8ala [italic [[] underline

Sample
TYR ILE ASP  LYSASN LYS LEU

ATTGAT ARGRATARAC TTRATACTAT ABAT
GATATAACTA TICTIATTIG AATTATGATA TTTAC

GIG TTAGEGATIT AATTATICTT
CCAC RATCCCTAR TTRATARGAR

< 3|

Lozdfrom file.. I ’ Savetafile ] { Save Settings s

[ ]

Restriction Map 1. Check the Restriction Map check box.

2. Configure the Restriction Enzymes (RENs):
a. Click Configure List.

b. In the Select Restriction Enzymes dialog box, click the check box of one or more
available enzymes.

Note: Check the Select/ Deselect All check box to select or deselect, respectively,
the available enzymes in one click.

c. Usethe button to add the available enzymes to the Select Enzymes pane. Use the
button to remove the selected enzymes to the Available Enzymes pane.
Note: Click to remove all the selected enzymes in a single click.

d. Click OK to confirm the edit or Cancel to exit the Select Restriction Enzymes dialog
box.

3. Select the Permitted Terminus Types check boxes to filter the types of RENs displayed.
You can select from:

L] 5,
] 3 4
e Blunt

4. Enter a numerical value in the Ignore RENSs having ... less than/ ... more than sites field.

The feature removes from the restriction map RENSs that do not fall within the specified
cut site range. Such RENs are listed but grayed out in the Restriction Map folder in the
Text Pane. They are not displayed in the Graphics and Sequence Panes.

5. Click OK to submit the Restriction Map Setup Option edits or Cancel to exit the
Preferences dialog box.
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The Restriction Map Setup dialog box looks like this:

ﬂ Preferences l 5 | S|
type filter text DMA/RNA Molecules Display Setup Configuration [ - v
Automatic Updates
. Designer Preference Display Profile: [Default v]
Display Preference Setup Options
a Display Setup -
Configure Restriction Enzymes
DNA/RNA Molecules Feature Map e =
Protein Molecules Name Recognition String Cuts After Owerhang End Enzyme Ty... Suppliers
GeneSynthesis Preference Apall gtgcac 1 “tgca 459 Restriction... Minotech Biotechn...
Internet Settings Aval cycgrg 1 *ycgr 4 (5 Restriction...  Bangalore Genei, EU...
Manage Organisms [C] Motifs Setup BamHI ggatcc 1 *gatc 459 Restriction... Bangalore Genei, EU...
» Metadata Configuration Auto Load Analysis Clal atcgat 2 *cg 239 Restriction...  Bangalore Genei, EU...
NCBI Conflguratmn Graphic Display EcoRI gaattc 1 *aatt 459 Restriction.. Bangalore Genei, EU...
Set Page Size PictureType HindIl aagett 1 “aget 459 Restriction... Bangalore Genei, EU...
Necol ccatgg 1 *catg 459 Restriction...  Bangalore Genei, EU...
Pstl ctgcag 5 tgca™ 4039 Restriction.. Bangalore Genei, EU...
Smal cccggg 3 ~ Blunt Restriction...  Bangalore Genei, EU...
Xmal ccoggg 1 *cogg 459 Restriction.. Bangalore Genei, Ne...
Configure List
Permitted Terminus Types
5 El Blunt
Occurrence (# of sites)
@ All ) Single ) Double ) >2 () Exact:
Ignore RENs having (# of sites)
) Less Than: Mare Than:
Ignore RENs cutting outside region Ignore RENs cutting inside region
From: To: Frem: To:
Load from file... ] [ Save to file... ] [ Save Settings As Remove Saved Settings
OK ] [ Cancel

ORFs

1. Check the ORFs check box.

2. Configure the ORF Parameters for specifying how the open reading frames (ORFs) are
displayed:

a.

In Start Codons and Stop Codons fields, enter start and stop codons for the new
ORFs.

Click the Default Start & Stop button to set the start and stop codons to the
following conventional values:

e Start codons—ATG, GTG

* Stop codons—TAA, TGA, TAG.
Check the Include Stop Codon in ORF box if you want the stop codon to be

considered as a part of the ORF. Otherwise, the stop codon is not considered as part
of the ORF and is not included.

3. Select the ORF Type.
* Complete: The Complete check box is selected by default.

a.

b.

In the Minimum Size field, specify the minimum size in base pairs. The default value
is 150 and can be changed as per requirement.

Check the Nested check box to look for nested ORFs. These are ORFs that occur
within the main ORF.
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* Incomplete:

a. Check the Incomplete check box and in the Minimum Size field specify the
minimum size in base pairs to display the incomplete ORF.

b. Check the Undefined Start/Stop check box to search for ORFs with undefined
starts, stops or both.

c. Check the Nested check box to look for nested ORFs.

Note: An ORF with an undefined start is one that has a stop codon at the end but no
corresponding start codon in the same frame.

An ORF with an undefined stop is one that has a start codon but no stop codon in the same
frame.

Incomplete ORFs are displayed as a dashed arrow in both the Graphics and the Sequence
Pane. Complete ORFs are displayed as solid arrows.

4. Select the Permitted Terminus Types check boxes to filter the types of RENs displayed.
You can select from:

] 5 4
L] 3,
e Blunt

5. Click OK to submit the ORFs Setup Option edits or Cancel to exit the Preferences dialog
box.

The ORFs Setup dialog box looks like this:

Setup Options Configure ORF Parameters

Feature Map Stant Codons: | ATG GTG
Sequence

Restriction Map StopCodons: | TAATGATAG

ORFs
T otitsSetup Default Start & Stop
Auto Lozd Analysis [ include stop Codon in ORF
Graphic Display
PictureType R
(ORFs which have both start and stop.
] Complet: i
CMEIEE odons defined sz above)
Minimum Size | 150 bp  [Nestsd
D\nmmp\eta [ORFs which do not have both defined

startor stop codons)
Minimum Size bp

Undefined

Lozd fromfile. H Savetofile. ][ Save Settings As

Auto Load Analysis 1. Check the Auto Load Analysis check box to specify the analyses to be shown in the
Sequence and Graphics Panes.

2. From the Available Analyses Results Subsets drop-down box, choose the Vector NTI
Database subset of saved analyses you want to display.
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3. Click the button to move the selected subset into the Load Analyses Results from
Subset section. All analyses listed in this subset are shown in the Molecule Viewing
window. Use the button to remove the selected subset.

Note: Click to remove all the selected subsets in a single click.

4. Click OK to submit the Auto Load Analysis Setup Option edits or Cancel to exit the
Preferences dialog box.
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The Auto Load Analysis Setup dialog box looks like this:

Setup Options.

Customize Analysis Results from Subsets

] Analysis Results (MAIN)

[0 Analysis Results (MAIN)

-g -.A .-v

Lozd fromfile. ] [ Savetofile

] [ Save Settings As

Cancel

1. Check the Motif Setup check box to display the motifs map.
The motif maps display has two tabs: Manage Motifs and Manage Parameters

2. Click Manage Motifs to view the Manage motifs display.

The Manage Motifs display includes the following panes:

* Available Motifs: includes motifs already chosen for a search

* Selected Motifs: includes motifs moved from the Available Motifs pane

* Motifs Properties: displays properties of the motif selected in the Available Motifs pane

Setup Options
Feature Map Manage Motfs | Manage Parameters
[#] sequence i
Restictn Availzble Motits Selected Motifs
[ orss i
La%>
Auto Lozd Analysis MatifName Sequence Description MatifName Sequence Description
Graphic Displzy 3'RACE AdapterP... GGCCACGCGTCE... 3'RACEAdspter
PictureType 4 (i
GEEGACAAGTTT,
... GEGGACCACTT.
M13Forward [20]  GTAMMACGACGG...  Universalforwar,
Mi3Reverse  CAGGAMMCAGCT.. Uriversalrevers
PRML AACGEAGTCAGG...  Sense primerfor
PRMZ ATCOGTTAGCEAG... Antisznse prime
SPGPromoter Pri.. GATTTAGETGACA.. Invitogen SRS Fr
T3 Promoter ATTABCCCTCACT.. Universal pimes
T7 Promoter Frimer TATACGACTCAC... InvtrogenT7Frg
Uriversal Amplif.. CUACUACUACUA... Uriversal Amplif
V5Reverse ACCGAGGAGAGE... Reverse primerf
f
¢ s |@ N
Load romfile. H Savetofil H SaveSettingsAs
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Note: Except for General, all other tabs in the Motif Properties pane appear disabled
when a motif is selected in the Available Motifs pane. Only when you use the Add and
Edit tools, to add or edit motif respectively, the other tabs are enabled. For instructions on
using the other features in the Motif Properties pane, refer to “Create an oligo” on page 24.

a. In the Manage Motifs display, move motifs from the Available Motifs pane to the
Selected Motifs pane using the button.

You can move back a motif from the Selected Motifs pane to the Available Motifs
pane using the button.
b. In the Available Motifs pane, click
— - to add new motifs
— @ {0 edit selected motifs
— ¥ to initiate an analysis of a selected motif

— X to delete a selected motif

3. Click Manage Parameters to view the Manage Parameters display.
The Manage Parameters display includes the following panes:

* Find Sites

¢ Similarity For Ambiguous Nucleotides

* Sort By

e Strand(s) to Search

e Ignore Motif Sites outside region

» Ignore Motif Sites inside region

Manage Motfs | Manage Parameters
Find Sites
(O BestFit: Similarity For Ambiguous Nudeotides

Q Minimum
(&) Similarity Threshold 100 ®
A
Waximum Numbar ofSites: | 10
© maximum
[tast | 10| Nucleotides Must Have 100% Similarity
Sort By Strand(s) to Search
(® MatifName {0 Number of Sites. Direct Complementary

Ignore Motif Sites outside region: Ignore Motif Sites insice region

From: Ta: From: Ta:

a. In the Find Sites pane, specify the similarity between motif and molecule sequence
for the motif’s site to be accepted. Choose between the Best Fit and Similarity
Threshold radio buttons.

* Best Fit selects only those motif sites that received the best relative score.

* Similarity Threshold displays all motif sites that have a similarity more than
or equal to the similarity you specify in the Similarity Threshold box.
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 To filter out all the motif sites that do not meet the specific requirement for 3’
end similarity, check the Last box and enter the number of nucleotides on 3’
end that should have 100% similarity.

Note: Any motifs that have more sites than specified in the Maximum Number of
Sites box are displayed as grayed-out folders in the Text Pane; they are not displayed
at all in graphics or Sequence Panes.

b. In the Similarity For Ambiguous Nucleotides pane, specify the acceptable
similarity between ambiguous nucleotides (if any).

Select from Minimum, Average, and Maximum radio buttons. The buttons indicate
the minimum, average, and maximum possible similarity that will be calculated
respectively for any nucleotide pair. For instance, if you are calculating similarity
between N and A, then the average similarity is 25%, the minimum similarity is 0%,
and the maximum similarity is 100%. In case of R and A they are 50%, 0%, and
100%; in case of R and T—0%, 0%, and 0%. For clarification of these IUB
nucleotide symbols, refer Appendix A.

N-N N-R N-A R-W R-A R-T
Maximum 100 100 100 100 100
Average 25 25 25 25 50
Minimum 0 0 0 0 0

c. Inthe Sort By pane, select the motifs sorting procedure to be used for the Motifs
folder. Choose between the Motif Name and Number of Sites radio buttons. Motif
Name sorts motifs alphabetically while Number of Sites sorts motifs by their number
of sites on the molecule.

d. Inthe Strand(s) to Search pane, select or deselect the Direct and/ or
Complementary check boxes to specify the strand(s) to be searched.

e. In the Ignore Motif Sites outside region/ Ignore Motif Sites inside region panes,
specify additional limitations on the motif sites to be displayed.

* Specify the Ignore Motifs Sites outside region to display only those motifs
located inside the region.

» Specify the Ignore Motifs Sites inside region to display only those motifs
located outside the region.

4. Click OK to submit the Motifs Setup Option edits or Cancel to exit the Preferences dialog
box.
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2.
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Check the Graphic Display check box to view the Graphics display editing features.

You can edit the graphical styles for graphical map elements directly from the Display
Setup dialog box (within Preferences) or in the Graphics Pane in the Graphic Editing
Mode.

In the center pane, elect the DNA-RNA (or Protein) feature to be edited.

= 1 DMARMAFeatures ~
£ -10Signal
] -35signal

]

] 5'uTR

B Allele

Ij Attenuator —
Ij C-Region

E CaATSignal

£ cos

Ij Cellular

Ij Centromere

£ Conflict

Ij D-Loop

Ij D-Zegment

Ij Enhancer

Ij Exon

] GCsignal

£ Gap

Ij Gene

Ij Glycosylation Site
Ij Homeodomain
Ij Inzertion

Ij Intron

Ij Jl-Segment
=R A

In the right hand side pane, select the Label from the Style drop-down menu. To add a new
label, click More...

Test: | @N |
Subsitution: ! @N signal/enzyme/matifimolecule name | % |
Font: | Arizl 9, Bold, RGB(D, 0, 0) | D

o J[ cna |

In the Label Properties dialog box, enter the Text

Select the Substitution from the drop-down menu and click Insert
Click ... to edit the font.

Click OK

Select the Connector from the Style drop-down menu. To add a new connector, click
More...

® Line Properties fgl

oo (]

o J[ e ]

In the Line Properties dialog box, select a pattern from the drop-down menu

Select a color from the Color palette
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* Click OK

5. Select a Symbol from the Shape and Style drop-down menus. To add a new style, click
More...

* Style Properties g|

Shape

Line
Pattern: | ——————— &
Fill
pattern: | [N~

o J[ e ]

* In the Style Properties dialog box, set the Shape, Line, and Fill properties
* Click OK

6. Click OK to submit the Graphic Display Setup Option edits or Cancel to exit the
Preferences dialog box.

The Graphic Display Setup dialog box looks like this:

= ] DNA-RNAFestures ~ Label
style: | @N Signsl Labal ~[ [ more
Connec tor
Style: | ——— Siznal Label ~|[ [ more
Symbal
Shape: | Arrow
Style Shape 1 ~l[ | Mor
Preview
Sample
T
sample
30bp
< >
~
Lozatrom fils ][ ssveromis

Graphic Edit Mode: Formatting and Annotating Pictures

Vector NTI™ Express Designer Software has two modes of operation in Graphics Panes.

* Molecule Editing mode (default) in which the Graphics Pane serves as a visual
environment for viewing and editing the content of a molecule itself. In molecule editing,
you are changing the nature of the molecule map and sequence. Selecting DNA molecule
fragments for Construction and Design also take place in Molecule Editing mode.

» Graphic Editing mode where you can edit the graphical representation of an image such
as format and arrange individual graphics symbols and labels. This mode is useful for
preparing publication-quality figures of the molecule.
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When in Graphic Editing mode, Vector NTI"" Express Designer Software changes the
way it selects objects in the Graphics Pane: the elementary units of selection are graphics
objects like labels and symbols, not elements of the molecule content. In Graphic Editing
mode, you can reposition and reformat labels and symbols, hide objects to prevent them
from being displayed, and format multiple objects at once using centralized style sheets.

Note:

+ Ifyou intend to edit the molecule itself, it is recommended that you perform that first
before you format molecule graphics.

» Graphic editing changes are not saved in database, but in a Molecule Document file.

To activate Graphic Editing Mode, in an active Graphics Pane, click Graphic Edit ( '#z) on
the toolbar.

All of the following operations are performed in Graphic Editing mode.

Formatting Objects on the Graphical Map

1. To format an object in the Graphics Pane, select the object by clicking on it or its label.

Selected objects in Graphic Edit mode are displayed with selection boxes or handles at
each corner. If this is not the case, check to make sure the Edit Graphic is depressed.

2. When the graphics objects to be formatted are selected, select Properties from the
associated shortcut menu.

3. In the Properties dialog box, select Line, Fill, or Text attributes (if a label is selected). If a
single symbol is selected, you may also change its Shape.

4. On the Properties tabs, select the pattern and color for Lines and Fill for selected graphics
objects. On the Shape tab, click the down arrow for selections. Click OK.

Note:

» Lines associated with symbols are the lines that surround the main symbol. Lines
associated with labels are the droplines connecting the labels to its corresponding symbol.

» Fill refers to the pattern and color with which the selected symbols are filled. Changing a
symbol’s filling does not affect the formatting of the line around that symbol.

The Default Shape option forces Vector NTI to assign the default shape to the given
symbol. You can edit the association between the element type and the default shape/style
in the Graphics Display Setup dialog box accessible from the Display Setup dialog box.
You cannot undo the Shape formatting.

e .

* Properties. EJ
Shaps
srape: | TR
Line

Pattern,

v

If you have selected label(s), the Properties dialog box includes a Text field.
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5.

In the text box, enter ordinary text or choose from a variety of special codes that are
converted into information about the symbol to which the label is attached. To insert a
substitution code, choose the code from the Substitutions box and click Insert. The code
is inserted at the current caret position.

This substitution model allows assignment of a single text “style” to all labels of a certain
kind. For example, if the text attribute for all restriction sites is “@N (@S)” then the actual
label for a Smal site 5354 bp will look like “Smal (5354)” with the REN name and site
position substituted for @N and @S. You might want to experiment with the different
substitution models.

Using the Font button on this tab, choose the font, font style, font size, effects, and display
color attributes of labels you selected. Attributes of currently selected font are displayed to
the right of the Font button.

Note: The font size you choose is not necessarily equal to the font size on the screen or on
the printed output. Displayed objects are stretched and shrunk as the picture magnification
is changed.

Annotations

Annotations are elements of the graphical representation of the molecule only and are not stored
in the database. To save an annotation, you need to save the display window as a Molecule
Document. To associate text information with a molecule itself, not its temporary graphical
representation, use the Comments or User Fields described in Chapter 1.

1.

To insert a text annotation on a graphical map, click Add Annotation ( & ) in the
toolbar.

In the Annotation dialog box, enter the text of a new annotation label. Click OK to return
to the Molecule Display window where the annotation is highlighted and selected with
handles.

Click and drag it to the location you choose in the Graphics Pane.

You can move annotations and change their font and formatting using the label formatting
techniques described above.

Deleting Annotations

1.

To delete an annotation, select it in the Graphics Pane, and select Edit » Delete
Annotation.

To delete an annotation from a Text Pane, click the annotation subfolder to select its line,
right-click, and select Delete Annotation ( E ) or select Edit » Delete Annotation.

Note: Annotation subfolders are the only folders of the Text Pane that can be deleted.

Undo and Redo

You can undo/redo movement and formatting of graphics objects, redefinition of styles, etc.
Undo/Redo also works in the Sequence Pane.

To undo an action, press Ctrl+Z or right-click Undo.
To redo an action, choose Ctrl+Y or right-click Redo.

Changing the Sizes And Shapes of Symbols

1.

To change the size or shape of a symbol, click Graphic Edit ( a#j ).
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Note: You cannot modify a graphic unless the Graphics Pane is in Edit Picture mode.

2. Select the object to be changed with a mouse click. Black drag boxes will appear at its
corners. Move the cursor to any drag box, changing it to a thin four-headed arrow (.« ).
Click and drag the black box, causing the symbol to change shape and/or size. Release
the mouse when the symbol has the new shape you want.

Il (Basg)
1(6838)

Moving Objects on the Graphical Map

1. To move a graphics object around the Graphics Pane, select the symbol or label. When the
cursor placed in the middle of the selected object turns into a four-headed arrow (C%)),
click and drag the object to the new location.

As labels are dragged, their droplines follow, tracking the connection to the object to
which they refer.

Most symbols representing features, restriction sites, etc., do not move completely freely
around the graphical map. They do move freely perpendicular to the “sequence” bar/ring,
but Vector NTI™ Express Designer Software prevents them from moving parallel to the
sequence bar without your permission. This is to keep the objects in the places
corresponding to their actual locations in the nucleotide or amino acid sequence.

2. To move a symbol parallel to the sequence bar of a graphical map, press and hold CTRL+
SHIFT and drag the object.

Note: This does not change the coordinates of the feature in the Feature map. To change
the coordinates you need to edit the feature in the Molecule Editing mode described in
Chapter 4.
Changing the Display Order Of Overlapping Graphics Objects
To change the display order of overlapping graphics objects,
1. Select the overlapping graphic objects.

2. Right-click on the editor, and select Bring To Front or Send To Back or the
corresponding commands from the shortcut menu.

Note: To make these changes, the Graphics Pane must be in Graphic Edit mode.

The following image demonstrates the results of bringing the DNA ring to the front of a
circular molecule display:
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Select Al Cirl+a

all (4034) BamHI (=
Properties ...

Style ...

Copy Style
Paste Style

Bring To Front

Send To Back

Find Sequenge Ctrl+F

Styles

A style is a named set of formatting attributes for graphics objects. Styles in Vector NTI™
Express Designer Software work much the same as they do in most word processing programs.
Styles provide a convenient and powerful way to organize the formatting of graphical maps.

Each style contains one or more of the following attributes: line, fill, text, and shape.

Although Vector NTI™ Express Designer Software has standard styles for symbols and labels,
you can also define your own. Once created, styles can be saved together with other parameters
in the Display Setup Profile or in Vector NTI Setup files.

To learn what style a graphics object has
1. Turn on the Graphic Editing mode.

2. Select the object or Style from the shortcut menu.

The style box in the Picture Element Style dialog box shows the style of the selected
object. If more than one object is selected, the style box shows the style of the last object
selected. The last selected object is displayed with small squares around it.

Assigning Styles to Graphics Objects
To assign an existing style to a graphics object,

1. Select the object(s) to which you want to assign a style and select Style from the shortcut
menu.

2. Inthe Style box in the Picture Element Style dialog box, select an existing style from the
pull-down list, or type a name, and click the OK button.

If you select an existing style or type its name, that style is assigned to the selected
graphics object(s), and the object(s) assume its format.

If you type a name that is not in the style list, a new style with the format of the currently
selected object(s) is created. If the selection includes more than one graphics object, a
newly created style contains only those attributes that are the same for all selected objects.

A style is the base format for a graphics object. You may make additional formatting changes to
graphics objects using the methods described in preceding sections.

Redefining a Style’s Format

To redefine the style of a graphic object, select the object,
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Display Profile setup options

1. Open the Properties dialog box, from the shortcut menu and make the desired changes for
the object and click OK.

2. Select Style from the shortcut menu.

3. In the Style drop-down menu, the name of the current style is displayed. Click OK to
apply the new format to an existing style.
In the Reapply Style dialog box that opens, choose the redefine operation you wish to
occur, and click OK:

® Reapply Style g|

Style: bhape 3
Options
@ Redefine the style using the selection 35 an example?

O Return the formatting of the selection to the style?

o J[ e ]

To accomplish the same end, select Redefine <name> Style by Example or the corresponding
command from the shortcut menu.

+ If you choose the Redefine Style option, any objects (even unselected ones) that currently
have that style will automatically change format to reflect the style’s new settings.

» Ifyou choose the Return Formatting to Style option, then the selected objects’ format is
restored to that Style’s format. Edit » Undo or the Undo button restores the former style.

Copy and Paste Styles

Once you have modified a symbol or label with a new format, you can easily reformat other
objects with the same format.

1. Select the modified object, and select Copy Style from the shortcut menu associated with
the modified object.

2. Move the cursor to another feature or label, and select Paste Style from the shortcut menu.

Saving Styles

The set of the styles and Standard Arrangement parameters appearing in the Molecule Display
Window are a part of the Display Setup settings.

To save a display window’s current styles,

1. Click Display Setup () n the Window toolbar and choose Display Setup from the
drop-down menu.

2. 1Inthe Display Setup dialog box, there are two options for saving styles:

» Save Settings As saves all the settings in Display Setup. The settings are given a
name that is then listed in the Display Setup drop-down menu. Properly saved Setup
Profiles are easily retrieved and applied to display windows. Click this button and
enter the name you want to assign to the current settings.
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Molecule Editor
Display Profile setup options

» Save To File saves current graphics display settings that you have defined. They are
not as easily retrieved as when you use the Save Settings As option. Use this option
as an example, when you are preparing graphics for publications and wish to transfer
formatting instructions from one display window to another. In the standard File
Save dialog box, choose a file name for current styles and Standard Arrangement
information.

The Saving Styles are divided into two types:

Molecule Document Files: In this saving style, you can export the file after editing. Go to
File » Export to export the edited file.You can only use the DNA/RNA Molecules
Document or the Protein Document file format. In the absence of these two file formats,
the Vector NTI™ Express Designer Software will prompt you with the message that the
Display Settings will not be saved.

Create Molecule Shortcut: In this saving style, you can create a shortcut that contains the
Display Settings configured in a non-graphical editing mode that can be saved. Changes
done in the graphic edit mode will not be saved into the Molecule Shortcut file.

Loading Styles

To apply a saved Display Profile to a Molecule Display window,

1.

Choose a profile entry name from the list in the Display Setup drop-down menu or in the
Settings Profile drop-down menu in the Display Setup dialog box.

When you make the selection, Vector NTI™ Express Designer Software loads the styles as
well as other settings from the profile but does not apply them to the active window until
you click the OK button.

Modify the settings further, if you like; click OK to accept the new setup or click Cancel
to leave the current window’s settings unchanged.

Change the Arrangement Setup

The Vector NTI™ Express Designer Software automatically rearranges the symbols and labels
on the graphics map when you change the set of restriction enzymes, edit the functional map of
the molecule, etc. This is called the Standard Arrangement.

Go to Toolbar in the Molecule Editor and click |# Standard Arrangement or by selecting
Standard Arrangement Item from the Molecule Editor Shortcut menu.

Standard Arrangement repositions all the elements back to the original default position.
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Display Profile setup options

Picture type 1. Check the PictureType check box to view the type of the picture in the Preview pane.

2. Select from Linear and Circular Picture Type radio buttons.

3. Click OK to submit the PictureType Setup Option edits or Cancel to exit the Preferences

dialog box.

Note: The Picture Type Display Profile setup option is applicable only to DNA/RNA
molecules. Protein molecules can be displayed only in the Linear style.

The PictureType Setup dialog box looks like this:

Figure 1 Linear Picture Type

Setup Options
[#] Feature Map
Sequence
Restriction Map
[] orrs

[ Motifs Setup

Auto Load Analysis
Graphic Display
PictureType

Picture Type: () Linear () Circular

Pre:

visw

Load from file... ] [ Savetofile...

Figure 2 Circular Picture Type

Setup Options

Feature Map
Sequence
Restriction Map
[ ores

[] wetifs setup

Auto Load Analysis
Graphic Display
PictureType

Load from file... ] [ Savetofile...
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2 Molecule Editor
Enter or edit a sequence

Enter or edit a sequence

The molecule sequence is displayed in the Sequence pane, and a graphical representation of the
sequence is displayed in the Graphics pane.

Enter a sequence 1. To enter a new sequence, click on an insert point in the Sequence pane and begin typing.
2. The Edit Sequence dialog will open, displaying your typed sequence.

Edit Sequence g|

Insert sequence at 235bp

235 RACCGTACGECE TRRCGRTCGR CET|
TECATECCEC  ATTGCTAGCT GCR

OK ] [ Cancel

3. Continue typing and click on OK to insert the sequence.

Select a sequence  To select part or all of a sequence:

» Drag your cursor over the desired portion sequence in the Sequence pane or Graphics
pane.

* Click on a feature in the Graphics pane or Feature Map that encompasses that sequence.

» Click Ctrl+a or right-click and select Select all to select the entire sequence.

Cut or copy a  To cut a sequence, select it in the Sequence or Graphics pane and click Ctrl+x, or right-
sequence click and select Cut, or select the command from the Edit menu. You will be prompted to
remove the sequence.

» To copy a sequence, select it and click Ctrl+e, or right-click in the Sequence or Graphics
pane and select Copy, or select the command from the Edit menu.

Paste a sequence 1. To paste a sequence from the clipboard, click on a particular insertion point in the
Sequence or Graphics pane and click Ctrl+v or select Edit » Paste.
2. The Edit Sequence dialog will open, displaying your pasted sequence. Click on OK to

complete the action.

Replace a To replace part or all of a sequence, select it in the Sequence Pane and type or paste as described
sequence above.

Delete a sequence To delete all or part of a sequence, select it in the Sequence or Graphics pane and click the
Delete key or right-click and select Delete.

Reverse a You can reverse all or part of a sequence:

sequence 1. Select all or part of the sequence in the Sequence or Graphics pane.
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Molecule features

2. Right-click and select Reverse Selection to Complementary.

Molecule features

Create a molecule
feature

Select a feature

Molecule features are regions of a DNA or protein sequence that you define and annotate. The
feature is then displayed in the Graphics pane and listed in the Feature Map.

Typical DNA molecule features might include coding regions, specific ORFs, primer binding
sites, etc. Protein molecule features might include structural features, binding sites, functional
domains, etc.

To create a molecule feature:

1. Select a portion of the molecule sequence by dragging in the Graphics pane or in the
Sequence pane.

2. Right-click and select Create feature from selection.

3. Inthe Feature dialog, select a category from the Feature Type list. Various miscellaneous
categories are available under Misc.

Feature dialogs for DNA (left) and protein (right)

Feature 7‘ Feature &‘
Feature Type Feature Name: Feature Type Feature Name:
[+ cos || ccaB (£ eond Mogifications ~
[ callutar Eoeires (23 Post-Translationsl Modifi | pascriptian:
[+ centromere (=[] Protein Functional Featuras.
¥ conflict 23 Domains
[#4 D-Loop (=423 DNA/RNABinding
[*) D-segment [®9) Basic
[ Enhancer [® HMc-ac:
Exon [®3 Homeodomain
[*4 GCsignal [® HTH
[# Glycosylationsite 83 Zinc Finger

[#4 Homecdomain [®4 DMA/RNA binding

[+ iona (23 MetsiBin

[* Insertien fram: | 503 3 other Location

[+ Intror T 813 (2 other From: | 108
- v

(34 Jsegmen 3 Complementary - 84 conn To: 156

[# Leucine Ziooer Domain

Annatations Annatations.

Key Value Add Key Value Add

Life Technologies 10800

4. Enter a Feature Name and optional Description.

5. The Location range is auto-populated based on your selection. Enter a different range in
the fields if desired.

6. For a DNA feature, select the Complementary check box if the feature is located on the
reverse strand.

7. Click on Add or Delete to add or remove Annotation keys. When adding a key, a blank
key is created in the table; type to replace the text.

8. When you are finished, click on OK. The feature will displayed in the Graphics pane and
in the Feature Map.

To select a molecule feature, click on it in the Graphics pane or in the Feature Map.

Vector NTI™ Express Designer Software User Guide 73



2 Molecule Editor
Create Vector NTI™ Express Designer Parts from molecules

Hide or display a To hide a feature or group of similar features, deselect the appropriate check box in the Feature
feature Map. To re-display it, re-select the check box.

Edit or delete a To edit a feature, right-click on it in the Graphics pane and select Edit feature. The Feature
feature dialog will open.

To deselect a feature, right-click on it in the Graphics pane and select Delete feature. You will
be prompted to confirm the deletion.

Create Vector NTI™ Express Designer Parts from molecules

Create Part from To create a Vector NTI™ Express Designer Part from a molecule or selected region of a
selection molecule:
1. Select all or a portion of the molecule sequence in the Graphics pane or in the Sequence
pane.

2. Right-click, or click on the Create Parts tool in the Analysis toolbar, and select Create
Part from selection.

3. In the Create New Part dialog, enter a name for the Part.

X

~
 Create New Part
Name ADRALA_1_2308

Part Category | Part Type w
Sequence
1 GRATTCCGRER TCRATGIGCAGE ARTGCTGRRT CITCCCCCRG CCRGGRCGRI A
CTTRRGECTT AGTRCRCGIC TTRCGRCTTR GRREGEGEIC GETCCIECTI
51 TARGRCRGCG CGGARRRGCR GRTICTCGTR ATTICTGERART TGCATGITEC
ATTCTGTCGC GCCTTITICGT CTRARGAGCAT TRAAGRCCTTR RCGTACRACK
101 ARGEAGICTIC CIGEATCITC GCACCCRGCT TCGEETRGEE RGEGERETCCC
TTCCTCRAGRG GACCTRGRRE CGIGEEICER  AGCCCATCCC TCCCTCRGGC
151 GEICCCEEEC TAGECCRGCC CGECAGETIGE AGREGEICCC CGEECRECCCC
CCREEECCCE ATCCGETCGEE  GCCETCCACC TCTCCCRGEE GCCETICEEGE
TN1 ECECSCCCCT  SECCLATETCT  TTALTECCTT  SeCCCTTORT  STeerTTe

Add to project | ExampleProjectl | indevice | Device_1 w

o J[ e ]

4. Select a standard Vector NTI™ Express Designer Part category from the Part Category
Type list, and a Part type from the Part Type list.

5. Under Add to Project and In Device, you can select an existing project and device or
create new ones.

6. When you are finished, click on OK. The Part will be displayed in the Vector NTI™
Express Designer window within a Device and a project. See Chapter 3, “Vector NTI™
Express Designer: Parts, Devices, and Circuits” on page 91 for more information.

Extract Parts from To create Vector NTI™ Express Designer Parts from the defined features in a molecule:

features 1. Select all or a portion of the molecule sequence in the Graphics pane or in the Sequence

pane.

2. Right-click and select Extract Parts from features.
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selected.

Restriction Analysis

3. In the Extract Parts from features dialog, the features in the molecule will be listed and

® Extract Parts from features

Subset Options
Fleaze zelect the destination folder. If duplicate records found:
58] Parts (MAIN) (3) Ask every time
(O Cverwrite All
() skipan
Review
Name Description Part Category Sequenc... Status
Source_1_2306  Source 2306 Ready
ADRA1A_1 23068 Gene Towic gene 2306 Ready
ADRAL1A 437_... CDS Coding Sequence 1500 Ready
ADRA1A 5B87_... Miszc. Feature 228 Ready
ADRAL1A_BSE_... Varistion Variation 1 Ready
ADRAL1A_BSE_... Varistion Variation 1 Ready
ADRA1A_1035... Varistion Variation 1 Ready
ADRA1A_1175... Varistion Variation 1 Ready
ADRAL1A_1475... Varistion Variation 1 Ready
ADRAL1A_1475... Varistion Variation 1 Ready
Open Parts in a new project
Summary
Total: 10 Ready: 10 Save Failed: 0 Saved: O Overwritten: 0 Skipped: 0

l

| |

Close

4. Deselect the check boxes next to the Parts you do not want to create.

5. Under Options, specify what to do in the event of duplicate Parts in the database.

6. Select the Open Parts in a new project check box to immediately open all the Parts in a
new Vector NTI"" Express Designer project window.

7. Under Add to Project and In Device, you can select an existing project and device or

create new ones.

8. When you are finished, click on Save. You will be prompted to overwrite or skip parts
with duplicate names in the database. See Chapter 3, “Vector NTI™ Express Designer:
Parts, Devices, and Circuits” on page 91 for more information.

Restriction Analysis

You can identify the restriction sites in a DNA/RNA sequence for hundreds of restriction

enzymes.

To begin, with a DNA/RNA molecule open, click on the Restriction Analysis button on the

Analysis toolbar.

¥

The Restriction Analysis tool includes commands for selecting and configuring a list of
restriction enzymes, and running the analysis.

Vector NTI™ Express Designer Software User Guide

75



Molecule Editor
Restriction Analysis

2

8 Vector NTI Express Designer - Molecule Editor (o | B [
File Edit View Curate Discover Design Confrm Tools  Help
o o
N A A .
< EEYH D99 # m D
E=RIE e 5 B
oF Restriction Analysis &,
XREF o Configure Restriction Enzymes -
Apall (GTGCAC): L sites Name. Recognition Stri Cuts Aft Qverh End E T iz
- [2] Awal (CTCGGG): 1 stes Petl (456) ame ecognition String uts After verhang  En nzyme Ty.. i
» ] HindIl (AAGCTT):1 sites GNG Apall gtgeac 1 gea 4(5) Restriction... Minetech Biotechn...
» [ Petl (CTGCAG): 2 sites NG5 GNGS el Aval cyegrg 1 yegr 4(5) Restriction... Bangalore Genei, EU... =]
4 Mon-Cutting Enzymes Gies solrce G BamHI ggatee 1 Agatc 4(5) Restriction... Bangalore Genei, EU... e
EcoRI sz apall (508) st (hsk)  GNGS Hi Clal ategat 2 rcg 2(5) Restriction... Bangalore Genei, EU.
Smal ‘ EcoRl gaattc 1 Aaatt 4(5) Restriction... Bangalore Genei, EU... =
Neol Hinclll aagett 1 Aaget 4(5) Restriction... Bangalore Genei, EU... =
BamHI Neol ceatgg 1 catg 1(5) Restriction... Bangalore Genei, EU.. o
Hmal Pstl ctgeag 5 tgea™ 4(3) Restriction.. Bangalore Genei, EU...
Clal Smal cecgag 3 ~ Blunt Restriction.. Bangalare Genei, EU... ]
! Xmal cccgag 1 *eegg 4(5) Restriction... Bangalore Genei, Ne..
I et
(B T
ARR
Configure List ¥
GNG5 -
598b Permitted Terminus Types -
p s @
Occurrence (# of sites)
@Al © Single ©) Double ©)>2 () Exact:
Ignore RENs having (2 of sites)
() Less Than: More Than:
Ignere RENs cutting eutside region Ignere RENs cutting inside region
From: Te: From: To:
5 B T U [Courier New |10~ Background color (1| Font color ||
1 CACAAACTGG GAGGARRACT GAGACCTCCT GGTACCCGCC GCCGGGCCIT TTAGARACTC CCACRAGCTC TGCCTICCCT CCCTGGICCT CTICAGACCC -
GTGTTTGACC CTCCTTTTGA CTCTGGAGGA CCATGGGCGG CGGCCCGGARA AATCTTITGAG GGTGTTCGAG ACGGAAGGGA GGGACCAGGA GARAGTCTGGG T
aval [133)
101 CCICTTAGIT CTTCGCGGCT AACGGCTCGC GCTCGGGGCC GGGIGIGGAG CIGGAACAGA GGGCTGGCAA GGCGCGCATC GGACCGAGGG TGGAGCCGCT L
. GGAGRATCAA GAAGCGCCGA TTGCCGAGCG CGAGCCCCGG CCCACACCTC GACCTTGTCT CCCGACCGTT CCGCGCGTAG CCTGGCTCCC ACCTCGGCGA =
Properties 201 GAGCACAGAR CCGGARACTT AGAGACARAG TTCGGAGCCC CGCCCCCGCC GCGCGCCGCT GAGTTGICTG GCCCCGCCGR  CCCACGGCCC  ACGACCCACC
Feat M CTCGTGTICTT GGCCTTTGAA TCTCTGTTTC AAGCCICGGG GC CTCAACAGAC CGGGGCGECT GGGTGCCGGGE TGCIGGGTGG
e #peLL 1328] M
Analysis Results 301 GACCCACGAR TCGGCCCGGC CGTCGCGIGC ACCATGICIG GCTCCICCAG CGTCGCCGCT ATGAAGARRG TGGTTCAACR GCICCGGCTG GAGGCCGGAC
CTGGGTGCTT AGCCGGGCCE GCAGCGCRACG TIGGTACAGAC CGAGGAGGIC GCAGCGGCGR TACTICITIC ACCAAGITGI CGAGGCCGAC CTCCGGCCIG
» PRl (433 Patl _(456)
T 401 TCRACCEOGRT ARRAGTTTCC CAGGCAGOTG  CAGRCTTGRRE ACAGTTOTAET CTRCRAGAATE CTCARCATRR COCTOTEOTE  ACTGGEAGTAT CTTCALGTAC 2
494 bp

Selecting enzymes
for analysis .

* To clear the list, click on Clear Selection.

Click on enzymes in the list to select or deselect them.
» To select all the enzymes in the list, click Select All.

Configuring the 1.

enzyme list

76

A default list of restriction enzymes to be used in the analysis will be selected.

To configure the enzymes in the Restriction Analysis tool, click on Configure List.
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Restriction Analysis

2. Use the commands in the Select Restriction Enzymes dialog to add or remove the selected
enzymes, then click Apply.

r 1
{8 Select Restriction Enzymes @

Subset Selection

] Enzymes (MAIN)

Filter
End: Enzyme Type: Suppliers: |[All -
Available Enzymes Selected Enzymes

[7] Select / Deselect All

Name Recognition String Cuts After * MName Recognition String Cuts After *
[ Aad cacctge 11 B Apall gtgcac 1

[ Aatl gacgtc 5 Aval cycgrg 1

[7] Acc651  ggtacc 1 BamHI ggatce 1

] Acd gtmkac 2 Clal atcgat 2 £
[ Acell cagctc 13 EcoRl gaattc 1

[ Aci cege 1 HindIl aagctt 1

[ Al aacgtt 2 MNeol ccatgg 1

[ Acul ctgaag 22 ZSHI ctgeag 2 m
[ Afel agcgct 3 % "ma_ cee99g - 2
4| 1 b 4| i L2

0K ] ’ Cancel

Filter the analysi [ To filter the analysis results by the terminus type of the restriction cut site, select or deselect the
results check boxes under Permitted Terminus Types.

Note: 5’ and 3’ refer to the overhang of the resulting cut site, e.g., with 5” deselected,
restriction sites with 5” overhangs will be removed from the analysis.

Ignore RENs Having Less Than/More Than ... Sites hides restriction sites that do not fall
within the range of the specified number of cut sites. Such RENs will be listed but deselected in
the Restriction Map in the Analysis Results. They will not be displayed at all in the Graphics
and Sequence panes.
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Molecule Editor
ORF Finder

Perform the
analysis

ORF Finder

Define start and
stop codons

ORF Types

78

When you have made your selections, click on Run. The sites will be displayed in the Graphics
and Sequence panes and listed in the Analysis Results.

~ e
BssSI (zo10) At
Acl (ze77) 7 ' ;
bla promoter
BssSI (2603) o
Acul (z013) BetAP] (z400) attR3
Aatll (2660) \\\
Drdl (2406)
M13 (-40) forward primer
M13 (-20) forward primer
—_ - - v
< ¥

GACTGTARRT

TIGTAGICCR ATTACCECAR ARACTACAGT ARRACGCECCR

801 CRCARCTGECC ATATCGEIGE TCATCATGCE CCRGCTITICR TCCCCGATAT GCRCCRCCEE
GIGIGACCEE TATAGCCACC ACGTAGTACEC GEICGARACGT AGGEECTATA CEIGEIGECC

To identify ORFs in a DNA or RNA sequence, click on the ORF Finder button in the | g
Analysis toolbar of the Molecule Editor. =

The ORF Finder tool contains settings for identifying ORFs within the sequence.

Start Codons: ATG GTG
Stop Codons: TAATGATAG

Default Start & Stop

Include Stop Codon in ORF
ORF Types

[CRFs which have both start and stop
v Ci let: \
Smplste codons defined as above)

Minimum Size | 150 bp  [¥]Nested

[CRFs which do not have both defined
start or stop codons)

Minimum Size bp

Undefined

* In the Start and Stop Codon ficlds, enter start and stop codons for the new ORFs. Click
the Default Start & Stop button to set the start and stop codons to the following
conventional values: Start codons—ATG, GTG; Stop codons—TAA, TGA, TAG.

*  Check the Include Stop Codon in ORF box if you want the stop codon to be considered
as a part of the ORF. Otherwise, the stop codon is not considered as part of the ORF and is
not included.

* Complete: The Complete check box is selected by default and in the Minimum Size
field the minimum size in base pairs is specified as 150. This can be changed according to
your requirement. Check the Nested check box to look for nested ORFs. These are ORFs
that occur within the main ORF.
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ORF Finder

* Incomplete: Check the Incomplete check box and in the Minimum Size field specify the
minimum size in base pairs for the incomplete ORF to be displayed. Check the Undefined
Start/Stop check box to search for ORFs with undefined starts, stops or both. Check the
Nested check box to look for nested ORFs.

Note:

* An ORF with an undefined start is one that has a stop codon at the end but no
corresponding start codon in the same frame

* An ORF with an undefined stop is one that has a start codon but no stop codon in the same
frame.

* Incomplete ORFs are displayed as a dashed arrow in both the Graphics and the Sequence
Pane. Complete ORFs are displayed as solid arrows.

Perform the Click on Run to perform the ORF analysis. The ORFs will be marked with directional arrows
analysis in the Graphics and Sequence panes and listed in the Analysis Results.

;A -

pDESTR4-R3\Vector\ll

4555bp
- I} v

501 CTIGARCATITRZ TATICCCCARG RARCATCRGET TARATGECEIT TITGAIGICR TITICECEE]
GACTGTARRZAT ATRRGEEEIC TIGIAGICCR ATTACCECARR RRACTACRGT ARRRGCECCE

801 CARCARCTGECC ATATCEEIGE TCATCATGCE CCRGCITICR TCCCCGATAT GCRCCRCCEC
GIGIGACCEE TATAGCCACC ACGTAGTACEC GEICGRRACGT AGGEEECTIATR  CEIGEIGECC

By default, ORFs are displayed for the direct and complementary strands. If single-stranded
sequence is displayed, only the ORFs for that strand are shown.
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Molecule Editor
Motif finder

Motif finder

To identify a Motif finder in a DNA or RNA sequence, click Motif Finder button in the

Analysis toolbar of the Molecule Editor.

The Motif Finder tool contains settings for identifying Motifs within the sequence.

Motif Finder

Selected Motifs
Maotif Name Sequence Description

Find Sites Options

O BestFit: Similarity For
@ Similarity Threshold: 100 O

@ Average
Maximum Number of Sites: O' .
I:‘ Last Nucleotides Must Have 100% Similarity
5

' >

More information on the Motif finder, see “Motifs Setup” on page 60.
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Translation tool

Perform the When you have made your selections, click on Run. The sites will be displayed in the Graphics
analysis and Sequence panes and listed in the Analysis Results.
[ BaculoDirect\Linear\DNA_verA &3 =0

' Clal (
EcoRI (61622)
3 4 Dl A L [+]
< ' 2
g B I U |CDuriErNew vl 8 v| Background color @ Font calor E]
EcoRl (2)

1 GRATICTACC CGTARRGCER GITIAGITIT GARRRACRRZR TGACATCATT TGTATARTGR CATCATCCCC
CITRRGATGE GCATTTCGCT CRRATCRRRZR CTITTITTGITT ACTETAGTAR ACATATTACT GTAGTAGEEE

101 GTARRGCGAG TICAGITITG ARRACRRATCE AGTCATACCT ARARCACGTITA ATARATCTICT GATATCAGCI
CATTTCGCIC ARRCGTCRRRAC TITIGITIAC TCAGTATGGAR TITGIGCRAT TATTAGRRAGR CTATAGTCGER

nnnnnnnnnn

Translation tool

To translate a DNA or RNA sequence into amino acids, click on the Translate button in
the Analysis toolbar of the Molecule Editor. AT
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2 Molecule Editor
Translation tool
The Translation tool contains settings for translating the sequence.

Select Genetic Code:

UNIVERSAL w

Select Translaticn Source
@Dire:tStrand OCDmplementar\rStrand

O & Frame Translation O Translate ORF's

Translation Frames

b I 4] B o8 ] -

I’}
3

I:‘Translate into new Protein

=[5

0}

(o) (o]

1. Select the genetic code for the desired organism to use as the basis for the translation from
the Genetic Code drop-down list. For more information on genetic codes, visit
www.ncbi.nih.gov/Taxonomy/Utils/wprintgc.cgi?mode=c.

2. Select the Translation Source from among the following options:

— Direct Strand — displays a translation of the direct strand sequence in the current
frame

— Complementary Strand — displays a translation of the complementary strand
sequence in the current frame

— 6 Frame Translation — displays up to 6 translations of the sequence depending on
the selections in the Translation Frame check boxes

— Translate ORFs — if you have used the ORF Finder to identify ORFs in the
sequence, this selection will translate the ORFs

3. Ifyou selected 6 Frame Translation, select number of direct and complementary
Translation Frames used to translate the sequence. Up to three direct strand (+1, +2, +3)
and three complementary strand (-1, -2, -3) translations may be selected.

4. To create a new protein molecule from the translation, select the Translate into new
protein. Otherwise the translation will be displayed within the DNA/RNA sequence.

5. Click on Run button to perform the translation.

Translation results  If you selected Translate into new protein, you will be prompted to name the new protein and
the protein molecule will be created.

Otherwise, translations of the direct strand will appear above the DNA sequence and
translations of the complementary strand will appear below the sequence.

Translated sequence using 6 Frame Translation with +2 Frames selected

+z TER LEUARG GLN ALA ILE ASN FHEVALTER LYS SERTER THI
1 MET |ILE THRFRO SERTYRGLN LEU CYS | GLU LYSLEU ASN
1 CRGEARACAC CTATGACCAT GATTACGCCR AGCTATCRAC TITGTIATAGR ARAGTTIGRAC
GICCITIGIC GATACTGEIAZ CTRATGCEET TCGATAGITE ARARCATATCT TITCRACTIG
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Oligo Duplex Analysis

Oligo Duplex Analysis

Oligo Duplex Analysis enables the analysis of one or more oligos for potential cross-reactivity
and dimerization.

To open the tool, click on the Oligo Duplex Analysis button in the Molecule Editor.

—
+ 11
ATaTTTo
b-d
-
User Defined Primer
Name 1
Sequence :I:_Ij
Description >4
h=
T
AAR
M
T
ATGC
*
Zelected Cligos/Primers: _
GGEGGACCACTTTGTACAAGAAAGCTGGGETN -
ey
2
dG Temperature(C): | 25.0
Stem Length(bp): E
Analyze ] [ Save Results
Analysiz Results: & Total
GEEGACRRCTTITGTACARRRRRCCAGECTNN Pl
[N
NNICGGACGRRRRRACRATCETTTGRARCACEEE
Stem Length = &
Dimer dG = -8.0 keal/mol
GEEGACRRCTTITGTACARRRRRCCAGECTNN
(NN (NN
NNTCGGACGRRRRLD CATGTTIGRRCRCEEEE
Stem Length = &
Nimer 4AF = -4 2 kral/mnl b
Ente ring or Using the tool, you can analyze oligo sequences that you enter in the fields at the top, or you can
selecting oligos analyze saved oligos in the database.

» Enter an oligo name and sequence under User Defined Primers at top of the window and
click on Add to List to add it to the list of oligo sequences below, and/or Save to
Database to save it as an oligo in the database.

* Click on Select Oligos in Database to select one or more saved oligos in the database to
analyze. Use Ctrl+click and Shift+click to select multiple oligos from the Oligos in
Database dialog.

The selected oligos will appear in the Selected Oligos/Primers list.
Analysis Select from the following additional analysis parameters:

parameters + dG Temperature: enter the temperature in degrees Celsius to be used for calculating free
energy values.
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Silent Mutation Analysis

* Stem Length: enter the minimum acceptable number of base pairs in a hairpin or dimer
stem.

Run the analysis Click on Analyze to run the analysis. Analysis results are displayed at the bottom of the
window.

Click on Save Results to save the analysis as a separate text file.

Analysiz Results: & Total

GEEGACRRCTTITGTACARRRRRCCAGECTNN e
[N
NNICGGACGRRRRRACRATCETTTGRARCACEEE
Stem Length = &
Dimer dG = -§.9 keal/mol

GEECACAACTITCTACARRRRRCCAGECTHN
1 1

NNTCGGACGRRRRLD CATGTTIGRRCRCEEEE
Stem Length = &
Nimer 4AF = -2 1 kral/mnl ¥

Note: In the graphical depiction of duplexes, vertical lines indicate the primary interaction,
based on the stem length set, and plus symbols indicate secondary interactions. The greater the
dG value, the weaker the interaction; secondary interactions are not considered in the dG
calculation.

Silent Mutation Analysis

In the Molecule Editor, you can search for “silent mutations” in a DNA/RNA sequence or
selected region of a sequence that do not affect amino acid translation but result in the creation
or disappearance of one or more restriction sites.

Note: You do not need to perform restriction analysis before running Silent Mutation Analysis.
1. Select a region of the sequence or make no selection to analyze the entire sequence.

2. Click on the Silent Mutations Analysis button to open the tool. T

AAR
3. Click on Add Enzyme from Database to select from a list of restriction enzymes

in the database. Use Ctrl+click and Shift+click commands to select multiple enzymes in
the Enzyme in Database dialog.

4. Click on OK to add the selections to the Available Enzymes list.

5. Use the >>, All>>, <<, and <<All buttons to move enzymes from the Available to the Use
list.

6. Click on Run to initiate the mutagenesis search. Vector NTI"" Express Designer analyzes
the sequence or selected region and attempts to generate suitable silent mutations. The
reading frame for amino acids is defined by the start of the selected region so that the first
three nucleotides of the selected region form the first codon.

The folder contains a list of mutation options that result in the appearing and/or disappearing of
at least one restriction site. The options are sorted by the position of the first altered nucleotide.
If you selected the complementary strand option, mutation coordinates on both complementary
and direct strands are listed.
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Web analyses

Web analyses

Note: The program is able to find both “single” (just one nucleotide altered) and “multiple”
(several neighbor nucleotides altered) mutations for any elementary event (appearing and/or
disappearing of at least one site) significantly widening the set of possible solutions compared
to just “single”’-mutation analysis.

A DNA or protein molecule sequence or part of a sequence can be analyzed using a variety of
online databases, search engines, and analysis tools.

Note: These analyses require an active Internet connection.

1. 1In the Graphics or Sequence pane, select the region of the sequence to analyze, or select
Ctrl+A to select the entire sequence.

2. Right-click and select Web Analyses » [search type] » [search database].

Note: You can also right-click on a molecule in the Database Explorer to analyze the entire
sequence.

3. The sequence will be automatically transferred to the analysis engine on the web:
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Back Translation

DNA Molecule Web Analyses.

M13 reverse primer

/E/ttR4

‘cdﬂ
cut Cirl+x

Copy cHl+c
Paste Cirl+v

Delete Delete

pDESTR4-R3\Vector\ll Select Al ctisa
4555bp

Web Analyses 0 compare Against ¥
Reverse Selection to Complementary CpG Island using EMBOSS cpgplot @EE]
Camera Gene Prediction RADAR @ EBI
Delete feature Primer Search Transcription Factors using TESS@UPENN
Edit feature gPCR
Create feature from selection RNA
Launch TOPQ Cloning
bla promoter Regenerator

~ Load in GeneArt

atts Launch Gateway

Load in Parts Assembler
\\ BLAST Sequence
13 (-40) forward primey  Primer Design 4

amp(R] |

r
3
3
r

M13 (-20) forward primer

Protein Molecule Web Analyses

Region_2 Protein Regicn_4
1 1 1

Region_1 Source Region_3

{ D cut ctrl+x )
Coy Cirl+C
Py [ e
L| Delete Delete :
Select Al col+a - YCYT
Web Analyses 3 Homology Modeling using CPHMODELS @CBS

Camera Compare Against 3 Homology Modeling using SWISS-MODEL @ExPASyY
Protein Feature Search  »

Create feature from selection
Regenerator
BLAST Sequence

Back Translation

Back Translation allows you to obtain a DNA sequence from a protein sequence by reversing
the translation process. You can select from a list of translation and codon usage table options
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1. With a protein molecule open, click on the Back Translation button in the

Analysis toolbar. b
Choose Table . .w
/@m
OUseTranslatiDnTable @Use Codon Usage Table
Translation Table :\F@\
Codon Usage Table
v

Translate into new Nucleotide

Back Translation Result:

M L H ki L L R R K A A~
ATG CTG AAC GTG CTG CTG AGG AGG AAG GCC

F © L ki T K K G M A
TTC TGC CTG GTG ACC AAG AAG GGC ATG GCC

T A T T A A A T H T
ACC GCC ACC ACC GCC GCC GCC ACC CAC ACC

P R L K T F K ki T R
CCC AGG CTG AAG ACC TTC AAG GTG TAC AGC

W H P D B P 5 A K P
v
< >

2. In the Back Translation Tool, select the translation table type: Use Translation Table or

Use Codon Usage Table.

3. Select the specific translation table from the drop-down list.

Note: For more information about translation and codon usage tables, visit www.ncbi.nih.gov/
Taxonomy/Utils/wprintgc.cgi?mode=c.

4. Select the Translate into new nucleotide check box to create a DNA/RNA molecule from
the resulting analysis.

5. Click on the Submit button.

If you selected the check box in step 3, you will be prompted to enter a name for the molecule
and save it to the database.

The results will be displayed in the Back Translation Result field.

Protein Domain and Motif Finder Analyses

You can analyze a protein sequence in Vector NTI"" Express Designer against databases of
known protein domains, families, functional sites, and motif fingerprints.

Protein Domain PROSITE and PRINTS are databases of biologically significant protein patterns and profiles
Analysis—PROSITE that can be used to identify the function of uncharacterized proteins. Comparing an unknown
and PRINTS polypeptide sequence in Vector NTI™ Express Designer to the motifs in these databases can
databases help determine any known protein families and domains to which the sequence may belong.

* For more information about the PROSITE database, visit http://prosite.expasy.org/.
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Protein Domain and Motif Finder Analyses

* For more information about the PRINTS database, visit www.bioinf.man.ac.uk/
dbbrowser/PRINTS/index.php.

Local versions of the PROSITE and PRINTS motif databases are provided as part of the Vector
NTI™ Express Designer installation.

1. To begin the analysis, with a protein molecule open, click on the Protein Domain button
in the Analysis toolbar of the Molecule Editor window.

2. Select the local version of the PROSITE or PRINTS database, installed with Vector NTT™
Express Designer.

ProSite database ({Local) |/ﬁ)ﬂ
PRIMTS Database (Local) A
el i)

3. In the Analysis Jobs window, the name of the job will appear listed in the left-hand pane
and the status will be “New submit...”

e Name AnalysisType | Description Status Modified Date
Patmatmotifs I8 patmatmotifsanalysis of ADRALA Patmatmatifs  Scana proteinsequen... | Complsted Men Dec 0508:3
Name: | ADCT7 |

 Patmatmotifs Parameters

[[] Accession number  [] Description [[] Full Usa

ot

Analysis Jobs

¥

|~
5%

4. Select the parameters that will be included with the results, then click on Submit.
5. When the analysis is complete, it will be listed in the left-hand pane as “Complete.”

6. Double-click on the complete job to return to the molecule with the results displayed in
the Sequence pane and the Analysis Results.

Analysis Results O apcyz [ =aoRALA 52 8 B
: o
Pro‘telr\ = Kﬁ\
Transmem_1  Source
[ pesezi pric 2lpha-i2-adrencrgic receptor, ise|| (] )
[JFull US: - Ne
[J#on Dec 05 02:38:07 DET 2011 { i

ADRA1A B
499aa
] 3

B

< >

MUFLSCNASD
TWARVDVLCC

b G VILGGLILFG VLGNILVILS VACHRHLHSV THYYIVNLAV ADLI
TASIMGLCII SIDRYIGVSY| PLRYPTIVT{ RRGIMALLCY WALSLVISIGC DPLFGWRQPAP EDE]

201 LVMYCRVYVV AKRESRGLKS GLKTDKSDSE (QVTLRIHRKN ADPACGSCMAS AKTKTHFSVR LLEFSREKKA AKTI
Feature Map 301 FKPSETVFKI VIWLGYLNSC INPII¥ECSS = LRIQCLRRK TL
401 MERG! I TVSKI CT TARTE: VT RLECSGMILA HCNLRLPGSR DSPASASQRA G GDY

Properties

Analysis Results

» Click on a feature in the Analysis Results pane to show expanded details for that result.

* Click on a check box in the Analysis Results pane to show or hide that feature in the
Sequence pane.

* Right-click in the Analysis Results pane and select Save All Analysis Results to
Database to save these to Analysis Results in your local database.
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Motif

Finder—InterProS

can sequence
search

Protein Domain and Motif Finder Analyses

* Analysis Results saved to the database will listed in the Database Explorer, under Results
in the Analysis Results folder.

E Results Name Analysiz Type Analysiz Object Name
Psc lysis of ADCYT at M... Pscan ADCYT
& Ij Local Databaze PzcanAnalysiz of ADCYT 3t M... Pscan ADCYT
] BLASTResults ) ) )
PatmatmotifsAnalysiz of AD... Patmatmotifs ADRALA
Analysis Results
lj PatmatmotifsAnalysiz of AD... Patmatmotifs ADCYT

£ Remote Database

E Database
@ Projects iGeneral Description:

E Results

Motif Finder uses a local version of the InterProScan sequence search engine to scan a protein
sequence for protein domains and functional sites. This search tool integrates analysis engines
from multiple protein signature databases. Using this tool, you can analyze a sequence using all
InterPro analysis engines or a subset.

* For more information about InterProScan and the databases/analytical tools it includes,
visit www.ebi.ac.uk/Tools/pfa/iprscan/.

A local version of the InterProScan search engine is provided as part of the Vector NTI™
Express Designer installation.

1. To begin the analysis, with a protein molecule open, click on the Motif Finder button in
the Analysis toolbar of the Molecule Editor window.

2. In the Analysis Jobs window, the name of the job will appear listed in the left-hand pane
and the status will be “New submit...”

Analysis Jobs Name Anzlysis Type Description Status Modified Date

L interProscannalysis of ADRATA InterProScan EMBL-E8I Protein Funct.. . NewSubmit WMon Dec 05 09:47:26 PST 2

InterProScan B Potmatmotitsanalysis of aDCY7 Patmatmotifs  Scana proteinsequen.. (g Completed Mon Dec 05 08:58:14 FST2

Fr ysis of ADRATA Patmstmotifs  Scana proteinsequen... 4} Completed Mon Dec 05 08:38:15 FST2
Name ‘ ADRALA ‘ B Pscananalysis of ADCYT Pscan Scans proteinsequenc... ) Completed Mon Dec 05 08:59:28 PST2.

= Selectad Analytical Application

Applications
BlastProDom
FPrintScan
Gene3D
=

[#] TmHmMm

Use Defaults

Analysis Jobs

3. Select the analytical application(s) to use from the available list of InterProScan tools,
then click on Submit.

Note: The more applications you select, the longer the analysis will take.

4. When the analysis is complete, it will be listed in the left-hand pane as “Complete.”
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Molecule Editor

Protein Domain and Motif Finder Analyses

5. Double-click on the complete job to return to the molecule with the results displayed in
the Sequence pane and the Analysis Results.

®} & &

= BACENOIBEL924
® SRCE, rnedapein=]

Clapcrr O apraia 1

)

)

m 5w

Click on a feature in the Analysis Results pane to show expanded details for that result.
Click on a check box in the Analysis Results pane to show or hide that feature in the

Sequence pane.

Right-click in the Analysis Results pane and select Save All Analysis Results to

Database to save these to Analysis Results in your local database.

Analysis Results saved to the database will listed in the Database Explorer, under Results in the
Analysis Results folder.

E Results

Name

Fscandnaly

Local Database
-] BLAST Results
Ij Analysiz Results
Ij Remaote Database

ﬂ Database

is of ADCY7 at M...
PatmatmotifzsAnalysiz of AD...
PatmatmotifzsAnalysiz of AD...
InterProScanAnalysis of ADR...

Analysiz Type
Pscan

Patmatmaotifs
Patmatmaotifs

InterProScan

Analysiz Object Name
ADCYT

ADRALA

ADCYT

ADRALA

@ Projects

G

iGeneral Description:
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3 Vector NTI™ Express Designer:
Parts, Devices, and Circuits

Vector NTI™ Express Designer Project Window

To view the Vector NTI™ Express Designer Project window, click on the Designer button on the

main toolbar.

E@E?’fz‘ﬁf&%ﬁl@@@:::c‘:bé%:z:@

Create a new, empty Designer Project

To create a new, empty Project, select File » New » Designer Project.

A new, untitled Project will open.

Analysis
Tools

Design Canvas
Toolbar

Elements R - [ S | T S i
Bar 8
|
#
B
@
Element
Selection
Pane
cioss |
[T
Collections —
Tabs
| | [NETET
: |
Design Information
Canvas Pane
Save a Project 1. To save the new Vector NTI"" Express Designer Project, select File » Save.

Vector NTI™ Express Designer Software User Guide

91
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Create a new, empty Designer Project

2. Enter a name for the Vector NTI'" Express Designer Project in the Save As dialog box that
comes up.

(3 (%]
Saveas: | 555-1
[ OK ] [ Cancel ]
3. Click OK to Save the name or click Cancel to exit the dialog.
The Vector NTI™ Express Designer Project gets saved to the Projects folder in the
Database Explorer.
Open an existing 1. To open an existing Vector NTI™ Express Designer Project, click 1 Database
Project Explorer in the main toolbar.

2. Click Projects in the Explorer Bar, then click Designer Projects in the Local Database
folder and in the Project Name column on the left hand side view, double-click on the
name of the project you want to open.

The requisite Vector NTI™ Express Designer Project will open in the Vector NTI™
Express Designer Design Canvas.

Project window The Project window consists of the following features:

features + Elements Bar: Toggles the list in the Element Selection Pane between different types of
Elements (Circuits, Devices, Parts, or Small Molecules).

* FElement Selection Pane: Displays Elements of the selected type (Parts, Devices, etc.)
under the selected Collections Tab.

* Collections Tab: Toggles the list in the Element Selection Pane between Generic Parts/
Devices, My Freezer, My Favourites, and Library.

» Design Canvas: Displays a graphical representation of Circuits, Devices, Parts, and Small
Molecules and their interactions, as well as the complete sequence.

* Design Canvas Toolbar: Includes tools for changing the Design Canvas display,
displaying the sequence, selecting Elements, and defining the interactions among
Elements.

+ Information Pane: Provides information about the Vector NTI™ Express Designer
Project, along with the following details about the individual Elements:

— Properties

— Characterization

— Truth Table

— Rules/Auto Design

— Variants

— Job
For more information on the above, see “Information about Parts, Devices, and
Circuits” on page 118.

+  Analysis Tools: Includes tools for showing the structure of the Vector NTI™ Express
Designer Assembly; analyzing restriction sites, terminators, and ribosome binding sites;
performing GeneArt'" optimization and synthesis; and other analysis tools.
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Design Canvas

Create a new, empty Designer Project

The Design Canvas displays a graphical representation of Circuits, Devices, Parts, and Small
Molecules and their interactions.

= *ExampleProject1 &3 =0

1% @ Q w[r— 42 ~—=w-%177 -

ﬁ — — ﬁ —

CMV prom. CMVforwa.. CMVforwa.. T7promoter  T7 primer pcDNAZL.
538bp 21bp 21bp 17bp 20bp 38bp

Device_1(765bp)

- - H
VSreverse.. V5 epitope Ex His tag BGH rever. H
21bp 42bp 18bp 18bp 1
N B
*Reporter (39bp)
P
| Neomycin
| 795bp
L
Receptor 1 Selection (795bp)

It includes tools for:

ATEG
-

«  Changing the display from the Design View | 1| to Sequence View

Note: The Sequence View includes the following additional tools: Show DNA sequence
|2, Show RNA sequence | ® , and Show Protein sequence | # . For more information on
the Sequence View, see “Sequence View pane” on page 96.

* Selecting ® and rearranging Parts, Devices, and Small Molecules
* Zooming in |® | and out | & of the design area

* Defining the interactions among Elements
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Create a new, empty Designer Project

Diagram interactions among Parts, Devices, and Small Molecules

The tools on the Design Canvas toolbar allow you to diagram interactions between Parts and
Devices and Small Molecules in a Circuit.

Fr — = A = — == = "1 "] 7] —

In a Circuit that includes Small Molecules, select one of the tools above and drag your cursor on
the Design Canvas from a particular Part or Device to a Small Molecule or the visa versa as

appropriate.

Tool

Interaction indicated

Production [r]

A particular sequence results in the production of the molecule

Inhibition =

A molecule that restrains, blocks, or suppresses

Absolute inhibition [

Unrestricted restraining, blocking or suppressing

Consumption o

The utilization of a molecule, especially the rate at which it is
used

Modulation [—|

The normal capacity of a cell's adaptability to its environment

Stimulation |

Positive fluctuation (speed) of a process. A stimulation can be, for
instance, a catalysis or a positive allosteric regulation

Absolute stimulation =

A stimulation that is crucial for expression

Necessary stimulation

&

A stimulation that is required for an expression to work

Repression (1]

The molecule represses expression of a particular gene

Activation [ A molecule enhances the interaction between RNA polymerase
and a promoter

Induction [=] A molecule activates a sensor that affects the expression of a
gene

Catalysis — Change in rate of a chemical reaction in the presence of a

catalyst
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ComponentsInUse  The Components In Use tree provides another method for viewing and manipulating the
tree structure of the Circuit and all its constituent Parts, Devices, and Small Molecules. Click ==
Components In Use button located at the top of the analysis tools to display the tree.

Note: You can access the Components In Use tree from both the Design View pane and the
Sequence View pane.

e empepmied i3 5| *5= components In Use ‘ =
|-_|'_‘-,gn QQ|\|F—|—|IL—<>—.-»—»‘1‘1“I,*¢ = Emmpletircuitl o ggf
B Devicel |

© CMV promater - a8
- B + CMVforward primer bd - =
< CMVforward primer bd o d
r’ o~ o I » N " 17 promotar - o *

i = T7primer 4 o
pCcDNAZ.1 MCS + o %

€MV prom CMV forwa CMV forwa T7 promater T7 primer pcONA3.1 i =] *Reporter Yy

s2abp 210p 210p 170p 200p EE R ; 2

i V5 reverse primer + ||

. - V5 epitope -+ 5

Device_1 [765bp) ExHistaz « C[V o

-+ BGH reverse primer -+ o

. B selection Y

{ © Neomycin - o

- -
| WSreverse VS epitope Gx Histaz BGH revar.
210p azbp 180p 180p
*Repartar 955p)
P
Neomycin
7356p
“Selection [73560)

Using the tree, you can:

» Rearrange Parts in a Device
* View the components of the sequence and select them while viewing the sequence

* Reverse the sequence of a Part by clicking on the = Reverse Sequence button against that
Part name

» Change the sequence of a Part to the reverse complement sequence by clicking on the
Reverse Complement Sequence button against that Part name. Upon completion of the
action, the Reverse Complement Sequence button changes to the color red &

* Hide or display Parts in the Design Canvas by unselecting or selecting, respectively, the
Show/hide check box against that Part name

« B Lockand g unlock Elements by the clicking the respective icon against the Part
name
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Rearrange Parts and Devices in a Circuit

You can rearrange Parts and Devices in a Circuit.

Rearrange Parts

To change the order of Parts within a Device:

«  Use the Selection Tool ™ in the Design Canvas toolbar to drag the Part to a new
position within the Device, or

* Inthe Components In Use tree, drag the Part name to the new position within the tree.

Rearrange Devices

To change the position of a Device on the Design Canvas, use the Selection Tool to drag the
Device.

Note: This will not change the order of Device sequences within the Circuit.

Sequence View To display the sequence of the entire Circuit in the Design Canvas, click on the Sequence View
pane button | %| in the Design Canvas toolbar. The display switches to the Sequence View of the
Circuit.
T *ExampleProject 4 2 =0 “i= Components In Use
T | | %‘ LU B Circuit1 o "‘:F?

€01 GCAGAGCTCC TGIGCCTTICT AGTTGCCAGC CATCIGITGT TIGCCCCICC CCCGIGCCTT 2 El D a P
CETCTCGAGE ACACCERAGRE TCRACECTCE CTAGACRACE RACCCEGAGE CEGCACCEAR + a I

561 CCTTGACCCT GERAGETECC ACTCCCACTE TCCTTTCCTR  ATAARATGAC GARATTGCAT - a =
GERACTGEERA CCTICCARCGE TGEAGEGIGAC  AGGARRGGAT TATTTTACIC CITTRACEIR = a é

721 CGCATTGICT GAGTAGGTGT CATTCTATIC TGEGGEGTGE GGTGEGEECAG GACAGCRAGE V5 epitope - a8
GCETRAACAGR CTCATCCACA GTARGATARAG ACCCCCCACC CCACCCCEIC CIGICEITCC VS reverse primer - a %

781 GEEAGGATIC GGRAGACRAT AGCAGECATE CIGEGEEATGC GEIGEECICT ATGGEETAAG -+ a =
CCCTCCTAAC CCTICIGTITA TCGICCGTIAC GACCCCTACG CCACCCGAGR TACCCCATIC d

241 CCTATCH A ACCCTCTCCT CGGICTICGAT TCTACGATCC CTAACCCICT CCICGGTICAT + a
GGDTBGE TCEEEACGRACERA GCCCAGAGCTAR AGATECTAGE GATTGGEAGR  GGAGCCAGTR + a @

801 CATCACCATC ACCATCCTCG ACTGEIGCCTT CTACTGTIGGEA ATEIGIGICR GTTAGEETET + ﬂ
GTAGTGETAE TGETAGGAGC TGEACACGGEAR  GATGACACCT  TACACACAGT  CARTCCCACR = a

S8l GEARAGICCC CAGECICCCC AGCAGECAGR  AGTATGECARR  GCATGECATICT  CARRTTAGICR = a
CCTITICRAGEE GICCGAGEGE TCEICCGEICT TCATACETITT CGETACGIAGR  GITAATCAGT - a

1021 GCRACCAGET GIGGARAGIC CCCAGGCICC CCAGCAGGCR GARAGTATGCA AARGCATGCAT - - a
CETITGEICCA CACCITICAC GEETCCCGAGE GEICGICCET CTITCATACET TICGTACEIR

1081 CTCARATTAGT CAGCAACCAT AGTCCCGCCC CTAACTCCGC CCATCCCGCC CCTAACTCCG
GAGTTARTCRE GICETTGETR TCAGGECEGE GATTGAGECE GETAGGECEE  GEATTERAGEC

1141 CCCAGTICCG CCCATTICTCC GCCCCATGGEC TGACTARATTT TITTTATTITA TGCAGAGECC
GEETCARGEC  GGETARGAGE CEEGETACCE  ACTGATTARR  ARRRRARTRRART  ACGICTICCGE

1201 GAGECCGECCT CIGCCICIGA GCTATTICCAG AARGTAGTIGAG GAGECTITIT TIGEAGECCIR
CTICCGECGEA  GRACGGAGACT CEATAAGETIC TTCATCACTC CTICCGARARR  ACCTCCGEAT

126l GECTITIGCA ARRRGCTCCC GEEAGCTITIET  ATATCCATTIT TCGTAATACE ACTICACTATA
CCGARARCCET TITTICGAGGE CCCTCGAACR TATACGTARR ACCATTATGC TCGACTGATAT

1221 GGEGAACTITICT TTIATTIGCAGC TTATAATCGGET TACARATAZR  GCAATAGCAT CACARATTIC
CCCTTGRRCR ARTRRACETCG ARTATTACCR ATGETTITATTT CETTATCETA  GTIGTTTARRRG

1381 ACRRRTRR2E CATTITITTIC ACTECATICT AGITEIGETT TETCCARACT  CATCRATETR
TEITTIATIIC GT. G TEACGTARGR TCRACACCAR ACRGGTITGA GTAGTTACAT 1

The Sequence View toolbar is displayed above the Sequence View pane.

T[%| [ m @

Select a sequence

To select the entire Circuit sequence

* In the Sequence View pane, right-click anywhere on the sequence and from the drop-
down options, select Select All.

* In the Components In Use tree, select the Circuit name at the top of the tree.
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To select a Device sequence

» Using the Selection tool, select the Device whose sequence you want to select, in the
Design pane. When you switch to the Sequence View pane, the sequence comprising the
Device will appear highlighted.

* In the Components In Use tree, click on the Device name whose sequence you want to
select and view.

To select a Part sequence

+ Using the Selection tool, select the Part whose sequence you want to select, in the Design
pane. When you switch to the Sequence View pane, the sequence comprising the Part will
appear highlighted.

* Inthe Components In Use tree, click on the Part name whose sequence you want to select
and view.
Edit a sequence
To edit the sequence in the Sequence View pane:
1. Select the sequence you want to edit.

2. Start typing in the new sequence at the location where you want to edit the current
sequence.

The typing action opens up the Edit sequence of <Part/ Device> dialog box and you can
identify the edited portion as it is highlighted in red.

3. Click OK to confirm the edit or Cancel to exit the dialog box.
Alternatively, you can also edit a particular sequence in the following way:

1. Select the sequence you want to edit.

2. Click the Properties tab in the Information Pane.
3. In the Sequence field, click Edit.
4

In the Edit sequence of <Part/ Device> dialog box, start typing in the new sequence at the
location you want to edit the current sequence.

5. Click OK to confirm the edit or Cancel to exit the dialog box.

Cut a part of a sequence
To cut a part of a sequence:

1. Inthe Components In Use tree, select the Part or Device from whose sequence you want to
cut.

The sequence of the Part or Device is then highlighted in the Sequence View pane.

2. In the Sequence View pane, in the highlighted sequence, select the portion of the sequence
that you want to cut.

3. Right-click on the selected portion and from the drop-down options, select Cut Sequence.
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Copy a part of a sequence

To copy a part of a sequence:

1. 1Inthe Components In Use tree, select the Part or Device from whose sequence you want to
copy.

The sequence of the Part or Device is then highlighted in the Sequence View pane.

2. Inthe Sequence View pane, in the highlighted sequence, select the portion of the sequence
that you want to copy.

3. Right-click on the selected portion and from the drop-down options, select Copy
Sequence.

Paste a part of a sequence

To paste a part of a sequence:

1. Inthe Components In Use tree, select the Part or Device into which you want to paste. The
sequence is highlighted in the Sequence View pane.

2. In the highlighted sequence, right-click in the desired location, and from the drop-down
options select Paste Sequence.

Vector NTI™ Express Designer Project properties

In the Information Pane, click on the Project tab to display the following properties of the
Project:

Project | Properties | Characterization | Truth Table | Rules/Auto Design | Variants | Job

* Core ¥ Host

—_— name asa Host E]—7
e | Dscription

Created By Smruthi Miraj

Created Date 2012-120312:17:01

Lest Modified By | Smruthi Miraj

o~ hwN —

Last Modified Date | 2012-12-03 12:25:56
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Table 1 Project properties

Field Description
Core
1. | Name Displays the name of the Vector NTI™ Express Designer
Project.
2. | Description Displays a short description of the Vector NTI™ Express
Designer Project.
3. | Created By Displays the name of the person who has created the
Vector NTI™ Express Designer Project.
4. | Created Date Displays the date on which the Vector NTI™ Express
Designer Project has been created.
5. | Last Modified By Displays the name of the person who has last modified
Vector NTI™ Express Designer Project.
6. | Last Modified Date Displays the date on which the Vector NTI™ Express
Designer Project was last modified on.
Host
7. | Host Displays the name of the target host in which the Vector
NTI™ Express Designer Project component is going to be
inserted.

Note: Edits can be made only to the Description and Host fields. All the other fields within the
Project tab in the Information Pane are read-only.

Vector NTI™ Express Designer Parts

A Vector NTI™ Express Designer Part is a DNA sequence that performs a single, specific
function within a larger sequence. Examples of Parts include the following:

* Attenuator

* Ribosome Binding Site (RBS)
* Enhancer

*  Promoter

» Terminator

* Coding sequence (CDS)

* Primer binding site

* Recombination site

Parts in Vector NTI™ Express Designer can be assembled into Devices and Circuits.
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Create a Part Create a Part from a template
To create a Part from a template:

1. In the Vector NTI™ Express Designer Project window with a Project open, click on the
Parts button g in the Elements bar, and click on the Generic Parts button in the
Collections Tabs to display a list of Parts templates.

2. Drag the desired Part template from the Element Selection Pane into the Design Canvas.

O | [B) senencrans B untitleda 231 .
L% @ @ [w|F = & = — = =177
il [ S—
” | = [ Resuistion
Regulstory Region
D ™ Promoter
5 Promoter- Constitutive :
& Promoter-Inducible
g pmmw oo
. e i
List of Parts e T )
“Device_1 (10bp]
templates = Ribosome insingsice
i RNA stabilizing element
" Restriction site
(£ composice
[Ed miscenianeous Project | Froperties| © 1on | Troth Table | RulesfAuto Design | Varisnts] Jou |
Device: *Device_1
e weme [oawes L ]
Generic Parts @ = :
button = ————— SR .
# My Freezer
Wy My Favourites : :
o
INBI ubrary Crestea gy [ robinsa1 |
» ||| cresceapece | 20130208 115520 ]

Alternatively, you can:

1. Select File » New » Part.
The Create New Part dialog box will open.

(3] Create New Part

Name | |
Part Category | V| Part Type | v|
Sequence

1
Add to project | 558 V| indwicE|DEuicE_1 V|
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2. 1Inthe Create New Part dialog box, enter or select the following:

Field Description

Name Enter a name for the Part you want to create

Part Category | Select an option from the Part Category drop-down list

Part Type Select an option from the Part Type drop-down list

Sequence Enter the sequence of the Part

Add to project | From the drop-down options, select an open project to add the newly-
created Part to. You can also select the <create new> option to add the
Part to a new project

In Device From the drop-down options, select an existing Device to add the
newly-created Part to. You can also select the <create new> option to
add the Part to a new Device

3. Click OK.

Create a Part from a molecule sequence

IMPORTANT! You can create a Part only from a DNA (vectors included) or an RNA molecule
sequence.

To create a Part from a molecule sequence:

1. In the Vector NTI™ Express Designer Software Molecule Editor, select the sequence or
part of sequence that you want to convert into a Part.

Note: To open a DNA/RNA Molecule, select an option from the Local Database in the
Database Explorer. Double-click on the option you want to open. The DNA/RNA
molecule will then open in the Vector NTI™ Express Designer Software Molecule Editor.

2. Right-click on the selected sequence and select Create Part from selection.

3. In the Create New Part dialog box, enter the Part-defining properties. Click OK.

The Part will be created from the sequence and will be displayed in a new, untitled or an
existing Project window.

To save a Part based on its category, right-click on the Part in the Design Canvas and select
Save <Part> as....

The Part will be listed:

* Inyour Library in a folder that includes Parts of the same category. For example, if the
Part you created is a Promoter, then that Part will be saved within the Promoter folder in
the Library.

+ In the Vector NTI™ Express Designer Software database within the Parts folder.
Depending on the name of the Part you created, you can click Next or Last to view the
Part in the database.

If you selected/ entered the Part Type, Characterization Status, and the Status that the Part is in
under the Part Properties tab in the Information Pane, these will be included while saving the
Part. These details can be viewed in the lower half of the Parts listing in the Vector NTI™
Express Designer Software database.
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Open an existing
Part
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Open an existing Part from the Library

1.

Go to the Part category folder within the Library and drag-and-drop the Part name onto the
Design Canvas to open it.

Or

You can enter the name of the Part in the search field. The name will appear within the
folder that you saved the Part in.

Drag-and-drop the Part name onto the Design Canvas to open it.

Open an existing Part from the Database Explorer

1.

Go to the Part category folder within the Database and click on Parts folder. The Part
names are listed on the right hand side.

Click Next or Last to view the Part you want and double-click on the Part name to open it.
Or

You can enter the name of the Part (entire or partial) in the Search field above the Parts
listing. Select Exact Match Only to retrieve the Part with the exact name you entered.

Click Search.

Click Advanced Search to filter your search further with the help of user-defined fields
that match the stored Parts which are classified under the defined fields. In the Advanced
Search dialog box:

a. Select a database location from the Look in drop-down list.

b. Within the Advanced Search window, select the check boxes for Attribute Filter,
Text Filter, Assay Filter..., and Sequence Ontology Filter and click the corresponding
Attribute Filter, Text Search Setup..., Assay Setup..., and Sequence Onthology
Setup... respectively to define the search conditions.

c. Within Name, click Exact Match Only and enter the exact name of the Part you are
looking for.

d. Click Search.

® Advanced Search

Lockin: | Parts (MAIN) E]
all of the specified szarch conditions below:

Attribute Filter Text Filter

Assay Filter.. Cntelogy Filter

Name

[ Exact Match only

Save search resultin a new subset.Subset Name: | jnyerters 2
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Features of a Part In the Design Canvas, a Part is graphically represented by a rectangular box within an outer box
that represents a Device.

Different symbols are used to identify the category of the Part displayed on the Design Canvas.
The name of the Part as well as the number of base pairs the Part is made up of is displayed
below the symbol.

For example, in the following graphic:

The outer light-colored box represents the Device, while the inner dark yellow colored
box is the Part.

* The p symbol indicates that the Part is a Promoter.

* The name of the Part, BBa |14032 is displayed below the Promoter symbol while 37bp
indicates that the Part is made up of 37 base pairs.

* The other symbols used to indicate the Part Category are:

Part category Symbol Part category Symbol
Regulation RNA stabilizing element ?
Regulatory Region Terminator -
Promoter — ORF
Promoter - Constitutive If’ Coding Sequence D
Promoter - Inducible Iﬁ' Protease i
Promoter - Repressible ﬁ, Construction
Insulator @ Primer binding site

-
Replication origin O Restriction site -
Ribosome binding site a
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Right-click on the Part and select one of the following options to accomplish the adjoining

tasks:

Select...

To...

Editing tools

Undo Undo an action. For example, if you moved one Part to
another location within a Device and want to revert to
original location

Redo Redo an action

Cut ‘Part’ Remove a Part

Copy ‘Part’ Make a duplicate of a Part

Paste Paste a Part that you have cut or copied from within the

same or another Device

Remove ‘Part’

Delete a Part

Select All

Select all the components in the Design Canvas

Save ‘Part’ as...

Save the Part with another name

Replace ‘Part’ as...

Replace the Part with another Part within the same or
another Device

Open ‘Part’ as molecule

Open Part sequence in the Molecule Editor as a new
molecule

Add ‘Part’ to <My Favourites>

Add a Part to the My Favourites folder in the Collections Tab

Add ‘Part” as Variant

Save the Part as an alternative to the original component.
The resultant Part will be appended to the list of Variants
under the Variant tab in the Information Pane

Rename ‘Part’

Rename a Part

Analyzing tools

Cloning Group

For a description of tools on this submenu, see the sections
on the individual cloning tools in Chapter 5, “Vector NTI™
Express Designer: Assembly Compatibility Check” on page
149.

Perform Terminator Analysis

To invoke an analysis tool to analyze the terminator
performance

RNA Analysis

To invoke an analysis tool to display the RNA secondary
structure

Perform RBS Calculator
Analysis

To invoke an analysis tool to analyze the RBS performance

Perform RBS Calculator
Design

To invoke a tool that generates an optimum RBS for a
sequence

GeneArt™ Portal

For a description of tools on this submenu, see the sections
on the individual GeneArt™ tools in Chapter 4, “Vector NTI™
Express Designer: Analysis Tools” on page 125.

Camera

Capture the Design Canvas onto the clipboard

Display setup

Change the icon color of the Part.
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Note: You can also access the right-click menu tools from the Components In Use tree.

Vector NTI™ Express Designer Devices

on | Truth Tabl

of CutGP_PRO_D
=| Copy GP_PRO_D

¥ Remove GP_PRO_D
Select Al

Save GP_PRO_0 as...

Replace GP_PRO_0...

Open GP_PRO_0 as molecule

Add GP_PRO_D to <My Favourites =
Add GP_PRO_0 as Variant

Rename GP_PRO_0

Cloning Group 4
Perform Terminator Analysis

RMA Analysis

Perform RBS Calculator Analysis
Perform RES Calculator Design
GeneArt Portal L4

Camera
Display Setup...

Vector NTI™ Express Designer Devices

Create a Device

Create a Device from a template

To create a Device from a template:

A Vector NTI™ Express Designer Device is a group of Parts sequences that are grouped to
indicate that they perform a specific function. For example, a Device may code for a particular
protein.

Every Part you create is nested in a Device. You can add multiple Parts to the same Device.

1. In the Vector NTI™ Express Designer Project window with a Project open, click on the
Devices button -§- in the Elements bar, and click on the Generic Devices button in the
Collections Tab to display a list of Devices templates.
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2. Drag the desired Device template from the Element Selection Pane into the Design
Canvas.

O | [B venerscvevices D] uneds i
|._ T & q |w[F = m = el o
S @) aner

~ 8
o
e —
. . i e o
List of Device : —5
templates | e Mo |
Generic Devices W
button — | J v
8B My Freeser -
oty Favourites
:|nl| Libracy e

Create a new Device
To create a new Device:

1. Select File » New » Device.

The Create New Device dialog box will open.

(% Create New Device

Name | |
Device Function | L |
Add to project | TAB-37 w |

o I o]

2. In the Create New Device dialog box, enter or select the following.

Field Description
Name Enter a name for the Device you want to create
Device Select an option from the Device Function drop-down list
Function
Add to From the drop-down options, select an existing project to add the newly-
Project created Part to. You can also select the <create new> option to add the
Part to a new project

3. Click OK.
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Add Parts to a You can add Parts to a Device in one of the following ways:
Device
Add Parts from a template

To add Parts into a Device from a template:

1. In the Vector NTI™ Express Designer Project window with a Project open, click on the
Parts button ¢ in the Elements bar, and click on the Generic Parts button in the
Collections Tab to display a list of Parts templates.

2. Drag the desired Part template from the Element Selection Pane into the Device box
displayed in the Design Canvas.

[2) cenericparts O “Untitled1 5% |

?‘; QQ‘T‘r—-—nn_—o—.-»—o.—l—t—l

[E0) GenericParts
& [E Regulstion

Regulstory Region

RN

List of Parts
templates

“Device_1 [106p}

Ribosome binding site
i RNA stabilizing element
T Termina tor
[] Resulstion+construction
= [ orF
= Coding Sequence
I Protesse
[ oRF+Construction
& [ Construction
=~ Primer binding site

"7 Restriction site

£ composice

[ Miscelianeous Prajsct | Prop: IE Truth Table Design | variants | Job |

Device: *Device_1

~ Core

Generic Parts ] |
button ———————— B

S My Freezer

W My Favourites

INBI Library

Create a new Part and add that to a Device

To create a new Part:

1. Select File » New » Part.
The Create New Part dialog box will open.

(3 Create New Part

Name [ |
Part Category | v | FartType | v|
Sequence

L]
Add to project |SSS v| indwicE|DeuitE_fl v|
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Save a Device

Open an existing
Device

108

2. 1In the Create New Part dialog box, enter the name and sequence for the Part; select an
option from the drop-down list for Part category, project, and Device. The Device name
that you select will then include the newly created Part.

Create a Part from a molecule sequence and add that to the Device

IMPORTANT! You can create a Part only from a DNA (vectors included) or an RNA molecule
sequence.

To create a Part from a molecule sequence:

1. 1Inthe Vector NTI™ Express Designer Software Molecule Editor, select the sequence or
part of sequence that you want to convert into a Part.

Note: To open a DNA/RNA Molecule, select an option from the Local Database in the
Database Explorer. Double-click on the option you want to open. The DNA/RNA
molecule will then open in the Vector NTI™ Express Designer Software Molecule Editor.

2. Right-click on the selected sequence and select Create Part from selection.

3. Inthe Create New Part dialog box, enter the Part-defining properties, including the Device
in which you want to include the Part in.

The Part will be created from the sequence and will be displayed in a new, untitled or
existing Device and Project window.

To save a Device based on its function, right-click on the Device in the Design Canvas and
select Save <Device> as....

The Device will be listed:

* Inyour Library in a folder that includes Devices performing the same function. For
example, if the Device you created functions as a Reporter, then that Device will be saved
within the Reporters folder in the Library.

+ In the Vector NTI™ Express Designer Software database within the Devices folder.
Depending on the name of the Device you created, you can click Next or Last to view the
Device in the database.

If you selected/ entered the Intellectual Property information, Assay Type, Associated
Reagents, Characterization State, and the Status that the Device is in under the Device
Properties tab in the Information Pane, these will be included while saving the Device. These
details can be viewed in the lower half of the Devices listing in the Vector NTI™ Express
Designer Software database.

Open an existing Device from the Library

1. Go to the Device Function folder within the Library and drag and drop the Device name
you want to open onto the Design Canvas.

Or

2. You can enter the name of the Device in the search field. The name will appear within the
folder that you saved the Device in.

3. Drag and drop the Device name onto the Design Canvas to open it.
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Open an existing Device from the Database Explorer

1. Go to the Devices folder within the Database and click on the folder. The Device names
are listed on the right hand side.

2. Click Next or Last to view the Device you want and double-click on the Device name to
open it.
Or

3. You can enter the name of the Device (entire or partial) in the Search field above the
Devices listing. Select Exact Match Only to retrieve the Device with the exact name you
entered.

4. Click Search.

5. Click Advanced Search to filter your search further with the help of user-defined fields
that match the stored Devices which are classified under the defined fields. In the
Advanced Search dialog box:

a. Select a database location from the Look in drop-down list.

b. Within the Advanced Search window, select the check boxes for Attribute Filter,
Text Filter, and Assay Filter and click the corresponding Attribute Filter, Text Search
Setup..., and Assay Setup... respectively to define the search conditions.

c. Within Name, click Exact Match Only and enter the exact name of the Device you
are looking for.

% Advanced Search

Lockin: | Devices [MAIN) E]
all of the specified search conditions below:
Attribute Filter Text Filter
[ Attributes Setup... ] [ Text Search Setup... ]
Assay Filter... Ontology Filter

Name

I:‘ Exact Match Only

Save search result in a new subset.Subset Name: | jqyerters

d. Click Search.
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In the Design Canvas, a Device is graphically represented by a rectangular box that includes
one or more smaller boxes that represent Parts.

The name of the Device as well as the number of base pairs the Device is made up of is
displayed outside the Device box. Right-click on the Device and select one of the following
options to accomplish the adjoining tasks

Select...

To...

Editing tools

Undo Undo an action. For example, if you moved a Device to
another location within a project and want to revert to
original location

Redo Redo an action

Cut ‘Device’ Remove a Device

Copy 'Device’ Make a duplicate of a Device

Paste Paste a Device that you have cut or copied from within

the same or another project

Remove ‘Device’

Delete a Device

Select All

Select all the components in the Design Canvas

Save ‘Device’ as...

Save the Device with another name

Replace ‘Device’ as...

Replace the Device as another within the same or
another project

Clear ‘Device’

Remove all contents of the selected Device

Open ‘Device’ as molecule

Open Device in the Molecule Editor

Add ‘Device’ to <My Favourites>

Add a Device to the My Favourites folder in the
Collections Tab

Add ‘Device’ as Variant

Save the Device as an alternative to the original
component. The resultant Device will be appended to
the list of Variants under the Variant tab in the
Information Pane.

Rename ‘Device’

Rename a Device

Analyzing tools

Cloning Group

For a description of tools on this submenu, see the
sections on the individual cloning tools in Chapter 5,
“Vector NTI™ Express Designer: Assembly Compatibility
Check” on page 149.

Perform Terminator Analysis

To invoke an analysis tool to analyze the tormentor
performance

RNA Analysis

To invoke an analysis tool to display the RNA secondary
structure

Perform RBS Calculator
Analysis

To invoke an analysis tool to analyze the RBS
performance

Perform RBS Calculator Design

To invoke a tool that generates an optimum RBS for a
sequence
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Select...

To...

GeneArt™ Portal

For a description of tools on this submenu, see the
sections on the individual GeneArt™ tools in Chapter 4,
“Vector NTI™ Express Designer: Analysis Tools” on page
125.

Camera

Capture the Design Canvas onto the clipboard

Display setup

Change the background color of the Device.

o]
I—’ H
A H
*Promoter... *Replicati... *RMA stabi...
10bp 10bp 10bp

of Cut Device_1
:=| Copy Device_1

¥ Remove Device_1
Select Al

Save Device_1as...

Replace Device_1...

Clear Device_1

Open Device_1 as molecule

Add Device_1 to <My Favourites=
Add Device_1 as Variant

Rename Device_1

Perform Terminator Analysis

RMA Analysis

Perform RBS Calculator Analysis
Perform RES Calculator Design
GeneArt Integration 4

Camera

Note: You can also access the right-click menu tools from the Components In Use tree.
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Vector NTI™ Express Designer Circuits

Rules for creating a

Circuit

Create a Circuit

112

Vector NTI™ Express Designer Circuits provide a way of diagramming sequences to indicate
interactions between two or more Devices with the help of other external small molecules
(including small RNAS, Receptors, and Ligands). Each component of a Circuit has an
individual function and collectively the resulting Circuit represents the objective of the
experiment design.

Interactions that you can diagram within a Circuit include:

*  Production r

* Inhibition [~

* Absolute-inhibition [+
e Consumption (=

*  Modulation [~

e Stimulation [~

» Absolute-stimulation |+
* Necessary-stimulation [+
* Repression |1

* Activation 1

* Induction 7

+ Catalysis |~

While creating a Circuit, in a Device:

* The Promoter always occupies the starting position

* A Promoter always comes before a Ribosome Binding Site (RBS).
* An RBS always comes before a Coding Sequence (CDS).

* A Terminator always comes after a CDS.

* A promoter organism == E. coli

* A Terminator is of instance (Bba_b0010)

» There is no selectable marker

Circuits are created by default when you create a Vector NTI"™ Express Designer Project. Each
Vector NTI™ Express Designer Project is a single Circuit, and each Part and Device are nested
in that Circuit. A Circuit can contain an unlimited number of Parts and Devices. You can save a
Circuit with a name other than the Project name and can open the same Circuit in another
Vector NTI™ Express Designer Project.

When you create a new Vector NTI™ Express Designer Project, the Name field under the
Properties tab in the Information Pane displays the default entry of Circuit 1.
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The following figure represents an example Designer Circuit:
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Save a Circuit There are three ways in which you can save a Circuit:

Save a Circuit using the right-click menu
To save the Circuit:
1. Right-click anywhere on the Design Canvas to open display the menu.
2. Select Save <Circuit> as....
3. Inthe Save As dialog box, enter a name for the Circuit in the Save as field.

4. Select the destination folder (the default folder is Circuits (MAIN)). Click OK.

Save a Circuit from the Information Pane
1. In the Information Pane, click Save As....
2. Inthe Save As dialog box, enter a name for the Circuit in the Save as field.

3. Select the destination folder (the default folder is Circuits (MAIN)). Click OK.

Save a Circuit from the Components In Use panel

1. From the Analysis Tools, click iE Components In Use to open the panel listing all the
components of the Circuit in use.

2. Right-click the top-most folder (default is Circuit-1) in the panel and select Save
<Circuit> as....

3. Inthe Save As dialog box, enter a name for the Circuit in the Save as field.
4. Select the destination folder (the default folder is Circuits (MAIN)). Click OK.

The Circuit will be listed:
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* Inyour Library in a folder that includes Circuits of the same type(?). For example, AND
Gate, OR Gate, NOT Gate.

+ In the Vector NTI"™ Express Designer Software database within the Circuits folder.
Depending on the name of the Circuit you created, you can click Next or Last to view the
Circuit in the database.

If you selected/ entered the Intellectual Property information, Assay Type, Associated
Reagents, Characterization State, and the Status that the Circuit is in under the Circuit
Properties tab in the Information Pane, these will be included while saving the Circuit. These
details can be viewed in the lower half of the Circuits listing in the Vector NTI™ Express
Designer Software database.

Open an existing Open an existing Circuit from the Library
Circuit 1. Go to the Circuit type folder within the Library and drag and drop the Circuit name you
want to open onto the Design Canvas.

Note: When you drag and drop a Circuit, the target Circuit merges into the Project. For
example, if you drag-and-drop a Circuit that contains four Devices into an open Project
containing one Device, then the resulting Project will include five Devices.

Or
2. You can enter the name of the Circuit in the
3. field. The name will appear within the folder that you saved the Circuit in.

4. Drag and drop the Circuit name into the Design Canvas to open it.

Open an existing Circuit from the Database Explorer

1. Go to the Circuits folder within the Database and click on the folder. The Circuit names
are listed on the right hand side.

2. Click Next or Last to view the Circuit you want and double-click on the Circuit name to
open it.
Or

3. You can enter the name of the Circuit (entire or partial) in the Search field above the

Circuits listing. Select Exact Match Only to retrieve the Circuit with the exact name you
entered.

4. Click Search.

5. Click Advanced Search to filter your search further with the help of user-defined fields
that match the stored Circuits which are classified under the defined fields. In the
Advanced Search dialog box:

a. Select a database location from the Look in drop-down list.

b. Within the Advanced Search window, select the check boxes for Attribute Filter,
Text Filter, and Assay Filter and click the corresponding Attribute Filter, Text Search
Setup..., and Assay Setup... respectively to define the search conditions.

c. Within Name, click Exact Match Only and enter the exact name of the Circuit you
are looking for.
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% Advanced Search

Vector NTI™ Express Designer Circuits

Lookin: | Devices [MAIN)

Attribute Filter

all of the specified search conditions below:

Text Filter

[ Attributes Setup... ] [ Text Search Setup... ]

Azzay Filter...

O

Name

I:‘ Exact Match Only

Save search result in a new subset.Subset Name: | jqyerters

Ontology Filter

O

d. Click Search.
Features of a In the Design Canvas, a Circuit is graphically represented by a two or more rectangular boxes
Circuit representing Devices that include one or more smaller boxes that represent Parts. Small

molecules, also graphically represented, are used to establish the relationship between the

Device ‘boxes’.

The name of the Circuit as well as the number of base pairs the Circuit is made up of is
displayed in the Name and Sequence fields respectively under the Properties tab in the

Information Pane.

Right-click anywhere in the Design Canvas and select one of the following options to

accomplish the adjoining tasks:

Select...

To...

Editing tools

Undo Undo an action. For example, if you moved a Circuit to
another location within a project and want to revert to
original location

Redo Redo an action

Cut Circuit’ Remove a Circuit

Copy “Circuit’ Make a duplicate of a Circuit

Paste Paste a Circuit that you have cut or copied from within

the same or another project

Remove ‘Circuit’

Delete a Circuit

Select All

Select all the components in the Design Canvas

Save Circuit’ as...

Save the Circuit with another name

Clear ‘Circuit’

Remove all contents of the selected Circuit

Open ‘Circuit” as molecule

Open Circuit in the Molecule Editor

Add ‘Circuit’ to <My Favourites>

Add a Circuit to the My Favourites folder in the
Collections Tab

Rename ‘Circuit’

Rename a Circuit

Vector NTI™ Express Designer Software User Guide

115



116

Vector NTI™ Express Designer: Parts, Devices, and Circuits
Vector NTI™ Express Designer Circuits

Select...

To...

Analyzing tools

Cloning Group

For a description of tools on this submenu, see
the sections on the individual cloning tools in
Chapter 5, “Vector NTI™ Express Designer:
Assembly Compatibility Check” on page 149.

Perform Terminator Analysis

To invoke an analysis tool to analyze the
tormentor performance

RNA Analysis

To invoke an analysis tool to display the RNA
secondary structure

Perform RBS Calculator Analysis

To invoke an analysis tool to analyze the RBS
performance

Perform RBS Calculator Design

To invoke a tool that generates an optimum RBS
for a sequence

GeneArt™ Portal

For a description of tools on this submenu, see
the sections on the individual GeneArt™ tools in
Chapter 4, “Vector NTI™ Express Designer:
Analysis Tools” on page 125.

Camera

Capture the Design Canvas onto the clipboard

Note: You can also access the right-click menu tools from the Components In Use tree.

3 *Untitled1 O =untitled2 53

T

T @ Q WM — Ha—— 17 —

it

Protein Receptor 1

< Undo

o Cut Circuit_1
|iZ| Copy Circuit_1

Select Al

*Fromater... Codi
10bp

Save Circuit_1as...

Clear Circuit_1

Open Circuit_1 as molecule

Add Circuit_1 to <My Favourites =

Perform Terminator Analysis

RMA Analysis

Perform RBS Calculator Analysis
Perform RES Calculator Design
GeneArt Integration 4

Camera

S D oo B cF S i
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Small Molecules

Small Molecules

Vector NTI™ Express Designer Small Molecules are entities within a cell that interact with the

Devices within a Circuit. Following are examples of Small Molecules:

DNA

Protein Receptor

Protein Transcription Factor
RNA

Small Molecule

Small Molecule - Amino Acid
Small Molecule - Carbohydrate
Small Molecule - Carbohydrate (Modified)
Small Molecule - Electron
Small Molecule - Lipid

Small Molecule - Lipid (Modified)
Small Molecule - pH

Small Molecule - photon

Small Molecule - RNA
Macromolecule

Modulation

Nucleic Acid Feature
Perturbing Agent

Protein Enzyme

Protein Fluor

Simple Chemical

Source Sink

To use a Small Molecule from a template:

1.

In the Vector NTI™ Express Designer Project window with a Project open, click on the
Small Molecules button | & | in the Elements bar, and click on the Generic Small
Molecule button in the Collections Tabs to display a list of Small Molecule templates.

Drag the desired Small Molecule template from the Element Selection Pane into the

Design Canvas.
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Information about Parts, Devices, and Circuits

Properties

118

In the Design Canvas with the Selection tool selected, click on a Part (innermost rectangular
box), Device (outer rectangular box), or Circuit (anywhere in the Design Canvas) to select it. In
the Information Pane, click on the Properties tab to display and enter information about the

selected Element.

X

=
|1/ @@ |[x[Fr =42 o= »+173 7 —

*Promoter *ORI *Ribosom... |
10bp 10bp 10bp

Device_1 [30bp)

Project | Properties | Characterization | Truth Table | Rules/Auto Design | Variants | lob

- Caore p Classification
Name I:‘Pr:muter b Origin
8l b Source
Sequence 10by Edi
i ? " p Intellectual Property

Fart Category fPrDther v_

Part Type :.Prr_‘matsr v

» Description

b Resgents
Properties field Description
Core fields
Name Enter a name for your Part, Device, or Circuit
Sequence Read-only field. Displays the number of base-pairs that

make up the Part, Device, or Circuit

Part Category (Parts only)

Part category is a functional unit of a Part. Select a
category for the Part from the options in the drop-down
list

Part Type (Parts only)

Part type is further classification of a Part Category.
Select a type for the Part from the options in the drop-
down list

Device Function (Devices only)

Device Function is the task performed by the Device.
Select a function for the Device from the options in the
drop-down list
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Properties field

Description

Description fields

Associated name

Read-only field. An alias name for Part, Device, or Circuit

Circuit Function (Circuits only)

Enter a function for the Circuit

Description

Created By

Enter a short description for the Part, Device, or Circuit

' Read-only field. Displays the name of the person who

created the Part, Device, or Circuit for the Vector NTI™
Express Designer Project

Created Date

Read-only field. Displays the date on which the Part,
Device, or Circuit is created

Last Modified By

Last Modified Date

Read-only field. Displays the name of the person who
last modified the Part, Device, or Circuit for the Vector
NTI™ Express Designer Project

' Read-only field. Displays the date on which the Part,

Device, or Circuit was last modified

Literature

Papers and publications related to the Part, Device, or
Circuit

Characterization Status

Status

Read-only field

' Select a status for the Part, Device, or Circuit from the

options in the drop-down list

Reagents fields

Associated Reagents

Enter the reagents being used with the Part, Device, or
Circuit in an experiment

Classification fields

Host Organism

Click [] open the Host dialog box. Select an option from
the names displayed. Click OK.

Note: To Add a Host to the Host dialog box, go to File
» New » Host. Follow the instruction wizard and click
OK.

Group/Class (Parts only)

Select an option from the options in the drop-down list

Source Organism (Parts only)

Direction (Parts only)

Enter the name of the organism

Select the direction from the options in the drop-down
list

Origin (Parts only)

Parent Molecule

Source fields

Enter the originating molecule for a Part

Institution

Lab

Enter the name of the institution of origin of the Part,
Device, or Circuit

' Enter the name of the lab of origin of the Part, Device,

Circuit

Investigator

Enter the name of the original investigator of the Part,
Device, or Circuit
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Properties field Description

Source ID Enter the original Source ID of the Part, Device, or
Circuit

Intellectual Property fields

IP Information Click Add to add an Associate IP for the Part, Device, or
Circuit

Click:
+ Alternatives, to select an alternative Part, Device, or Circuit to replace the existing one.
* Save As..., to save the Part, Device, or Circuit with another name.

»  Remove, to delete the Part, Device or Circuit from the Vector NTI™ Express Designer
Project.

Characterization In the Design Canvas with the Selection tool selected, click on a Part, Device, or Circuit to
select it. In the Information Pane, click on the Characterization tab to display and enter
information about the selected Element.

1. At the bottom of the pane, click Add to open the Characterization Data dialog box.

a. Enter/ select options in the fields under General Information and Statistical
Information.

b. For the general information, attach an image, a Adobe™" PDF file, or an Excel™
(.xls) file to the characterization data

c. Ifyou upload an .xls file, you can select the Plot type and the statistical information
will be automatically populated. You will, however need to enter the statistical
information manually, if you upload a PDF file or an image.

d. The contents of the .pdf or image file are displayed in the pane below the Plot type.
e. Click OK.

The following graphic represents an example of the Characterization Data dialog box:
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@ Characterization Data
General Information

Nama Promotar characterization

Attachmant | C\Documants and Settings\anghl P F pef
Assay

Host

08O

Exzernal Link

Description | An example

Flottype

Information about Parts, Devices, and Circuits

Statistical Informaticn
Min

Mean

Max

Standard Deviation
Quantitative Parformance

Qualitativa Parformance

! Promoter Output
(Pecf20_992::gfp - GFP synthesis rate: Molecules/cellfs)

1.0 100.0

Antsigma

[ASF20_992] (molecules/cell)
Promoter Output

992::gfp — GFP synthesis rate: Molecules fcell/s)

Sigma expression

(ECF20_992)

Antisigma expression §*
(As20_992)

3]

A

r

—>
[ECF20_292] (molecules . .
Sigma Time (min) =
2. Click Edit to edit a characterization data.
3. Click Delete to remove characterization data.
Truth Table The Truth Table captures the relationship between all the input and output entities of a Device.

This feature is applicable only to Devices. In the Design Canvas with the Selection tool
selected, click on a Device to select it. In the Information Pane, click on the Truth Table tab to
display and enter information about the selected Device.

* The left-hand view displays all the inputs and outputs of a Device.

* The right-hand view calculates and displays the Truth Table. ‘1’ represents presence of an
entity in a Device, while ‘0’ represents absence of an entity in the Device.

Rules/ Auto Design  The Rules/ Auto Design feature allows you to create one or more rules that you can use to
automatically design a Vector NTI™ Express Designer Part or Device, and validate the design.

Note: You can also use the Auto Design feature without defining any rules.

Note: If you want a Part to be replaced with other Part options from the Vector NTI™ Express
Designer Software database during Auto Design, ensure that the Part is unlocked in the
Components In Use panel before using the Auto Design feature.

The Rules/ Auto Design feature is only applicable to Parts and Devices and not to Circuits. The
following rules can be created for Parts and Devices, respectively.

* Comparison Rule: This rule is applicable only to Parts. In this type of rule you can select
the desired properties of a Part and compare that with a given value. The resultant rule will
then allow or disallow the inclusion of a Part/s with that given value during Auto Design.
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Composition Rule: This type of rule is structural in nature and is applicable only to
Devices. For example, you may want a promoter to be placed in front of a reporter and so
on. The resultant rule will then allow or disallow that composition during Auto Design

To add rules:

1.
2.

In the Design Canvas with the Selection tool selected, click on a Part or Device to select it.

In the Information Pane, click on the Rules/ Auto Design tab to display and enter
information about the selected Element. If you select a Part, the rules panel allows you to
specify the Part rules. If you select a Device, the rules panel allows you to specify
compositional rules.

For Parts:

a.

e.

Select a Part, click on the icon in the Part Name field to unlock the Part or unlock the
Part in the Components in Use pane.

Select a Property for the rule from the options in the drop-down list.

Select an Operator for the rule from the options in the drop-down list.

. Chose a Value from the drop-down list, or type in a Name if that was the property

selected, as a constraint.

Click Add Rule.

For Devices:

Note: Only Part instances and Part templates replaced with instances from the Vector
NTI™ Express Designer Software database in the selected Device will be available in the
Operand drop-down options. Part templates used while creating a Device will not be
available as options in the Operand drop-down menu.

a.

b.

C.

Select a Part from the database for the rule from the options in the drop-down list.
Click [] to add Parts from the Vector NTI™ Express Designer Software database as
options while creating a rule.

Note: For Parts that are locked, clicking on B will not display any Parts in the
Vector NTI™ Express Designer Software database. For unlocked Parts, clicking on
B will list all available Parts in the Vector NTI™ Express Designer Software
database that can be used in Auto Design.

Select an Operator for the rule from the options in the drop-down list.

Click Add Rule.
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Information about Parts, Devices, and Circuits

(Optional) If you want to combine two rules to form a compound rule:

IMPORTANT! You must have at least one rule defined to create a compound rule.

a. Select the first rule you want to add.
b. Select the operator (and/ or).
c. Select the second rule you want to add.

d. Click Add Compound Rule.
In the Rule List, select the check box for the Rule/s you want to use. Click Validate.

To select all the rules in the Rule List, click Select All. To deselect all the rules in the Rule
List, click Deselect All. Click Remove to delete a rule from the Rule List.

Note: Only selected rules will be used for Auto Design.

In the Auto Design section, select the Generate only check box if you want to limit the
number of permutations generated by the Auto Design tool.

Note: The maximum number of permutations generated by the application is 10,000.

Click Auto Design. The section below will list the Device variants generated using the
constraints in the specified rules.

Variants are project-specific. The Variants tab in the Information Pane performs two main
functions:

You can view all the variants in a project.
You can replace a component in a design with a variant.
You can rename a variant.

You can save a variant to a database subset.

To replace a component with a variant:

1.
2.

3.

Click on a Part or Device in the Design Canvas to select it.

In the Variant table, right click on the desired variant, then select Replace current
Component with Variant.

The variant will replace the selected Part or Device in the Design Canvas.

To rename a variant:

1.
2.

Click on the Part or Device in the Design Canvas to select it.

In the Variant table, click the Device Name field to highlight the name of the variant you
want to rename, then type in the new name.

To save a variant:

1.
2.

Click on a Part or Device in the Design Canvas to select it.

In the Variant table, select the check box or click on the variant you want to save, then
click Save to DB to open the Save Variants window.

Select the destination folder, then click Save.
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Job The Job tab in the Information Pane lists all the long-running processes. Analysis functions like
‘Perform RBS Calculator Analysis’ and ‘Perform Terminator Analysis’ are some of the
examples of the long-running processes performed by the application.

The viewing pane under the Job tab automatically lists the process when it is started and
displays the run status in the Status column. On the completion of a process, the Status column
displays ‘Completed’ against the Analysis type.
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Restriction analysis

You can identify the cut sites in a Circuit for hundreds of restriction enzymes. The sites will
displayed on the Circuit sequence.

ATGC
With a Circuit open, click on the Restriction Analysis button & on the Analysis toolbar.

The Restriction Analysis tool includes commands for selecting and configuring a list of
restriction enzymes and running the analysis.

ATGE
d§=’ Restriction Analysis

ﬂTrG_,C
Selected Restriction Enzymes : QE'
Name Recognition 5tring =g
BamHI ggatce
Bell ECCNNNNNgEC %
EcoRl gaattc
Hindlll amgctt -xu
Pstl ctgcag
Smal CCCEEE %
Zbal tctaga
&
a
[ Clear Selection ] [ Configure List

Permitted Terminus Types

5 E Blunt
Ignore RENz having:

...lessthan |1 sites

... more than | 2 sites

Select enzymes for A default list of restriction enzymes to be used in the analysis will be selected.

analysis + Click on enzymes in the list to select or deselect them.
* To clear the list, click on Clear Selection.
» To select all the enzymes in the list, click Select All.

Configure the 1. To configure the enzymes in the Restriction Analysis tool, click on Configure List.
enzyme list
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GeneArt™ Project Manager portal

2. Use the commands in the Selected Restriction Enzymes dialog to add or remove the
selected enzymes, then click on Apply.

Selected Restriction Enzymes

Selected Enzymes: Enzymesz in Databaze:
_ Name Recognition 5tring b
Aatll T Aarl - 3
AccE5L L] Aar cacctge -
Accl | Aatll E3CEtC
Acelll [] Accesi getace
Adil [] Accl gtmkac
Adl : Acelll cagctc
Acul [] Acil CCEC
Afel ] Acll EE=:419
AfiIL W A =

|| Afel 3ECECt

Remove All L_| Aflll cttaag

|| Afin acryst

: Agel SCCESt

: Ahdl E3cnnnnngtc

: Alel C3CNNNNELE

: Alol gaacnnnnnntec

i TUI. 3gct W

Select All
[ Apply ] [ Cancel

Filter the anal_ysis To filter the analysis results by the terminus type of the restriction cut site, select or deselect the
results check boxes under Permitted Terminus Types.

Note: 5’ and 3’ refer to the overhang of the resulting cut site, e.g., with 5° deselected,
restriction sites with 5° overhangs will be removed from the analysis.

Ignore RENs Having Less Than/More Than ... Sites hides restriction sites that do not fall
within the range of the specified number of cut sites. Such RENs will be listed but deselected in
the Restriction Map in the Analysis Results. They will not be displayed at all in the Graphics
and Sequence panes.

Perform the When you have made your selections, click on Run. The sites will be displayed overlaid on the
analysis sequence.
Sacl (503)

01 GCAGAGCTCC TETGCCTTCT AGTTGCCAGC CATCTGTTGT TTGCCCCICC  CCCGTECCTT
CEICTCGAGE ACARCGEGRAGR TCRACGEICE GTAGACRACR ARRCEEEGAGE GEECRACEERR
61 CCTTGACCCT GGRRGGTECC ACTCCCACTG TCCITTCCTA ATARRATGAG GAAATTGCAT
GERACTGGER CCTTCCRCGE TGRGEGTGAC AGGRRRGGAT TATTITTIACTC CTTTARCGTR
721 CECATTGEICT GAGTRAGEIGT CRTTCTATIC TGGEEGEEEIGE GEIGEEECRE GRCAGCRAGE
GCGIEC&%@ICC&C& GTRRGATRRG RCCCCCCRCC CCRCCCCGIC CIGICEITCC
BseMIl [721)

78l GEEREERTTE GGARGACRRT RGCAGGECATE CIGEGERTEC GEIGEECICT ATGEGETRRAG
CCCTCCTRRC CCTTICIGITR TCGETCCGTAC GARCCCCTIRCE CCRCCCGAGR TRCCCCRTTIC

Bzal [863)

i,
841 CCTIATCCCTR RACCCICTICCT CGEICICGAT TCTIRCGATCC CTARRCCCICT CCICGEICRT
GERTAGEGAT TCEEGRGAGELR GCCAGRECTR  AGRTGCTRGE GATTIGGEGAGLR.  GGAGCCRETR

Note: Restriction analysis sites are not saved with the Circuit or the Project.

GeneArt™ Project Manager portal

Vector NTI™ Express Designer Software enables you to submit sequences for synthesis directly
to the GeneArt"" Project Manager portal on the Thermo Fisher Scientific website.
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GeneArt™ Project Manager portal

Set your GeneArtTM Before proceeding, enter your login ID and password information for the GeneArt™ Project

Integration login ID Manager website into Vector NTI™ Express Designer Software.

and password Note: If you do not have a login ID and password, visit the website to set up an account.
1. Select Tools » Preferences.

2. Inthe Preferences dialog, select GeneSynthesis Preference.

Enter your login ID and password in the appropriate fields, and click on OK.

- .
. Preferences

@ Username cannot be empty !

Automatic Updates
Designer Preference
Dizplay Preference

Internet Settings
Manage Organizms
Metadata Configuration
MNCBI Configuration

Set Page Size

Configure GeneSynthesis Portal

Genefynthesis Preference

9 (=63

Automatically use the following credential when connect to the portal

1 New user ? Visit www lifetechnologies.com for account registration.
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GeneArt™ Gene Optimization

To visit the GeneArt™ Project Manager portal, click on the GeneArt Portal button on the

Analysis toolbar & and select Go to Portal Project Manager.

technologies

Products & Services New |deas Communities & Social Technical Resources About Us
My Projects My GeneObserver™ News Custom Gene Synthesis | Need help? Watch the tutorials
1 Project Manager 2 Project Configurator 3 Project Summary
Learn more about portal enhancements New! GeneArt® Strings™ DNA Fragments
Mow online - new layout and functions for DMA Fragments up to 1,000 bp, produced in 5
Project Manager and Project Configurator business days, ready for cloning Learn more ==

+ New Project Search your projects Q

Project Name = ] : Date % Project ID % Folder «
P Folder: Example folder Rename | Delete 1 project
¥ Folder: My VectorNTl uploads  Rename | Delete 63 projects
GeneSynthesis Praject1 = Draft 2013-03-10 2013AAFJIP My VectorNTl uploads Summary
GeneSynthesis Project40 E= Draft 2013-03-08 2013AAES6P My VectorMT! uploads Summary
Mac28C3GS = Draft 2013-03-08 2013AAESSP My VectorMT! uploads Summary

GeneSynthesis ttt Draft 2013-03-08 2013AAER4P My VectorMT! uploads Summary

GeneArt™ Gene Optimization

Open GeneArt™
Gene Optimization
tool

128

The GeneArt™ Gene Optimization tool allows to you optimize a particular Part, Device,
Circuit, or other DNA molecule for a particular expression system, based on an analysis of the
open reading frames (ORFs) within the sequence. The tool will change key bases in the
sequence based on the expression system and other parameters.

The final sequence can then be automatically submitted to the GeneArt'" Project Manager
portal on the Thermo Fisher Scientific website for synthesis. See “GeneArt"™" Project Manager
portal” on page 126 for information about the portal and setting up a login and password.

You can open the GeneArt™ Gene Optimization tool for a Part, Device, or Circuit from within
the Design Canvas, or you can open it for all or part of a DNA molecule loaded in the Molecule
Viewer.

For a Part, Device, or Circuit

Note: The sequence of the Circuit or Device to be analyzed must be a multiple of 3 bases in
length and contain a translatable Part. The sequence of a Part to be analyzed must be
translatable.

To open the tool, either:
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GeneArt™ Gene Optimization

* Right-click on the Part, Device, or Circuit and select GeneArt Portal » Gene
Optimization.

» With a Circuit, Device, or Part selected, click on the GeneArt Portal button on the

Analysis toolbar @ and select Gene Optimization.

For a DNA molecule

In the Molecule viewer, right-click on all or part of the molecule sequence and select GeneArt
Portal » Gene Optimization.

In the GeneArt dialog box, the selected sequence will be displayed.

e-Optimization - Define ORF

Circuit 1 Show Annotations
Selected ORF Translated Protein Cptimized Result Motif To Avaid Protectad Region

+1 ME A

1 TTCRRRTATG TATCCGCTCR TGARGACAATA ACCCIGATAZR ATGCITCAAT AATATTGARR ARRGGRRGRAGT TTCACACAGE mcc. Tl
+1 TYRTHRTYR LYS ARGGLU SER ARG TYR ARG LEU PHE WAL ASP WVALGLN SER ASP ILE ILE ASP THR PRO GLY ARGARG MET VAL ILE
101 TACACCTATR 2R CCGTTATCET CIGITIGIGE ATGTACACAC TCGATATTATT CGACACCCCCC CCCCACCGRAT GCGTIGATC
+1 ALSARG LEU LEU SER ASP LYS WAL SER ARG GLU LEU TYR PRO WAL VAL HIS ILE GLY ASP GLU SER TRP ARG MET MET THR THR ASP I

201 CRCETCTECT GTCAGATAAR GETCTCCCETE  ARCTTTACCC  GETGETECAT  ATCEEEGATE  RARAGCTGEECE CATGATEACC  RCCGRTR
+1 PROAL SER VAL ILE GLY GLU GLU WAL ALA ASP LEU SER HIS ARGGLUASN ASP ILE LYS ASN ALA ILE ASN  LEU METPHE TRP GLY IL
301 GEICTCCGIT ATCEEEEAAGC ARRGIGGCTGA TCICAGCCAC CGECGARRATE RACATCRARRRR CECCRATTRARC CTIGATEITCT  GGEGGAAT
401 AGTCCCCRGE CTICCCCAGCR GGCAGRAGTA TGCARRGCAT GCATCICRRT TAGTCAGCAR CCRGGEIGIGE ARRGTCCCCR  GECTCCC
501 TATGCRRRGC ATGECATCICR ATTAGTCAGC ARCCATAGIC CCGCCCCIAR CICCGCCCAT CCCGCCCCTA  ACTCCGECCCR  GTTCCEC
801 CATGGECTGAC TRATTTTITIT TATITATGECA GAGGCCGEAGE CCGCCICIGC CICTGAGCTIR TTCCRGRRCT  AGTGAGGAGE CTITITT
+1 METSER ILE SER SER ARG VAL LYS SER LYS ARG ILE GLN LEU GLY LEU ASN GLN ALA GLU LEU ALAGLN LYS WAL GLY THR THR GLN
701 .Eﬂﬂm CITCCAGGET ARRARRCCARR AGRRTCCAGC TTGGACTTAR CCAGGCTGAR CTTGCTICRARR AGETIGEGERAC TACCCAG

+1 GLNLEU GLU ASN GLY LYS THR L¥S ARGPRO ARG PHE LEU PRO GLU LEU ALA SER ALA LEU GLY VAL SER WAL ASP TRP LEU LEU ASN €
201 AGCTCCARAR CCGTAAAACT ARCCGACCAC CGCITITTACC AGAACTTICGCE TCACCTCITC CGCCIARCTGT TCACTCGCIC CTCAATC
+1 SERSN VAL ARG  PHE WAL GLY HIS WALGLU PRO LY¥S GLY LYS TYR PROLEU ILE SER MET VAL ARG ALA GLY SER TRP CYE GLU ALA CY

301 GRATETTAGR TITETTEEGEC ACETTGAGCC CRARGGELRR  TATCCATTGR  TTRAGCATGET TAGRGCTGEET TCGTGETETIE  RRAGCTTE
+1 ILE LYS ASP ILE ASPGLU TRP TYR ASP SER ASP VAL ASN LEU LEU GLY ASN GLYPHE TRF  LEU L¥S WAL GLU GLY ASF SER METTHR
1001 ATCAAGGRCR TIGATGAATE GTATGACAGT GACGITAACT TATTAGGCAR TGGATICTIGE CTIGARGCITE ARGETEATIC CATGACC

+1 GLNSER ILE PRO GLU GLY HIS MET VAL LEU VAL ASPTHR GLY ARG GLUPRO WAL ASN GLY SER LEU VAL WAL ALA LYS LEU  THR ASP £
1101 RBARAGCATCCC TGARGETCAT ATEGTGTTAE TAGATACTGE ACGGEAGCCA GTGAATGGAA ECCTTGTIET AGCCARACTGE ACTGACE .,
< | A

When performing codon optimization, please consider only nuclectides in following fragments :

ilable Open TS (s):
Name Start P End Po. Length Start Codon(s) Stop Codon(s)

Device_... B& 351 306 w ATG w TAA

Device_... 701 1338 636 w ATG W TAATAA

[¥]select/unselect anl Define OFF... || Remove ORF

ORF List When you first open the tool, Vector NTI™ Express Designer will automatically analyze the
sequence and identify any ORFs based on start and stop codons. That list will be displayed at
the bottom of the dialog box.

The ORF list includes the start and stop positions, length, and start and stop codons of the ORF.

Available Open Reading Frame(s) :

Name StartP... End Pao... Length Start Codon(s) Stop Codon|s)
Device_... 886 391 308 w ATG w TAA
Device_... 701 1238 e36 w ATG w TAATAA
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Note: Some ORFs in the list may have overlapping sequences. Only non-overlapping ORFs
may be optimized.
Define ORFs Add ORFs

If no ORFs can be identified in the sequence or you want to add others, you can add them as
follows:

1. Click on Define OREF, enter a name for the ORF, and specify the first and last bases within
the larger sequence.

Note: The defined ORF must have a multiple of three bases but does not require start and stop
codons, which you can add later (see below).

2. The ORF will be added to the list of Available Open Reading Frames.

Add/remove start and stop codons to ORFs

To add start and stop codons to an ORF that doesn’t have one, click on the blue plus sign ¥ in
the appropriate column under Available Open Reading Frames and select Add <Start/Stop>
Codon.

To remove a start or stop codon, click on the down arrow in the list ¥ and select Remove
<Start/Stop> Codon.

Remove ORFs

To remove an ORF from the Available Open Reading Frames list, select the check box next to
the name and click Remove ORF.

Show Annotations

At the top of the window, select the check boxes under Show Annotations to display the desired
features overlaid on the sequence.

Select... To...
Selected ORF Highlight the selected ORF(s) in the sequence
Translated protein Display the corresponding amino acid sequence above the
selected ORF sequence(s)
Optimized result At the end of the optimization process, highlights the

bases that have been optimized

Motifs to avoid Highlights restriction site and custom motif sequences to
avoid during optimization.

Protected region Highlights regions that you have protected from changes
during optimization.

Select ORFs for Select the check boxes next to the ORFs in the list for optimization.

optimization Click on Next to continue processing.
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restriction sites
and custom

motif(s) to avoid

GeneArt™ Gene Optimization

When you click on Next, you will be prompted to select any restriction sites and/or custom
motifs that you do not want to allow in the sequence. Optimization will alter the selected sites.

Note: Selection of these sites/motifs is optional. To skip this step, click on Next.

Restriction sites to avoid

Recognition sites for common restriction enzymes will be listed under Restrictions Sites to
Avoid, along with the number of times they occur in the selected ORFs or the larger sequence.

Circuit_1 Show Annotations
Selected ORF [] Translated Frotein Optimized Result  [v] Motif To Avoid Frotected Region

AccBsl -
o~ 2
MET GLN
TrcazaTaTe  TATHSEEEEE TSAGACAATA ACCCTEATAZ  ATGCTTCAAT RATATTGRAR RAAGGRRGACT TTcAciczce  aaacci@Eca e
TYR THR TYR LY ARGGLU SER ARG TYR ARG LEU PHE VAL ASF VALGLN SER ASF ILE ILE  ASPTHRPRO GLY ARGARG MET VAL ILE FRO L
TACACCTATA AR CCEITATCGT CIGTTTGIGE ATGIACAGAG TGATATTATT GACACGCCCG GGCGACGGAT GEIGATCCCC C
Customl
gl
ALAARG LEU LEU SER ASP LYS VAL SER ARG GLU LEUTYR PRO VAL VAL HIS  ILE GLY ASP GLU SER TRP ARG METMETTHR  THR ASP MET ALA
CACGICTECT GTCAGATARR GICTCCCET:  2nf@BBMMCCC  GGTGGTGCAT ATCGGGGATE  ARAGCTGECG  CATGATGACC ACCEATATEE C
PROVAL SER VAL  ILE GLY GLU GLU VAL ALA ASF LEU SER HIS A ASN ASPILE LYS ASN ALA ILE ASN  LEUMETPHE TRF GLY ILE TER

GETCTCCETT ATCEEEGAAC AAGTEECTGA TCTCAGCCAC CECGAARATE ACATCAARAZ CECCATTAAC CTEATGTTCT GCGCCAATATE @
Nsil
NN
MET GLY ARG SER METGLN SER MET HIS LEU  ASN TER
aeTecccace  crccocacca  E@cccacan cratecaane cEEEScTc AaT@EEltacT CRCCARCCAC  CTETGGAARE  TCCCCAGECT G
Wil
CAGARGTATE cmc—cﬂc:mrm CTCAGCAACC ATAGTCCCEC CCCTAACTCC GCCCATCCCE  CCCCTAACTC CECCCAGTITC €

Bsplsl
ccc—ccﬁcrc—ncrur TITITTIATT TATGCAGAGG CCGAGGCCGC CICIGCCICT GAGCTATICC AGARGTAGTG AGGACECITT T

When performing codon optimization, please do not allow the following restriction sites or custom motifs to be created in the
seguence (Optional) :

Restriction Sites To Avoid : Show All + | Custom Motif{s) To Avoid :

Name RecognitionSite | Occurence [Seq... | Occurence (ORF A [ETE RecognitionSite | Occurence (Seq... | Occurence (ORF)
[ ndel CATATG 1 1 B Customl  cttta 1 1
[ ngomiv GOCEGET o o
[ nhel GCTAGC o ]
[ Mot GCEECCED o 0
[ mew TCECEA o 0 N
[ RE TGCECA o o
Nsil ATGCAT 2 1 g (= 3
[ sty N B v
< | [¥] select/unselect Al e

Select the check boxes next to the sites you want to avoid. They will appear flagged in red in the
sequence.

Note: Ifthe motifis not flagged, select the Motif to Avoid check box under Show Annotations
at the top of the dialog box.

Custom motifs to avoid

To define a custom motif to avoid:

1. Click on Define Motif and enter the sequence and name.

Name : | CustomMotifl |

Sequence : | CAGCAAG |

2. When you click on OK, the custom motif will appear flagged in the sequence.
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To remove a custom motif from the list, select the check box in the list and like on Remove
Motif.

Click on Next to continue processing.

Select protected When you click on Next, you will be prompted to select any regions in the sequence that you do
regions not want changed during optimization.

Note: Selection of protected regions is optional. To skip this step, click on Next.

Restriction sites to protect

Recognition sites for common restriction enzymes will be listed under Restriction sites to
protect, along with their specific start and end positions and length in the sequence.

Circuit_1 Show Annotations
[¥]selected ORF [v] Transiated Protain  [v] Optimized Result Motif To Avsid Protected Region

A

1 TTCRRATATE TATCCECTCAR TEAGACRATE ACCCTEATAR ATECTTCRRT RATATTGARR RRBGRRGAGT TTCRCRCAGE AR

+1 TYRTHRTYR LYS ARGGLU SER ARG TYR ARG LEU PHE VAL ASP WALGLN SER ASP ILE ILE ASP THR PRO GLY ARGARG MET \
101 TACACCTATZ A CCCTTATCGT CIGITIGTGE ATCTACACAC TGATATTATT CACACCCCCG GGCGACGGAT GG
S (%1

+1 PRO ILE GLY ASP GLU SER TRP ARG MET MET THR TH
Z01 GEIEETECAT ATCEEEGEATE ARRECTGECE CATGATGRCC AC
+1 ILE GLY GLU GLU WAL ALA ASP LEU SER HIS ASN ASP ILE LYS ASN ALA ILE ASN  LEU METPHE TRP

301 BEICTCCETT ATCEGEGEARE  RAGTGECTGAR  TCTCAGCCAC CECGRRRRTG  ACRTCARRRR  CECCATTRAC CIGATETICT  BE
Nsil

o,
+1 MET GLY ARG SER METGLN SER MET HIS LEU  ASH TER
401 AGTCCCCAGE CTCCCCAGCA EREGECAGAR GraTccaaac CEBSBNCTC 2ATEEETAGT CAGCAACCAG GTETGEAAAG TC
Nsil 3
< | >

‘When performing codon optimization, please do not remove the following restriction sites or custom motifs from the sequence

(Optional) :
Restriction Sites To Protect : Show All + | Custom Motif(s) To Protect :
Name StartP... | EndFo. Length A iEnE StartP EndPao.. | Length
[ eim £33 704 3
[ emzsi 201 206 13 =
[ epuial 304 303 3
[ Bsaei 178 187 10
[ esent 414 413 3
[ Bsevi 452 437 3
[ Bsevi 725 734 3
[ Bspiizm 504 503 3 m
M Rzntan7 142 147 3 % _E ine Motif...

Select the check boxes next to the restriction sites you want to remain unaltered. They will
appear flagged in yellow in the sequence.

Note: If the region is not flagged, select the Protected Region check box under Show
Annotations at the top of the dialog box.

Custom motifs to protect

To define a custom region to protect:
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1. Click on Define Motif and enter a name, start coordinate, and stop coordinate.

& Protect Region @

Start:

2. When you click on OK, the custom region will appear flagged in yellow in the sequence.
To remove a custom region, select the check box in the list and like on Remove Motif.

Click on Next to continue processing.

Select parameters In the next window, select the final optimization parameters:

and optimize 1. Select Local from the Optimization invoked from drop-down list to select the local

optimization algorithm.
2. Select your expression system from the Target Host drop-down list.

3. When you have made your selections, click on Optimize.

Optimization Parameters

Optimization invoked from | Local A |

Target Host |Es:heri|:hia cali v|

[ View Report “ Reset “ Save Result “ Optimize |

4. Optimization progress will be displayed in a progress bar. Any sites or motifs that cannot
be avoided will be noted in popup dialogs.

5. The final optimized sequence will be displayed, with base changes shown in red below the
original sequence.

BstBl

GLY LYS TYR PRO LEU ILE SER MET VAL ARG

T GC CT
+1 TYR ASP ILE LYS ASP ILE ASP GLUTRP TYR ASP SER AS VAL ASN LEU LEU GLY ASN GLY PHE TRP LEU L¥S WAL GLU GLY
1001 TACGATATCA AGGACATIGA TGAATGETAT GACAGTGACE TTAACTTATT AGGCAATGGR TICTGECTGA AGGTTGAAGE

T 2 T C = TICC T TC GC = T T E
+1 VALGLY GLN SER ILE PROGLU  GLY HIS MET VAL LEU VAL ASP THR GLY ARG GLUPRO VAL ASN GLY SER LEU WAL VAL ALA
1101 TREETCAZAC CATCCCIGAR GGETCATATGEE TEITAGTAGR TACTGGRCGE:E GAGCCRGTERA  ATGGRAGCCT TETTETAGCC |
T = T G T G& T C T T A G T T = T &

Note: If the base changes are not shown in red, select the Optimized Result check box under
Show Annotations at the top of the dialog box.

Viewing, saving, » Click on Reset to clear the optimization results and re-optimize, and/or go back and select
and resetting the different motifs to avoid or protected regions.
results » To view a report of the results, click on View Report. This will generate a PDF report of

the optimization, including the pre- and post-optimization sequences.
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+  Click on Save Result to save the optimized sequence as a molecule in the Vector NTI™
Express Designer Software database. Click on Save as File to save it as a separate file in
various formats (GenBank'", FASTA, EMBL, etc.).

@ save As g|
Save as:

Please select the destination folder.

= ] DNA/RNAMolecules [MAIN)

Iy Vectors

Save As File ] [ OK ] [ Cancel

Saving and loading  You can save the optimization settings for use on other sequences.

the optimization «  Click on Save Profile and enter a name in the dialog box to save the settings as a
profile configuration file to your local hard drive or network.

» Click on Load Profile to select a saved profile from your hard drive or network.

Sending the Click on Finish to exit the optimization tool. You will be prompted to send the optimized result
optimized result for gene synthesis (see next section).
for synthesis

GeneArt™" Gene Synthesis

GeneArt™ Gene Synthesis enables to you submit a Part, Device, or Circuit, or all or part of a
DNA molecule to the GeneArt™ Project Manager portal on the Thermo Fisher Scientific
website for synthesis. See “GeneArt™ Project Manager portal” on page 126 for information
about the portal and setting up a login and password.

Open the GeneArtTM To optimize the sequence first, use the GeneArt™ Gene Optimization tool (see previous
Gene Synthesis section).. When you complete the optimization workflow, you will be prompted to proceed to
tool synthesis.

You can also open the GeneArt™" Gene Synthesis tool directly for a Part, Device, or Circuit
from within the Design Canvas, or you can open it for all or part of a DNA molecule loaded in
the Molecule Viewer.

For a Part, Device, or Circuit

To open the tool, either:

* Right-click on the Part, Device, or Circuit and select GeneArt Portal » Gene Synthesis.
* With a Circuit, Device, or Part selected, click on the GeneArt Portal button on the

Analysis toolbar @ and select Gene Synthesis.
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For a DNA molecule

GeneArt™ Gene Synthesis

In the Molecule viewer, right-click on all or part of the molecule sequence and select GeneArt
Portal » Gene Synthesis.

The Gene Synthesis Project Options dialog box will open.

? Gene-Synthesis - Project Option

Cireuit_1_optimized_
1 TTCRRATATG TATCCGCTCR TGAGACRATR ACCCTGATAR ATGCTTCRRT AARTATTGARR RARGGRRGAGT TTCACRCAGE RRRC
101 TATACCTATR RRCGCGRRRG CCGCTATCGT CIGITIGITG ATGTTCAGRE CGATATTATC GRTACRCCGE GICGICGIAT GGIT]
201 CRCGTICTGECT GRGCGATARR GITAGCCEIG RACTETATCC GGITGTICAT ATTGEIGATG RRRGCTGECE TRATGATGRCC RCCE]
301 GGITAGCEIT ATTGEIGRRG AAGTTGCRGR TCTGAGCCRT CGTGARRRCE ATATCRARRRR TGCCATCRRC CTGRTGTITT GGGE(
401 AGTCCCCRGE CICCCCRGCR GGCAGRAGTR TGECRRAGCRT GCATCTCRRAT TAGTCAGCRR CCRGGTGIGE RRRGTCCCCR  GGCT(
501 TATGCRARGC ATGCATCTCAR ATTAGTCRGC RARCCATRGTC CCGCCCCTRR CTCCECCCAT CCCGCCCCTR  ACTCCGCCCR  GTTC
601 CRTGGCTGRAC TARTTTITIIT TATTTATGECR GAGGECCGREG CCGCCTCIGC CICTGAGCTR TTCCAGRRGT AGTGRGGRGG CTTIT]
701 ATGAGCATTR GCAGCCGTGET TARARARARGCRRR CGIRTTCRGC TGGETICTGRR TCRAGECRGRR CTGGECACRGR RRAGTTGECAC CRCOC(
801 AGCTGEARRR TGGIARRACC RRRCGTCCGC GITITICTGCC GGRACTGECR  RGCGCACTGE GIGTTAGCGET TGEATTGECTG  CTIGA]
301 CRRTGTTCGT TITGITGEIC ATGTTGARCC GRRRGETARR TATCCECTGR TTAGCATGET TCGTGCAGET AGCTEETGEIC  RRGCH
1001 ATTARRGRTR TCGATGRATG GTATGRTAGC GACGTTRAATC TGCTGEGCRR TGGTITITIGE CTGARRGTIE ARGGTGATAG CRTG
1101 RERGCRTTCC GGRRAGETCAT ATGETICIGE TTGATRCCGEG TCGTGRRCCE GITRRTGETR GCCTGEITGET  TECRRRRCTG  RCCE
1201 CTITCRRRRRR CTGETTATTG ATGETGGEICR GRRATATCTG RRRCGTCIGR ACCCGAGCTG GCCGATGRCC CCGATTRRTG  GTRR]
1201 GITGIGEITIE ARGCCCGIGT GRARATTIGIT TGATGATART RRCCAGGCRT CRRATRRRRC GRRAGGCTCR GICGRRRGAC TGGE(
1401 TIGTTIGICE GIGRAC
& H
By selecting the biosafety level corresponding to the project, customer confirms that
(i) such classification is correct and accurate
(i} the cust has read, understood and accepted the biosafety confirmation.
Biosafety classification: | Leval1 3 |
Vector resistance option: | standard vector contsins ampicillin resistance 4 |
encodes antibiotic resistance
contains ori
[ encedes toxic protein
[] TsEfree production
D Include sub-cloning
[ J[ =)
Select synthesis 1. In the dialog box, select from the following synthesis options:
H . . . .
options — Biosafety classification: Select Level 1 or Level 2. For a copy of the Thermo Fisher

Scientific Biosafety Confirmation, click on the link in the dialog box.

— Vector resistance option: Select from the options for ampicillin or kanamycin

resistance.

— Encodes antibiotic resistance, Contains ori, Encodes toxic protein: Select the
appropriate check boxes if your sequence includes any of these features.

— TSE-free production: A specialized level of production that ensures
decontamination of agents causing transmissible spongiform encephalopathy (TSE)
diseases.

2. Select from the following options:

— Click on Submit to submit the sequence for synthesis to the online GeneArt™
Project Manager portal.
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— Click on Save to save the Gene Synthesis Project in the Vector NTI™ Express
Designer database.

— If you will be subcloning into a vector, select the Include subcloning check box and
click on Next. Follow the steps described in the next section.

— Ifyou are done, click on Finish to exit the GeneArt™ Gene Synthesis tool.

Select the Include subcloning check box and click on Next to clone your sequence into
one of several Thermo Fisher Scientific vectors. A list of available vectors will be
displayed.

Subcloning 1.

2. Select a vector in the list to display the vector map.

3. Select from the Cloning Sites Available list for cutting the vector for insertion of your
sequence, then click Next.

136

Cloning Vectors Available bla promoter )
Name Length Form Desc
pBAD/Hiz A 4102 Circular AmplR) fCMV promc
pBAD/His B 4082 Circular
pBAD/His C 4100 Circular l o
pcDNA3.1(+) 5423 Circular {
pCDNA 3.1(+) Hyzro 5601 Circular /
pcDNA3.L [+)Zeo 5015 Circular /
pcDMASFRT 50e9 Circular /
pChlamy_1 4283 Circular
pFastBacl 4776 Circular B
pFastBacHT A 4856 Circular
pFastBacHT B 4g57 Circular pCDNA 3.1(_'_)
pFastBacHTC 4858 Circular
pPICZa A 3533 Circular 5428bp
pPICZs B 3597 Circular pUC origin ]
pPICZa C 3588 Circular
pRSETA 2897 Circular  Comp.
pRSETE 2887 Circular Comp.
pRSETC 28595 Circular Comp.
pSyn_1 3780 Circular \ p
pYES2 5856 Circular o
3 | B / \ v 4
b3 £ < | 3
Cloning Sites Available 1 GRCEGATCEE  GREATCTCCC  GRTCCCCTIAT  GETIGECRCICT CAC—IACAAE :
CTGCCTRAGCC CICTRGAGGG CTAGGGEATR CCRCGTGRGR  GTCRIGTTI
Name StartP... End Po... Occure... |# 101 GEAGETCGCT GACTAGTGCG CGAGCAARAT TTARGCTACA ACAAGGCAI
] xnol 385 330 1 CCTCCAGCGR CTCATCACEC GCTCGITITA AATTCCATET TGITCCCI:
D Xbal 351 =1 1 201 CTeCTICGCG ATGTACEGEC CRGRTATACE CGITGRCRTT  GRTTATIE
Hindill 311 316 1 GRCEAAGCEC TACATECCCG  STCTATATEC GCRACTGTAR  CTAATAACT
D AspT18l 317 22 1 301 TEEAGITCCG CGTITACATAR CTTRCOGETAR ATGECCCOECC TEECTGACK
] samk 323 534 N ACCTCAACEC CCAATETATT CRATGCCATT TACCGECCEE  ACCGACTGL
D MNhel gas 900 1 B 401 RRCCCCRATR GGEEACTTTCC ATTIGACGICR  ATGECETGECAC  TATTTACEH
O et p— 85 N 2 TTGCGETTAT CCCTGRAAGG TAACTGCAGT TACCCACCTC ATABRATEC(
< | 501 CCTATIGRCG TCRRTGACGG TRRRTGECCC GCCIGECRIT ATGCCCRG
— = c SEATRRATES  RSTTROTACC  RTTTROCGRSS  CECRCCGTIE TROGECTOI
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4. Select from the Restriction sites found in sequence to identify the restriction enzyme cut
sites in your sequence, or click on Add Site to add restriction enzyme cut sites to specific
locations in the sequence based on your cloning technology. The sites and cut region will
be highlighted in the sequence

Circuit_1_optimized_
Eon

1 RARTATGIATC CGCTCATGAG ACAATARCCC TGATAARTGC TTCAATARTA TTGAARARGE ARGAGITICA CACAG
101 BARGTGIATA CCIATARRCG CGARAGCCUEC TATCGICIGI TTGITGATGL TCAGAGCGAT ATTATCGATA CACCGGGICE TCGTA
701 CARGCGCACE TCIGCTGAEC GATAARGITA GUCGIGAACT GIATCCGEIT GITCATATIG GLGATGARAG CIGECGTATE ATGAC
301 CEITCCGEIT  AGUGITATIG GIGAAGARGT TGCAGATCTE AGCCATCGIE ARRRCGATAT CRABARTGCC ATCARCCIGA TEITT
401 GIGEAARGIC CCCAGGCTCC CCAGCAGGCA GAAGTATECA AAGCATGCAT CTCAATTAGT CRGCARCCAG GIGIGGRARE TCCCC
501 CAGAMGIATG CARBRGCATEC ATCTCAATTA GICAGCRACC ATAGTCCCEC CCCTARCTCC GCOCCATCCCE  COCCTARCTC  CECCC
501 CCGCCCCATE  GCIGACIARAT TTTTITTATT TATGCAGAGE COGAGECCEC CICTGCCICT  GARGCTATICC AGAAGIAETE  AGGAG
701 TAGGCTATGA GCATIAGCAG CCGTGITAAR AGCARACETA TTCAGCIGES TCIGARTCAG GCAGARCIGE CACAGARAGT TGGCA
501 TTGAMCAGCT GGABRARTGET ARARCCARAC GICCGOGITI TCIGCCGEAR  CIGGCAAGCG CACTEGEIGT  TAGUGITEAT TEGECT
301 CEATMECAAT GITCEITITG TTGGICATGT TGARCCGARA GETABATATC CGCIGATTAG CATGEITCET GUAGGIAGECT GEIGT
1001 TATGATATTA BAGATATCGA TGAATGETAT GATAGCGACG TIAATCIGCI GEGCAATGGT TITTGGCIGA ARGITGAMGE TGATA
1101 TIGETCAGAE CATICCGEAA GEICATATGG TTCTGGITGA TACUGEICGI  GARCCEGITA ATGGIAGCCT GGITGITGCA  ARACT
1201 AGCCACCITC BARARACTGE TTATIGATGG TGETCRGAAR TATCTGARAG GICIGARCCC GAGCIGECCG ATGACCCCGA  TTAAT
1301 ATCGGETGITE TGGITGARGC CCGIGIGARR TTIGITTGAT GATAATAACC AGGCATCARR TRARACGAAR GGCICAGTCG RAAGA

EcoRl
1401 _tarcrerrer rrercecrer  Ach Add e
Enzyme :
Sequence: | SAATTC |
Location: | 1 |
Hint : [1-1423)
' ,
Restriction Sites Found In Sequence Show All +  Custom Sites (Motifs to be inserted) :
{Includes occurrence of sites in sequence) : — —
Name Start Position End Position
Name Start Position End Position Occure.... L] EcoRl 1 5
[ Ecorv 2 EcoRl 1423 1428
[ Ecot221 2
I:l FauNDI 1124 1129 1
[ kpnzi 1114 1118 1 -
[ mbil 20 25 1
[0 mphi1c3i 2
[ wral 1118 1118 1 ~ Add Site... ][ Remove Site(s)
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5. Click on Next to view the resulting construct.

Cloning Strategy ‘LDn;VE[tDr (sense Insert) v|
. bla promoter
Cloning Info P
Vector Cloning Site 1 Ampi(R) )FMV FFDthEF/W prit
| EcoRI [gasttc] (Shared) CMV forward pi
|
G EcoR! (953)
E
C|IT|THAA
Vector Cloning Site 2
| EcoRl [gaattc] (Shared)
alalTlTlc puC origin
G .
Construct s
Insert Cloning Site 1 (5)
[ EcoRi[gaztiq] 68500p
AlA|T|T|C
G
Inzart CloningSite 2 (3]
SV40 pA
EcoRI jad
[ EcoRi [a=tte] N
G ™., BGH revers
C|T|T|A|A BGHpA [
Neo(R) 1 origin
Sva0 early promoter
5 ‘ >
1 GARCGGATCGE GARGATCTCCC GATCCCCTAT GGIGCACTCT CAGTA(A
CTEGCCTRAGCC  CTCTRGRGGE  CTAGEGGATRE  CCACETGRGR  GTCATL
101 GGAGGTCGCT GAGTAGCTGCC CGAGCAARAT TTAAGCTACR ACAAGC
CCTCCAGCGR CICRTCRCGC GCICGITITAR AARTTICGRIGTI TIGITICC
201 CTECTTCECE ATGTACGEEC CAGATATACE CETTEACATT  GATTRD
fLARLLACAC  TLALTACCMR  ATATLTITAC  APLLATATIL STILTI
< |
[ Print ] [ Export ] [ Submit ] [ Save ]

6. Select the Cloning Strategy from the options under the drop-down list. The design of

Submit the
sequence

138

each cloning site is shown under Cloning Info

Cloning Strategy Leng Vector [Sense Insert) w

Long Vector (Sense Insert)
Long Vectar [Antizensze Insert)

Cloning Info

Vector Clonine Site T

When you have made your selections, select from the following options:

Click on Print to generate a PDF of the construct.
Click on Export to save it as a molecule in the Vector NTI™ Express Designer database

Click on Save to save it as a Gene Synthesis Project in the Vector NTI"" Express Designer
database.

Click on Submit to submit the sequence to the online GeneArt'" Project Manager portal.
You will receive a notice when the submission has been made (see the next section).

When you are done, click on Finish to exit the GeneArt™ Gene Synthesis tool.
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RBS Calculator

The RBS Calculator calculates the rate of translation initiation for every start codon in an
mRNA transcript, and can also be used to optimize a synthetic ribosome binding site sequence
to achieve a targeted translation initiation rate. The calculator was designed by Howard Salis,
and is described in the publication:

Salis, H.M. (2011) The ribosome binding site calculator. Methods in Enzymology 498, 19—42.

RBS Calculator To analyze a sequence for translation initiation sites using the calculator:

Analysis 1. With a Circuit open, click on the RBS Calculator button % on the Analysis toolbar and

select RBS Calculator Analysis. The RBS Calculator window will open.

RBS Analysis
Organism or [165 rRNA) | w | [ Analyze ]
mRNASequence
1 RATGETGRATG TGRRRCCAGT ARCGTTRTAC GATGICECRE RGTATGCCER L
TACCRCTIAC ACTTIGETCR TTGCRATATE CTACRGCGIC TCATRCGEECC i
51 TEICICTIAT CRGACCGTIIT CCCECEIGET GRACCRAEECC RGCCRCOGTTT
LCRGRGRRTE CGICTGGECRARR GEECECRCCR CTTGEICCGE  TCEETIGCRAR
101 CTIGCGRRRAC GCEGGRRRRR CGIGERRECEE CEATGECGER GCTGRATTRC
GRCECTTITIGE CGCCCITITIT CARCCTITICGCC GCTRCCECCT CGACTTRRTGE
151 ATTCCCARCC GCETEECACR  ACRACTGECE GSECRARCACT CEITGCTIEAT
TRREEETITEE CGCACCETET TGITGRCCEC CCGITTIGICR  GCRARCGACTR b
Result
mRNASequence :
Start pos) TIR[zu) dG total dG[mRNA:rRNA) dG{mRNA) dG|zpacing) dG|standby) dG|start) Kine
i) k.

2. From the Organism or (16S RNA) drop-down, select a bacterial species by name (type
the first few letters to jump to that name in the list) or by the last 9 nucleotides of the 16S
rRNA (listed in parentheses after the name).

3. Click Analyze to begin the analysis.

4. The progress of the analysis and the results will be listed under the Job tab below the
Project window.

Project | Properties | Characterization | Truth Table | Rules/Auto Design | Variants | Job

Request D Status Component Name Analysiz Type Date/Time
1302021902147 Q Completed BBa_C0012 RBS Calculator SatFeb 02 15:02:48 PST 2013
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5. When the analysis is complete, double-click on the job in the list to display the results in
the Calculator window.

(3 RBS Calculator §
RBS Analysis
Organism or [165 rRNA) | V| [ Analyze ]
mRNASequence
1 RATGETGRRTE TGRRRCCAGT ARCGTTRTAC GATGTICECRE RGTRATGCCER L
TACCACTTAC ACTTTIGETCR TTGCRATATE CTACAGCEIC TCATACGECC 3
51 TEICICTIAT CRGACCGTIT CCCECEIGET GRACCREECC REGCCRCGETTT 7
LCRGRGRRTE GICTGGECRARR CGEECECRCCER  CTITGEICCGE  TCEETIGCRAR
101 CTIGCGARRAC GCEGEGRRRRR CIGERRECEE CGRTGECGER GCTGRATTRAC
GRCECTTITIGE CEGCCCITITT CRCCTIICGCC GCTRCCECCT CGRCTTRATGE
151 ATTCCCARRCC GCETIEECACE ACRACTEECE GECRARCACT CETITECIGAT
TRRGEEETIGE CGECACCETET TGEITGACCEC CCEITIGICR  GCRRCGRCTR w
Result
Il
[ ]
mRNASequence :
Start pos) TIR[zu) dG total dG[mRNA:rRNA) dG{mRNA) dG|zpacing) dG|standby) dG|start) o~
ATG k 846.61 241 3.82 -4.40 0.00 462 -1.19 T
GTG 4 44699 3.83 -1.50 -5.40 0.00 0.00 0.07
ATG = 287.47 481 0.00 -6.00 0.00 0.00 -1.19
GTG 10 150.08 573 4.42 -6.00 0.00 4.62 0.07 C
v
¢ I >
[ Export Report ] [ Print Report ] [ Close ]

6. Each start codon will be highlighted in the sequence, and the table will show the data for
each translation initiation site, as follows:

140

Value Explanation
Start Start codon
(Pos) Position of the start codon within the sequence
TIR(au) Translation initiation rate; a measure of the affinity of a ribosome
for binding to the RBS
dG total Total Gibbs Free Energy (kcal/mol), defined as dGIMRNA:rRNA) +

dG(start] + dG(spacing])- dG(standby)- dG(mRNA)

dG (mRNA:rRNA]

The energy change brought by binding of the 16S rRNA tail to the
specific binding region in the 5" UTR of the mRNA

dG(mRNA)] The free energy change for an mRNA sequence in solution to fold
into a native secondary structure

dG(spacing) The free energy change brought by the spacing sequence between
the RBS and the start codon, determined by the sequence length
using an empirical formula derived from experimental data

dG(standby) The energy needed to expose the 165-rRNA binding site to the
165-rRNA

dGl(start) The free energy change that results from binding of the 16S-rRNA

to the start codon

Kinetic Score

Export/print report

Click on Export Report to export the report as an Excel™ (.xIs) spreadsheet.

Click on Print Report to print the report in tabular form.
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RBS Calculator

RBS Calculator To design a sequence using the calculator:
DESIgn 1. Select a Circuit, Device, or Part that begins with a start codon.

2. Click on the RBS Calculator button % on the Analysis toolbar and select RBS
Calculator Design. The RBS Calculator window will open.

(3 RBS Calculator Design

RBS Design
Target Translation Initistion Rate | | Proportional scale [0 to 100,000+ DGDE|Z Maximize
Crganism or [165 rRNA) | »

|
|
Pre-Sequence(optional: add only if <35bp) | |

Optimization iteration cycle: | 500 | cycles [enter value between 1 to 5000),1 “C least robust fast analysis), 5000 "C most robust [slow analysis: many hours/days)

mRNASequence

1 ATCCTGAATE TGRAACCAGT RAACCTTATAC GATGICGCAG ACTATGCCEG
TACCACTTAC ACTTTGCTCA TTGCAATATC CTACAGCGTC TCATACGECC
51 TGICTCTIAT CAGACCETTT CCCGCGTGGT GARCCAGECC AGCCACGTTT
ACACAGAMTA GTCTGECARA CEGCCCACCA CTTGETCCCE  TCEETGCARA
101 CTECGAARAC GCGCCARARR CGTGGAAGCGE CGATGECEGR GCTGAATTAC
CACGCTTTTG CECCCITTTT CACCTTCGCC GSCTACCGCCT  CGACTTAATG
151 ATTOOCARCS COCTEECRASE ACRACTEECE  CECARRCRCT CETTECTEAT

12

(14

Result

Start pos) TIR[zu) dG total dG[mRNAr... dG[mRNA) dG(spacing) dG(standby) dG(start) Kinetic Score

3. Enter the desired rate of Target Translation Initiation in the top field. This is a
proportional scale from 0.1 to 100,000 or more.

Note: To massively overexpress a protein, select the Maximize check box.

4. From the Organism or (16S RNA) drop-down, select a bacterial species by name (type
the first few letters to jump to that name in the list) or by the last 9 nucleotides of the 16S
rRNA (listed in parentheses after the name).

5. If the ribosome binding site is <35 nucleotides long, enter a nucleotide sequence in the
optional Pre-Sequence field that will appear before the RBS, using A/G/C/T/U.

6. Enter the number of times the design tool will iterate through the sequence in the
Optimization iteration cycle field. More cycles will produce a result that matches the
translation initiation rate more precisely, but will require more processing time. We
recommend that you experiment with a fewer number of cycles (35-50) and assay the
results.

7. Click Design to begin the analysis.

8. The progress of the analysis and the results will be listed under the Job tab below the
Project window.

Project | Properties | Characterization | Truth Table | Rules/Auto Design | Variants | Job

Request D Status Component Name Analysiz Type Date/Time

513-32-33-353-3?5-3 - Running BBa_C0012 RBS Design Sun Feb 03 09:30:37 PST 2013
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RBS Calculator

9. When the analysis is complete, double-click on the job in the list to display the results in

the Calculator window.

(% RBS Calculator Design

RBS Design
Target Translation Initiation Rate | Eooo.o Proportional scale (0to 100,000+ [ | Goal: Maximize
Crganism or [165 rRNA) | 536(ACCTCCTTA) vi

Pre-Sequence(optional: add only if <35bp) | ACGT |

Optimization iteration cycle: | 50 | cycles [enter value between 1 to 5000),1 “C least robust [fast analysis), 5000 “C most robust [slow analysis: many hours/days)

mRNASequence

1 ZACGTICIARGR G GRRATATACT RACGATGEIGAR TCEIGRARACCR L
TGCRRGRICT CITTATATGA TCTACCACTT ACACTITGGET
51 GTARCGITAT ACGATGICGC AGAGTATGCC GEIGICICIT ATCAGACCET
CATTECRATR TECTACAGCE TCTCATACEE CCRCAGRGAR TRAGTCTEECR
101 TICCCGCGIE GIGARCCAGE CCAGCCACET TICIGCGARR ACGCEGGARR
ARGEECECAC CACTTGGEICC GGICGGIGCE  AAGACGCTIT TGCGCCCITIT

151 RRCTEERARCS  CECEATECOE  CACCTERATT  ACATTOOCRR  COCCETEECE —

Result

Start pos) TIR[zu) dG total dG[mRNAr... dG[mRNA) dG(spacing) dG(standby) dG(start) Kinetic Score
ATG 32 209.79 551 3.82 -7.50 0.00 462 119 0.54

[EtpurtREpurt ] [ Print Report ] [ Create RBS ] [ Cloze

]

10. The designed RBS will be highlighted in the sequence, with the pre-sequence highlighted

in blue and the designed sequence highlighted in green. The table will show the data for

the RBS, as follows:

Value Explanation
Start Start codon
(Pos) Position of the start codon within the sequence
TIR(au) Translation initiation rate; a measure of the affinity of a ribosome
for binding to the RBS
dG total Total Gibbs Free Energy (kcal/mol) change of the RBS, defined as

dG(mRNA:rRNA] + dG(start) + dG(spacing]- dG[standby)-
dG(mRNA)

dG (mRNA:rRNA]

The energy change brought by binding of the 16S rRNA tail to the
specific binding region in the 5" UTR of the mRNA

dG(mRNA) The free energy change for an mRNA sequence in solution to fold
into a native secondary structure

dG(spacing) The free energy change brought by the spacing sequence between
the RBS and the start codon, determined by the sequence length
using an empirical formula derived from experimental data

dG(standby) The energy needed to expose the 165-rRNA binding site to the
16S-rRNA

dGl(start) The free energy change that results from binding of the 16S-rRNA

to the start codon

Kinetic Score
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RNA Analysis

RNA Analysis

Export/print report

Click on Export Report to export the report as a Excel™ (.xls) spreadsheet.

Click on Print Report to print the report in tabular form.

Save

To save the design as a new Part in the database, click on the Save button.

The RNA Analysis tool can be used to analyze the secondary structure of an RNA sequence,

and edit that sequence to alter its structure. It uses the minimum free energy algorithm of Zuker
& Stiegler (1981). See:

Zuker, M. and Steigler, P. (1981) Optimal computer folding of large RNA sequences using
thermodynamics and auxiliary information. Nucleic Acids Research 9, 133-148.

T RNA Analysis

Sequence”
1 RUGACUUCRU CUCUGCCCUG UGGEECRARACE UCUUURUUGU URCAGRUGAC -~
51 CEGRGECGCCUZ GCECUUUCCE ACGCECRUUU  UCGECGEAULZ  AGUCARUUGR
101 UCURUCRACE RGCCGEERAUC GUUCUGECUE ACCRUARRCE CGACRUGEUU =
151 UACRACCGAC UGEUUCEUCE UUUECGUUCE CUGEGACUGR CGERUUUCGEE
201 UCRUUAUCUE RACUUGCUGE RRUCURRUCE GCRCAGCGEU GACUGECAGE
251 CEUUUAUCRR UUCECUEACC RCGRRUCUER CGGECRAUUUUU CCEUGREGECR w
[ Analyze ] [ Generate Dot Plot ] [ Save ] [ Save Az Variant ] [ Print Structure ] [ Save Image
RMA Secondary Structure
Min. Energy Bracket notation ’_\
BT =
-315.1 AECCCOCCCORAE R ...
3153 RTRTTRTIIE
-315.2 LA 111 AT 1 e
Secondary Structure
o [ i [ e
u ) u-g =
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[ 3t
Mg 2 L ; (=
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2 A b
< | B
[ Zoom In ] [ Zoom Out ] [ Close

Analyze a sequence 1. To begin, select a Circuit, Device, or Part and click on the RNA Analysis button % on
the Analysis toolbar. The corresponding RNA sequence will be displayed in the RNA
Analysis window, with uracil residues for thymine.
2.

Vector NTI™ Express Designer So

In the RNA Analysis window, click on the Analyze button.
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RNA Analysis

Minimum energy
value

Edit the sequence

View the secondary
structure

144

3. When analysis is complete, possible RNA secondary structures are listed below the
Sequence Pane.

4. The minimum free energy (MFE) value of each structure is displayed in the Min. Energy
field, and the structure is displayed in bracket notation.

RMNASecondary Structure

Min. Energy Bracket notation

-1042.5 RURIAUTTRIRR AN

The minimum free energy value of the secondary structure is calculated using a loop-based
energy model and the dynamic programming algorithm introduced by Zuker et al. This loop-
based energy model treats the free energy of an RNA secondary structure as the sum of the
contributing free energies of the loops contained in the structure. According to the energy

parameter set and a default temperature of 37 °C, the secondary structure that minimizes the
free energies is computed.

Type directly in the Sequence pane to enter new bases or delete or overwrite existing bases.
You can then click on Analyze again to analyze the edited sequence.

Click on a value in the Min. Energy field to display a visualization of the secondary structure
in the Secondary Structure pane.

916 (000 CC 000 AEECCC-ECEOCL- EECCCOCUEEREOEOEL...... )

(OO COEL (O ..

Secondary Structure

c
Sy
[~
a
gyM

]
SGgazggui.c

foudcdgug

oo ) e |

Close

Drag the corner of the RNA Analysis window to expand or shrink the window.
Click the Zoom In and Zoom Out buttons to zoom in or out of the display.
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Generate Dot Plot

Save the sequence

RNA Analysis

Click on a nucleotide in the Secondary Structure pane to highlight it in the sequence pane.
Right-click the highlighted nucleotide to directly select a different base in the Secondary
Structure pane. The change appears in red in the Sequence pane and the secondary
structure plot is automatically reanalyzed incorporating the change.

If you edit the sequence and re-analyze, the structure in the Secondary Structure window
will change.

To print the structure, click on Print Structure.

To save an image of the structure in one of several image formats, click on Save Image.

Click on a value in the Min. Energy field and then click on Generate Dot Plot to display a
base-pairing probability matrix of the secondary structure.

ACWC U UcC U U U UUCAh URU UAUUGAABER U UUAUCHBGGBUUNLUUGUCUCHUBABLE G,

Cc - c-rc-copcc-onco

o
[]

=
]

P

The X and Y axes of the matrix are the bases in the sequence, and each square represents a
pairing of the X base and Y base at that position.

Pair probabilities are displayed in the upper right triangle of the matrix.

The size of the black boxes within each square is proportional to the base pairing
probability of the X and Y bases, where small boxes indicate a low probability and large
boxes a high probability to form a base pair

Click on Save to save the RNA sequence or edited sequence as a molecule in the Vector NTI™
Express Designer database.

Click on Save as variant to save the RNA sequence or edited sequence as a variant to the
Circuit, Device, or Part used to generate the sequence.
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Terminator Calculator

Terminator Calculator

The Terminator Calculator can be used to find a transcription terminator within a larger
sequence, calculate its free energy value, and analyze its secondary structure.

1. To begin, with a Circuit open, click on Terminator Analysis "8 on the Analysis toolbar.

~ .
 Terminator Calculator

Terminator Calculator
Sequence
1 RCATTGATTIR TTITGCRCGEC GTICRCACTTIT GCTATGCCAT AGCATITITIA
TETAACTART ARACCTECCE CAGTCTGARR CEGATACEGTA TCGTARRRRI
51 TCCRTRRGRT TRGCGGATCC TARCCTGRCGC TITTITATCGC ARRCTCTICTAC
LEGTATTCTR ATCECCTAGE ATGEACTGCE RRRRRTRAGCE TTGRAGRGEATC
101 TEITICICCR TACCGITITT TIGEGCTAGC GTRGRRRRGR TCRRRGERTC
AL GRAGEET ATGECRRRRR ARCCCGRTCE CATCITTICT AGTTTCCTAL
151 TTCTTGAGAT CCTTTITITC TGCECGTAAT CTGCTECITE CARACRARRIY
4 | &
ew Terminator Structure
Result
Start Position: l:l
Terminator: | |

2. Click on Analyze to begin analyzing the sequence.

3. The progress of the analysis and the results will be listed under the Job tab below the
Project window.

Project | Properties | Characterization | Truth Table | Rules/Auto Design | Variants | Job

Request D Status Component Name Analysiz Type Date/Time

513-32-352-35-3?34 " Running Circuit_1 Terminator Calculator ‘Wed Feb 06 20:50:52 P5T2...

4. When the analysis is complete, double-click on the job in the list to display the results in
the Calculator window.

~ .
 Terminator Calculator

Terminator Calculator

Sequence

1 ACARTTGATTIZ TITGCRCGEEC GICRCACTIT GCTATGCCART AGCATITITZ A

TETAACTART ARACCTECCE CAGTCTGARR CEGATACEGTA TCGTARRRRI
51 TCCATRRGAT TAGCEGEATCC TACCIGARCEC TITTTATICEC ARCTCICTAC
AGETATICTR ATCGCCTAGE ATGEACTGCE RRRRRTRCGCE TTIGRGRGATC
101 TEITICICCR TACCEITITT TIGEECTIAGC GCIAGRRRAZCGR TCRRRGEATC
AC GRGET ATGECRRRRZZ  RACCCEATCE CATCTIITICT AGITICCTAC

151 TTCTTGAGAT CCTTTITITC TGCECGTAAT CTGCTECITE CARACRARRIY
| =

[Ead

[ View Terminator Structure Analyze

Result

Start Position: 201

Terminator: | AACCACCGCUACCAGCGGUGGUUUGUUUGCCGE |

Best dG total: -2.133413545058585 | kcal/maol

5. In the Result section:
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Terminator Calculator

— The terminator sequence is displayed in the Terminator field.

— The starting position of the terminator within the sequence is displayed in the Start
Position field.

— The Best dG Total indicates the free energy change (kcal/mol) of the RNA structure
formed by the terminator.

6. Click on View Terminator Structure to load the terminator sequence into the RNA
Analysis tool (see “RNA Analysis” on page 143).
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Terminator Calculator
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Vector NTI™ Express Designer:
Assembly Compatibility Check

The Assembly Compatibility Check tool allows you to select Circuit, Device, and Part
sequences in a Project and configure them so that they are compatible with various assembly
technologies, including:
* Restriction enzyme cloning:
— Parts Assembler (page 152)
* Recombination site cloning:
— Gateway " Technology (page 156)
* End homology cloning:
— Seamless/High Order (page 161)
— SLIC (page 163)
— CPEC (page 166)
— Exo/Fill in/Ligation (page 168)
» Type II Restriction Enzyme cloning:
— GoldenBraid (page 170)
— Golden Gate (page 172)
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Configuration and assembly

Configuration and assembly

1. To begin, with a project open, click on the Assembly Compatibility Check button & | on
the Analysis Tools toolbar. The following window will open:

@ Assembly Compatibility Check

ATGC
[ select / unselecc Al a§’
RECloning 0
Technolosy Status =
Parts Azsembler [Shatty, 2008) (] §7
[T
Recombination Site Cloning =]
Technolosy Status 7
- @
Gateway [Hartley, 2000) &

End Homelogy Clening

Technolosy Status

[[] seamiess/High Order [Liang, 2012} (7]
[ stic ui, 2007) (@)
[[] cPEC (Quan, 2o0o9) @
[ ExefFill InjLigation (Gibsen, 2009} @

Type IS RE Cloning
Technology Status

[] Golden Braid (Sarrion-Perdigenes, 2011) (7]
[] Golden Gate (Engler, 2011} (7]
Compatibility Check
Compatibility Errors [ Warnings
Technology Level Message Part

2. In the tool, select the check boxes next to the assembly technologies you want to
configure.

3. Click the Configure button next to the selected technology. A dialog box will open in
which you can select the appropriate assembly settings and the Parts, Devices, and/or
Circuits in the Project to assemble. The settings for the different tools are described on the
following pages:

Assembly settings Described on page...
Parts Assembler settings 152
Gateway® Cloning settings . 156
Seamless/High Order assembly settings 161
SLIC assembly settings 163
CPEC assembly settings 166
Exo/Fill In/Ligation assembly settings ' 168
Golden Braid assembly settings 170
Golden Gate assembly settings 172

4. After you select the assembly settings, the status icon will change to a yellow warning
icon ., indicating that the settings have changed but have not been tested.
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Configuration and assembly

5. Click on Compatibility Check to test the settings. The Status icon for each technology
will change depending on the results of the test:

— A green check box 2 indicates that the selected sequence and technology settings
are compatible, and the Assemble button will become active.

— A red exclamation point ¥ indicates that the selected sequence and technology
settings are not compatible, and a message will appear in the Compatibility Errors/
Warnings table describing the error. Position your cursor over the Message link to

display the full message.
Recombination
Technology Status
Zeamless/High Crder w
[]stic/crec/Gibson (7]
Compatibility Check
Compatibility Errors / Warnings
Technology Level Meszage Part
Seamless/High Or... Error The 3'of "pUC1SL" does not share end-ti——_** - Il nn wenssnd
The 3'of "pUC18L" does not sh
are end-terminal homelogy with
the 5'end of its adjacent fr
agment. Pleaze check "Amplify"
<

Close

6. Depending on the results of the Compatibility Check for each selected technology,
proceed as follows:

— If Compatibility Check passed, click on Assemble to complete the assembly.

— If Compatibility Check failed, click on the appropriate error/warning message or the
appropriate Configure button to edit the settings, if desired.
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Parts Assembler settings

7. When you click on Assemble, the Preview Results dialog will open. The resulting
assembly or assemblies for that technology will be listed in a table. Click on an assembly
to preview it in the window.

® Preview Results

Final Construct |Vector Backbone || Assembled Fragments | Individual Fragments Used

R KR [ v

1

terminator stem loop

BBa_BO017(Terminator) suffixl € colihis operon terminator

terminator stem loop new_feature
prefix ! VR
end of terminator

ORI

\\ | N |

- el B AT e =
1 TACTAGTAGC GECCECTIGCER GTCCGECRARR  RRAGEGCRAGC  GIGTCACCAC CCTGCCCTTT TICTTTARRR CCERRRAGAT TIaA
ATEATCATCE CCGEECEACET  CREGCCETIT  TITCCCETIC CRCRAGTGETE  GGACGGEARR  RRGRARTTIT  GECITITCTAR 21
101 TCCTICGECTICR CIGACTCGCT GCGCTICGEIC GITCEECTIEC GGECEAGCEET  ATCAGCTCAC TCRRRGECGE TRATACEEIT 21
RGEAGCGAGCT GACTGAGCGR CGCGAGCCRG CRRGCCGARCGE CCGCICGCCR  TRGICGRGIG  AGITICCECC ARTTATGCCRR  TF
201 ACGCACGAAA GARCATGTGA GCARRAGCCC AGCARAAGEC CAGGARCCGT AAARACECCE CGITECTGEC GITTTTCCAC AcY
| *

|~

[ Exportas C5V ] [ Save Final Construct I [ Close ]

8. Click on Save Final Construct to save only the final construct assembly as a separate
molecule in the Vector NTI™ Express Designer database, and/or Export as CSV to export
the assembly sequence as a comma-separated values text file.

& Save As DNA

Save as:

Please select the destination folder.

= £ DMA/RNAMolecules (MAIN)
Iy Vectors
Save As File ] [ OK ] [ Cancel

Parts Assembler settings

The Parts Assembler contains settings for standard restriction enzyme cloning. For more
information about the predefined standards used in Parts Assembler, see Chapter 18, “Parts
Assembler” on page 271.
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Parameter profile

Custom settings

Parts Assembler settings

Click on the Configure button for Parts Assembler to open the following dialog:

® Configure Parts Assembler (Shetty, 2008) Parameters

Name: | Parts_Assembler_fssembled(pSB1A3_GP_PRO_O_BBa_BO023_BBa_CO0011_optimized_for_Arabidop. |

Parameter Profile:

Settings
Reference: Thomas Knight, 2003

Standard:

Generated Prefix: |

Generated Suffix: |

Type |l RE:

Vector Selection

Vector:

Fragments to Azzemble

Mo. of Fragments: | &

| Length: [ 1218

3
m

Circuit_1_optimized_for_Escher...
Device_1_optimized_for_Esc...

GP_PRO_O
BBa_BO029
BBa_C0011_optimized_for_...
GP_PRO_13
BBa_CO056_optimized_for_...
BBa_BO0010_optimized_for_...

REREREOO 2

Direction
FORWARD
FORWARD
FORWARD
FORWARD
FORWARD
FORWARD
FORWARD
FORWARD

Type

Circuit

Device

Promoter
Shine_Dalgarno_...
Coding Sequence
Promoter

Coding Sequence

Terminator

Length

1416
1416
70
15
306
309
636
20

OK

| [ concet

Under Parameter Profile, select the default parameters or select custom. If you select
parameters, a standard set of restriction enzymes and a compatible vector will be preselected.

If you select custom under Parameter Profile, the following settings become available:

Predefined assembly standards

The predefined assembly standards in Parts Assembler are listed below. To conform to a
predefined assembly standard, the selected Circuit, Devices, or Parts must not contain the
restriction enzyme digestion sites listed in the table for that standard. Some standards also
include additional rules. For more information about the predefined assembly standards, visit
http://openwetware.org/wiki/The BioBricks Foundation:Standards/Technical/Formats.

Assembly Standard

Parts must not contain the following restriction sites

10 EcoR I, Not I, Xba I, Spe |, Pst I, Nhe |, Pvu Il, Xho |, Avr II, Sap |
12 EcoR I, Spe |, Nhe |, Not |, Pst |

20 ' EcoR [, Xba I, Spe I, Sbf |

21 EcoR |, Bgl Il, BamH I, Xho |
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Vector NTI™ Express Designer: Assembly Compatibility Check

Parts Assembler settings

Assembly Standard

Parts must not contain the following restriction sites

23

25

EcoR I, Not I, Xba I, Spe |, Pst | (in addition, sequences must be
in frame without start or stop codons, and may not begin with
“TC”)

' EcoR , Not I, Xba |, NgoMI (aka NgoMIV), Agel, Spe |, Pst |

Note: BioBrick is a trademark of the BioBricks Foundation, Inc. The BioBrick trademark is
used herein merely for the purpose of fair use. The BioBricks Foundation, Inc. is not affiliated
with Thermo Fisher Scientific. The BioBricks Foundation, Inc has not authorized, sponsored or
otherwise endorsed this product or our use of the BioBrick trademark herein. Information about
BioBrick™ and the BioBricks Foundation, Inc. can be found at www.biobricks.org.

Creating a new assembly standard

To create your own assembly standard, click on the Add button and fill in the appropriate

information.

% Manage Standard g|
Name: Scar:
Prefix:
Suffix:

Restriction Sites

Name Sequence

OK ] [ Cancel ]

Field Description

Name The name of the standard.

Scar The bridging sequence created by the
overlap of the restriction digested ends. The
scar sequence is determined by the
restriction enzymes used in the assembly.

Prefix The sequence between the vector and the
beginning of the fragment insertion, as
determined by the restriction enzymes used
in the assembly.

Suffix The sequence between vector and the end of

the fragment insertion, as determined by the
restriction enzymes used in the assembly.

Restriction sites

Click on the Add and Remove buttons to add
and remove restrictions enzymes to the list.
These enzymes will be used in the assembly.

» Click on View/Edit to view or change the selected custom assembly standard.

* Click on Delete to delete the selected custom assembly standard.
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Parts Assembler settings

Generated prefix and suffix

These are the sequences between the vector ends and the fragment insertion, based on the
selected restriction enzymes used to insert the fragment. For predefined assembly standards, the
entries in the Generated Prefix and Generated Suffix fields are autogenerated based on the
restriction enzymes selected below the fields.

For custom assembly standards, enter the appropriate prefix and suffix sequence based on your
restriction enzyme selections.

Type Il restriction enzymes

These are the enzymes that will be used to generate the overlapping ends of the vector.

* Predefined assembly standards: All the available enzymes for use with these standards
are listed, and a subset of these are preselected. You can use the preselected enzymes or
select from the others available.

+ Custom assembly standards: The restriction enzymes you selected when you created the
new standard will be listed and selected.

Vector selection

Under Vector Selection, click on the B button to select from the vectors available in the Vector
NTI™ Express Designer database.

* Predefined assembly standards: The preselected vector is designed for compatibility
with the selected restriction enzyme cut sites.

+ Custom assembly standards: Be sure to select a vector that is compatible with the
restriction enzymes you have selected. To view the cut sites for the selected enzymes,
select the enzymes in the lower right corner of the vector selection window.

# Prepare Vector E‘El@
[<ciex ror Ve @&
Praviously chosen Vecior:  pSB1A3 Bl (21) -
Vector Fragment
Choose a vector: Spel'(3) A
[ veme Lengn | rom A ||| vector Fragment Vector Fragment
BaculoDirect\Linear\, 135370 Linear —
BaculoDirect\Linear\, 5770 Linear
BaculoDirect\Linear\, . 139370 Circular
BBa_K174018 2393 Linear I
BLOCK-iT-Palll-miR-lac 5759 Circular
BLOCK-T-Folll-mifLM.. 5755 Circular pSBlA3
BLOCK-iT-Palll-miR-luc 5759 Circular 2155bp
PAdfCMV/\VS-DEST 36686 Circular
pAd/PL-DEST 38364 Circular
padblockit_dest_vard 34384 Circular
padgw_uSlzminshrna.. 33562 Circular
pBAD-DEST49 8160 Circular
pRADTOPO 128 Linear 3
pbadtopolacavbhis_v.. 7183 Circular I3 S
pBLOCKAT3-DEST vers 5295 Circular ¥ =
2 Spel (3} petl(21) Al
- 1 I;[;;E}AEE GECC! crecn & BARCGGCARG GTGTCACCAC TTC
Chooose enzymes to digest vector: ATGATCATCE 2ze
i ! 101 TCA
| EnzymeName Occurence Site S2que = =E
; Ecafl 1 GAATTC 201 CAGERACCET ceT ™
| 4] xbat 1 TCTAGA b3
| ] spel 1 ACTAGT | | 2
} = 1 crecae | || o site None No Site
I 5 15~ none e none -3
3 nene -  none =
Fragments to The Fragments to Assemble list at the bottom of the dialog box lists the individual Parts and
assemble Devices in the order in which they appear in the Circuit.
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Vector NTI™ Express Designer: Assembly Compatibility Check
Gateway® Cloning settings

Fragments to Azzemble

Mo. of Fragments: | & Length: | 1416
Name Direction Type Length

I:‘ Circuit_1_optimized_for_Escher... FORWARD Circuit 1416
I:‘ Device_1_optimized_for_Esc... FORWARD Device 1416
GP_PRO_O FORWARD Promoter 70
BBa_B0029 FORWARD Shine_Dalgarno_... 15
BBa_C0011_optimized_for_... FORWARD Coding Sequence 306
GP_PRO_13 FORWARD Promoter 309
BBa_CO056_optimized_for_... FORWARD Coding Sequence 636
BBa_BO0010_optimized_for_... FORWARD Terminator 20

1. Select the check boxes next to the individual Parts and Devices or the entire Circuit that
you want to assemble. Note that a selected Device or Circuit will be treated as a single
fragment.

2. Inthe Direction column, specify the orientation of each fragment in the final assembly by
selecting Forward or Reverse.

Complete the Click on OK to complete the configuration. The status icon in the Assembly Compatibility
configuration Check pane will change to a yellow warning icon 4. , indicating that the settings have changed.

Then proceed with compatibility check and assembly, as described in “Configuration and
assembly” on page 150.

Gateway® Cloning settings

These settings allow you to configure your Circuits, Devices, and Parts for assembly using
Gateway® Cloning or MultiSite Gateway® Cloning.

+ Gateway® Cloning enables cloning of a single fragment. For an overview, see
Chapter 15, “Gateway® Cloning” on page 243, and the Gateway® Technology User Guide
or Gateway® Technology with Clonase™ II User Guide, available for download from
www.thermofisher.com/manuals.

+  MultiSite Gateway® Cloning enables simultaneous cloning of up to four fragments. For
an overview, see the MultiSite Gateway® Pro User Guide, available for download from
www.thermofisher.com/manuals.
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Gateway® Cloning settings

When you first open the Gateway® Cloning configuration tool, the Configure Base
Parameters window will be displayed.

® Configure Gateway (Hartley, 2000) Assembly Parameters

Configure Base Parameters

Configure parameters needed for cloning and the fragments needed for aszembly.

Azzembly Type: | Multi Site Gateway w |

MNo. of Entry Clones: | 3 |

Fragments to Azzemble

Mo. of Fragments: | 3 | Length: | 524 |
Name Direction Type Length

I:‘ Circuit_1 FORWARD 538

I:‘ Device_1 FORWARD 538

GP_PRO_1 FORWARD Promoter 138

I:‘ BBa_B0029 FORWARD Shine_Dalgarno_... 15

BBa_C0011 FORWARD Coding Sequence 306

BBa_BOO10 FORWARD Terminator 20

Configure base In the Configure Base Parameters window, select the following settings:

parameters 1. From the Assembly Type drop-down, select Gateway or MultiSite Gateway. This

selection will affect settings on all subsequent screens.

2. Inthe Fragments to Assemble field, select the check boxes next to the individual Parts and
Devices or the entire Circuit that you want to assemble. A selected Device or Circuit will
be treated as a single fragment. Note the following:

—  Gateway® Cloning: You can select a single Circuit, Device, or Part.
— MultiSite Gateway® Cloning: You can select up to four Devices and/or Parts.

3. In the Direction column, specify the orientation of each fragment in the final assembly by
selecting Forward or Reverse.

4. Click Next to proceed to the next window.
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Vector NTI™ Express Designer: Assembly Compatibility Check
Gateway® Cloning settings

Configure PCR
settings

Configure PCR Settings

Zetthe PCR Settings and att sites for amplification

Fragments to Amplify

In the Configure PCR Settings window, select the following settings.

® Configure Gateway (Hartley, 2000) Assembly Parameters

of fragments

Accession
GP_PRO_1

BBa_CO011
BBa_BOD1D

Name
GP_PRO_1

BBa_CO011
BBa_BOD1D

To Sense Site Antisense Site Descript

122

From

attBl attB4

attBar attB3r

80 attB3 attB2

PCR Amplification Settings for GP_PRO_1

Analysiz Conditions

Tm[C] %GC Length
== [400 ESET ESE | @ ona O rna
<[ 850 || =[e00 | =25 |

Add GGGG-attBx 5' extensions

of Sense Primer:

of Antisense Primer:

| sttB1[ACAAGTTTCTACAAAAAAGCAGGCTTA) W

| | sttB4[ACAACTTTGTATAGAAAAGTTGGETE) w

Add to Oligo List
DAuugenerateﬂ primers to oligo list

Amplify

Fragments to Amplify

1. The selected fragment(s) will be

for each fragment will listed.

and To fields.

loaded in the Fragments to Amplify list, and the attB sites

To change the regions to amplify in the selected fragments, type a new range in the From

PCR Amplification settings for each fragment

Select the desired amplification settings for each fragment under PCR Amplification Settings.
For MultiSite Gateway® Cloning, the settings will change depending on the selected fragment

in the Fragments to Amplify list.

The standard options are described below.

PCR Amplification Setting

Description

Tm(C)

Enter limits in degrees Celsius for primer
melting temperature (T,;,) (temperature at
which 50% of primer is a duplex) and the
difference between T, for sense and
antisense primers.
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Gateway® Cloning settings

PCR Amplification Setting

Description

%GC

Enter limits in degrees Celsius for primer
melting temperature (T,,) (temperature at
which 50% of primer is a duplex) and the
difference between T, for sense and
antisense primers.

Primer Length

Defaults to 20-25, recommended for
Gateway® Primers

DNA/RNA button

Select the type of nucleotide sequence.

Add GGGG-attBx 5" Extensions

The default attB extensions are for single
fragment cloning: attB1 for the sense primer
and attB2 for the antisense primer. Select
from the drop-down list to replace the
defaults with other attB sequences for
creating Entry Clones for MultiSite Gateway®
Cloning projects.

Add to oligo list

Select this check box to add the primers you
generate to the oligo list

Amplify

When you have made your selections, click on the Amplify button. The Next button will
become active. Click on it to proceed to the next window.

Configure pDON R In the Configure pDONR Vectors window, the selected fragments will be listed.

V o
eCtO rs * Configure Gateway (Hartley, 2000) Assembly Parameters
Configure pDONR Vectors
Choose the pDONR Vectors to be used for entry clones
BP Inserts
Name Accession Type Division Senze Site Antisense Site Description
The PCR Product of GP... The PCRProductofG...  EntryCloning attBl B2
The PCR Product of BB... The PCRProductofB...  Entry Cloning attBar attB3r
The PCR Product of BB... The PCRProductofB...  Entry Cloning attB3 attB2
L) 33
pDOMR Vector
Name Accession Type Division SanzeSite Antisense Site Description
pDONR221-P1P4 pDONR221-P1P4 Entry Cloning YN attP1 attP4 (Invitrogen Vector) Compl
pDONR221-P4rP3r pDONR221-P4rP3r Entry Cloning SYN attPar attP3r (Invitrogen Vector)
pDONR221-P2P2 pDONR221-P3P2 Entry Cloning YN attP3 attP2 [Invitrogen Vectar)
< I >
e
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Vector NTI™ Express Designer: Assembly Compatibility Check

Gateway® Cloning settings

1.

Click on the Add button to select the appropriate pPDONR vector for each fragment, based
on the attB sites in each fragment.

The Choose Vector window will open, displaying a list of the pPDONR vectors in the
Vector NTI™ Express Designer database. Select the vector and click on OK.

Note: For MultiSite Gateway® Cloning, each fragment will require a separate pPDONR
vector. Make sure the attP sites in the pDONR vectors match the at¢B sites in the
fragments.

Back in the Configure pDONR Vectors window, when you have made your selections,
click on Next to generate the entry clones and proceed to the next window.

Configure In the Configure Destination Vectors window, the resulting entry clones from the
Destination Vectors recombination reaction will be listed.

® Configure Gateway (Hartley, 2000) Assembly Parameters.

Configure Destination Vectors

Choose the Destination Vectors to be used for expression clones

Entry Clones
Name Accession Type Division Sense Site Antizense Site Description
Entry Clone/pDOMR22... Entry Clone/pDOMR2...  Expression Cloni.. SYN attll attl4
Entry Clone/pDOMR22... Entry Clone/pDOMRZ...  Expression Cloni.. SYM attRd attR3
Entry Clone/pDONR22... Entry Clone/pDOMR2Z...  ExpressionCloni.. SYN attL3 attL2
£ *

Destination Vector

Name Accession Type Division Sense Site Antisense Site Description

pDEST32 pDEST32 Exprassion Cloni .. SYN sttRl sttR2 (Invitrogen Vector)

b4

1. Click on the Add button to select the desired pDEST vector.
2. The Choose Vector window will open, displaying a list of the pDEST vectors in the
Vector NTI™ Express Designer database. Select the vector and click on OK to return to
the Configure Destination Vectors window.
Complete the Click on Finish to complete the configuration. The status icon in the Assembly Compatibility
configuration Check pane will change to a yellow warning icon 4 , indicating that the settings have changed.

Then proceed with compatibility check and assembly, as described in “Configuration and
assembly” on page 150.
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Seamless/High Order assembly settings

Seamless/High Order assembly settings

For an overview of Seamless and High Order assembly methods, see Chapter 17, “GeneArt®

M 29
Cloning” on page 263.
* Configure Seamless/High Order (Liang, 2012) Parameters
Name: | High_Order_assembl=d(ps8143_GF_FRO_1_Bas_C0011) |
Parametes e
Settings
Assembly Type ‘ High Order (Lisng, 2012) v |
Maleculs Form ‘Cm:u\ar v|
Vector Direction ‘Furward v|
Frimer Setting
[[] Reuse existing primers?
Primer Name: | PCR Primer |
Oligo Name: | stiteh Cligo |
Vactor Selection
Vector: | psa1A3 | D
Start Position: | 1 Stop Position: | 2,155 | CJametity [#] stirch
Fragments to Assemble
No. of Fragments: | 2 | Langth: [ 224
Name Direction Type Length | Amplify Stitch
[0 circuit_1 FORWARD Circuit 538
O Device_1 FORWARD Device 533
GP_PRO_1 FORWARD Promoter 122 @ no 2 ves
O BBa_BO02S FORWARD Shine_Dalgarno_.. 15
BBa_C0011 FORWARD Coding Sequence 306 0 ves @ no
O BE3_BO010 FORWARD Terminatar =

Parameter profile Under Parameter Profile, select the default parameters or select custom.

Custom settings If you select custom under Parameter Profile, you can select from the following settings:

Select... To...

Assembly Type High Order or Seamless. See Chapter 17, “GeneArt®

Cloning” on page 263 for more information.

Molecule Form The form of the resulting molecule: Circular or Linear.

Vector Direction The orientation of the fragment(s) in the final assembly:

Forward or Reverse.
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Vector NTI™ Express Designer: Assembly Compatibility Check
Seamless/High Order assembly settings

Primer settings Reuse existing primers?

If you select this check box, you can select existing primers from the Vector NTI™ Express
Designer oligo database that you know are suitable for use with the fragments you are
assembling.

Frimer Setting

Reuse existing primers?

Configure Sense Primer Configure Antisense Primer

Name = Sequence 15 | | Name Sequence | |
M13 Forward [-20) GTAAAACGACGG... 16 | M13 Reverse CAGGAAACAGCT... 17 |
PRM1 AACGCAGTCAGG... 20 | PRM2 ATCCGTTAGCGAG... 20 i

Click on Configure Sense Primer or Configure Antisense Primer to select from the oligos in
the database.

¥ Oligos in Database X
Name Sequence Length | #

: 3'RACE Adapter Primer GGECCACGCGTCGACTAGTACTTTTIIT... 37

: Abridged Universal Amplificati... GGCCACGCGTCGACTAGTAC 20

: Gateway Forward [attB1) GEGGACAAGTTTETACAAAAAAGCA. . 31

: Gateway Reverse [attB2) GEGGACCACTTTGTACAAGAAAGCTG... 30

z M13 Forward [-20) GTAAAACGACGECCAG 18

: M13 Reverse CAGGAAACAGCTATGAC 17

z PRM1 AACGCAGTCAGGCACCETET 20

: PRM2 ATCCGTTAGCGAGGTECCGE 20

: SPE Promoter Primer GATTTAGGTGACACTATAG 13

: T3 Promoter ATTAACCCTCACTAAAGGGA 20

: T7 Promoter Primer TAATACGACTCACTATAGGE 20

: Universal Amplification Primer  CUACUACUACUAGGCCACGCGTCGA.. 32

: V5 Reverse ACCGAGGAGAGGGTTAGGGAT 21 e

Select All ] [ClearSEIe:tiDn] [ OK ] [ Cancel

Primer name/oligo name

If you do not reuse existing primers, specify a base name for the primers (Primer Name) or
stitching oligos (Oligo Name) that will be automatically generated by the configuration tool.

Vector selection 1. Under Vector Selection, click on the B button to select from the vectors available in the
Vector NTI™ Express Designer database.

2. Ifthe ends of the linearized vector do not share homology with the ends of the first and
last fragment, select the appropriate check box:

— Amplify: The ends of the vector will be amplified by PCR primers to create end
homology with the fragments, or

— Stitch: (High Order assembly only) The vector and fragment ends will be bridged by
stitching oligos.
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SLIC assembly settings

Fragments to The Fragments to Assemble list at the bottom of the dialog box lists the individual Parts and
assemble Devices in the order in which they appear in the Circuit.
Fragments to Azzemble
Mo. of Fragments: | 2 Length: | 444
Name Direction Type Length Amplify Stitch
I:‘ Circuit_1 FORWARD Circuit 538
I:‘ Device_1 FORWARD Device 539
GF_PRO_1 FORWARD Promaoter 138 @ no @ ves
I:‘ BBa_B0029 FORWARD Shine_Dalgarno_... 15
BBa_C0011 G REVERSE Coding Sequence 306 Q YES &y NO
I:‘ BBa_BOO10 FORWARD Terminator 20

1. Select the check boxes next to the individual Parts and Devices or the entire Circuit that
you want to assemble. Note that a selected Device or Circuit will be treated as a single
fragment. See Chapter 17, “GeneArt® Cloning” on page 263 for limitations on numbers of
fragments in a Seamless or High Order assembly.

2. Inthe Direction column, specify the orientation of each fragment in the final assembly by
selecting Forward or Reverse.

3. Inthe Amplify and Stitch columns, select Yes or No for each fragment, depending on
whether:

— The fragment ends are already homologous (No in both columns)
— You want to add end homology via PCR amplification (Amplify = Yes), or
— You want to bridge non-homologous ends with stitching oligos (Stitch = Yes).

Note: For a detailed description of these options, see “Design PCR primers to create end
homology” on page 267 and “Design stitching oligos (High Order Assembly only)” on page

267.
Complete the Click on OK to complete the configuration. The status icon in the Assembly Compatibility
configuration Check pane will change to a yellow warning icon 4. , indicating that the settings have changed.

Then proceed with compatibility check and assembly, as described in “Configuration and
assembly” on page 150.

SLIC assembly settings

For an overview of the sequence and ligation—independent cloning (SLIC) method, see:

Li, M. Z., and Elledge, S. J. (2007) Harnessing homologous recombination in vitro to generate
recombinant DNA via SLIC. Nature Methods 4, 251-256.
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Vector NTI™ Express Designer: Assembly Compatibility Check
SLIC assembly settings

® Configure SLIC (Li, 2007) Parameters.

Name: | SLIC_Assembled(pUC19L_GP_PRO_1_BBa_C0011)

Settings

Molecule Form: | Circular

Vector Direction: | Forward

Primer Setting

[ Reus= existing primars?

Primer Name: | PCR Primer

Vector Selection

Vector: | pUC1SL | D

start Position: | 1 Stop Position: | 2,658 | [ ampiity
Fragments to Assemble
No. of Fragments: | 2 | Length: [ 424
Name Diraction Type Length | Amplify
O  circuit2 FORWARD Circuit 539
[d] Device_1 FORWARD Davice 533
GP_PRO_1 FORWARD Promater 138 ) ves
[d] 28s_RO02S FORWARD Shine_Dalzsrno_.. 15
BBa_C0011 FORWARD CodingSequence 306 ) YES
[d] 282_B0010 FORWARD Terminatar =

Parameter profil_e Under Parameter Profile, select the default parameters or select custom.

Custom settings If you select custom under Parameter Profile, you can select from the following settings:

Select... To...

Molecule Form The form of the resulting molecule: Circular or Linear.

The orientation of the fragment(s) in the final assembly:
Forward or Reverse.

Vector Direction

Primer settings Reuse existing primers?

If you select this check box, you can select existing primers from the Vector NTI™ Express
Designer oligo database that you know are suitable for use with the fragments you are

assembling.

Frimer Setting

Reuse existing primers?

Configure Sense Primer Configure Antisense Primer

Name = Sequence 15 Name =« Sequence |
M13 Forward [-20) GTAAAACGACGG... 16 M13 Reverse CAGGAAACAGCT... 17
PRM1 AACGCAGTCAGG... 20 PRM2 ATCCGTTAGCGAG... 20
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SLIC assembly settings

Click on Configure Sense Primer or Configure Antisense Primer to select from the oligos in
the database.

¥ Oligos in Database X
Name Sequence Length | #

: 3'RACE Adapter Primer GGECCACGCGTCGACTAGTACTTTTIIT... 37

: Abridged Universal Amplificati... GGCCACGCGTCGACTAGTAC 20

: Gateway Forward [attB1) GEGGACAAGTTTETACAAAAAAGCA. . 31

: Gateway Reverse [attB2) GEGGACCACTTTGTACAAGAAAGCTG... 30

z M13 Forward [-20) GTAAAACGACGECCAG 18

: M13 Reverse CAGGAAACAGCTATGAC 17

z PRM1 AACGCAGTCAGGCACCETET 20

: PRM2 ATCCGTTAGCGAGGTECCGE 20

: SPE Promoter Primer GATTTAGGTGACACTATAG 13

: T3 Promoter ATTAACCCTCACTAAAGGGA 20

: T7 Promoter Primer TAATACGACTCACTATAGGE 20

: Universal Amplification Primer  CUACUACUACUAGGCCACGCGTCGA.. 32

: V5 Reverse ACCGAGGAGAGGGTTAGGGAT 21 e

Select All ] [ClearSEIe:tiDn] [ OK ] [ Cancel

Primer name

If you do not reuse existing primers, specify a base name for the primers (Primer Name) that
will be automatically generated by the configuration tool.

Vector selection 1. Under Vector Selection, click on the B button to select from the vectors available in the
Vector NTI™ Express Designer database.

2. If the ends of the linearized vector do not share homology with the ends of the first and
last fragment, select the Amplify check box. The ends of the vector will be amplified by
PCR primers to create end homology with the fragments.

Fragments to The Fragments to Assemble list at the bottom of the dialog box lists the individual Parts and
assemble Devices in the order in which they appear in the Circuit.
Fragments to Azzemble
Mo. of Fragments: | 2 Length: | 444
Name Direction Type Length Amplify
I:‘ Circuit_1 FORWARD Circuit 538
I:‘ Device_1 FORWARD Device 539
GP_PRO_1 FORWARD Promoter 138 @ ves
I:‘ BBa_B0029 FORWARD Shine_Dalgarno_... 15
BBa_C0011 FORWARD Coding Sequence 306 Q YES
I:‘ BBa_BOO10 FORWARD Terminator 20

1. Select the check boxes next to the individual Parts and Devices or the entire Circuit that
you want to assemble. Note that a selected Device or Circuit will be treated as a single
fragment. See Li and Elledge (2007) for limitations on numbers of fragments in a SLIC
assembly.

2. In the Direction column, specify the orientation of each fragment in the final assembly by
selecting Forward or Reverse.

3. In the Amplify column, select Yes or No for each fragment, depending on whether the
ends are already homologous (No) or you need to add end homology with the adjacent
fragment via PCR amplification (Yes). See Li and Elledge (2007) for more information.

Complete the Click on OK to complete the configuration. The status icon in the Assembly Compatibility
configuration Check pane will change to a yellow warning icon . , indicating that the settings have changed.
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Vector NTI™ Express Designer: Assembly Compatibility Check
CPEC assembly settings

Then proceed with compatibility check and assembly, as described in “Configuration and
assembly” on page 150.

CPEC assembly settings

For an overview of the circular polymerase extension cloning (CPEC) method, see:

Quan, J., and Tian, J. (2009) Circular Polymerase Extension Cloning of Complex Gene
Libraries and Pathways. PLoS ONE 4, €644 1. doi:10.1371/journal.pone.0006441

? Configure CPEC (Quan, 2009) Parameters El

Name: | CPEC_Assembled|pUC13L_GP_PRC_1_BBa_C0011) |

Parametar o

Settings

Maolecule Form: | Circular

Vector Direction: | Forward

Primer Setting

[] Reuse existing primars?

Primer Name: | FCR Primer |

Vector Selection

Vector: | pucist | E]

Start Position: | 1 Stop Position: | 2,655 | Ce] amptity

Fragments to Assemble

No. of Fragments: | 2 | Lengtn: [ 222

Nama Diraction Type Length | Amplify
[0 circuic 1 FORWARD Circuit 533

O Device_1 FORWARD Device 533

GP_PRO1 FORWARD Prometer 12z () ves
O B8a_BOD23 FORWARD Shine_Dalgarne_.. 15

BBa_0D011 FORWARD CodingSequence 306 () YES
O B8a_B0D10 FORWARD Terminatar 20

Parameter profile Under Parameter Profile, select the default parameters or select custom.

Custom settings If you select custom under Parameter Profile, you can select from the following settings:

Select... To...

Molecule Form The form of the resulting molecule: Circular or Linear.

Vector Direction The orientation of the fragment(s) in the final assembly:

Forward or Reverse.
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Primer settings

Vector selection

Fragments to
assemble

CPEC assembly settings

Reuse existing primers?

If you select this check box, you can select existing primers from the Vector NTI™ Express
Designer oligo database that you know are suitable for use with the fragments you are
assembling.

Frimer Setting

Reuse existing primers?

Configure Sense Primer Configure Antisense Primer

Name = Sequence 15 Name Sequence |
CAGGAAACAGCT... 17
ATCCGTTAGCGAG... 20

M13 Forward [-20) GTAAAACGACGG.. 16 M13 Reverze
PRM1 AACGCAGTCAGG... 20 PRM2

Click on Configure Sense Primer or Configure Antisense Primer to select from the oligos in
the database.

¥ Oligos in Database X
Name Sequence Length ||l#

: 3'RACE Adapter Primer GGECCACGCGTCGACTAGTACTTTTIIT... 37

: Abridged Universal Amplificati... GGCCACGCGTCGACTAGTAC 20

: Gateway Forward [attB1) GEGGACAAGTTTETACAAAAAAGCA. . 31

: Gateway Reverse [attB2) GEGGACCACTTTGTACAAGAAAGCTG... 30

z M13 Forward [-20) GTAAAACGACGECCAG 18

: M13 Reverse CAGGAAACAGCTATGAC 17

z PRM1 AACGCAGTCAGGCACCETET 20

: PRM2 ATCCGTTAGCGAGGTECCGE 20

: SPE Promoter Primer GATTTAGGTGACACTATAG 13

: T3 Promoter ATTAACCCTCACTAAAGGGA 20

: T7 Promoter Primer TAATACGACTCACTATAGGE 20

: Universal Amplification Primer  CUACUACUACUAGGCCACGCGTCGA.. 32 )

: V5 Reverse ACCGAGGAGAGGGTTAGGGAT 21 e

Select All ] [ClearSEIe:tiDn] [ OK ] [ Cancel

Primer name

If you do not reuse existing primers, specify a base name for the primers (Primer Name) that
will be automatically generated by the configuration tool.

1. Under Vector Selection, click on the B button to select from the vectors available in the
Vector NTI™ Express Designer database.

2. Ifthe ends of the linearized vector do not share homology with the ends of the first and
last fragment, select the Amplify check box. The ends of the vector will be amplified by
PCR primers to create end homology with the fragments.

The Fragments to Assemble list at the bottom of the dialog box lists the individual Parts and
Devices in the order in which they appear in the Circuit.

Fragments to Azzemble

Mo. of Fragments: | 2 | Length: | 444

Name Direction Type Length | Amplify
I:‘ Circuit_1 FORWARD Circuit 538

I:‘ Device_1 FORWARD Device 539

GP_PRO_1 FORWARD Promoter 138 @ ves
I:‘ BBa_B0029 FORWARD Shine_Dalgarno_... 15

BBa_C0011 FORWARD Coding Sequence 306 Q YES
I:‘ BBa_BOO10 FORWARD Terminator 20
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1.

Complete the
configuration

Vector NTI™ Express Designer: Assembly Compatibility Check
Exo/Fill In/Ligation assembly settings

Select the check boxes next to the individual Parts and Devices or the entire Circuit that
you want to assemble. Note that a selected Device or Circuit will be treated as a single
fragment. See Quan and Tian (2009) for limitations on numbers of fragments in a CPEC

assembly.

In the Direction column, specify the orientation of each fragment in the final assembly by

selecting Forward or Reverse.

In the Amplify column, select Yes or No for each fragment, depending on whether the
ends are already homologous (No) or you need to add end homology with the adjacent
fragment via PCR amplification (Yes). See Quan and Tian (2009) for more information.

Click on OK to complete the configuration. The status icon in the Assembly Compatibility
Check pane will change to a yellow warning icon . , indicating that the settings have changed.

Then proceed with compatibility check and assembly, as described in “Configuration and
assembly” on page 150.

Exo/Fill In/Ligation assembly settings

For an overview of the exonuclease, fill-in, and ligation DNA assembly method, see:

Gibson, D., Young, L., Chuang, R., Venter, J.C., Hutchison III, C., and Smith, H. (2009)
Enzymatic assembly of DNA molecules up to several hundred kilobases. Nature Methods 6,
343-345.
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® Configure Exo/Fill In/Ligation (Gibson, 2009) Parameters

Settings
Molecule Form: | Circular

Vector Direction: | Forward
Primer Setting

[] Reuse existing primers?

Primer Name: | PCR Primer

Vector Selection

Vector: | pUC19L

Start Position: | 1

Fragments to Assemble

No. of Fragments: | 2

3
m

Circuit_1
Device_1
GP_PRO_1
BE3_BOO2S
BBa_00011
B2s_BOO10

OrROEOOE

Nama: | Exo/Fill_In/Ligation_Assembled(pUC15L_GF_PRO_1_B8a_C0D11)

Parameter Frofile: | custom -

Stop Pasition: | 2,653 [¥] ampiify
Length: | 444

Diraction Type Length  Amplify
FORWARD Cireuit 533
FORWARD Device 533
FORWARD Promoter 138 @ v
FORWARD Shine_Dalgarno_... 15

C REVERSE CodingSequence 306 2 ves
FORWARD Terminater 20
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Exo/Fill In/Ligation assembly settings

Parameter profile Under Parameter Profile, select the default parameters or select custom.

Custom setting [ If you select custom under Parameter Profile, you can select from the following settings:
Select... To...
Molecule Form The form of the resulting molecule: Circular or Linear.
Vector Direction The orientation of the fragment(s) in the final assembly:
Forward or Reverse.

Primer settings Reuse existing primers?

If you select this check box, you can select existing primers from the Vector NTI™ Express
Designer oligo database that you know are suitable for use with the fragments you are
assembling.

Frimer Setting

Reuse existing primers?

Configure Sense Primer Configure Antisense Primer

Name Sequence 15 Name Sequence |
M13 Forward [-20) GTAAAACGACGG... 16 || M13 Reverse CAGGAAACAGCT... 17 I
PRM1 AACGCAGTCAGG... 20 | PRM2 ATCCGTTAGCGAG... 20

Click on Configure Sense Primer or Configure Antisense Primer to select from the oligos in
the database.

¥ Oligos in Database X
Name Sequence Length | #

: 3'RACE Adapter Primer GGECCACGCGTCGACTAGTACTTTTIIT... 37

: Abridged Universal Amplificati... GGCCACGCGTCGACTAGTAC 20

: Gateway Forward [attB1) GEGGACAAGTTTETACAAAAAAGCA. . 31

: Gateway Reverse [attB2) GEGGACCACTTTGTACAAGAAAGCTG... 30

z M13 Forward [-20) GTAAAACGACGECCAG 18

: M13 Reverse CAGGAAACAGCTATGAC 17

z PRM1 AACGCAGTCAGGCACCETET 20

: PRM2 ATCCGTTAGCGAGGTECCGE 20

: SPE Promoter Primer GATTTAGGTGACACTATAG 13

: T3 Promoter ATTAACCCTCACTAAAGGGA 20

: T7 Promoter Primer TAATACGACTCACTATAGGE 20

: Universal Amplification Primer  CUACUACUACUAGGCCACGCGTCGA.. 32

: V5 Reverse ACCGAGGAGAGGGTTAGGGAT 21 e

Select All ] [ClearSEIe:tiDn] [ OK ] [ Cancel

Primer name

If you do not reuse existing primers, specify a base name for the primers (Primer Name) that
will be automatically generated by the configuration tool.

Vector selection 1. Under Vector Selection, click on the g button to select from the vectors available in the
Vector NTI™ Express Designer database.

2. Ifthe ends of the linearized vector do not share homology with the ends of the first and
last fragment, select the Amplify check box. The ends of the vector will be amplified by
PCR primers to create end homology with the fragments.
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Vector NTI™ Express Designer: Assembly Compatibility Check
Golden Braid assembly settings

Fragments to The Fragments to Assemble list at the bottom of the dialog box lists the individual Parts and
assemble Devices in the order in which they appear in the Circuit.
Fragments to Azzemble
Mo. of Fragments: | 2 Length: | 444
Name Direction Type Length Amplify
I:‘ Circuit_1 FORWARD Circuit 538
I:‘ Device_1 FORWARD Device 539
GP_PRO_1 FORWARD Promoter 138 @ ves
I:‘ BBa_B0029 FORWARD Shine_Dalgarno_... 15
BBa_C0011 FORWARD Coding Sequence 306 C) YES
I:‘ BBa_BOO10 FORWARD Terminator 20

1. Select the check boxes next to the individual Parts and Devices or the entire Circuit that
you want to assemble. Note that a selected Device or Circuit will be treated as a single
fragment. See Gibson et al (2009) for limitations on numbers of fragments in an assembly.

2. Inthe Direction column, specify the orientation of each fragment in the final assembly by
selecting Forward or Reverse.

3. Inthe Amplify column, select Yes or No for each fragment, depending on whether the
ends are already homologous (No) or you need to add end homology with the adjacent
fragment via PCR amplification (Yes). See Gibson et al (2009) for more information.

Complete the Click on OK to complete the configuration. The status icon in the Assembly Compatibility
configuration Check pane will change to a yellow warning icon . , indicating that the settings have changed.

Then proceed with compatibility check and assembly, as described in “Configuration and
assembly” on page 150.

Golden Braid assembly settings

For an overview of the GoldenBraid assembly method, see:

Sarrion-Perdigones, A., Falconi, E.E., Zandalinas, S.I., Juarez, P., Fernandez-del-Carmen, A.,
Granell, A., Orzaez, D. (2011) GoldenBraid: an iterative cloning system for standardized
assembly of reusable genetic modules. PLoS One 6, €21622. doi: 10.1371/
journal.pone.0021622.
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Parameter profile

Custom settings

Vector selection

Fragments to
assemble

Golden Braid assembly settings

* Configure Golden Braid (Sarrion-Perdigones, 2011) Parameters

Primary Vector 1 Primary Vector 2

Hame: | Gircuit_1 Name: | Circuit_1 |

Settings Settings
Type I RE: | 8551 [Recognition: GETCTC, Gap: T v Type Il RE: | Bal [Recognition: BGTCTE; Gap: 1] v
Vector Salection Vectar Selactian
Vector: | pDEBA12C Vector | D Vector: | pDGBC12E Vector ] D

Fragments to Assemble Fragments to Assemble

Ma. of Fragments: | 1 | Langth: [ 138 ] No. af Fragmants: | 1 | Lengeh: [ 308
Name Direction Type Length Name Direction Type Length
D Circuit_1 FORWARD Circuit 539 D Circuit_1 FCRWARD Circuit 539
] Device_1 FORWARD Device 532 0 Device_1 FORWARD Devica 533
GP_PRO_1 FORWARD Promater 138 O GP_PRO_1 FORWARD Promoter 138
] 32a_BOO2S FORWARD Shine_Dalgarnc_.. 15 0 BE2_BOO23 FORWARD Shine_Dalgarna_... 15
O 88a_COD11 FORWARD CodingSequence 306 BBa_C0011 G REVERSE CodingSequence 306
] 32a_BOO10 FORWARD Tarminstar 8 0 BE2_B0010 FORWARD Terminater 80
Secondary Vectar
Parameter e
Settings
Construct Form: [ Circular v/
Type I RE: | 3smal [Recognition: CGTCTC; Gap: €] v/
‘Vector Selection
Vectar: | pDGB1483_Vactar ] E

Cancel

Under Parameter Profile, select the default parameters (braidl, braid2, or braid3) or select
custom, for the Primary Vector 1, Primary Vector 2 and Secondary Vector.

If you select custom under Parameter Profile, you can select from the following settings:

Setting Description
Construct Form The form of the resulting molecule: Circular or Linear.
Type Il RE The restriction enzyme to be used.

Under Vector Selection, click on the B button to select from the vectors available in the
Vector NTI™ Express Designer database.

The Fragments to Assemble lists for Primary Vector 1 and Primary Vector 2 lists the individual
Parts and Devices in the order in which they appear in the Circuit.

Fragments to Azzemble

Mo. of Fragments: | 2 | Length: | 444
Name Direction Type Length | Amplify
I:‘ Circuit_1 FORWARD Circuit 538
I:‘ Device_1 FORWARD Device 539
GP_PRO_1 FORWARD Promoter 138 @ ves
I:‘ BBa_B0029 FORWARD Shine_Dalgarno_... 15
BBa_C0011 FORWARD Coding Sequence 306 O YES
I:‘ BBa_BOO10 FORWARD Terminator 20
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Vector NTI™ Express Designer: Assembly Compatibility Check
Golden Gate assembly settings

1. Select the check boxes next to the individual Parts and Devices or the entire Circuit that
you want to assemble. Note that a selected Device or Circuit will be treated as a single
fragment. See Sarrion-Perdigones et al. (2011) for limitations on numbers of fragments in
an assembly.

2. Inthe Direction column, specify the orientation of each fragment in the final assembly by
selecting Forward or Reverse.

Complete the When you have made your selections for the Primary Vector 1, Primary Vector 2 and

configuration Secondary Vector, click on OK to complete the configuration. The status icon in the Assembly
Compatibility Check pane will change to a yellow warning icon .. , indicating that the settings
have changed.

Then proceed with compatibility check and assembly, as described in “Configuration and
assembly” on page 150.

Golden Gate assembly settings

For an overview of the Golden Gate assembly method, see:

Engler, C., and Marillonnet, S. (2011) Generation of families of construct variants using golden
gate shuffling. Methods Mol Biol. 729, 167-181.

? Configure Golden Gate (Engler, 201 1) Parameters

Mame: | Golden_Gate_Assembled(pACYC177_GP_PRO_1_BBa_B0029_BBa_C0011_BBa_BOD10)
Parameter Profile: | default |
Settings
Construct Form:
Type |l RE:
Vector Selection
Vector:
Fragments to Azzemble
Mo. of Fragments: | 4 Length: | 538
Name Direction Type Length
I:‘ Circuit_1 FORWARD Circuit 538
I:‘ Device_1 FORWARD Device 539
GP_PRO_1 FORWARD Promoter 138
BBa_B0029 FORWARD Shine_Dalgarno_... 15
BBa_C0011 FORWARD Coding Sequence 306
BBa_BOO10 FORWARD Terminator 20
OK ] [ Cancel

Parameter profile Under Parameter Profile, select the default parameter or select custom.
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Custom settings If you select custom under Parameter Profile, you can select from the following settings:

Select...

To...

Construct Form

The form of the resulting molecule: Circular or Linear.

Type Il RE

The select the restriction enzyme to be used.

Vector selection Under Vector Selection, click on the B button to select from the vectors available in the
Vector NTI™ Express Designer database.

Fragments to The Fragments to Assemble list at the bottom of the dialog box lists the individual Parts and
assemble Devices in the order in which they appear in the Circuit.
Fragments to Azzemble
Mo. of Fragments: | 2 Length: | 444
Name Direction Type Length Amplify
I:‘ Circuit_1 FORWARD Circuit 538
I:‘ Device_1 FORWARD Device 539
GP_PRO_1 FORWARD Promoter 138 @ ves
I:‘ BBa_B0029 FORWARD Shine_Dalgarno_... 15
BBa_C0011 FORWARD Coding Sequence 306 C) YES
I:‘ BBa_BOO10 FORWARD Terminator 20

1. Select the check boxes next to the individual Parts and Devices or the entire Circuit that
you want to assemble. Note that a selected Device or Circuit will be treated as a single
fragment. See Engler and Marillonnet (2009) for limitations on numbers of fragments in

an assembly.

2. 1Inthe Direction column, specify the orientation of each fragment in the final assembly by

selecting Forward or Reverse.

Complete the Click on OK to complete the configuration. The status icon in the Assembly Compatibility
configuration Check pane will change to a yellow warning icon 4. , indicating that the settings have changed.

Then proceed with compatibility check and assembly, as described in “Configuration and

assembly” on page 150.
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Primer Design

This chapter describes the functions for designing primers and probes in Vector NTI™ Express
Designer, including settings for designing PCR primers, sequencing primers, and hybridization
probes. Vector NTI"" Express Designer can design primers for an entire DNA molecule
sequence or part of a sequence selected in the Molecule Editor window. After selecting the
target sequence, the maximum and minimum product length and parameters are determined,
and the software evaluates, rates and sorts several design options. You can further fine-tune the
oligos and annealing parameters if you wish, save the primers or probes as separate molecules
in the database or to the Oligo List, order custom oligos from Thermo Fisher Scientific, or use
the primers in recombinant cloning strategies.

The following table summarizes the various primer/probe design options in Vector NTI™
Express Designer:

Design Tool Purpose

Find PCR Primers Inside Specify limits for PCR primer search such as length of target
Selection sequence, output options, attach restriction sites, etc.
Amplify Selection Similar to Find PCR Primers except that primer hybridization

domains upstream and downstream from the target sequence
can be specified. Primers will be generated anywhere within
the designated upstream and downstream domains.

Sequencing primers Set parameters for sequencing and primer regions and
primer; analyze primers.

Hybridization Probes Set parameters for target region, output options; analyze
probes.

PCR Using Existing Oligos | Similar to Find PCR Primers, but, for the selected
amplification region, allows you to search for suitable PCR
primers from among those selected from the Vector NTI™
Express Designer oligo Llist.

Primer3 Design primers and hybridization probes for PCR.

Open the primer/probe design tools

The design tools are located on the Molecule Editor toolbar.

1. With a molecule loaded in the Molecule Editor, you can design oligos for the entire
molecule sequence or a selected region:

— To design primers/probes for the entire molecule, make no sequence selection before
you open the design tool.

— To design primers/probes for a specific region of the sequence, select the region
(e.g., by dragging or clicking on a feature in the Graphics or Sequence pane) and
then open the tool.
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n Primer Design
Save and load settings
2. Click on Primer Design in the toolbar and select from the drop-down list of design tools:

Find PCR. Primers Inside Selection
Amplify Selection

Sequencing Primers

Hybridization Probes

PCR Using Existing Cligos
Primer3

3. Each primer tool opens in a separate pane in the Molecule Editor window, with the basic
settings accessible in the pane. For advanced settings, click on the Advanced button in the
pane to open a separate dialog box.

Primer Design pane

D oAl ':&
R & B[ ol s
Promoter Prokaryotic -

= ater .

| =]

=

.

i

& A

pcDNA3.1(+)
5428bp

glication Origin

Advanced settings

Save and load settings

The Save and Load buttons at the bottom of each pane (or at the bottom of each tab in the
Advanced settings dialog) allow you to save your primer/probe design settings to a file and
load the settings file for subsequent analyses. Design settings are saved as *.per files.

This is useful for saving frequently used settings.

Run the design tool

After you have selected the desired settings (see the following pages for more details about
individual settings), click on Run in the primer design tool, or click on OK in the Advanced
settings dialog of the tool.

Primer/ probe The primer or probe designs will be added as features in the molecule, and listed in the Feature
design results Map and displayed in the Graphics pane of the Molecule Editor (see “Molecule features” on
page 73).

Primer and probe designs are sorted in descending order in the Feature Map according to their
rating values calculated based on the importance factors assigned in the Qualities tab (see page
189). The molecule region of each design is listed in parentheses.
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Run the design tool n

The results are also listed under Analysis Results in the Molecule Editor window, along with
specific information about each oligo sequence.

Analysis Results

BN = cuencingorine:s |
=] I:‘Sequencing Primers:10Z8 to 1252
= I:‘Sequencing Domain §1: from 1028 to 1252
=[] ceTTTARACCCECTGATCAG
[Jee: s0.0
I:‘ Length: 20
[1site: 100z
[Qtm: 52,6 ¢
[Jae: -34.7 keal/mel
[Jas: -1553.3 keal/mel
[Jas: -412.1 calimel
[JTime: 1s/01/2012 22:18:21
[=-[E] HybridizaticnProbes
Hybridizatic:n Probes:1028-1252
[JTime: 1s/01/2012 23:38:21

Primer and probe designs are also be listed in the Ordering dialog, under Primers.

Save primer/ probe  There are a number of ways to save primer/probe designs:

designs + To save them as Analysis Results in the database, right-click on a top branch in the
Molecule Editor Analysis Results pane and select Save All Analysis Results to
Database.

» To save them as oligos in the Oligos Database, right-click on a primer/probe sequence in
the Molecule Editor Analysis Results pane and select Save Primers to Oligo Database.

* To add them to the Oligos List, right-click on a primer/probe sequence in the Molecule
Editor Analysis Results pane and select Add Primers to Oligo List.

Analysis Results

=[] SequencingPrimers
= I:‘ Sequencing Primers:10Z8 to 1252
= I:‘Sequencing Domain §1: from 1028 to 1252

=]

|

Collapse Branch

O
O
| Camera

| Add Primers to Oligo List

O Save Primers to Oligo Database. ..

E Save All Analysis Results to Database. ..

I:‘ Time: 15|
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Primer Design

Find PCR Primers Inside Selection settings

Find PCR Primers Inside Selection settings

178

Select Find PCR Primers Inside Selection to design primers within a selected region or the
entire molecule for PCR amplification. With the molecule open in the Molecule Editor, select
the region to be amplified, then select Primer Design » Find PCR Primers Inside Selection
from the Molecule Editor toolbar.:

%__8 Primer Design - Find PCR Primers Inside Selection ¢=_g"
=
Find PCR Primers *
ATGC
Region of Analysis o?
From | 2136 bp To | 2930 bp V]
L1
Product Length E
Min | 536 bp Max | 795 bp
=1
M4
Max. Mo. of Primers | & -
=1
Spkdey
b Analysis Conditions 1
b Attach to 5' Terminus
el
4111
AR
[Ad\ran:ed] [Luad...] [SEVE...] [ Default ] T
AAR

The following are the unique settings for Find PCR Primers. These are also available under
the Primers tab if you click on the Advanced button:

Find PCR Primers
setting

Description

Region of Analysis

The start and end coordinates of the region to amplify. You can enter
new coordinates, or select a region of the sequence before opening
the tool to pre-populate the region coordinates.

Product Length

Enter the maximum and minimum lengths of the molecule target
region. Note: Unless you specify differently here, the minimum
amplicon length may be less than the target sequence you selected.

Maximum Number
of Primers

Enter the number of sense-antisense primer pairs to be found. The
actual result may contain fewer than this number if there are not
enough possible primers.

Analysis Conditions settings

Click on the Analysis Conditions drop-down to access these settings:

Analysis Conditions
setting

Description

DNA/RNA radio button

Select the type of target nucleotide sequence.

Salt Concentration

Enter the PCR reaction salt concentration in mMol, if known.

Probe Concentration

Enter the value of probe concentration in pMol, if known.

dG Temperature

Enter the temperature in degrees Celsius to be used for
calculating free energy values.

Vector NTI™ Express Designer Software User Guide



Amplify Selection settings n

Analysis Conditions

setting Description

Tm Enter limits in degrees Celsius for primer melting temperature
(T,,) (temperature at which 50% of primer is a duplex) and the
difference between T,,, for sense and antisense primers.

%GC Enter the limits of G/C percentage in the primer and the difference
between GC percentages for sense and antisense primers.

Length Enter primer length limits. Note: Nucleotide sequences such as
RENSs attached to a primer’s 5" end are included when calculating
primer length.

Note: The calculation for Tm is dependent on primer and salt concentrations; varying these
concentrations can greatly affect the Tm for any given primer. Make sure to adjust these
parameters according to your reaction conditions when performing your PCR analysis to ensure
that you obtain accurate Tm values.

Attach to 5" Terminus settings

Click on the Attach to 5’ Terminus drop-down to access these settings

Attach to 5’

Terminus setting Description

Attachto 5 Terminus | Enter a short (=/<18 bp) nucleotide sequence [if any) to be attached

of Sense Primer to the 5" end of either primer. To choose from recognition sites of
and/or Antisense database RENSs, click the Browse button next to each field.
Primer

Note: This sequence, while considered in primer parameters, does
not affect the calculation of complementarity between primer and
molecule. A sequence can be attached to the primer whether or not
the primers are user-defined or designed by the software.

Advanced settings: Primers tab

Click on the Advanced button below the main settings to open the Advanced settings dialog.
Under the Primers tab, the settings described above are listed, in addition to the following:

Advanced Primers

setting Description

User-Defined Enter user-defined primer sequences or a primer from the oligo

Primers database. The search engine checks the compatibility of the primers
according to primer parameters.

Additional advanced settings are described in “Shared Advanced settings” on page 186

Amplify Selection settings

Select the Amplify Selection primer design tool to amplify an entire selected region of a
molecule. With the molecule open in the Molecule Editor, select the region to be sequenced,
then select Primer Design » Amplify Selection from the Molecule Editor toolbar.
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Primer Design
Amplify Selection settings

These settings are similar to the Find PCR Primers settings except that you can specify primer
hybridization regions upstream and downstream of the target sequence.

Amplify Selection picks primers to amplify the entire selection. If suitable primers cannot be
found inside the selected region, the search will expand within the specified upstream and
downstream flanking regions.

b4 p P " - >4
b-d Primer Design - Amplify Selection ¢=_g"
=
Amplify Selection *
¥
Amplicon must include region of molecule
From: | 523 bp To: | 534 bp E_«f
Max bp before selection | 5
=]
Max bp after selection 5 M4
Max. Mo. of Primers. 5 ,Iil
Spkey
F Analysis Conditions 1
-
b Attach to 5' Terminus + 111
AT
T
[Advan:ed ] [ Load... ] [Sa\re... ] [ Default ] AR

The following are the unique settings for Amplify Selection. These are also available under the
Primers tab if you click on the Advanced button:

Amplify Selection

setting Description

Amplicon Must Include Set the 5" and 3’ positions for region of the molecule that must

Region of Molecule be included in the final amplified product.

Max bp before selection Provides additional upstream region where the primer may be
made.

Max bp after selection Provides additional downstream region where the primer may
be made.

Maximum Number of Enter the number of sense-antisense primer pairs to be found.

Primers The actual result may contain fewer than this number if there

are not enough possible primers.

Analysis Conditions settings

For information about the Analysis Conditions settings, see page 178.

Attach to 5" Terminus settings

For information about the Attach to 5’ Terminus settings, see page 179.
Advanced settings: Primers tab

Click on the Advanced button below the main settings to open the Advanced settings dialog.
For information about the Advanced settings on the Primers tab, settings, see page 179.
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PCR Using Existing Oligos settings n

Additional Advanced settings

Additional advanced settings are described in “Shared Advanced settings” on page 186

PCR Using Existing Oligos settings

Select PCR Using Existing Oligos to search for suitable PCR primers from among those in the
Vector NTI™ Express Designer Oligo Database. With the molecule open in the Molecule
Editor, select the region to be sequenced, then select Primer Design » PCR Using Existing
Oligos from the Molecule Editor toolbar.

%__8 Primer Design - PCR Using Existing Oligos =
=
3
FCR Using Existing Oligos *
ATGC
Region of Analysis o?
From | 1022 bp To | 1039 bp V]
L1
Product Length E
Min | 18 bp Max | 183 bp
=1
Sense and Antisense Primers in Database s
Sense Primers. ] [Antisense Primers EH\'
Selected:0 Selected:0 1
b Analysis Conditions Vi
_ AT
b Attach to 5' Terminus T
V.V

[Ad\ran:ed] [Luad...] [SEVE...] [Default]

These settings are similar to the Find PCR Primers settings with a few exceptions. The
following are the unique settings for PCR Using Existing Oligos. These are also available
under the Primers tab if you click on the Advanced button:

PCR Using Existing

Oligos setting LEEETITE

Sense Primers Click the Sense Primers button and select the desired primer(s)
from the Oligo Database.

Antisense Primers Click the Antisense Primers button and select the desired primer(s)
from the Oligo Database.

Note: Since you can choose the number of 3” and 5’ primers, these settings effectively enable
you to analyze one 3’ primer against an array of 5’ primers or vice-versa.

Analysis Conditions settings

For information about the Analysis Conditions settings, see page 178.

Attach to 5" Terminus settings

For information about the Attach to 5’ Terminus settings, see page 179.
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Primer Design
Sequencing Primers settings

Advanced settings

Click on the Advanced button below the main settings to open the Advanced settings dialog.
Advanced are described in “Shared Advanced settings” on page 186

Sequencing Primers settings

Select Sequencing Primers to find primers for sequencing a DNA molecule fragment. With the
molecule open in the Molecule Editor, select the region to be sequenced, then select Primer
Design » Sequencing Primers from the Molecule Editor toolbar.

o4 pp . P e
o Primer Design - Sequencing Primers ¢=_g"
=

Sequencing Primers *
ATGC
Seqguencing Region C’?
From: | 1022 bp To: | 1033 bp C-d
e}

Domain L:
Sequencing Domain 300 =1
e

Primer Hybridization Domain | 50

=1
Spkey

Max. No. of Primers | 1 1
F Analysis Conditions el
Ad d ] [ Load ] [ i ] [ Default ] 2
vance oad... ave... efau ann

Primers will be generated anywhere within the designated “Primer Hybridization Domain”
(upstream and downstream).

If the sequencing region is long enough, it is divided by Vector NTI"™ Express Designer into
smaller sequencing domains, areas in which a single sequencing reaction will take place. The
size of the primer hybridizing domain may then be set, as well as other primer parameters.
Several primer options are evaluated and sorted from best to worst.

Note: Sequencing primers are designed for a sequence region, not an entire molecule.

The following are the unique settings for the Sequencing Primers tool. These are also available
under the Primers tab if you click on the Advanced button:

Sequencing -
Primers setting Description
Sequencing Region Region that you want to sequence. Enter the start and end

coordinates of the region to be sequenced.

Sequencing Domain | Enter the number of bases to be sequenced in a single sequencing
reaction.

Primer Hybridization | Enter the length of region where primers for each sequencing
Domain domain should be sought. Primers are generated within the set
domain.
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Sequencing

Primers setting e Sl

Maximum Number Enter the number of primers to be found for each sequencing

of Primers domain. (The actual result may contain fewer primers than this
number if there are not enough possible primers.]

DNA/RNA Select the type of nucleotide sequence.

Complementary Select if you are sequencing the complementary strand.

Strand

User-Defined First Enter a user-defined nucleotide sequence to be evaluated as a

Primer primer for the FIRST sequencing domain, instead of leaving the

primer search to Vector NTI™ Express Designer Software.

Analysis Conditions settings

For information about additional Analysis Conditions settings, see page 178.

Advanced settings

Click on the Advanced button below the main settings to open the Advanced settings dialog.
Advanced settings are described in “Shared Advanced settings” on page 186.

Hybridization Probes

Select the Hybridization Probe settings to find oligonucleotides that will hybridize to a
selected molecule sequence. Vector NTI™ Express Designer can generate a set of oligos or use
user-defined or database-stored oligos to test for hybridization efficiency with a target
molecule.

With the molecule open in the Molecule Editor, select the hybridization region, then select
Primer Design » Hybridization Probes from the Molecule Editor toolbar.

%__8 Primer Design - Hybridization Probes

Hybridization Probes
Search Region

From: | 1022 bp To: | 1039 bp

Max. No. of Output | 1

]

B 2T Bk o

b Analysis Conditions

=

HE

Advanced ] [ Load... ] [ Save... ] [ Default ]

Ee it
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Primer3 settings

The following are the unique Hybridization Probes settings. These are also available under the
Primers tab if you click on the Advanced button:

Hybridization
Probes setting

Description

Search Region

Region for which you want to design the probe. Enter the start and
end coordinates.

Maximum Number

Enter the number of probes to be found for the region. (The actual

of Output result may contain fewer probes than this number if there are not
enough possible designs.]

DNA/RNA Select the type of nucleotide sequence.

Complementary Select if you are sequencing the complementary strand.

Strand

User-Defined Oligo

Enter a user-defined nucleotide sequence to be evaluated as a probe
instead of leaving probe search to the software.

Analysis Conditions settings

For information about additional Analysis Conditions settings, see page 178.

Advanced settings

Click on the Advanced button below the main settings to open the Advanced settings dialog.
Additional advanced settings are described in “Shared Advanced settings” on page 186.

Primer3 settings

184

Select Primer3 to design primers within a selected region or the entire molecule for PCR
amplification. With the molecule open in the Molecule Editor, select the region to be amplified,
then select Primer Design » Primer3 from the Molecule Editor toolbar.:

04 pas S B
%] Primer Design - Primer3 %'
Region of Analyziz %
From | 1 bp To | 2393 bp ,:;?;
Product Length D__;
L
Product Size Ranges | 100-300
Max No of Primers | 1 2
=ME
F Analysis Conditions -
Spkey
Advanced ][ Load... ][ Save... ][ Default 1
e
+111
AT
T
ARR
.
—
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The following are the unique settings for Primer3. These are also available under the General
tab if you click on the Advanced button:

Find PCR Primers
setting

Description

Region of Analysis

The start and end coordinates of the region to amplify. You can enter
new coordinates, or select a region of the sequence before opening
the tool to pre-populate the region coordinates.

Product Length

Enter the maximum and minimum lengths of the product as a range.
Note: Default range is set at 100-300 nt.

Maximum Number
of Primers

Enter the number of sense-antisense primer pairs to be found. The
actual result may contain fewer than this number if there are not
enough possible primers.

Analysis Conditions settings
Click on the Analysis Conditions drop-down to access these settings:

Analysis Conditions
setting

Description

Salt Concentration

Enter the PCR reaction salt concentration in nM, if known.

Probe Concentration

Enter the value of probe concentration in nM, if known.

Tm

Enter limits in degrees Celsius for primer melting temperature
(T,,) (temperature at which 50% of primer is a duplex) and the
optimal T, for sense and antisense primers.

%GC

Enter the limits of G/C percentage in the primer and the optimal
GC percentage for sense and antisense primers.

Length

Enter primer length limits and the optimal primer length for
sense and antisense primers. Note: Nucleotide sequences such
as RENs attached to a primer’s 5" end are included when
calculating primer length.

Note: The calculation for Tm is dependent on primer and salt concentrations; varying these
concentrations can greatly affect the Tm for any given primer. Make sure to adjust these
parameters according to your reaction conditions when performing your PCR analysis to ensure
that you obtain accurate Tm values.

Advanced settings: General tab

Click on the Advanced button below the main settings to open the Advanced settings dialog.
Under the General tab, the settings described above are listed, in addition to the following:

Advanced Primer3
setting

Description

Excluded Region

Enter user defined sequence range to be excluded from amplified
product.
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Primer tab

Click the Primer tab enter user defined primer sequences and set acceptable limits for
nucleotide repeats, mispriming, and 3’-end stability.

Primer setting Description

Forward/Reverse Input | Enter a user-defined nucleotide sequence to be evaluated as a
Primer Sequence(s) primer.

Maximum Enter the maximum permitted length of nucleotide repeats in

Polynucleotide Repeat | primers.

Maximum difference in | Enter difference in degrees Celsius between T,;, for sense and
Tm antisense primers.

Primer maximum
mispriming

Primer Pair maximum

mispriming
Maximum 3" end Specify the number of nucleotides required to have 100%
stability complementarity with the target sequence at the 3" end.

Shared Advanced settings

Click on the Advanced button below the main settings to open the Advanced settings dialog.
The following Advanced settings are the same for all the primer/probe design tools.

Amplicon tab

Click the Amplicon tab to customize parameters relating to the resulting PCR product. %GC
content for the product or a portion of the product and allowed bases adjacent to the primer
annealing site can be specified.:

Amplicon setting Description

Amplicon %GC Enter the minimum and maximum for the desired %GC content in
the PCR product.

Next to Primer Choose accepted bases for the four successive bases adjacent to the

Annealing Site primer annealing site. Set minimum and maximum %GC range for
a specified length of the amplicon adjacent to the primer annealing
site.

Structure tab

Click the Structure tab to set acceptable limits for nucleotide repeats, palindromes and hairpin
loops for the primers. You can also check your primers/product for a selected group of
restriction sites from this tab.

Structure setting Description

Nucleotide Repeats Enter the maximum permitted length of nucleotide repeats in
primers.

Palindromes Enter the maximum permitted length of palindromes in primers.
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Structure setting

Description

Hairpin Loops

Stem Length: Enter the minimum number of base pairs in a
hairpin stem. (This value is also used as a minimum stacking
length for primer-primer complementarity and primer-primer 3’
end complementarity.) Permitted with dG: Check the Permitted
box for hairpin loops; enter the minimum permitted value for free
energy of hairpin loops. Primers with hairpin loops which have
free energy values > /= to this number will be accepted.

Check Hairpin Loops,
Palindromes,
Nucleotide Repeats

3" Region of ...

and Dimers Only Within

Check this box and enter the length of a 3’ region if all of a
primer’s features (repeats, palindromes, hairpin loops, dimers)
should be checked only within that 3’ region.(If this box is empty,
the whole primer will be evaluated.)

Check Primers For
Restriction Sites From

Check to find possible cloning sites inside primers and attached
nucleotide sequences [if anyl. In the drop-down menu, specify the
REN subset. Enzymes will be checked for the presence of their
sites in the primers and attached sequences, and within the PCR
product.

Pairs tab

Click the Pairs tab to specify how closely parameters such as Tm and %GC, etc. must match
between two primers in a generated primer set.

Pairs setting

Description

Tm Difference

Enter difference in degrees Celsius between T,,, for sense and
antisense primers.

%GC

Enter the difference between GC percentages for sense and
antisense primers.

Primer-Primer
Complementarity

Check the Permitted box for primer-primer complementarity;
enter the minimum permitted value for duplex free energy.

Primer-Primer 3" End
Complementarity

Check the Permitted box for primer-primer 3" end
complementarity; enter the minimum permitted value for duplex
free energy.

Similarity tab

Click the Similarity tab to determine the similarity relationship between the primers and the

target sequence.

Similarity setting

Description

Best Fit

Check this button to specify the search for site(s) with maximum
similarity with no set threshold.

With Similarities > =
Similarity Threshold

Check this button to indicate similarity site search above the
specified similarity threshold.

Similarity Threshold

Enter the percentage of minimally acceptable similarity.

Last ... Nucleotides
Must Have 100%
Similarity

Check and specify the number of nucleotides necessary to have
100% complementarity with the target sequence at the 3" end.
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Similarity setting Description

Similarity Between
Ambiguous
Nucleotides

Specifies acceptable similarity between ambiguous nucleotides (if
any). The Average, Minimum, and Maximum buttons indicate that
the average, minimum, and maximum possible similarity will be
calculated respectively for any nucleotide pair. For instance, if you
are calculating similarity between N and A, then the average
similarity is 25%, the minimum similarity is 0%, and the maximum
similarity is 100%. In case of R and A they are 50%, 0%, and 100%;
in case of R and T—0%, 0%, and 0%.

The similarity table used by Vector NTI™ Express Designer is as follows:

N-N N-R N-A R-W R-A R-T
Maximum 100 100 100 100 100 0
Average 25 25 25 25 50 0
Minimum 0 0 0 0 0 0
3" End tab

Click the 3° End tab to set specifications for the 3’ end of the primers generated by Vector
NTI™ Express Designer. Parameters such as dG and specific nucleotide content for the 3’ end
of both sense and antisense primers can be set here.

3’ End setting Description

dG <= Specify the maximum permitted value of 3" end free energy.

Length for Analysis Enter the length of the primer’s 3’ region that should be analyzed.

Sense Primer 3’
Nucleotides

Check the nucleotide boxes to specify permitted last primer
nucleotides for the sense primer.

Antisense Primer 3’
Nucleotides

Check the nucleotide boxes to specify permitted last primer
nucleotides for the antisense primer.

Uniqueness Tab

Click the Uniqueness tab to select settings to determine the uniqueness of the generated
primers. These parameters can be used to help ensure that generated primers bind to the desired
template area with greater specificity than to the rest of the PCR product.

Uniqueness tab

setting Description

Uniqueness Checks for | Choose the area of the molecule to check for primer uniqueness.
Either the entire molecule or the Amplicon only can be selected
for the uniqueness check.

Max Allowed Similarity | Check this box and enter the similarity threshold to check primer
uniqueness on the molecule. Primers which have parasitic
hybridization with similarity >/= this threshold will be rejected.
Note: this similarity threshold must be </=the minimum similarity
required for hybridization of user-defined primers (if any).

Max Consecutive Match | Check this box and enter the maximum acceptable match of
for Entire Primer consecutive bases for the entire primer and the Amplicon.
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Uniqueness tab

setting Description

Primer 3" End Check the first box and enter the number of consecutive 3" bases
that must match the amplicon with 100% similarity. Check the
second box and specify the maximum acceptable % match
between the Amplicon and the designated number of bases on the
3" end of the primer.

Qualities tab

Click the Qualities tab to set parameters that govern primer quality by determining how much
weight should be assigned to the parameters on other tabs. These values affect scoring functions
that evaluate the quality rating of the primer sets generated.

The importance factors are integers between 1 and 10 used in calculating the score evaluating
primer/oligo quality. The lower the factor, the less weight given in the calculation. For example,
for minimal importance, enter 1 in the appropriate box. For maximum importance, enter 10.
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BioAnnotator™

BioAnnotator'" is a sequence analyzer that performs certain types of DNA/RNA sequence
analyses and displays the results as linear graphics.

Launching BioAnnotator™

To open BioAnnotator'":
* Right-click on a DNA/RNA molecule in the Database Explorer and select Bioannotator,
or

* With a molecule open in the Molecule Editor, click on the Bioannotator button
on the right-side toolbar.

The BioAnnotator™ window contains three panes: a Sequence Info pane, Graph pane,
and Sequence Pane.

Sequence Info [l ereB1 &3 (=]
Select Graph

| eCcontent 5} v/

GC Content [3)

Window Sizs: 11

Refresh Graph
Properties
Length 2964
2 E= 1452 2074 2087
801 TICTACAGTA TGCACAGACC ACTGATGEAC AGCAGATCIT AGTGCCCASC AACCAAGTTE TTGITCAAGC TECCTI®

R ———— ARGATGTCAT ACGTSTCTGE TGACTACCTE TCGTCTAGRR TCACGGETCE  TTEETTCAAC AACAAGTTCE ACGERA(.
Sequence Info 901 TCGCACACCA CCCACTACCA CIATICCCCC TCCACTICIT ATCCCATCCT CCCCACCACT TCCIACACAC CCTCC

AGCGTGICST GGGTGATCGT GATAACGGGG ACCTCAACRR TACCGTAGGR GGGGICGIGA AGGATGTSIC GEACE

.

Selecting an analysis

In the Sequence Info pane:
1. Select the graph to display from the Select Graph drop-down list.

2. Select any additional settings for the specific graph (see Analysis parameters on
page 192).

3. Click on Refresh Graph to display the graph.
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Graph and Sequence panes

Highlight sequence
region in the graph

Magnify the graph
Determine the

value at a point in
the graph

The graphs in BioAnnotator'" display physiochemical properties of the DNA molecule. The
Graph pane consists of the graphical analyses region: a vertical (Y) axis, showing minimal and
maximal values of analysis results, and an individual horizontal (X) axis displaying numerical
positions in the sequence, scrollbars, and the legend that displays the name of each analysis.

At any point along the sequence (X-axis), the value (Y-axis) for the property is derived not just
from the specific base at that point, but from adjacent bases as well. For each property, the
algorithm determines the optimum window of adjacent bases to be considered when calculating
the value for a point. For instructions in modifying the Window Size parameter, sce Window
size on page 192.

To highlight a particular data region, drag your cursor in the Graph or Sequence pane and the
corresponding region will be highlighted in both panes.

Click in the Graph pane and use the mouse wheel to change the horizontal scale of the graph to
zoom in on particular features. A scroll bar will appear below the graph as you magnify.

To determine the value at a particular point on the graph, hold your cursor over the bar in the
graph at that point. A popup number will be displayed, reflecting the value at that point.

If you have magnified the graph and highlighted a region in the sequence, you can see the value
calculated for that specific region.

GC Content (%)

Note: The Window Size parameter described below means that there is not necessarily a 1:1
correlation between a particular base or small group of bases in the sequence and a value in the
graph. Due to physiochemical interactions within a sequence, each analysis algorithm
necessarily calculates graph values from a “window” of surrounding data points.

Analysis parameters

Window size

192

The following parameters and setting are available in the Sequence Info pane.

All the graphs have a Window Size parameter. This is the number of adjacent data points used
in averaging values for each displayed data point, and the optimal value is analysis dependent.
The default window size has been optimized based on the selected analysis, but this value can
be changed. You can experiment with different window sizes and their effect on the resulting
graph by entering a different number in this field.
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After any change, click on Refresh Graph.

Analyses Melting temperature and free energy are calculated using the “nearest neighbors” method. For
descriptions and constants and algorithms used to calculate thermodynamic parameters, see Appendix B.
parameters The available DNA/RNA analyses and their specific parameters are:

* Free Energy (dG) (kcal/mol)

— This can be recalculated for a different temperature by entering a new value in the
Temperature ficld ( °C).

*  Melting Temperature (GC Content) ( °C)

— This can be recalculated for a different Salt Concentration (mMol) and %
Formamide of the solution by entering new values in the appropriate fields.

* Sequence Complexity
*  GC Content (%)
* Nucleic Acid Distribution (%)

— Select the bases for which you want to calculate the percent distribution using the
check boxes under Sequence includes.

*  Melting Temperature (Thermodynamic) ( °C)

— This calculation is dependent on the Salt Concentration (mMol) and %
Formamide of the solution, as well as the concentration of any probe in the solution
(Probe Concentration in pMol).

* Entropy (dS) (cal/K/mol)
» Enthalpy (dS) (kcal/mol)

After any change, click on Refresh Graph.
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Regenerator

The Regenerator application in Vector NTI™" Express Designer Software enables you to back-
translate a DNA sequence from a protein sequence, or modify an existing DNA sequence for a
given expression system. You can introduce mutations such as insertions, deletions, and
substitutions, or modifications like restriction or Gateway® sites, in the back-translated DNA
sequence, which can then be optimized for a specific expression system.

Regenerator Workflow

1. Load a protein or DNA sequence into Regenerator from the Molecule Editor.
2. If desired, introduce insertions, deletions, or substitutions into the sequence.

3. Select the desired expression system.
4

. If desired, add attachments relevant to downstream cloning to the back-translated DNA
sequence.

5. Save the newly created DNA sequence as a molecule in the database and/or send it for
synthesis.

Open Regenerator

To launch Regenerator:
1. Load a protein or DNA molecule into the Molecule Editor.
2. Select part of the sequence or make no selection to select the entire sequence.

3. Right-click in the Graphics pane and select Regenerator or click on the
Regenerator button in the Molecule Editor toolbar. E
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Regenerator tool features

The Regenerator tool will open.

& Regenerator E]@@

Protein to be Expressed

1 MVFLSGNASD SSNCIQPPAP VNISEAILLG VILGGLILFG VLENILVILS VACHRHLHSV THYYIVNLAV ADLLLISTVL
101 IWRRVDVLCC TASIMGLCII SIDRYIGVSY PLRYPTIVIQ RRGIMALLCY WALSLVISIG FPLFGWRQPAP EDETICQINE
201 IVMYCRVYVV AKRESRCLE GLETDESDSE QVILRIHREN APRCCSCMAS AKTETHFSVRE LLEFSREEEA AKTLGIVVEC
301 FEPSEIVFEI VEFWLGYLNSC INPIIYPCSS EFEEAFQNVL RIQCLEREQS SKHALGYILH PPSQAVEGQH EDMVRIDVGS
401 SMPRGSARIT VSEDQSSCIT ARTESRSVIR LECSGMILAH CNLRLEPGSRED PASASQARC TIGDVEPPGRR HQAQLIFVEL

£ >

To make Mutations:
Substitutions - Highlight the amine acid|s) and type in your changes

Deletions - Highlight the amino acid(s) and use Delete or Backspace key
MNote: Deletions will not marked in the protein sequence

Insertions - Place your cursor upstream of the insertion point and type in your changes Refresh DNA Sequence ] [\l’iew Mutant Protein ]

In Silico DNA Sequence

Expression SYStem: | p.charichia coli K12 v| Genetic Code | UNIVERSAL v|

41 EK K A A K T 5 G | v ¥ 6 C F V s c W 5 P F.E.'8 ¥ M FifS

801 AAZRRZ222CCE GCGARARCCC TGGECATIGT GGEIGEECIGC TITGIGCIGT GCIGECIGCC GITITIICIE GIGATGECC
TITTTITCGC CGCITITGEG ACCCGTRACR CCACCCGACG ARRCRCGACR CGACCGACGG CARARRACAC CACTACGE

1 F K P 5 E T ¥ F K | ¥ FW 85 G Y 5§ N 5 C [ N P | i

501 TITARACCGAR GCGARACCET GITTARRATT GIGITITGEC TEEGCTATCT GRACAGCTGC ATTARCCCGA TTATTTAI
ARRTTTGECT CGCTTIGECR CARRATTTTAR CRCRARACCE ACCCGATAGR CTIGTCGACE TARTTGEECT ARTRARTZW

£ [ | >

Add Attachment to In Silico DNA Sequence

@AddtuE'TErminus OAddtuE'TErminus

Restriction Site |Aar|-|:a|:|:t§|: V|

I:‘ Gateway Site

I:‘ User Defined | |

Add Attachment(s) [Mote: Attachments are not optimized for expression)

[CIEaraIIMutatiunsandAttarhmEntj] [ View In Silico DNA ] [ Send for Synthesis ] [ Exit

Regenerator tool features

The Regenerator tool has two main sequence panes, as well as various controls for editing the
sequence:

* The top pane contains the input amino acid sequence or DNA sequence and is editable,
allowing you to add or delete amino acids or bases directly in the sequence.

* The middle pane contains the in silico DNA sequence generated from the mutations
selected or entered in the tool.

Create mutations in the input sequence

You can insert, delete, or substitute amino acids (for proteins) or bases (for DNA) in the input
sequence directly.

» To insert amino acids or bases, place your cursor upstream of the insertion point and type
in your desired changes.
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» To substitute one or more amino acids or bases, highlight the desired part of the input
sequence and type in your desired changes.

* To delete part of the input sequence, highlight the sequence and use the Delete or

Backspace key.

Protein to be Exprezsed

1 MVFLSGNASD SSNCIQELAD

VHNISKAILLG VILGGLILFG VLGNILVILS VACHRHLHSV THYYIVNLAV ADLLLTSTIVL

101 IWARZVDVLCC TASIMGLCII

SIDRYIGVSY FPLRYPTIVIQ RRGIMALLCY WALSLVISIG FPLEGWRQPAP EDETICQINE

201 LVMYACREVYV VAHRESRELE

SCLETIDESDS EQVILRIHRE NAPRACGSGMA SAHTETHESYV RLLEFSREEE ARETLEIVVE

301 DFEPSEIVFE IVEWLGYLNS

CINPIIYPCS SQEFEEAFQN VLRIQCLRERE (SSEHALGYT LHPPSQAVEG (HEDMVRIEV

401 FSSMPRESAR  ITVSEDDSSC

TTARTESRSYV TRLECSGMIL AHCWNLRLPGS RDSPASASQR ACGTIGDVERE REHQAQLIEV

<

To make Mutations:

>

Substitutions - Highlight the amine acid(s) and type in your changes

Deletions - Highlight the amino acid|z) and use Delete or Backspace key
Mote: Deletions will not marked in the protein sequence

Insertions - Place your cursor upstream of the insertion point and type in your changes

Clear mutations
sequence.

View the mutated

sequence
Molecule Editor.

Refresh DNA Sequence ] [View Mutant Protein

Click the Clear all Mutations and Attachments to remove mutations and restore the original

The View Mutant Protein/DNA button is enabled once any mutation is introduced into the
input sequence pane. Click this button to view the mutated protein or DNA sequence in the

The protein is given a name using the following convention VNTI_<Protein Name>_mutant.

Refresh the in silico

DNA Seq uence Sequence button.

InSilico DNA Sequence

To update the In Silico DNA Sequence pane with any mutations, click on the Refresh DNA

Expression system: | pocharichia coli K12 w | GeneticCode | UNIVERSAL v
I:‘ 3-Letter AA Code
N M T M E 5 G E N Q o 5 6 D A A V T E A ENQ O M T A
1 ATGACCATGC ARACCGGCGC GCAARACCAC CAGAGCGECE ATGCOGCGET CACCGARGCE CAAAACCAGC  AGATGACC
TACTEETACC TTTCECCECE  CCTTTTEETC  STCTCECCEC  TACGCCECCA  CTEECTTCEC  CTTTTGETCE  TCTACTES
.. AT 5 A Q V 5 M F A A H A T 5 5 A F T vV T s v a 5 F
101 CEACCCTEEC GCAGETEASC ATECCGECEE CGCATGCEAC CAGCAGCECE  COSACCETGA  COCTESTGCA

ccTeccea ™
>

Optimize the expression system and genetic code

* Select the desired Expression system from the drop-down list. The in silico DNA
sequence will automatically update based on an internal codon usage table for the
expression system in Vector NTI™ Express Designer.

» Select the desired Genetic code from the drop-down list. The in silico DNA sequence will
automatically update based on the selection.

» Toggle between 1- and 3-Letter AA Code by clicking the 3-Letter AA Code check box.

Add attachments

You can add the following attachments to the 5° and 3’ ends of the in silico DNA sequence:
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Note: The 3’ end attachment will always be the Reverse Complement of the sequence
displayed in the attachments dialog box.

Add Attachment to In Silico DNA Sequence

@AddtDE'Terminus OAddtDE'Terminus

Restriction Site Aarl - cacctge hd

Gatewsy Site attB1 - ACAAGTTTGTACAAAAAAGCAGGCTTA ¥

Add Attachment(s) [Mote: Attachments are not optimized for expression)

* Select the Restriction Sites check box and then select from the drop-down list to add a
restriction site to the selected end(s) of the in silico DNA sequence. The selected
Restriction Site appears in the DNA sequence pane at the 5’ and 3’ end, based on your
selection.

+ Select the Gateway® Sites check box to add attB sites for Gateway® cloning to the back
translated molecule. In the Choose attB Extension dialog box that appears based on the
terminus you have selected (5° or 3”), select a fragment from the list and click OK. The
selected Gateway® site appears in the DNA sequence pane at the 5 or 3’ end, based on
your selection.

» Select the User Defined check box to add special sequences (promoter, tags, etc.) to the
back translated molecule. Enter the sequence in the field; the The sequence will appear in
the DNA sequence pane at the 5” or 3’ end, based on your selection.

Note: The attachments made to the DNA sequence will not appear in the protein sequence
pane.

Clear attachments Click on Clear All Mutations and Attachments to clear all attachments and restore the
original sequence.

Generate a new sequence and send for synthesis

* Click on View In Silico DNA to open the newly created DNA molecule in the Molecule
Editor You can then save the molecule, and copy and submit the sequence for synthesis as
described below.
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*  Click on the Go to Gene Synthesis button to go to the Thermo Fisher Scientific GeneArt®

gene synthesis service website. There you can create an account and submit the in silico
DNA sequence for synthesis.

Gene Synthesis by GeneArt®

Life Technologies Corporation completed the acquisition of
GeneArt® in December 2010. We have combined the
convenience of the Life Technologies online ordering
system, with cutting-edge GeneAr® service offerings,
including GeneOptimizer® technology for high-quality
gene expression and optimized gene synthesis.

How to Order

Configure your project Have us configure your project
Direct ordering via online portal (lowest Ordering via E-mail (Additional fees for
rate) manual processing apply)

« Secure data submission « Personal support

« Fastand easy project design « Project set-up by GeneArt® scientists

« Benefit from more than 10 years of

« Direct online ordering or project or )
experience

assistance by our experienced
specialists * Use the Excel data sheet to transfer
. . your sequence directly to

* Actual online project status geneartsupport@lifetech.com

« Instant overview of project history

configure your project submit your request
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BLAST search

Open the BLAST
search tool

BLAST search
settings

BLAST and Entrez Searches

Vector NTI™ Express Designer Software includes the search engines BLAST and Entrez Query
for querying sequences.

BLAST (Basic Local Alignment Search Tool) is a search engine for exploring available public
sequence databases for DNA or protein sequence similarities to a query sequence. BLAST
programs have been designed for speed, with a minimal sacrifice of sensitivity to distant
sequence relationships. BLAST scores have a well-defined statistical interpretation, making
real matches easy to distinguish from random background hits. BLAST uses a heuristic
algorithm that seeks local as opposed to global alignments and is therefore able to detect
relationships among sequences that share only isolated regions of similarity.

For detailed information on BLAST search types, settings, parameters, search databases, etc.,
visit http://blast.ncbi.nlm.nih.gov/Blast.cgi.

» To BLAST search an entire molecule in the database:
— Select the molecule in Database Explorer, right-click, and select BLAST Search.

— Open the molecule in the Molecule Editor and click on the BLAST button on the
main toolbar.

§|'_‘|$i'“’"‘-*;%é@é%l&lé@@@zzscbhﬁzzz

» To BLAST search part of a sequence, open the sequence in the Molecule Editor, select the
desired part of the sequence in the Graphics or Sequence pane, and right-click to select
BLAST sequence.

* To open a blank BLAST search window and type and paste a sequence directly into the
tool, click on the BLAST button on the main toolbar without selecting a molecule first.

The BLAST search tool settings are displayed in the right-hand pane of the tool; the results of a
search are displayed in the left-hand pane.

Select the following settings to define your search:

Program

In the Program drop-down menu, specify the type of database search to be performed:

blastn Compares a nucleotide query sequence against a nucleotide sequence
database.

blastp Compares an amino acid query sequence against a protein sequence
database.
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BLAST search

blastx Compares a nucleotide query sequence translated into all reading frames
against a protein sequence database.

tblastn Compares a protein query sequence against a nucleotide sequence
database dynamically translated in all six reading frames (both strands).

tblastx Compares the six-frame translations of a nucleotide query sequence
against the six-frame translations of a nucleotide sequence database. This
program cannot be used with the nr database.

Algorithm

In the Algorithm drop-down menu, specify the type of algorithm search to be performed. In
addition to blastn and blastp, algorithm searches include:

megablast | Concatenates many queries to save time spent scanning the database. It
is optimized for aligning sequences that highly similar and is up to 10
times faster than more common sequence similarity programs. It can be
used to quickly compare two large sets of sequences against each other.
MEGABLAST permits searching with batches of ESTs or with large cDNA
or genomic sequences.

PHI blast Pattern Hit Initiated BLAST. A program for searching a protein database
using a protein query; it seeks only alignments that preserve a specified
pattern contained within the query.

PSI blast Position Specific Iterated BLAST. A program for searching protein
databases using protein queries to find other members of the same
protein family.

Database

In the drop-down list, select the GenBank ™ database to query:

Menu item Description

nr/nt Peptide Sequence Database: All non-redundant GenBank™
sequences and CDS translations.

Nucleotide Sequence Database: All GenBank+EMBL+PDB
sequences (no EST, STS, GSS or phase 0, 1 or 2 HTGS sequences).
No longer non-redundant.

Refseq RNA Human Genome BLAST databases: human RefSeq mrna with
NM_#### or XM_#### accessions

Refseq Genomic Human Genome BLAST databases: human genomic contig
sequences with NT_#### accessions

Chromosome Nucleotide Sequence Database: complete chromosomes

EST Nucleotide Sequence Database: EST (Expressed Sequence Tags)—

mouse and human.

EST-others Nucleotide Sequence Database: EST (Expressed Sequence Tags)—
other than mouse and human.

GSS Nucleotide Sequence Database: Genome Survey Sequence,
includes single-pass genomic data, exon-trapped sequences, and
Alu PCR sequences.
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Menu item Description

HTGS Nucleotide Sequence Database: Unfinished High Throughput
Genomic Sequences.

PAT Protein sequences from the Patent division of GenBank™.

PDB Peptide Sequence Database: Saccharomyces cerevisiae protein

sequences—genomic CDS translations.

Nucleotide Sequence Database: Saccharomyces cerevisiae
genomic nucleotide sequences.

Alu repeats Peptide Sequence Database: Translations of select Alu repeats
from REPBASE.

Nucleotide Sequence Database: Select Alu repeats from REPBASE.

DBSTS Nucleotide Sequence Database: Database of
GenBank+EMBL+DDBJ sequences from STS Divisions.
ENV-NT Sequences from environmental samples, such as uncultured

bacterial samples isolated from soil or marine samples. The
largest single source is the Sargasso Sea project. This does not
overlap with the Nucleotide Sequence Database.

Limit by Entrez Query

This check box lets you limit the BLAST search to the results of an Entrez query against the
database chosen. This can be used to limit searches to subsets of the BLAST databases.

Select the check box and in the field below enter terms that would normally be allowed in an
Entrez search session. For example:

protease NOT hivl[Organism] — this form of a search will limit the search to all proteases,
except those in HIV 1.

biomol_mrna[PROP] AND brain — this form of a search can be used to limit searches to a
particular molecule type

Mus musculus[Organism] — this form of a search will limit the search to a specific organism.
Enter the name of the organism in the Entrez Query field with the [Organism] qualifier.

General Parameters

The parameters here are almost identical to parameters for the various BLAST searches at the
NCBI website. For more information regarding these parameters, visit http:/

www.ncbi.nlm.nih.gov/blast/html/blastcgihelp.html.

Max target sequences— The maximum number of aligned sequences to display.

Expect threshold—The statistical significance threshold for reporting matches against
database sequences. The default value of 10 means that in a database of the current size, 10
matches would be expected merely by chance (stochastic model of Karlin and Altschul, 1990.)
Hits showing a statistical significance greater than the Expect threshold are not reported.
Increasing the E value above 10 produces a larger list with more low-scoring hits (chance
matches). Lower expectation value thresholds are more stringent, leading to fewer chance
matches being reported.
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If your query peptide or nucleotide sequence is short, you might want to increase the Expect
value. Because a short query is more likely to occur by chance in the database, even a perfect
match can have low statistical significance and may not be reported. Increasing the E value lets
you look farther down the hit list and see matches that would normally be discarded because of
low statistical significance.

Word size—Word size is roughly the minimal length of an identical match an alignment must
contain if it is to be found by the algorithm. Mega BLAST is most efficient with word sizes 16
and larger, although word size as low as 8 can be used. If the value W of the word size is
divisible by 4, it guarantees that all perfect matches of length W + 3 will be found and extended
by Mega BLAST search, however perfect matches of length as low as W might also be found,
although the latter is not guaranteed. Any value of W not divisible by 4 is equivalent to the
nearest value divisible by 4 (with 4i+2 equivalent to 4i).

Scoring Parameters

* Match/Mismatch Scores—Reward and penalty for matching and mismatching bases.
Many nucleotide searches use a simple scoring system that consists of a “reward” for a
match and a “penalty” for a mismatch. The (absolute) reward/penalty ratio should be
increased as one looks at more divergent sequences. A ratio of 0.33 (1/-3) is appropriate
for sequences that are about 99% conserved; a ratio of 0.5 (1/-2) is best for sequences that
are 95% conserved; a ratio of about one (1/-1) is best for sequences that are 75%
conserved.

* Gap costs—The penalty to open a Gap and penalty to extend a Gap. Increasing the Gap
Costs decreases the number of Gaps introduced in the alignment.

Filters

* Low-complexity—This filter masks off segments of the query sequence that have low
compositional complexity (as determined by the SEG program of Wootton & Federhen,
Computational Chemistry, 1993). Regions with low-complexity sequence can create
problems in sequence similarity searching by producing artificial hits, sequences that are
not truly related. Such hits can produce high scores because of the presence of low-
complexity regions.

*  Human Repeats—This option masks Human repeats and is especially useful for human
sequences that may contain these repeats.

*  Mask for Lookup—This option masks only for purposes of constructing the lookup table
used by BLAST. The BLAST extensions are performed without masking.

*  Mask lower case characters—With this option selected you can cut and paste a FASTA
sequence in upper case characters and denote areas you would like filtered with lower
case. This allows you to customize what is filtered from the sequence during the
comparison to the BLAST databases.

1. To perform the search, click on Submit.

2. The search progress will be displayed left-hand pane of the BLAST search viewer. When
the search is complete, the search will be flagged as Complete.
3. Right-click on the search result and select from the following options:
— Save to Local Database—saves the search in the local database.
— Save as tab delimited file—save as a text file.

— Edit search—change the search parameters and re-Submit.
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BLAST search n

— Delete BLAST job—-clears the results from the list.

Request D Status Databaze Tool Query Length Hit Count Date/Time e

DucrET 1011 b |27 32 | Woodecostaoooarsraon ||
Save to Local Database
Save as tab delimited file
Edit search

Delete BLAST job

Double-click on the search result to open the result in the BLAST Result Viewer.

Note: BLAST results that have been saved to the database may be opened in Database
Explorer; click on Results and open the BLAST Results folder.

BLAST Result Double-click on a BLAST search result in Database Explorer or the BLAST tool to open the
Viewer result in the BLAST Result Viewer.

Table pane

Graphics pane

Sequence pane

The Viewer contains three main panes:

The Table pane displays a textual list of query “hit” molecules for the sequence
The Graphics pane displays the corresponding sequence of each hit in graphical form

The Sequence pane displays the Query sequence, “hit” sequence (with Accession
number), and Consensus sequence

Click on a row in the Table pane or a feature in the Graphics pane to display the corresponding
sequence in the Sequence pane.

Table pane columns

E-Value: This value reflects the likelihood that the similarity between the sequences
would occur by chance when searching a database of a particular size. A zero or extremely
low number suggests that the match is so perfect that it is extremely unlikely that the
similarity would occur randomly.

Name: The NCBI sequence identifier of the query hit.
Accession: The GenBank™ Accession number of the hit.
Bit Score: A measure of how close the identity of the match is to the query sequence.

Identity: The ratio (and percentage) of matching residues in the hit elements. The
numbers n/n refer to the number of identical residues out of the number of matches in the
hit element. This is important to consider when determining the significance of this
statistic. A high identity percentage may mean nothing if a low number of nucleotides is
being compared.

Positives: the ratio (and percentage) of similar residues in the hit elements

Query From/To/Orientation: The start and end position numbers in the query sequence
matching that of the hit element, and the strand that corresponds to the hit element.
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BLAST and Entrez Searches

+ Hit From/To/Orientation: The start and end position numbers in the hit sequence
matching that of the query element, and the strand that corresponds to the query element.

Download sequence features and save them as molecules

In the Table pane, click on the link in the Name column to download the sequence and database
information for that query molecule from the NCBI database and save it as a separate molecule
in Vector NTI™ Express Designer Software. The database information for the sequence will be
populated in the Properties of the created molecule.

Note: You will be prompted to submit your email address when connecting to the NCBI
database.

You can use the NCBI Entrez cross-database search engine directly from Vector NTI™ Express
Designer Software. For more information about this search engine, visit
www.ncbi.nlm.nih.gov/sites/gquery.

Note: An Internet connection is required to perform this search.

To perform an Entrez search, click on the Public Database Search button on the main toolbar.

Ow@ER¥ aEvn 0O0OWO &:
The Entrez search tool will open.
_,:“ Entrez Query Requi 1o Status Databs SearchTerm Date/Time
Database |protein v
searchTerm [ ool
< ba

The Entrez search tool includes the following panes:

*  Query pane—Contains settings for formulating a query.
* Query List pane—Lists the status of each query request.

* Results pane—Displays the results of a query.

The Entrez search engine allows you to search across a wide variety of NCBI databases.

1. To begin, select the desired NCBI database from the Database drop-down list:

— PubMed: A database of biomedical literature citations and abstracts from
MEDLINE, life science journals, and online books
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— Gene: Wide-ranging database containing nomenclature, Reference Sequences
(RefSeqs), maps, pathways, variations, phenotypes, and links to genome-,
phenotype-, and locus-specific resources worldwide.

— OMIM: Database of human genes and genetic phenotypes.

— Protein: Database of translations from annotated coding regions in GenBank™",
RefSeq and TPA, as well as records from SwissProt, PIR, PRF, and PDB.

— Structure: Database of three-dimensional genetic and protein structures.

— Popset: Database of DNA sequences that have been collected to analyze the
evolutionary relatedness of a population.

— Nucleotide: Database of genome, gene and transcript sequences from several
sources, including GenBank™", RefSeq, TPA and PDB.

— SNP: Database of single nucleotide polymorphisms (SNPs).

2. Search terms will vary by database. You can enter known search terms directly in the
Search Term field, or you can use the Search Builder function to construct your search
from known database elements and Boolean operators. For a description of search terms
and operators, visit www.ncbi.nlm.nih.gov/books/NBK3837/.

3. Select the desired Page size.
4. When you have made your selections, click on Submit.

5. The search progress will be displayed Query List pane. When the search is complete, the
search will be flagged as Complete and the search results will be displayed in the Results

pane.
Entrez search Entrez search results are displayed in tabular form in the Results pane.
results P—
i i) )

Database |protein v

SearchTerm [ prolactin[Protein Name]

>

-

<

Results: 1-200f 410

Caption Title CreateDate UpdateDate Taxld Gi Length
AMA31578 prolactin [Ovis aries] 1993/08/30 1993/08/11 9940 387876 220
AdA4SE11 prolactin [Oncorhynchus mykiss gairdneri 1994/08/24 1994/08/23 857570 532239 210
5128 531226 212
3123 531228 200
167318 3273437 190
167318 37734377 0
9606 531103 220
9825 551230 229
9825 551226 229
9940 551265 229

prolzctin [Greochromis nileticus]

prolactin [Breochromis niloticus]

AND || |All Fields v

prolzctin [Capra hircus]

prolactin [Czpra hircus]

prolactin [Gis arizs] !/ !/
prolzctin [Coragonus sutumnalis] 1993/08/28 2005/08/18 27773 312638 210
prolactin [Taenis hydstizens| 2002/04/23 2005/04/15 85431 20330092 222
prolactin [Nycticebus pygmaeus] 2004/07/26 2006/11/14 101278 50657062 220 -

Entrez Query

| s
g

The table of results includes columns appropriate for the database you are querying.
Click on the link in the Results pane to open the online database record for each result.

Note: Entrez queries are not saved in the Vector NTI™" Express Designer Software database.

Editing and + To delete an Entrez query, right-click on it in the Query List pane and select Delete search

deleting queries job.
» To edit a query, right-click on it in the Query List pane and select Edit search.
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GenomeBench-

GenomeBench™ can be used to download, view, analyze, annotate, and save local copies of
reference genomic DNA sequences from several principal Distributed Annotation System
(DAS) servers.

GenomeBench™ was designed to support the following workflows:

* Retrieval of genomic data from public DAS servers.

* Annotating and creating a local copy of a genomic region.
In support of these workflows, it accepts megabase-sized genomic sequences and all attendant
track annotations. All annotated features are linked to their corresponding region of the
genomic sequence backbone; additional information for any sequence-based annotation (for
example, mRNAs, ESTs, and STSs), including other defined features from the GenBank™

record, is easily downloadable. Annotated sequences can be aligned with the genomic backbone
simply by dragging and dropping into an alignment window.

Proprietary DNA sequences stored in the Vector NTI™ Express Designer local database can
also be positioned along genomic backbones using Spidey or Sim4 alignment algorithms to
determine the intron-exon structure of genes of interest. Genomic sequences in
GenomeBench™ can be exported to Vector NTI™ Express Designer for further sequence
analysis, such as PCR primer design or the creation of spliced transcripts.

GenomeBench™ also provides the capability to query public databases and perform sequence
and feature searches.

Download data from public DAS servers

Vector NTI™ Express Designer has preconfigured DAS servers
To launch GenomeBench™ and download data:
1. Click on the GenomeBench button on the main toolbar.
2. When you first open the application, an empty project will be displayed.

3. In the GenomeBench™ toolbar (on the right side of the window), click on the
Load from DAS Server button to download genomic data from one of the pre- +
configured public DAS servers:

— Genome Reference Consortium: human (GRCh)
— National Center for Biotechnology Information mouse genome assembly (NCBIM)

— Rat Genome Sequencing Consortium (RGSC)
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GenomeBench™

Download data from public DAS servers

— NCBI'’s 32K BAC array, BAC end-sequence pairs, and Fosmid clone end-sequence
pairs

E DAS-Select the chromosome

DAS Authority Sources
Last Update Time: 2011-11-08 1%:16 o — e i
Authority Sources# hglg Human sapiens Human Feb. 2009 (GRCh37/hg19) Geno...
P
NCEIM x
RGSC 7
NCEBI 3
Chromosomes
Last Update Time: 2011-11-08 1%:16 E
Chromosomes Name Length Orientation ’:
1 249250621 Forward
2 2431959373 Forward __
3 158022430 Forward
4 191154276 Forward
5 180915260 Forward
B 171115067 Forward
7 159138663 Forward w
[ OK ] [ Cancel

N o g &

In the DAS Server dialog, select the server from the DAS Authority list.
Select the genomic source from the Sources list.
Select the desired chromosomes from the Chromosomes list, then click on OK.

In the Load Fragment dialog, specify the base range of the sequence to download using the
Start and Length fields

Select the feature information to download from the Feature Type list, which displays a
selected list of features available in the DAS databases.

Load Fragment le

Positions

Start: 15000
Length: 25000

Feature Type

Name Category L]
wgEncodeHaibMethylRrbsT47dE...  transcription
wgEncodeOpenChroemChipMcf7C... transcription
wgEncodeHaibTfbsEcclEralphaa...  transcription

sgpGene transcription
wgEncodeGencodeManualvid transcription
lincRMAsTranscripts transcription
xenokst transcription
nestedRepeats transcription W
Add ] [ Remave ]
[ OK ] [ Cancel ]

— Use Ctrl+click and Shift+click to make multiple selections.

— Click on Remove to remove selected features from the download.
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— Click on Add to open the Feature Types Filter and select from all available feature
types to add them to the Feature Type list.

9. Click on the OK in the Load Fragment dialog to begin the download.

Note: It can take some time for all the features to load, but you can start working on features
that have loaded before the remaining features are loaded.

10. The download time can vary considerably depending on the server connection and data
volume.

11. When the download is finished, the GenomeBench™ Project viewer will display the

project.
Data Loadmg You can monitor the download progress by clicking on the Download Progress button
i ™
Monitor on the GenomeBench  toolbar. .* .
Data Loading Monitor § |
Main Sequence
Request Status Time b
xenoMrna features " Inloading ©00:03:41
intronEst features *o InQueue  00:03:41
refGene features *o InQueue  00:03:41
wgEncodeGencodeManualvdfeat.. 7 InQueue 00:03:41
lincRNAsCTTestes_R features *° InQueus 00:03:41
mgcFullMrna features *° InQueus 00:03:41
vegaPseudoGene features *° InQueus 00:03:41
wgEncodeGencode2wayConsPseu... & InQueue 00:03:41
wgEncodeGencode2wayConsPseu... & InQueue 00:03:41
wgEncodeGencodefutoVd features &7 InQueue 00:03:41
burgeRnaseqGemMapperalignTes... ¥ InQueue 00:03:41
sestanBrainAtlas features *o InQueue  00:03:41
cedsGene features *o InQueue  00:03:41
wgEncodeOpenChromChipMef7Cm... &7 InQueue 00:03:41
nscanGene features *o InQueue  00:03:41
nestedRepeats features *° InQueue  00:03:41 b
< ¥

In the Data Loading Monitor, features are listed as “Loading” or “In Queue.” To delete an “In
Queue” feature in the list, select it and click on Abort.

Local GenomeBench™ Projects

GenomeBench™ Projects that have been downloaded can be saved in the local Vector NTI™
Express Designer database for future access:

» To save a project to the local database (i.e., after downloading the data from the DAS
server), select File » Save As and specify a name for the project in the dialog box.

+ To open a saved project, open GenomeBench™ and click on the Load from
Local Database button. Then select the project name from the Existing Genome E
Projects dialog.
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GenomeBench™ Project Viewer

The GenomeBench™ Project Viewer contains the following panes: Map Overview, Feature
Map, Genome Features, and Genome Sequence View.

Map Overview

Feature Map

Genome Features/
Sequence View

Map Overview

Feature Map

212

: w v s a s ’:.' B s e i 2 i e e TR
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e 1 :

e ol il T @
uch0Tboy. 1w 1. 5TLT q
PN Y |

ueO03or. 20w 3. 1134619 Q
A WA
3u8
Fuscrrenes
TCONS_D0005408.chr . 1043818
a] ARDIITL.che 3. LT
Ll e TSN
528809, che 3655823
B
298182 che . 1304048
/
0019980, che3. 1134564 || .4.

The Map Overview pane presents a graphical depiction of the entire chromosome and has the
following features:

* A ruler marks the length of the chromosome.

* The rod-shaped band depicts the sequence/chromosome.

» Narrowed areas on the rod indicate centromeric regions.

* Cytoband patterns are indicated by the vertical dark lines that run the length of the rod.
Pause the cursor over a particular cytoband to display a tool tip with information about the
cytoband.

5EM B4M T2M B0M

[ birzfpizileslezs] [ I X_E
© 1250k 1300k 1350k 1400k
—|—|c\¢ubanu p14.2:58600000-63700000—

Centromeric regions and cytoband patterns are shown only for those DAS servers that provide
the information in the correct format.

The Feature Map Pane shows a graphical depiction of the features for the currently loaded
fragment.

Like the Overview Pane, the Feature Map Pane has a ruler at the top to help you visualize the
orientation of features along the length of the fragment.

Feature types or tracks display along the left side of the Feature Map Pane. Different features
are depicted with various graphical representations and are labeled with the feature name.
Shown features are listed along with relevant feature information in the Genome Features pane.
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the feature.

Magnifying tools

Editing features

The associated GenBank™ accession number is derived from the Target Accession number of

Use the magnifying tools to the right of the Feature Map to magnify features in the pane

horizontally.

&

Genome Features The Genome Features pane lists the features in the map by name, and indicates their type,

and Genome

location, orientation, and feature category.

S e q uence [ Genome Features | [ Genome Sequence View
Name Type Start
DCB54910.chr3.9... xenoEst 1000300
EZ159107.chr3.9... =enocMrna 574496
FC129225.chr3.8... xenoEst 1000165
CB308280.chr3.5... xenoEst 5995965
GEB74B06.chr3.5... xenoEst 595701

The Genome Sequence pane displays the entire downloaded sequence

Editing features

Length
a0
20
31
a9
261

Crientation

UNKNOWN
UNKNOWN
UNKNOWN
UNKNOWN
UNKNOWN

Category
transcription
transcription
transcription
transcription

transcription
=

In the Feature Map and Genome Features list, the right-click menu allows you to create, edit, or

delete features.

Right-click on a feature in the map or list and select:

» [Edit the selected feature: Edit basic settings and information for the feature, including
feature name, type, orientation, and position in the segment or multiple segments.

Name: ElEBlO?.:hrE.B?EMBE
Type: w

Crientation:

Position

O.Single Segment Start

Edit Feature(EZ159107.chr3.974495)

@ Direct O Complementary O Not oriented

End

X

@ Multiple Segments | 974496..974515,1222609..1222662

[ OK

| [ concet

]

* Create New Feature: Create a new feature, using the same settings and fields as in the
Edit Feature dialog.

* Delete the selected feature: Deletes the selected feature.
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Align Multiple Sequences

The simultaneous alignment of multiple nucleotide or amino acid sequences is an essential tool
in molecular biology. Alignment enables you to design PCR primers for amplifying a region of
aligned DNA/RNA molecules. Multiple alignments are used to find diagnostic patterns,
characterize protein families, as well as detect or demonstrate a similarity between new
sequences and existing families of sequences. They are also useful in predicting secondary and
tertiary structures of new sequences, suggesting oligonucleotide primers for PCR and serving as
an essential prelude to molecular evolutionary analysis.

AlignX™ is the multiple sequence alignment tool of Vector NTI™ Express Designer Software.
In addition to aligning sequences, it can be used to create and manage sequence alignment
projects. It uses a modified Clustal W algorithm and incorporates the following features:

* Phylogenetic tree construction, displayed in graphical representation
* Use of residue substitution matrices

* Secondary structure consideration

*  Multicolored alignment presentation

* Automatic consensus calculation

+ Full alignment editing capabilities

Open AlignX~

There are several ways to open the AlignX™" tool:

* Click on the AlignX button on the main toolbar.
fracs aavn coowo &=

» In Database Explorer, right-click on a molecule or Ctrl+click on multiple molecules and
select AlignX - Align selected Molecule(s) to load those molecules into the tool.

+ Load an existing AlignX"" project as described in “Manage AlignX"" projects” on page
216.

AlignX™ window The AlignX™ window consists of the following panes:

* Project Properties pane: Contains the Project Description and the Fragments list. As
molecules are added to an AlignX"" project, they are listed in the Fragments list.

* Alignment Settings pane: Contains the settings used to perform the alignment.

* Graphs pane: Displays a graphical representation of the aligned molecules, showing both
similarity and absolute complexity for consensus.

» Alignment pane: Displays the aligned sequences, with aligned regions highlighted
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Project description |

Phylogenetic tree

Align Multiple Sequences
Manage AlignX™ projects

Phylogenetic Tree pane: A graphical representation of the degree of similarity among
sequences (for three more sequences).

B Vector NTI Express Designer = AlignX

File Ede View Curate Discover Design Confirm Tock Help

Graphics pane

Fragments list

, = I o= [ = - P A T T g
< O% A% S EYE D299 wo & W
Project Properties 1= “New AlignX Project 2015-11-18-12-25-3 11
- Y E oG &
Praject Details
x peDNAS. LHygro_+_ (0.00084) R
Project Name: New AbgnX Proyect_2015-11-18-12-25-34 -
Description: N Praject
[T"Creation Date: 18-11-201512:25:34
Created By: Derna User
Molecule Type: o - PEOMAZ. L/Hygre_-_ (0.0065)
Algnment Dptions B Slow Fast
Fragment List
T Tetect Urselect 20 7
Sequence Name Length

5514
601
pod

— - peDNAD. 1/Hish (0.081C
7] 55, peDMAZL M A ,

¥ 5 peDNALL Hygro(=)
¥ =, peDMALL Hygrol-)

Alignment pane

Alignment settings —

Project Properties
Alignerrrt et

Manage AlignX~ projects

Save and rename a

project

Open a project

Close a project

216

Following analysis, a new AlignX"" project is automatically named New AlignX
Project <timestamps. To edit the name or description, click |=| Edit Project
Properties.

To save changes to a project, select File > Save or File > Save As. Save the project as
either an Alignment Project (*.aprx) or Multiple Sequence Formats (*.msf).

To load an existing project in the database, in Database Explorer, go to the Projects list,
double-click on the Projects folder, select the Alignment Projects folder from the Local
Database, and double-click on the AlignX™ project in the list to open it

Use this method to load projects saved in earlier versions of VectorNTI. While you can
open projects from the database, you cannot save to the database from Vector NTI Express
Designer. .

@ Projects

= Ii] Local Databaze
Ii] Alignment Projects
Ii] Contig Azsembly Projects
Ii] Cloning Projects

+ Ii] Remaote Databaze

Name Description Author Madified

pcDNA3. 1AlignProject
pcDNAG.2AlignProject

2011-12-1107:09:14
2011-12-1011:38:55

To load an existing project that has been saved as a .apr, .aprx, or .msf file, select File >
Open > Alignment Project, then choose between the supported formats.

To close a project, click “ Close Project. If there are unsaved changes, you will be prompted
to save the project before closing.
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Select fragments to align

Save consensus After you perform an alignment, you can save the consensus sequence as a separate molecule in
sequence the database. Right-click over the consensus sequence, and select Save As Molecule.

Select fragments to align

The tools for selecting the fragments to align are located in the Fragment List region of the
Project Properties pane.

Project Properties

Project Details
B x

Project Name: Mew AlignX Project_2015-11-20-10-33-58 =~
Description: New AlignX Project

Creation Date: 20-11-2015:10:39:58

Created By: Susan Tate

Molecule Type: DMNA

Alignment Options: @ Slow () Fast

Fragment List

[¥] Select/Unselect All =9 X
Sequence Name Length

=%, pcDNAZ1/His A 5514

=% pcDNAZL/Hygro(+) 5601

=% pcDNA3/Hygro(-) 5600

Project Properties

Alignment Settings

Add fragments To add fragments:

+ Click = Add molecule(s) from file(s) to this list for alignment to select .gb, .gp, or
fasta sequence files.

* Click EEJ Add molecule(s) from the database to this list for alignment to select DNA
or Protein molecules from the local database.
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Select fragments to align

Note: Use the drop-down menu to toggle between molecule types (DNA vs. Protein).
Press the Ctrl or Shift keys to select multiple files/molecules.

ﬁ Data from the local database @
Type Subset | MAIN - Search
MName Form Length Description 'S
ADCYT Linear 6196 Heomo sapiens adenylate cyclase 7 (ADCYT), mRMA. E
Adeno2 Linear 35937 Adenovirus type 2, complete genome.
BaculoDirect\Linear\DMNA  Linear 139370 (Invitrogen Vector)
BaculoDirect\Linear\DM... Linear 5770 (Invitrogen Vector)
BaculeDirect\Linear\DM...  Circular 139370 (Invitrogen Vector)
BBa_K174018 Linear 2393 GEMEART PMQ Plasmid Backbone
BLOCK-iT-Poll-miR-lac... Circular 5758 (Invitrogen Vector)
BLOCK-iT-Poll-miR-LM... Circular 5758 (Invitrogen Vector)
BLOCK-iT-Poll-miR-luc... Circular 5758 (Invitrogen Vector)
BPV1 Circular 7945 bovine papillomavirus type 1.
<< First | | < Prev | Page 1 ofib

Remove fragments To remove a fragment from the AlianTM project, select the check box next to the sequence
name in the Fragment List and click on the 3 Remove selected molecule(s) from alignment.
This will remove the fragment from the project, not delete it from the database.

Select fragments To select fragments for alignment, select the check boxes next to the fragment names in the
to al_ign Fragments List.
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Alignment settings

Alignment settings

Click on the Alignment Settings button below the Project Properties pane to view the settings
for performing an alignment.

Alignment Settings

»

General Options

Molecule Type: DNA

Iterations TREE -

MNumber of Iterations 1

 Pairwise Alignment Options

) Slow @) Fast
Gap Penalty 3
K-TUPLE (Word Size) 1
Window Size 5

Score Type PERCENT -

MNo. of Best Diagonals 5

+ Multiple Alignment Options

m

DMNA Weight Matrix IUB -
Protein Weight Matrix | GONMNET

Gap Open Penalty 15.0

Gap Extension Penalty  6.66

% Identity For Delay 30

DMNA Transitions Weight 0.5
Use Megative Matrix 1

Protein Gap Parameters

Hydrophilic Residues GPSNDQEKR
Gap Separation Distance | 4

Residue Specific Penalties

Hydrophilic Penalties
End Gap Separation

~ Phylogenetic Tree Options

Use a Kimura's correction [

Ignore positions with gaps [

L=
Default Settings

Project Properties

T

i%
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DNA weight matrix
programs

Protein weight
matrix programs

Molecule type

Iterations

220

Clustal W v2.1

The local Clustal W algorithm uses matrices to determine alignments of protein and DNA
sequences with each other. The program allows you to select different matrices to identify
related sequences. For sequences with high similarity, it is best to use a more strict matrix so the
algorithm will favor conserved substitutions. For more divergent sequences, more loosely
related matrices score frequent substitutions highly. The lower numbered matrices are more
strict, the higher numbers favor more divergent matches.

The following matrices are available in the AlignX program.

IUB

This is the best default matrix for the BESTFIT comparison of two nucleic acid sequences. X’s
or Ns in a nucleic acid sequence are treated as matches to any IUB ambiguity symbol and score
a mismatch of 0. Matches score 1.9.

PAM (Dayhoff)
These matrices are the original matrices, developed in the 1970s, that are used in many
applications. The matrices used are PAM 20, 60, 120 and 150.

GONNET

These matrices are calculated in a similar way to the PAM matrices but they are calculated
using more recent snapshots of the data available to us now. They appear to be more sensitive
than the PAM matrices. We provide the GONNET 80, 120, 160, 250 and 350 matrices.

BLOSUM (Henikoff)
These matrices appear to be the best available for performing database homology searches. The
matrices used as BLOSUM 80, 62, 45 and 30.

Identity Matrix (ID)

This matrix gives a score of 1.0 for two amino acid matches or a 0 otherwise. It is good for
quick screens of conserved homology between sequences.

CLUSTALW

This is the second nucleic acid matrix. It is similar to the identity matrix, in that matches score
1.0 and mismatches or IUB symbols score 0. It is good for a fast comparisons between a set of
sequences.

DNA or Protein is automatically detected and displayed.

A remove first iteration scheme has been added. This can be used to improve the final
alignment or improve the alignment at each stage of the progressive alignment. During the
iteration step each sequence is removed in turn and realigned. If the resulting alignment is
better than the previous alignment it is kept. This process is repeated until the score converges
(the score is not improved) or until the maximum number of iterations is reached. The user
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Alignment settings

can iterate at each step of the progressive alignment by setting the iteration parameter to
TREE or just on the final alignment by setting the iteration parameter to ALIGNMENT. The
default is no iteration. The maximum number of iterations can be set using the numiter
parameter. The default number of iterations is 3.

Choose an option from the pull-down menu, then enter the Number of Iterations in the box

below.
Slow options Description
NONE Do not perform any additional iterations
when performing alignment.
TREE Do an iteration at each step of the
progressive alignment.
ALIGNMENT Iterate only on the final alignment.

Pairwise alignment  These settings control pairwise distances based on the Clustal W algorithm selected.

The Alignment Type options control the speed/sensitivity of the initial alignments:

* Fast (approximate) method

* Slow (more accurate) method uses two gap penalties (for opening or extending gaps) and
a full amino acid weight matrix. This is the default setting.

There are different sets of parameters, depending on the alignment type:

Slow options Description

DNA Weight Matrix IUB (default) or Clustal W

Gap Open penalty The penalty for the first residue in a gap
Gap Extension penalty The penalty for additional residues in a gap
Protein weight matrix BLOSUM, PAM, GONNET, and ID

Fast [approximate] These similarity scores are calculated from fast, approximate, global alignments, which are
alignment determined by four parameters. Two techniques are used to make these alignments very fast:
Only exactly matching fragments (k-tuples) are considered, and only the best diagonals (the

arameters
P ones with most k-tuple matches) are used.
Fast options Description
K-TUPLE (Word size] Change the K-tuple value to limit the word-length the

search should use. A word-length of 2 is sensitive
enough for most protein database searches. The
general rule is that the larger the word length, the less
sensitive, but faster the search will be.

INCREASE this value for speed, or DECREASE for
sensitivity. For longer sequences (e.g. >1000 residues)
you may need to increase the default. The maximum
value is 2 for proteins and 4 for DNA.

Window Size The number of diagonals around each of the best
diagonals used. Decrease this value for speed or
increase it for sensitivity.
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Fast options

Description

Score Type

No. of Best Diagonals

Percent or absolute

The number of k-tuple matches on each diagonal (in an
imaginary dot-matrix plot] is calculated. Only those
with the most matches are used in the alignment.
Decrease the value for speed or increase it for
sensitivity.

GAP PENALTY

This is a penalty for each gap in the fast alignments. It
has little affect on the speed or sensitivity except for
extreme values.

Multiple Alignment  These parameters control the final multiple alignment.

options Option

Description

DNA/Protein Weight Matrix

All algorithms designed to evaluate pairwise sequence
alignment are based on systems which rank aligned
residues. Nucleotides or amino acids that are identical
or similar in alignment score higher than those less
similar. Matrices generated with these assigned scores
are used to detect similarities between differing
sequences. The most common of many different scoring
systems are based on substitutions of amino acids in
related proteins.

Gap Open Penalty

The penalty for the first residue in a gap

Gap Extension Penalty
% ldentity For Delay

The penalty for extending a gap by one residue.

" The DELAY DIVERGENT SEQUENCES switch delays the

alignment of the most distantly related sequences until
after the most closely related sequences have been
aligned. The setting shows the percent identity level
required to delay the addition of a sequence; sequences
that are less identical than this level to any other
sequences will be aligned later.

DNA Transition Weight

The TRANSITION WEIGHT gives transitions (A to G or C
to T, i.e. purine-purine or pyrimidine-pyrimidine
substitutions) a weight between 0 and 1. A weight of zero
indicates that the transitions are scored as mismatches,
while a weight of 1 gives the transitions the match score.
For distantly related DNA sequences, the weight should
be near to zero. For closely related sequences it is useful
to assign a higher score.

Use Negative Matrix

Num of Iteration

In the weight matrices, you can use negative as well as
positive values. However, the matrix will be
automatically adjusted to all positive scores, unless the
NEGATIVE MATRIX option is selected.

" 1(default] to 10

222
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Protein Gap Parameters

Description

Hydrophilic Residues

NEED INFO

Gap Separation Distance

GAP SEPARATION DISTANCE tries to decrease the
chances of gaps being too close to each other. Gaps that
are less than this distance apart are penalized more
than other gaps. This does not prevent close gaps; it
makes them less frequent, promoting a block-like
appearance of the alignment.

Residue Specific Penalties

Hydrophilic (gap) Penalties

RESIDUE SPECIFIC PENALTIES are amino acid specific
gap penalties that reduce or increase the gap opening
penalties at each position in the alignment or sequence.
As an example, positions that are rich in glycine are
more likely to have an adjacent gap than positions that
are rich in valine.

' HYDROPHILIC GAP PENALTIES are used to increase the

chances of a gap within a run (5 or more residues) of
hydrophilic amino acids. These are likely to be loop or
random coil regions where gaps are more common.

End Gap Separation

END GAP SEPARATION treats end gaps just like internal
gaps for the purposes of avoiding gaps that are too close
(set by GAP SEPARATION DISTANCE above). If you turn
this off, end gaps will be ignored for this purpose. This
is useful when you wish to align fragments where the
end gaps are not biologically meaningful.

Phylogenetic Tree

The Phylogenetic Tree is calculated and displayed after three or more sequences are aligned. It

options can be built using two different methods; NJ or UPGMA. The calculated distance values are
displayed in parenthesis following the molecule name in the Phylogenetic Tree pane..

Phylogenetic Tree Option

Description

Clustering: NJ

The Neighbor Joining method (NJ) of Saitou and Nei
works on a matrix of distances between all pairs of
sequence to be analyzed. These distances are related to
the degree of divergence between the sequences.

Clustering: UPGMA

Use a Kimura's correction

The Unweighted Pair Group Method with Arithmetic
Mean (UPGMA] is a simple agglomerative or hierarchical
clustering method in which, at each step, the nearest
two clusters are combined into a higher-level cluster.

" This option attempts to correct divergence for the fact

that observed distances underestimate actual
evolutionary distances. See papers on Motoo Kimura for
more information.

Ignore positions with gaps

With this option enabled, any alignment positions where
any of the sequences containing a gap will be ignored
and ambiguous parts of the alignment which are usually
concentrated around gaps will be discarded.
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Graphs pane

Perform the
alignment

Graphs pane

Similarity
(Consensus) graph

Absolute
Complexity
(Consensus) graph

Select a region

Identify a data point

When you have selected the fragments you want to align and the proper alignment settings,
click Submit.

The Graphs pane provides a graphical representation of sequence similarity and complexity
among the aligned sequences.

The graphs in this pane interact with the sequences as listed in the Alignment pane.

To generate the Similarity graph (upper graph), specific values (in a 0-1 range) are assigned to
each residue at a given alignment position in each aligned sequence, depending on whether the
residue is identical, similar, or weakly similar to the corresponding residue of the consensus
sequence. The values (1 (identical), 0.5 (similar), and 0.2 (weakly similar) for each residue at a
given position are totaled; the sum is divided by the number of the sequences in the alignment,
“normalizing” the resulting value.

The Complexity graph (lower graph) is calculated as a sum of all pairwise residue substitution
scores at a given alignment position divided by the number of pairs in the alignment. The scores
are taken from the residue substitution matrix used for alignment calculation.

Drag your cursor over a region of a graph to highlight the corresponding sequence in the
Alignment pane.

Mouse over a region of a graph or alignment pane to display data point information such as the
position, weight, symbols, identity, or positive status.

Alignment pane

Select a region

Alignment toolbar

224

The Alignment pane displays aligned sequences and the resulting consensus sequence. The
bottom row in the pane consists of the alignment consensus. Consensus residues are those that
appear most commonly at a particular site.

Note: You can save the consensus sequence as a separate sequence molecule; click on Save
Consensus in the Project Properties pane.

Drag your cursor over a sequence region in the Alignment pane to highlight that same region in
the Graphs pane.

Button Description

Delete the selected fragment
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Button

Description

Copy the selected sequence

Edit alignment

Camera

Print

Alignment setup

Vector NTI™ Express Designer Software User Guide

225



Align Multiple Sequences
Alignment pane

226 Vector NTI™ Express Designer Software User Guide



3D Molecule Viewer

The 3D Molecule Viewer is a tool for visualizing protein structures in three dimensions. It can
open Protein Data Bank (PDB) files with the file extension *.pdb.

The 3D Molecule Viewer uses JMol, an open-source Java viewer for chemical structures in 3D
that has been integrated into Vector NTI" Express Designer. For more information about JMol,
visit www.jmol.org.

Download 3D Structure Files

You can search for PDB files (with the *.pdb file extension) in public databases using the
Entrez query tool in Vector NTI™ Express Designer. Click on the Public Database Search
button on the main toolbar, and for the database type, enter “structure.”

Save downloaded *.pdb files in an appropriate file location and access them using the tool as
described below.

Open a molecule in 3D Molecule Viewer

1. To open a PDB molecule in the 3D Molecule Viewer, click on the 3-D Molecule Viewer
tool on the main toolbar, or select it from the Discover menu.

[Oveaaw as()n coowo &=

2. In the Open dialog, select a *.pdb file to open it.
To open a different molecule, select File » Open » 3D Molecule.

Note: The PDB file you open will remain open in Vector NTI"" Express Designer until you
close the window, and you can navigate back to it by clicking the 3-D Molecule Viewer button.
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1 2 3D Molecule Viewer
Elements of the 3D Molecule Viewer window

Elements of the 3D Molecule Viewer window

The 3D Molecule Viewer window consists of three panes:
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* Graphics pane—displays the three-dimensional structure of the molecule.
* Properties pane—Ilists any properties associated with the molecule
*  OQOutline pane—Ilists the amino acids in the sequence
The right-click menu in the Molecule Display pane contains information about the molecule

and tools for manipulating the graphic representation of the structure, exporting molecule data
in various formats, and optimizing the display.

Magnify and rotate the molecule

In the Molecule Display pane:

* To zoom in or out, rotate the wheel on your mouse or select Zoom from the right-click
menu.

* To rotate the molecule in three-dimensional space, drag your cursor in the pane.

» To reposition the molecule within the pane without rotation, hold the Ctrl + Alt keys and
drag your cursor in the pane.

» To begin spinning the molecule in three-dimensional space, select Spin » On from the
right-click menu, and adjust the settings on the Spin menu. Select Spin » Off to stop
spinning.
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Highlight an amino acid or a chain

Highlight an amino acid or a chain

* Click within the structure in the Molecule Display window to highlight a particular amino
acid. Click on it again to un-highlight it.

* Click on an amino acid in the Outline pane to highlight it in the Molecule Display pane.

* Click on a chain in the Outline pane to highlight that entire amino acid chain in the
structure.

Additional menu operations

The right-click menu in the Molecule Display window contains all the J]Mol commands for
viewing and manipulating the structure. For additional information about these commands, visit
www.jmol.org.
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1 2 3D Molecule Viewer
Additional menu operations

230 Vector NTI™ Express Designer Software User Guide



Sim4

Launch Sim4
analysis tool

Sim4 and Spidey Analysis

Sim4 and Spidey are tools for aligning expressed nucleic acid sequences (e.g., mRNA) with
genomic sequences in online databases. Vector NTI™ Express Designer includes these tools for
analyzing molecules stored in the database.

Sim4 is a similarity-based tool for aligning an expressed nucleic acid sequences (EST, cDNA,
mRNA) with a genomic sequence. For more information about Sim4, see http://

www.hgmp.mrc.ac.uk/.
Sim4 employs the following multi-stage BLAST-based technique:
» Sim4 detects all possible exact matches of W-mers between the two sequences and
extends them to maximal scoring gap-free segments (exon-cores).

» Exon-cores are extended into the adjacent, as-yet-unmatched fragments using greedy
alignment algorithms. Heuristics are used to favor configurations that conform to the
splice-site recognition signals. If necessary, the process is repeated with less stringent
parameters on the unmatched fragments.

Sim4 functions similarly to BLAST, but performs a more thorough mRNA alignment search.

To open the Sim4 Analysis tool:

+ In Database Explorer, right-click on a molecule or use Ctrl+click or Shift+click to select
multiple molecules and right click. In the right-click menu, select Analysis
Monitor » Sim4 Analysis.

* With a molecule open in Molecule Editor, click on the Sim4 Analysis button in the
Molecule Editor toolbar.

The Analysis Monitor will open, with the Sim4 Analysis settings selected and the selected
molecule(s) listed.
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Simé4 and Spidey Analysis
Sim4

The analysis window has an Analysis Jobs pane containing the analysis settings, and an
Analysis List pane listing the molecules loaded in the tool.

Analysis]obs Mame Analysis Type Descri ption Status Modified Date
L sim2anzlysiz of BRAF simé Aligning a transcribed and spliced DHAseq... 7 Hew Submit Sun Dec 1111:17:17 PST20...
Si|‘|]4 Alsim4Ana\vs\5DfEDK2 Sim4 Aligning s transcribed and zpliced DNA zeq. *" New Submit Sun Dec 1111:17:18 PST 20.
F¥ncans ot s sms | ein e sraoicea e NewSopmi | Sumoee 1 11:000¢ 720 |
Mzme | CREB1

from ta

strand(s) () Direct (0 Complementary (%) Both

w Simd Parameters
Word siza(1..15] 12
Limit of Score Drop-off 12
Search for Small Brans @nNe Oes
Diagonal Distance 10
[¥] Allow ambiguity characters
[]weight factor for linking HSPs:
 HSPscore threshold
[DFirststage

[]second staze

Analysis Jobs
Analysis Jobs Molecule and strand to analyze
settings In the Analysis Jobs pane:
» Select the molecule from the Name drop-down list.
* Specify the Strand to analyze. The Both option searches both strands and reports the best
result.
Simé4 parameters
*  Word Size — The number of DNA bases in a size unit. The larger the word size, the faster
and less sensitive Sim4 becomes.
* Limit of Score Drop-off — The trigger for stopping ungapped extension.
* Search for Small Exons — If Yes is selected, an additional search for small exons is
performed.
» Diagonal Distance — The upper boundary of diagonal distance within consecutive HSPs
in an exon.
* Allow Ambiguity Characters — If checked, allows the following ambiguity characters:
ABCDGHKMNRSTVWXY. If unchecked, only the following characters are allowed:
ACGTNX.
*  Weight Factor for Linking HSPs — The multiplication factor used when calculating the
score of a chain of HSPs.
* Defaults — Resets Sim4 parameters to the original default values.
HSP Score Threshold
» First Stage — The threshold for HSPs for the first stage of comparison. If no value is
specified, the default value is used.
» Second Stage — The threshold for HSPs when aligning the extended-and-unmatched
portions. If no value is specified, the default value is used.
Submit the job When you have made your selections, click on Submit.
232
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results

Spidey

Launch Spidey
analysis tool

Spidey

When analysis is complete, a Completed check box will appear next to the job name in the
Analysis Monitor.

The Analysis Monitor contains a list of all the analyses performed by Vector NTI™ Express
Designer, including Sim4 analyses. Click on Analysis Monitor on the main toolbar to open it.

§Dﬁfﬁ&iéﬁf§%§0@@>1::c:>§»3£+::=

To view the analysis for a particular molecule, you can:

*  Open the molecule in the Molecule Editor, and click on Analysis Results.
* Open the Analysis Monitor and double-click on the particular analysis.

Spidey is an mRNA-to-genomic alignment program. It takes as input a single genomic
sequence and a set of mRNA accessions or FASTA sequences. All processing is done one
mRNA sequence at a time. The first step for each mRNA sequence is a high-stringency BLAST
against the genomic sequence. The BLAST alignments are sorted by score and then assigned
into windows by a recursive function. For more information about Spidey, see

www.ncbi.nlm.nih.gov/spidey/.

After the genomic windows are constructed, the initial BLAST alignments are freed and
another BLAST search is performed, this time with the entire mRNA against the genomic
region defined by the window, and at a lower stringency than the initial search. Spidey then uses
a greedy algorithm to generate a high-scoring, non-overlapping subset of the alignments from
the second BLAST search. This consistent set is analyzed carefully to make sure that the entire
mRNA sequence is covered by the alignments.

Once the mRNA is completely covered by the set of alignments, the boundaries of the
alignments are adjusted so that the alignments abut each other precisely and so that they are
adjacent to good splice donor and acceptor sites. To position the exon boundaries, the adjacent
exon alignment overlap region plus a few base pairs on each side is examined for splice donor
sites, using functions that have different splice matrices depending on the organism chosen. The
top few splice donor sites (by score) are then evaluated as to how much they affect the original
alignment boundaries. The site that affects the boundaries the least is chosen, and is evaluated
as to the presence of an acceptor site. The alignments are truncated or extended as necessary so
that they terminate at the splice donor site and so that they do not overlap.

For details on Spidey analysis, see http://www.ncbi.nlm.nih.gov/IEB/Research/Ostell/Spidey/
index.html.

To open the Spidey Analysis tool:

» In Database Explorer, right-click on a molecule or use Ctrl+click or Shift+click to select
multiple molecules and right click. In the right-click menu, select Analysis
Monitor » Spidey Analysis.

»  With a molecule open in Molecule Editor, click on the Spidey Analysis button in the
Molecule Editor toolbar.

The Spidey Analysis tool will open with the selected molecule(s) listed.
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Simé4 and Spidey Analysis
Spidey

The analysis window has an Analysis Jobs pane containing the analysis settings, and an
Analysis List pane listing the molecules loaded in the tool.

Anabysis Jobs

Spidey

ST

Analysis Jobs Molecule and organism to analyze

settings In the Analysis Jobs pane:

* Select the molecule from the Name drop-down list.

* Specify the Organism to analyze for your genomic sequence.

Spidey Parameters *  Minimum mRNA Genomic Identity — Percent identity cutoff for gene models.

*  Minimum Length of mRNA Covered —- mRNA length coverage cutoff in percent for
gene models.

* Limit Number of Gene Models to — Sets the maximum number of gene models Spidey
analysis returns.

¢ E-value

— 15t Pass — The E-value cutoff for the initial high-stringency alignment. The higher
the value, the less stringent and faster the run.

— 2nd Pags — The E-value cutoff for the low-stringency BLAST search within a
genomic window, based on the high-stringency result.

— 3rd Pass — The E-value cutoff for a very low-stringency BLAST search to find hits
for mRNA gaps.

+ Divergent Sequences — If checked, search parameters are adjusted to tolerate mismatches
and gaps for inter-species alignment.

» Use Large Intron Sizes — If checked, much larger maximal intron sizes are allowed.
Checking this option increases computation time significantly.

* Defaults — Sets Spidey parameters to original default values.

Submit the job When you have made your selections, click on Submit.
When analysis is complete, a Completed check box will appear next to the job name in the
Analysis List.
View analysis The Analysis Monitor contains a list of all the analyses performed by Vector NTI™™ Express
results Designer, including Spidey analyses. Click on Analysis Monitor on the main toolbar to open it.

é\@\ﬁfﬁ&*é“@;f&%0@@1::6::»5% o

To view the analysis for a particular molecule, you can:
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*  Open the molecule in the Molecule Editor, and click on Analysis Results.
* Open the Analysis Monitor and double-click on the particular analysis.
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Launch
Clone2Seq™

Clone2Seq™
window

Select molecules

Clone2Seq-

Clone2Seq™ simplifies the two fragment restriction and ligation cloning process. Using
Clone2Seq™, you will be able to clone a single DNA or RNA insert into a vector without
having to go through multiple steps of the molecule construction wizard.

To launch Clone2Seq™:

.+ Click O Clone2Seq on the main toolbar.
» Select File » New » Clone2Seq Project from the main menu.

The Clone2Seq™ window consists of two molecule panes, and a left pane containing the
Fragment List and Molecule Properties lists. In the Fragment list, a red font indicates the
selected molecule on the left, adn a blue font indicates the molecule on the right.

The left-most molecule pane contains the DNA/RNA molecule that is first fragment in the
clone, and the right-hand pane contains the second fragment.

For each molecule, the restriction sites (selected by Restriction Analysis in the Molecule Editor)
will be displayed in the molecule pane, and sequence ends of linear molecules will be shown in
the View Sequence field below the pane.

Figure 3 Clone2Seq™ Window

8 Vector NI Expeess Designer - CloneZSeq
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1. Click on Open below the left-hand pane to select the first molecule.
2. Repeat this operation in the right-hand pane to select the second molecule.
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Note: Click on Clear to remove a molecule from the pane.

Note: The molecule in the left-hand pane will always be the first fragment of the clone and
the molecule in the right-hand pane will always be the second fragment of the clone. This
maintains the directionality of the resulting construct.

Molecule Notes about Clone2Seq™" assembly:

requirements +  Two linear molecules with blunt ends may be cloned. These blunt ends are created via
restriction digest of sites that generate blunt ends.

* Two linear molecules with overhangs must have matching overhangs. This can be
accomplished via restriction digestion, as described in Generating molecule fragments
below, or by modifying the fragment ends, as described in Modifying fragment ends.

» Circular molecules must be linearized on a cut site, as described in Generating Molecule
Fragments below.

Show or hide Click “ Restriction Analysis in the panel toolbar to view and select restriction sites

restriction sites in displayed in the molecule pane. Click Configure List to adjust the list of displayed sites.

molecules Changes to the selected restriction enzymes will trigger a restriction analysis and update the
reflected sites on the pane.

rﬁ Restriction Map @1

Configure Restriction Enzymes

Name Recognition String Cuts After Overhang E
Apall gtgcac 1 *tgca 4
HAoval cycgrg 1 *yegr 4
BarmHI ggatcc 1 *gatc 4
Clal atcgat 2 *cg 2
EcoRI gaattc 1 *aatt 4
HindIl aagctt 1 *agct 4
MNeol ccatgg 1 *catg 4
Pstl ctgcag 5 tgca® 4
Smal cccggg 3 ~ E
Xmal cccggg 1 *cegg 4
“ 1 ¢

‘ Configure List ’

Permitted Terminus Types

#]5 #3 Blunt

Occurrence (# of sites)

@ All () Single ) Double ) =2 () Exact:

Ignore RENs having (# of sites)
) Less Than: More Than:

Ignore REMs cutting outside region  Ignore RENs cutting inside region

From: To: From: To:

0K ] ’ Cancel
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-
ﬁ Select Restriction Enzymes

Filter

Subset Selection

] Enzymes (MAIN)

End: Enzyme Type: Suppliers: |[All

Available Enzymes

Selected Enzymes

[7] Select / Deselect All
Name Recogniti
[ Aad cacctge
[ Aatd gacgtc
[7] Acc651  ggtacc
[ Acd gtmkac
[[] Acell cagcte
[ Acil ccge
[ Aclt aacgtt
] Acul ctgaag
[ Afel agcgct
4 | i |

on String

Cuts After = Name
11 L Apall
5 Boval
1 BarmHI
2 Clal
13 EcoRI
1 HindIl
2 Mol
22 .
3 il Srnal
v [

I

Recognition String Cuts After

gtgcac
cycgrg
ggatcc
atcgat
gaattc
aagctt
ccatgg
ctgcag
cccggg
J

| »

m

T R R N e e

0K ] ’ Cancel

Generate molecule To generate a molecule fragment from a linear or circular molecule in CloneZSeqTM:

fragments 1.

Click on a restriction site in the desired molecule to generate a single cut site (in the case

of circular molecules), or shift-click on two restriction sites to select the region between
them (the region will appear selected in the window, as shown below).

Xmal
Small
Xmal (155
5 (157) Au

Avalfis5) Nce

EcoRI (2)

Aval

Smal
Xmal
Aval

1777)
1775, Ncol (2215)
1775) Neol (2173)

Xmal (1231)
Smal (1233)
(287) Aval [1231)
(280) ADRALA
Aval (522) ADRALA ADRALA
0l (440) Aval (945) ADRALA
1) ) ADRALA AD A ADRALA
=) ADRA1A Sounce ADRALA
| |

W

~

S L

ADRA1A
2306bp

Note: When selecting restriction enzymes that generate overhangs, be sure to select enzymes
in both molecules that will generate complementary overhangs. Alternatively, you can modify
the fragment ends as described below.
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Clone2Seq™

2. Click on Cut & Add below the molecule pane.
The fragment will be added to the Fragment List.

Note: Fragments in the list are named for the molecule, as well as the region that was cut. For
example, ADRATA 1 608 is a fragment of the ADRA1A molecule taken from the 1-608 bp

region.

3. To select the fragment for cloning, right-click on the fragment in the list and select Assign
To Left Pane or Assign To Right Pane.

4 Fragment List

> (L]
>[4
>[4

ADRALIA
ADRATA 1775 2307

ADR| <= Assign To Left Pane
ADR| = Assign To Right Pane
pcDl

Delete Fragment
peDl
(&l

Save Fragment

4. The fragment will be added to the appropriate pane, and the cut ends will be displayed

below that pane.

Awal (387)

5-
3

ADRALA 387 1775 Aval (1775)
gag ¥ —

CCGG 1385 bp -3

------------------------------ GGCC -5

5. Repeat this procedure for the second molecule.

Edit the Frag ment Right-click on a fragment in the Fragment List and select Delete Fragment to delete it, or Save

List Fragment to save it as a molecule in the database.
Modify fragment 1. To modify the ends of a molecule or fragment, click Modify, then select the desired
ends modification for the Left and Right Terminus using the drop-down list.
8 Modify Ends S
Aval (387 ADRALA_387 1775 Aval (1775)
. o2 ¥ .

5'- CCGGE 1385 bp -3

3o GGCC 5

Left Terminus

Medification:

Neone

Klenow Fill-In
Partial Fill-In
3'-5' exon

3'-3 exon [ oK ] ’ Cancel ]

Right Terminus

The modification will be previewed in the dialog.

2. Click OK to make the modification.
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Assemble the
molecule
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Project Details / Fragment List

4 General Description
MName: Mew Clone25eq Project_2015-11-20-14-22-01
Created By: Susan Tate
Created Date: Fri Nov 20 14:22:01 P5T 2015
Description: New Clone25eq Project

[ 2 Edit ] [ ] Save ] [ % Close

4 Fragment List

ADRALIA

> ADRALIA 1775 2307

> ADRAIA 1 387

» [] ADRALA 1 387 155387

» [] ADRALIA 1 38712

» [] ADRALA 1 387 2 155

> ADRALA 387 1775
pcDMASL(+)/myc-His\A
pcDMAS1/His\A

ﬁ
G' o5 Assemble Tb ¥ Delete
u

%] Project Details / Fragment List

|=| Fragment 1 Properties

|=| Fragment 2 Properties

2. In the Construct Molecule dialog box, enter a name for the assembly and select the
desired Molecule Form, Type, and Start Position.

-
ﬁ Construct Molecule

S

Mame: BRAF_BPV1

Molecule Form Molecule Type
@ Circular () Linear @ DNA

Start Position
(7) Recipient's Start

@ Position 1 of Fragment# 1

Cancel

1. When you have made your selections, click Assemble. This button will not be available
unless both molecules are linear.
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3. Click OK. The assembled molecule displays in a preview window.

rﬁ Clone2Seq Project @1
® &% UE

BRAF_BPV1
1911bp

EE

[ sawe |[ o |

Note: Use the tools in the window to magnify the molecule or display it as linear or circular.

4. Click Save to save the molecule to the database.

Multipl_e fragment To clone multiple fragments using CloneZSeqTM, first create a clone from two fragments as
cloning described above, then generate a clone from the cloned molecule and the next fragment. Repeat

as necessary.
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For more
information

Gateway® Cloning
Workflow

Gateway® Cloning

Gateway® Cloning Technology is a rapid and highly efficient method for the cloning and
subcloning of DNA segments. This system is based on the well-characterized bacteriophage
lambda-based site-specific recombination system (atfL x atfR <> atfB x attP).

Gateway® Cloning is a 2-step process. In the first step a sequence of interest containing a#/B
sites is recombined with a donor vector containing a#P sites into an entry clone, creating atfL
sites in the process. The second step recombines the a#fL-containing entry clone with a
destination vector containing attR sites, generating an expression clone that can be propagated
and expressed in a range of host cells for a given experiment.

For detailed information on Gateway® Cloning, see the Gateway® Technology User Guide or
the Gateway® Technology with Clonase™ II User Guide, available for download from
www.thermofisher.com/manuals.

Workflow diagram

BP Reaction
attB attB attP attP attL attL attR attR
gene
(e 1 + S—
attB-flanked donor —_— entry
PCR product or vector clone
expression clone
LR Reaction
attL attL attR attR attB attB attP attP
+ LR Clonase™
Entry destination _— expression By-product

clone vector clone

Step 1. Create an entry clone

The standard method for creating an entry clone in the Vector NTI™ Express Designer
Gateway® Cloning Tool involves amplifying a sequence or molecule of interest with at/B-
containing primers designed by the software, then performing BP recombination with a donor
(pDONR) vector to generate an entry clone.

PCR product (flanked by attB sites) + pDONR vector (with attP) <> Entry Clone
(with attL)

You can also create an entry clone by the following methods:

+  Select an existing atfB-containing DNA molecule— From within the Gateway® Cloning
Tool, you can select an already existing a#/B-containing DNA molecule in the database,
such as a Gateway® Expression Clone or a pCMVSPORTS library, for recombination with
a donor vector, to create the entry clone
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15 Gateway® Cloning
Gateway® Cloning Tool

Construct an entry clone by alternative molecule construction methods— You can
construct your own entry clone using other Vector NTI™ Express Designer molecule
construction methods, ensuring that the clone contains the required atfL1 and atfL.2 sites
(labeled as features as described in “Create Expression Clones by LR”), then save the
molecule in the database and select it directly in the Gateway® Cloning tool.

Step 2. Create an expression clone

Using the Gateway® Cloning Tool, entry clones created from any of the above methods are
recombined with destination (pDEST) vectors in an LR recombination reaction to generate

expression clones, which can drive expression of the sequence of interest when transformed
into host cells.

Gateway® Cloning Tool

Open the Gateway®
Cloning Tool

Gateway® Project
pane

244

The Gateway® Cloning Tool contains settings and functions for assembling a Gateway®
construct using the workflow described above, and for creating and managing Gateway®
Cloning projects.

There are several ways to open the tool:

Click on the Gateway Cloning button on the main toolbar.
Select File > New > Gateway Cloning Project from the main menu. -

With a molecule open in Molecule Editor, right-click in the Graphics or
Sequence pane and select Launch Gateway.

Load an existing Gateway® Cloning project as described in “Create, save, and load
projects” on page 246.

The tool window is composed of the following panes:

This pane displays the name of the current project, and includes controls for editing, saving, and
closing projects. It also lists any generated molecules for the current project.
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Gateway® Cloning Tool

Click on the Gateway Project button to display this pane.

@ Gateway Project

{=] General Info
Mew Gatewsay Cloning Project

PCR Analysis : The PCR Product of GNG5_attB3_attB4

< Il |

Task List pane This pane displays the list of tasks in the selected project. Click on the Task button to display
this list.

@ Task

’ Amplify Fragments to use in BP Reaction
’ Recombine Entry Clones by BP

’ Preview Entry Clones

’ Create Exprezsion Clonesz by LR

------ ’ Preview Expreszsion Clones

@ Gateway Project

]

»

As you navigate through the Gateway® Cloning workflow, the Task List displays the current
task, and allows you to move between tasks by clicking on a different task.
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15 Gateway® Cloning
Create, save, and load projects

Current Task pane This pane displays the commands and settings for the currently selected task in the project. As
you navigate through the Task List workflow, the functions in this pane will change.

Fragments to Amplify

Name Accession From To SenszeSite Antizense Site Description
pCRB/GW-TOPO pCRB/GW-TOPO 211 270
GNGS GNGS 1 €38 Homo sapiens guanine nucleotide bin...

Add ] [ Remove
PCR Amplification Settings
Analysis Conditions
Tm([E] WEC Length
>= | 40.0 >= | 35.0 >= | 109 @ DNA O RNA
==| 5.0 <= | 80.0 == | 114
Add GGGG-attBx 5' extensions
of Sense Primer: of Antizense Primer:
sttB3[ACAACTTTGTATAATAAAGTTGLT) | | sttBA[ACAACTITGTATAGAAAAGTTGEGTG) w
Add to oligo list
[[] Add genersted primers to oligo list
Advanced ] [ Amplify

Create, save, and load projects

The tools for saving, editing, and closing projects are located in the Gateway® Project pane:

@ Gateway Project

=] General Info
CDK2 Gateway Cloning project

+ To save a new Gateway® Cloning project, click on Edit Project in the Gateway® Project
pane. In the dialog, enter a name and any description for the project.

» To save changes to a project, click on the Save Project button.

» To close a project, click on the Close Project button. If there are unsaved changes, you
will be prompted to save the project before closing.
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Gateway® Cloning workflow

* To load an existing project, in Database Explorer, go to the Projects list, double-click on
the Projects folder, select the Cloning Projects subfolder from the Local Database, and
double-click on the Gateway® Cloning project in the list to open it.

Description Author Modified Claning Technology

Eg] Projects [ETE

CDK2 Gateway Cloning project 20111208 12:15:40 Gateway_attB1_attB2
=£) Local Database

] Aliznmant Projects

£ ContigAssembly Projects

£ Cloning Projects

®- E1 Remote Database

(L] patabase
B proects
(&) Results

General Description:

Gateway® Cloning workflow

Amplify fragments
to Use in BP
reaction

The Task List displays the default Gateway® Cloning workflow:
* Amplify Fragments to Use in BP Reaction
* Recombine Entry Clones by BP
* Preview Entry Clones
* Create Expression Clones by LR

* Preview Expression Clones

This section describes each task in the workflow.
The Amplify Fragments to Use in BP Reaction task is the default task displayed when you

first open the Gateway® Cloning Tool.

The first step in this task to select the fragment(s) you want to amplify by PCR for use in a BP
cloning reaction. These fragments will be listed in the Fragments to Amplify list.

Fragments to Amplify

Name Accession From To Sense Site Antisense Site Description
GNGS GNGS 1 698 Homao sapiens guanine nuclesotide bin
¥CRO1OC ¥CRO1OC 1 852 &.cerevisiae chromosome IIl complete...

Add ] [ Remove

Load molecules or fragments in the Fragments to Amplify list

*  With a molecule open in Molecule Editor, right-click in the Graphics or Sequence pane
and select Launch Gateway to load the entire sequence in the list.

» With a molecule open in Molecule Editor, select a portion of the sequence in the Graphics

or Sequence pane, right-click, and select Launch Gateway to load only that part of the
sequence in the list.
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Gateway® Cloning workflow

+  With the Gateway® Cloning window open, make sure the Amplify Fragments to Use in
BP Reaction task is selected and click on the Add button under Fragments to Amplify to
select a complete molecule from the database.

To change the regions to amplify in the selected molecules, type a new range in the From and
To fields in the Fragments to Amplify subpane.
PCR Amplification settings

With the fragment(s) loaded, select the desired amplification settings under PCR
Amplification Settings. The standard options are described below.

PCR Amplification Setting Description

Tm(C]) Enter limits in degrees Celsius for primer
melting temperature (T,;,) (temperature at
which 50% of primer is a duplex) and the
difference between T, for sense and
antisense primers.

%GC Enter limits in degrees Celsius for primer
melting temperature (T,,) (temperature at
which 50% of primer is a duplex) and the
difference between T, for sense and
antisense primers.

Primer Length Defaults to 20-25, recommended for
Gateway® Primers

DNA/RNA button Select the type of nucleotide sequence.

Add GGGG-attBx 5" Extensions The default attB extensions are for single

fragment cloning: attB1 for the sense primer
and attB2 for the antisense primer. Select
from the drop-down list to replace the
defaults with other attB sequences for
creating Entry Clones for MultiSite Gateway®
Cloning projects.

Add generated primers to oligo list Select this check box to add the primers you
generate to the oligo list

Note: For additional amplification settings, click on Advanced. The advanced amplification
settings are identical for all PCR primers, and are described in “Amplify Selection settings” on
page 179 and “Shared Advanced settings” on page 186.
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Recombine Entry
Clones by BP

Amplify

Gateway® Cloning workflow

When you have made your selections, click on the Amplify button. The next task pane will be
displayed, and the generated PCR product(s) will appear listed in the BP Inserts subpane, and
also listed in the Gateway® Project pane.

@ Gateway Project

=] General Info
CDK2 Gateway Cloning project

[=B The PCR Product of ADRA1A_1_2306_attB1_attB2
=) FindPCRPrimers
=) Product of Length 2367
=) Senze Primer
Start:1
GC:42.86
Length: 48

Tm:63.24C
dG:-89.31 keal/mel
dH:-387.2 keal/meal
dS:-993.5 cal/maol
Antizenze Primer
Frimer Pair Data
| >

|~

Sequence: GEGGACAAGTTTGTACA:

In the Recombine Entry Clones by BP task pane, you can modify the list of fragments with
atfB sites and select a donor (pDONR) vector or vectors with which to create entry clones.

@ Task

BP Inserts.
P el Fragmants to uss n 2P Resction Name Accession Type Division Sense Site Antisense Site Description
P Recombine Entry Clones by BP Tha PCR Product of GN... The PCA ProductofG...  Entry Cloning FRI =Bl attB2 Homo sapiens zuznine nucle
P> Freview Entry Clones The PCR Product of BR... The PCA ProductofB...  Entry Cloning FRI a8l attB2 Homao sapiens v-raf murine sz
P creste Bxpression Clones by LR
P Preview Brpression Clones
Add Clear All Remave
pDONR Vectar
Name Accession Type Division SenseSite Antisense Site Description
pDONR221 pDONR221 Entry Cloning =uPl P2
Ea Gateway Project l Clear All I Remove

Create Entry Clone

BP Inserts

The fragments you amplified with a#/B sites are listed in the BP Inserts list at the top of the

pane.

* To add a previously amplified fragment with a#B sites, or a fragment designed with a#/B
sites by another means (e.g., restriction-ligation), click on the Add button and select the
molecule from the database.

* To remove a molecule from list, select it and click on Remove.

» To clear the entire list, click on Clear All.
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Gateway® Cloning

Gateway® Cloning workflow

pDONR Vector

The pDONR vector is a type of Gateway® Cloning vector that contains a#fP sites, which are
recombined with the fragments containing at¢B sites to create entry clones.

attB attB attP attP attL attL attR attR
+ -CCdB BP Clonase™ Il -m + m -cch El
attB-flanked PCR donor —_— entry by-product

product or attB

b clone
expression clone

vector

A variety of pDONR vectors are sold by Thermo Fisher Scientific, and in silico sequences for
these are installed as part of the default Vector NTI™ Express Designer installation.

IMPORTANT! To be recognized as a pDONR vector in Vector NTI™ Express Designer, a
molecule must contain the correct atfP1 and attP2 sequences, and these sites must be labeled as
features in the molecule with the feature names attP1 and attP2. See Chapter 2, “Molecule
Editor” on page 47 for information on identifying and naming features.

To select a pDONR vector:
* Click on the Add button and select the pPDONR vector from the database.

« To remove a vector from list, select it and click on Remove.

* To clear the entire list, click on Clear All.

Create the Entry Clone

When you have made your selections, click on Create Entry Clone. The Preview Entry
Clones task pane will open.
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Preview Entry
Clones

Create Expression
Clones by LR

Gateway® Cloning workflow

The Preview Entry Clones task pane lists all the entry clones created from the a#/B-containing
fragment(s) and the donor vector(s) you selected, and includes a preview window for viewing

an entry clone.

@ Task Entry Clones

B> Preview Entry Clones Entry Clone/pDONR22... EntryClone/pDONR2...  Entry Cloning attll attL2
P Creste Expression Clones by LR

B> amplity Fragments to sz in BF Rey Name Accession Type Division Sense Sitz Antisense Site Descriptic

P Recombine Entry Clones by 8F Entry Clone/pDONR22... | Entry Clone/pDONRZ... | Entry Cloning I R - T

P> Preview Bxpression Clones

GNAQ

T-Gene  GNAQ
%Suurce \\ |

GNAQ__GHAQ
GNAQR\

< | > 4247bp

@ Gateway Project

Task GNAQ

|~

::ct & |2 _
GNAQ N )
GNAQ\ GNAQ\\\\_\

Eni -y Clone/[ DDNRI 21/ he PCR Product of G- Q_1_1700

(5

|€

Entry clones contain a#fL.1 and a#fL2 sites, and are used to generate expression clones via an LR

reaction.

In the Entry Clones list:

» Select a clone and click on Save to Database to save it as a DNA molecule in the
database.

» Click on a clone to display it in the Preview window.

In the Preview window:

* Using the magnifying tools to zoom in and out of the molecule.

XK

» Display the molecule as linear or circular by clicking on the appropriate button.

i | |

After creating entry clones, click on Create Expression Clones by LR in the Task List to
proceed to the next task in the workflow.

Any entry clones that you generated from the previous tasks in the workflow will be listed in

this window.
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Gateway® Cloning workflow

In the Create Expression Clones by LR task pane, you can modify the list of entry clones and
select a destination (pDEST) vector or vectors with which to create expression clones.

E::] Task Entry Clones

B> amplify Fragments to use in BF Reaction (=2 fEET=ETT Type
Entry Clone/pDONR22... EntryClone/pDONR2...  Expression Cloni atel1 sttl2

Entry Clone/pDONR22... Entry Clone/pDONR2...  Expression Cloni a1 =tel2

Division Sense Site Antisense Site Descr

Destination Vector
Name Accession Type Division Sense Site Antisense Site Descr
pDEST24 pDEST24 Expression Cloni. SYN artR1 attR2
EE] Gateway Project Add Clear All

[E) Task

Entry Clones

Any entry clones that you generated from the previous tasks in the workflow will be listed in
the Entry Clones list.

» To select new or additional entry clones in the database, click on the Add button and
select from the dialog box.

IMPORTANT! To be recognized as an entry clone in Vector NTI™" Express Designer, a
molecule must contain the correct atfL1 and atfL.2 sequences, and these sites must be labeled as
features in the molecule with the feature names attLL1 and attL2. See Chapter 2, “Molecule
Editor” on page 47 for information on identifying and naming features.

* To remove an entry clone from the list, select it and click on the Remove button.
» To clear the list, click on Clear All.

pDEST Vector

The pDEST vector is a type of Gateway® Cloning vector that contains a#R sites, which are
recombined with the fragments containing attL sites to create expression clones.

attL attL attR attR attB attB attP attP
gene ccdB
Lo ] LR Clomase™ 1 [eere ] + [ ]
entry destination — expression by-product
clone vector clone

A variety of pDEST vectors are sold by Thermo Fisher Scientific, and in silico sequences for
these are installed as part of the default Vector NTI™ Express Designer installation.

IMPORTANT! To be recognized as a pDEST vector in Vector NTI™ Express Designer, a
molecule must contain the correct a#/R1 and a#fR2 sequences, and these sites must be labeled as
features in the molecule with the feature names attR1 and attR2. See Chapter 2, “Molecule
Editor” on page 47 for information on identifying and naming features.

To select a pDEST vector:

* Click on the Add button and select the pDEST vector from the database.
» To remove a vector from list, select it and click on Remove.
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Preview
Expression Clones

Gateway® Cloning workflow

* To clear the entire list, click on Clear All.

Create the Expression Clone

When you have made your selections, click on Create Expression Clone. The Preview

Expression Clones task pane will open.

The Preview Expression Clones task pane lists all the expression clones created from the entry
clones and the destination vector(s) you selected, and includes a preview window for viewing

an expression clone.

@ Task Expression Clones

B> amplify Frazments to use in

Express Clone/pDEST2. . Express Clone/pDEST...  ExpressionCloni..  SYN

i&pressclnne_"‘pDESTZ. Espress Clone/pDEST...  ExpressionCloni.. SN

Nama Accession Type. Divisi

Save to Database

Preview

Express Clone/pLUEST.

Promoter Prokaryotic  Primer

@ Gateway Project

) Task

CNR221/The PCE

7009bp s

N

Eroduct of

In the Expression Clones list:

» Select a clone and click on Save to Database to save it as a DNA molecule in the

database.

» Click on a clone to display it in the Preview window.

In the Preview window:

» Using the magnifying tools to zoom in and out of the molecule.

® &K

» Display the molecule as linear or circular by clicking on the appropriate button.

lllc

(53
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Gateway® Cloning workflow
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TOPO® Cloning in
Vector NTI™
Express

TOPO® Cloning

TOPO® Technology is a fast, efficient way to clone. The key to TOPO® Cloning is the enzyme
DNA topoisomerase I, whose biological role is to cleave and rejoin DNA during replication. To
harness this activity, vectors are linearized and each end is conjugated with topoisomerase on
the 3' phosphate. This enables fast ligation of DNA sequences with compatible ends. After 5
minutes at room temperature, the enzyme is released, the ligation is complete and the
recombinant molecule is ready for transformation into E. coli.

Many Thermo Fisher Scientific expression vectors are adapted for one-step TOPO® Cloning of
PCR products in both directional and non-directional formats. Other vectors contain a#¢
recombination sequences exterior to the TOPO® cloning sites so that cloned inserts are ready
for entry into the TOPO® system.

TOPO® vectors can be grouped into three categories, based on the nature of their ends:

*  Zero-Blunt vectors have two blunt ends and can accept blunt-ended DNA fragments,
including amplicons produced by a proofreading polymerase. Inserts are cloned in both
orientations.

* T-A vectors have two ends with 3’-T overhangs. They can accept products of PCR
amplification with a Tag polymerase, whose terminal transferase activity adds 3°-A
overhangs to the amplicon. Inserts are cloned in both orientations.

* In directional vectors one terminal is blunt ended and the other has a 5’-GGTG overhang
on the bottom strand. PCR products are generated with a 5’~-CACC extension on one end
and this strand when unwound is preferentially annealed to the vector overhang. More
than 90% of the clones are in the correct orientation and the time spent in screening
colonies is thereby reduced.

The presence of topoisomerase enzyme also helps protect vector ends from degradation,
particularly from contaminating nucleases that may be present in ligase preparations. Moreover,
the avoidance of restriction site cutback for cloning PCR products means that internal cleavage
sites are not a problem.

Any linear, double-stranded DNA sequence of interest may be cloned into a TOPO® vector
using Vector NTI™ Express Designer. In addition, linear sequences with 3’-A overhangs, the
products of PCR amplification with a 7ag DNA polymerase, may be cloned into TOPO®-TA
vectors. Such Tag-generated molecules can be generated in silico using the TOPO® Cloning
tool.

TOPO® Cloning Tool

Open the TOPO®
Cloning Tool

The TOPO® Cloning Tool contains settings and functions for assembling a TOPO® construct
using the workflow described above, and for creating and managing TOPO® Cloning projects.

There are several ways to open the tool:
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TOPO® Cloning Tool

* Click on the TOPO Cloning button on the main toolbar. @
T
+ Select File » New » TOPO Cloning Project from the main menu.

*  With a molecule open in Molecule Editor, right-click in the Graphics or Sequence pane
and select Launch TOPO Cloning.

+ Load an existing TOPO® Cloning project as described in “Create, save, and load projects”
on page 258.

The tool window is composed of the following panes:

TOPO® Project The TOPO® Project pane displays the name of the current project, and includes controls for
pane editing, saving, and closing projects. It also lists any generated molecules for the current
project.

Click on the TOPO Project button to display this pane.

) TOPO Project

=] General Info
TOPOCloningADRALA

{= The PCR Product of ADRALA_587_1414_T-A
=) FindPCRPrimers
=) Product of Length 830
Sense Primer

Antizenze Primer
Frimer Pair Data
Time: 10/12/2011 20:42:18

{C_] ToPO Project

@ Task
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Task List pane

Current Task pane

TOPO® Cloning Tool

The Task List pane displays the list of tasks in the selected project. Click on the Task button to

display this list.

@ Task

’ Amplify Fragments to use in TOPO Reaction
P Crest=TOPG Clones
’ Preview Clones

< |
-

) TOPO Project

| K4

Task

As you navigate through the TOPO® Cloning workflow, the Task List displays the current task,
and allows you to move between tasks by clicking on a different task.

This pane displays the commands and settings for the currently selected task in the project. As
you navigate through the Task List workflow, the functions in this pane will change.

Fragments
Name From To Length Form Description
ADRA1A 1 2306 2306 Linear Homo sapiens adrenergic, alpha-14-, 1
CREB1 1 2984 2984 Linear Homo sapiens cAMP responsive elzm..
PCR Amplification Setting
Analysis Conditions
Tmc] £
=[a00 | =[mo | | @oNa (RNA
«|es0 | «[soo |
Clening termini
) Blunt () pirectional
Add to Oligo List
[[] Add generated primers to oligo list
Advanced
Amplify
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16 TOPO® Cloning
Create, save, and load projects

Create, save, and load projects

The tools for saving, editing, and closing projects are located in the TOPO® Project pane:

) TOPO Project

=] General Info
TOPOCloningADRALA

+ To save a new TOPO® Cloning project, click on Edit Project in the TOPO® Project pane.
In the dialog, enter a name and any description for the project.

+ To save changes to a project, click on the Save Project button.

» To close a project, click on the Close Project button. If there are unsaved changes, you
will be prompted to save the project before closing.

* To load an existing project, in Database Explorer, go to the Projects list, open the Cloning
Projects folder in the Local Database, and double-click on the TOPO® Cloning project in
the list to open it.

@ Projects Name Descript... Author Madified Cloning Technology
i ADRA1A_TOPO_Project 2011-12-1009:59:33 TOPOCIoning_T-A
=+ Local Database CDK2 Gateway Cloning project 2011-12-1005:48:46 Gatewsy_sttB1_sttB2
£ Alignment Frojects New Parts Assembler Project 2011-12-1101:37:1% BioBrick

[l Contig Assembly Projects
[l Cloning Projects
+ Ii] Remote Database

[='_] Database
Ea Projects
E Results

General Description

TOPO® Cloning workflow

Amplify fragments
to Use in TOPO®
reaction

258

The Task List displays the default TOPO® Cloning workflow:

+  Amplify Fragments to Use in TOPO® Reaction
+  Create TOPO® Clones

e Preview Clones

This section describes each task in the workflow.

The Amplify Fragments to Use in TOPO Reaction task is the default task displayed when
you first open the TOPO® Cloning Tool.
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The first step in this task to select the fragment(s) you want to amplify by PCR for use in a
TOPO® cloning reaction. These fragments will be listed in the Fragments list.

Fragments
Name Accession From To Length Form
ADRALA ADRALA 1 21308 21308 Linear
BRAF NM_004333 1 2510 2510 Linear

Description
Home sapiens adrenergic, alpha-14-, ...

Homa sapiens v-raf murine sarcoma vi..

Load molecules or fragments in the Fragments list

* With a molecule open in Molecule Editor, right-click in the Graphics or Sequence pane
and select Launch TOPO Cloning to load the entire sequence in the list.

*  With a molecule open in Molecule Editor, select a portion of the sequence in the Graphics
or Sequence pane, right-click, and select Launch TOPO Cloning to load only that part of
the sequence in the list.

+  With the TOPO® Cloning window open, make sure the Amplify Fragments to Use in
TOPO Reaction task is selected and click on the Add button under Fragments to select a
complete molecule from the database.

To change the regions to amplify in the selected molecules, type a new range in the From and
To fields in the Fragments to Amplify subpane.

PCR Amplification Settings

With the fragment(s) loaded, select the desired amplification settings under PCR
Amplification Settings. The standard options are described below.

Standard settings

Tm(C]) Enter limits in degrees Celsius for primer melting
temperature (T,,,) (temperature at which 50% of primer is
a duplex) and the difference between Ty, for sense and
antisense primers.

%GC Enter limits in degrees Celsius for primer melting

temperature (T,,,) (temperature at which 50% of primer is
a duplex) and the difference between T, for sense and
antisense primers.

Primer Length

Defaults to 20-25, recommended for TOPO® Primers

DNA/RNA button

Select the type of nucleotide sequence.

Add generated primers to oligo
list

Select this check box to add the primers you generate to
the oligo list

Cloning termini

In the options under Cloning termini:

* Choose Blunt to generate an amplicon with 2 blunt ends. These will be the exact
boundaries of the selection. These amplicons are best used with Zero-Blunt TOPO®

vectors.
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TOPO® Cloning workflow

* Choose T-A to generate an amplicon as would be produced by amplification with a Tag
polymerase. The primers in such a case will anneal to the exact boundaries of the
selection. However, terminal transferase activity in the enzyme will add 3’-A overhangs to
each end of the amplicon.

+ Choose directional for cloning in TOPO® directional vectors, e.g. pENTR-D/TOPO®.
The amplicon will be generated using primers, one of which includes a 5’-CACC
extension.

Advanced

For additional amplification settings, click on Advanced. The advanced amplification settings
are identical for all PCR primers, and are described in Chapter 6, Primer Design.

Amplify

When you have made your selections, click on the Amplify button. The next task pane will be
displayed, and the generated PCR product(s) will appear listed in the Inserts subpane, and also
listed in the TOPO® Project pane.

) TOPO Project

=] General Info
ADRA1A_TOPO_Project

[=B The PCR Product of ADRA1A_500_2306_T-A
=) FindPCRPrimers
=) Product of Length 1809
=) Senze Primer
Start:1
GC:38.89
Length: 18
Sequence: TAACATTTCCAAGGCCAT
Tm:45.17C
dG:-29.41 keal/mael
dH:-141.0 keal/mael
d5:-368.3 cal/mal
=) Antizenze Primer
Start: 1792
GC:50.0
Length: 18
Sequence: TAACCAATGGCTATGGEGEC
Tm:42.34C
dG:-31.12 keal/mael
dH:-145.2 keal/mal
ds:-377.0 cal/mol

| >

(4
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Create TOPO® In the Create TOPO® Clones task pane, you can modify the list of fragments and select a
Clones vector or vectors with which to create TOPO® clones.
Inserts:
Name Accession Type Division Length Form Description
The PCR Productof AD... The PCR Product of A... T-A FRI 1809 Linear Home sapiens adrenergic, alpha-14-, r...
The PCR Productof BR... The PCR ProductofB... T-A PRI 2512 Linezr Homo sapiens v-raf murine sarcoma vi...

Vectors:

Name Accession Type Division Length Form Description

Add Clzarall

Inserts

The fragments you amplified are listed in the Inserts list at the top of the pane.

* To add a previously amplified fragment or a fragment designed with the necessary
overhangs by another means, click on the Add button and select the molecule from the
database.

» To remove a molecule from list, select it and click on Remove.

* To clear the entire list, click on Clear All.

Vectors

To select a vector:

e Click on the Add button and select the vector from the database.
« To remove a vector from list, select it and click on Remove.

» To clear the entire list, click on Clear All.

Create the TOPO® Clone

When you have made your selections, click on Create TOPO® Clone. The Preview Clones
task pane will open.
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Introduction

GeneArt®
Seamless Cloning
Overview

GeneArt® High
Order Assembly
Overview

GeneArt® Cloning

Using Vector NTI™ Express Designer, you can create GeneArt® assemblies from DNA
molecules in the database. Simply select the fragments to be assembled and the software will:

* Analyze the sequences for homologies between the fragments
» Design PCR primers to create the necessary end homologies
+  Design stitching oligos for use in GeneArt® High Order assemblies

+ Display the assembled molecule with the specified primers and/or stitching oligos in a
single molecule file

For more information about GeneArt® technology, visit our web site at
www.thermofisher.com and search for “GeneArt.” Detailed technical information for each
type of GeneArt® assembly method is available in the following user guides: Genedrt®
Seamless Cloning and Assembly Kit User Guide and GeneArt® High Order Genetic Assembly
System User Guide. These are available for download from www.thermofisher.com/manuals
and are supplied with each kit.

GeneArt® Seamless Cloning Technology is a highly efficient, vector-independent system for
the simultaneous and seamless assembly of up to four DNA fragments plus a vector totaling up
to 13 kb in length (including the vector). The system allows the cloning of the DNA fragments
into virtually any linearized E. coli vector, does not require pre-existing recombination sites or
any extra DNA sequences, and eliminates the need for extensive enzymatic treatments of the
DNA such as restriction and ligation. A single proprietary enzyme mixture recognizes and
precisely assembles the DNA fragments sharing a 15-base pair (bp) end homology that you can
create by PCR amplification.

The GeneArt® High-Order Genetic Assembly System is a highly efficient, vector-independent
system for the simultaneous assembly of up to 10 DNA fragments plus a vector totaling up to
113 kb in length (including the vector). The system relies on yeast’s ability to take up and
recombine DNA fragments with high efficiency. This process, termed transformation-
associated recombination, greatly reduces in vitro handling of DNA and eliminates the need for
enzymatic treatments of DNA such as restriction and ligation while allowing precise fusions of
DNA sequences.

How GeneArt™ Assembly Works

In GeneArt® Assembly, multiple DNA fragments plus a vector can be joined using overlapping
sequence homology between fragment ends to splice the fragments together. If homology does
not already exist between fragment ends, Vector NTI™ Express Designer will automatically
design PCR primers that you can use to add homology to the fragments via PCR amplification.
Alternatively, for High Order Assembly, up to three sets of “stitching” oligos may be designed
to create splices across fragments without homology.
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17 GeneArt® Cloning
Open the GeneArt™ Assembly Tool

When the fragments and vector are assembled in Vector NTI'" Express Designer, the software
performs a homology check based on the rules for the GeneArt® Assembly method you are
using. The homology of the sequence ends will be analyzed, and in High Order Assembly the
internal sequences of the fragments will also be analyzed to ensure that any internal homologies
will not interfere with fragment splicing. Then any required PCR primers—and/or, in the case
of High Order Assembly, stitching oligos—will be designed.

The rules for homology are described in detail in the GeneArt® Seamless Cloning and Assembly
Kit User Guide and GeneArt® High Order Genetic Assembly System User Guide.

Seamless Cloning: Workflow diagram and an example of PCR primers designed to generate a
15-bp fragment end homology:

| e—
= m— ) .
Linear vector Recombine DNA fragments circAusI:lre?:r:Z?ruct
DNA fragments and linear vector
15-bp homology
I 1
5'-GTG AAT TCG,GGC TCG TTA GGA CTA...-3' ForwardPrimer
N for Fragment 2
'
9-nt : 6-nt
Reverse Primer :
for Fragment1 3'-...ATA CCC CAC TTA AGC:CCG AGC-5'
'
i
Sequences specific Sequences specific
to Fragment 1 to Fragment 2

High Order Assembly: Workflow diagram and an example of PCR primers designed to generate a
30-bp fragment end homology:

X X
-—
— X X X

X
Stitching
oligos

o —_— —

Linear vector
Transformation-associated recombination

30-nt homology

f R ! Forward Primer
5'-TCG AGC GCA TTT CGC,CGT ARA GCG AGT TTA TTA GGA CTA...-3' for Fragment 2
'

DNA fragments

Assembled construct

15-nt H 15-nt
Reverse Primer H

'
for Fragment1  3'~---GTG AAT TCG AGC TCG CGT ARA GCG,GCA TTT CGC TCA AAT-5'

T
Sequences specific : Sequences specific
to Fragment 1 il to Fragment 2

Open the GeneArt™ Assembly Tool

You can open the GeneArt® Assembly Wizard from the Molecule Editor with a molecule
loaded or from the main toolbar with no molecule selected.

Note: All molecules used in GeneArt® assembly must be linear.

From the molecule 1. With a linear DNA molecule loaded in the Molecule Editor, select the part of the sequence
editor you want to clone or make no selection to clone the whole molecule.
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GeneArt™ Assembly Wizard

Note: The selected molecule or sequence must be >100 bp.

2.

3.
From the main 1.
toolbar with no
molecule selected 2.

Right-click and select Load in GeneArt or click on the GeneArt Cloning button on the
main toolbar.

e e ge%E 00

Select the strand you want to analyze (Direct or Complementary).

The GeneArt Assembly Wizard will open with the molecule or sequence loaded.

With no molecule selected, click on the GeneArt Cloning button on the main toolbar, or
select Design » GeneArt Cloning.

The GeneArt Assembly Wizard will open with no sequence loaded.

GeneArt™ Assembly Wizard with molecule selected

& GeneArt Assem bly

GeneArt Assembly Wizard
Azzembly Farameters
Assembly: Seamless Cloning w Molecule form: @Cir:ular OLinear
Fragments
Vector Source DMNA Order | 5tart Position Fragment Length Orientation Amplify
By CDK2 v 1 2226 Forward N

Add Fragment l [REmD\rE Fragment | Total Length: 2226bps

GeneArt™ Assembly Wizard

The GeneArt® Assembly Wizard window lists the molecules and fragments to be assembled
and includes settings for assembly.

Assembly settings  The tool includes different options for Seamless Cloning or High Order Assembly.

1.

Select the appropriate Assembly option from the drop-down list.

2. Select the Molecule Form you want for the final assembly: Circular or Linear.
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GeneArt™ Assembly Wizard

Add and organize
fragments

266

The Assembly Wizard has tools for adding and removing fragments and designating their order
of assembly.

Fragment requirements

A fragment for GeneArt® Assembly can be any molecule in the database that is >100 base pairs
in length.

Add fragments

To add a fragment, click on the Add Fragment button and select a molecule from the database.

Open Molecule rz|
Database DMA/RNAS |
Name Identifier Length Form #
ADCYT 4557254 E156 linear
ADCY7 E136 lineai
Adenc2 35937 lineai
ADRALA 15451758 2306 lingai
ADRALA 2306 lingai
BaculoDirect Linear DNA 139370 lineai
BaculoDirect Linear DN.... 5770 lineai
BaculoDirect Linear DN.... 139370 circul
BaculoDirect\Linear\DNA 138370 linga
BaculoDirect\Linear\DN... 138370 circul %
< ' >
OK ] [ Cancel

The molecule will appear added to the list in the tool.

Fragments

Vector Source DNA Order | 5tart Position | Fragment Length Orientation Amplify
¥ ADRALA v 1 2308 Forward N
N CDK2 1 1 2226 Forward N

Select the vector

One fragment in each GeneArt® assembly must designated as the vector. The vector forms the
base fragment onto which other fragments are added. The vector is always the first fragment
listed in the Wizard, and is flagged with a “V” in the Order column.

To change the fragment designated as the vector, click inside the Vector column and that
fragment will be moved to the top of the list.

gctor Source DNA Order | 5tart Position | Fragment Length Orientation Amplify
Vector icon ‘ ADRALA v 1 2308 Forward N

Re-order fragments

The fragments will be assembled in the order in which they’re listed in the GeneArt® tool,
starting with the vector. The order of the fragments is reflected in the Order column, which
designates the vector with a “V” and numbers the rest of the fragments in order.
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Design PCR
primers to create
end homology

Design stitching
oligos (High Order
Assembly only)

GeneArt™ Assembly Wizard

To re-order the numbered fragments, select a fragment in the list and then click on the Up or
Down button to change its position. Note that you cannot move a fragment into the Vector
position using the buttons—select the vector as described above.

Fragments

Vector Source DNA Order | 5Start Position | Fragment Length Orientation Amplify
¥ ADRALA v 1 2308 Forward N
N BRAF 1 1 2510 Forward N

N CDK2 2 1 2226 Forward N

’ Add Fragment ] ’Remu\re Fra;ment] Total Length: 7042bps

Figure 4 Clicking on the Up button to move a selected fragment up in the list.

Fragment orientation

The orientation of each fragment in the final assembly is indicated in the Orientation column
(Forward or Reverse). You can change the orientation by clicking in this column.

Remove a fragment

To remove a fragment, click on it in the list to select it and then click on Remove Fragment.

Vector NTI™ Express Designer Software can automatically design PCR primers for adding
homology to the ends of a fragment for GeneArt® assembly. In the PCR reaction, each primer
will add bases to the amplified fragment to create the necessary homology with the adjacent
fragment.

Note: If the fragments already have the required end homology, primer design is unnecessary.

This primer design option is available for both Seamless Cloning and High Order Assembly,
though the length of the PCR primers varies between assembly methods, based on their
different end homology requirements. The primer design rules are described in detail in the
GeneArt® user guides. The PCR primer designs will be saved with the final assembled
molecule.

To design PCR primers to create the necessary homology for a fragment:
1. Click in the Amplify column for that fragment.

2. The N will change to a Y for that fragment.

=nt Length Orientation Amplify

Forward N

Reverse E A

For High Order Assembly, in addition to primer design to create end homology, up to three sets
of stitching oligos may be designed to create splices across fragments without homology. These
oligo linkers create a “bridge” across adjacent fragments to promote recombinational joining in
yeast.

Vector NTI™ Express Designer Software User Guide 267



17 GeneArt® Cloning
GeneArt™ Assembly Wizard

Note: A limit of three sets of stitching oligos may be used in a single High Order Assembly, and if
stitching oligos are used, a total of five fragments plus vector may be included in the assembly.
(This differs from a High Order Assembly without stitching oligos, which can include up to 10
fragments plus vector.)

The stitching oligo rules are described in detail in the GeneArt® High Order Genetic Assembly
System User Guide. The oligo designs will be saved with the final assembled molecule.

To select stitching oligos for a particular fragment:
1. With High Order Assembly selected, click in the Stitch column for that fragment.

2. The N will change to a Y for that fragment.

rientation Amplify = Stitch

rward N N

rward E ¥ N

[ G

rward N ¥

rward E ¥ N
Create the 1. When you have selected your desired settings in the GeneArt® Assembly Wizard, click on
assembled the Next button.
molecule 2. Specify a name for the molecule in the database, as well as names for any PCR primers

and/or stitching oligos.
3. The final assembly will be displayed in the Molecule Editor.

[ Anahrum Bevlts T Teradet dammegid _ACRA L JEAP (DR IPAL (RET)

Gerwart_Primess_A0AALL(BRAE F|

GeneArt Assembled | ADRALA_BR\|_CDK2_EPAC_GRB2)
11442k

* The source fragments will be listed in the Feature Map under Misc Feature.
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Click on a PCR Primer or Stitch Oligo in the Graphics pane to highlight that feature in the

sequence.

Source

Stitch Oligos_ADRA1Aetc(CDK2-EPAC_F)
P
TEEARAEUEA  GAALALETTAS AUCUCGLELTEAR Crii

COCTTIEICC  CElbiICATIEE  CACCLELEUC  CALGUCCIACC  TIGUGLICATA
7001 CACCGAGIIC CCGACCGCCA CCRAGRAGGCCC CEGCCCIGCIT CCCIGCIGCC CIGGCAGCCR GICCAGCTAG GCACTGGCCC  AGTIM
GTEECTCRARG  GECTGECGEET  GGICTCCEGG  GCEEGRCGRR  GEGRCGRCGG  GACCEICGET  CAGETICGEATC  CGTIGRCCGEE  TCRAL

The PCR primers and stitching oligos are listed in the Analysis Results pane, and will be

added to the Ordering list.
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GeneArt™ Assembly Wizard
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Additional
Information about
Parts and
Standards

Parts Assembler

Using Vector NTI™ Express Designer Software, you can assemble standard DNA parts that
encode basic biological functions from molecules using defined assembly standards. The
standard DNA sequences defined in Vector NTI™ Express Designer have been developed via an
open technical standards-setting process led by the BioBricks Foundation.

At its most basic level, a part is any DNA sequence with a defined biological function (e.g., a
promoter region, a sequence encoding a protein, etc.). To join two parts together, upstream and
downstream sequences containing sites for specific restriction enzymes are added to each part.
This allows for the creation of larger parts by chaining together smaller ones in any desired
order. In the process of chaining parts together, the restriction sites are removed, allowing the
further use of those restriction enzymes without breaking the new, larger assembly apart. To
facilitate this assembly process, each part itself may not contain any of these restriction sites.

Vector NTI™ Express Designer Parts Assembler is compatible with BioBrick™ part standards.
For general information about the BioBricks Foundation, visit www.biobricks.org. For
information about parts and assembly standards, including instructions and tutorials, visit http:/
/openwetware.org/wiki/The_BioBricks_Foundation:Standards/Technical/Resources.

The DNA sequences of thousands of public domain standard biological parts are available
through the Registry of Standard Biological Parts at http://partsregistry.org.

For a detailed description of the assembly standards, visit http://openwetware.org/wiki/
The_BioBricks_Foundation:Standards/Technical/Formats.

Note: BioBrick is a trademark of the BioBricks Foundation, Inc. The BioBrick trademark is
used herein merely for the purpose of fair use. The BioBricks Foundation, Inc. is not affiliated
with Thermo Fisher Scientific. The BioBricks Foundation, Inc has not authorized, sponsored or
otherwise endorsed this product or our use of the BioBrick trademark herein. Information about
BioBrick™ and the BioBricks Foundation, Inc. can be found at www.biobricks.org.

Using the Parts Assembler

Selecting Parts

To open the Parts Assembler:

e Click on the Parts Assembler button on the main toolbar. -
* Select File » New » Parts Assembler Project from the main menu. (=

The Parts Assembler window is divided into two panes—one for each part you want to
combine.

1. To select the first part that you want to assemble, click on the Open Molecule button
beneath the left pane, and select the molecule from the database. The molecule must be
compatible with a defined assembly standard, as described in the following section.
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1 8 Parts Assembler
Using the Parts Assembler

2. Select the second molecule in the right pane.

Parts Assembler Workflow
5 Generalinfo BBa_A340620 BBa_B0010
New Parts Assembler Project 999bp 80bp
# FragmentList
< 5 I3 ¥
Moleculel Molzcule2
[Ethrme:t] [Save Prmeu] [ Close
Open Molecule Open Molacule
fl The compliant assembly standard|s) for this part: The compliant assembly standard(s) for this part:
i Assembly Standard 10; Assembly Standard 12; Aszembly Standsrd 10; Assembly Standard 12;
= [ Assemble ] [ Exit

When you select a molecule, its sequence will be displayed in the pane and the assembly
standards that are compatible with that sequence will be listed at the bottom of the pane. If the
molecule does not conform to any of the standards, you will receive a warning message.

Restrictions on Any molecule in the database can be selected as a part, as long it conforms one of the assembly

Parts standards shown in the following table. To conform to an assembly standard, the molecule must
not contain the restriction enzyme digestion sites listed in the table for that standard. Some
standards also include additional rules. For more information about assembly standards, visit
http://openwetware.org/wiki/The BioBricks Foundation:Standards/Technical/Formats.

Assembly Standard Parts must not contain the following restriction sites

10 EcoR I, Not |, Xba I, Spe |, Pst I, Nhe |, Pvu Il, Xho I, Avr Il, Sap |

12 ' EcoR I, Spe |, Nhe I, Not |, Pst |

20 EcoR I, Xba I, Spe I, Sbf |

21 EcoR I, Bgl Il, BamH [, Xho |

23 EcoR I, Not I, Xba I, Spe |, Pst | (in addition, sequences must be
in frame without start or stop codons, and may not begin with
“TC”)

25 EcoR I, Not I, Xba I, NgoMI (aka NgoMIV), Agel, Spe |, Pst |

Note: If you are planning to create and share parts with other individuals and groups using
these standards, we recommend designing them so that they contain none of the restriction sites
listed for any of the assembly standards, to ensure maximum portability.

Assembly Settings When you have selected two molecules, click on the Assemble button at the bottom of the
window.
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Completing and
previewing the
assembly

Using the Parts Assembler

The Construct and Assemble dialog will open with options for assembly.

Construct and Assemble g|

Name AzzemblyProjectl
Device Type
v
I:‘ Other
Chassis
Bl:heril:hia coli I:‘Sal:l:harum\rl:esl:erevisiae

[ Bacillus subtilis ~ Other

Azzembly Settings

Part One Direction: Direct ¥
Part Two Direction: Direct ¥
Azzembly Methods: Azzembly Standard 10 w

OK ] [ Cancel

Enter a name for your new construct in the Name field.

Device Type

A “device” in is any construction that performs a particular biological function. The Device
Type section of the dialog allows you to characterize the type of device you are constructing.
This information will be included in the General Description information of the assembled
molecule.

The drop-down list includes standard types of devices. Alternatively, you can select
Unassigned from the list, or enter your own device description by selecting the Other check
box and typing in the field.

Chassis

Parts are typically integrated into the genome of a particular organism—a.k.a. a “chassis”—for
propagation and functionality. You can specify the genome of the organism that you will be
using by selecting the appropriate check box or entering text in the Other field. This selected
chassis will be listed in the General Description information of the assembled molecule.

Assembly Direction and Standard

Select the direction of each molecule to use for the final assembly, and select the assembly
standard to use from the drop-down list.

Note: If there is no shared assembly standard that will work with both molecules, this drop-
down list will be blank and no assembly will be possible.

When you click on OK in the Construct and Assemble dialog, the assembled molecule will
open in a Preview window.

You can use the tools in the window to magnify the assembly, or view it as a linear or circular
molecule.

Click on Save in the Preview window to save the assembly as a molecule in the database.
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Viewing the assembly in Molecule Editor

Viewing the assembly in Molecule Editor

To view the assembled molecule in the Molecule Editor, open the Database Explorer and open
the molecule.

Properties O crebL O cok2 O ErRAF T PartsAssembler1 £% 8 %_g

[ General Description XXX l

DNA PartsAssamblerl’
; y " SCAR(BB Assembly Standard 10) o
DeviceType Protein Generator; Chassis:EscherichiaCali i

Lensth: 1087 bp "
Form: Linear <,
& Standara Flsids
T
Accession Number: PartsAssembler] PartsAssemblerl an
Reterances 1087bp .
(=} Comments. ot
nsert: 88a_4340520 5
vector: BBa_BOC10

Properties

Feature Map

TCTTCGCTIT
AACTATATAE &
CTC TTGATATATC

Analysis Results

The assembled molecule consists of the two original sequences joined together with a standard
bridging sequence or “scar” created by the overlap of the restriction digested ends. The scar
sequence is determined by the restriction enzymes used in the assembly standard, as described
on the web pages mentioned earlier.

* The original parts are listed in the Components list in the Properties pane.

* The scar is listed in the Feature Map, and displayed as feature in the Graphics pane.

* The General Description includes the information you entered about the assembled part,
including device type and chassis.
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Contig Assembly using
ContigExpress' program

ContigExpress'" program is a program for assembling and editing sequencing fragments, either
in the form of text sequences or chromatograms from automated sequencers, into longer
contiguous sequences or “contigs.”

ContigExpress™ program uses CAP3 to drive the assembly process. This widely-used sequence
assembly program can use quality value scores (QVs) in ends trimming, contig construction and
consensus calculation. It also produces excellent results when QVs are unavailable. It is capable
of using forward-reverse constraints to evaluate contigs, a feature that helps in accurate
placement of repetitive sequence fragments. It can also identify and discard chimeric
sequencing reads that frequently result from lane tracking errors. One of the major strengths of
CAP3 is its consensus generation algorithm based on weighted sum of QVs.

ContigExpress " program analysis can be saved as a ContigExpress Project, which contains the
fragments, their assemblies, and assembly options. In ContigExpress” program, fragments can
be edited directly, with the chromatograms in full view. Changes are tracked and a history is

maintained. The contigs generated can be saved to theVector NTI™ Express Designer database.

Launch ContigExpress’ program

You can launch the ContigExpress™" program tool in one of the following ways:

* Click on the ContigExpress button on the main toolbar.

O QE%E 000 w®

* In the menu bar, go to Confirm » ContigExpress.
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* Goto File » New » ContigExpress Project.
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Open a Contig Assembly Project and add fragments to the project

Irrespective of the option you choose to open the ContigExpress™ program tool, you will need
to enter a Name and Description in the Contig Assembly Project dialog box. Click New to
create a new project or Cancel to exit the dialog box.

Note: The Contig Assembly project takes a default name Contig Assembly ‘count’, where
count corresponds to the Contig Assembly project number.

o )

Name: Contig Azsembly 1

Description:

Open a Contig Assembly Project and add fragments to the project

Open the demo
Contig Assembly
Project

Open an existing
Contig Assembly
project

276

1. Open ContigExpress'" program and launch the default demo project.
The Contig Assembly DemoProject contains 12 fragments, from the installation folder,
listed in the Project View pane as well as the Project Editor pane. (Figure 5 ).
Example of the demo project folder: C:\Program Files\Life Technologies\Vector NTI
Express Designer\Demo Projects\ ):
The tools for assembling and managing the fragments are located in the Project Editor
pane.

= r—t—

Figure 5 Fragments added to a Contig Assembly project

As you add fragments, they are listed in the Project Viewer pane as well as in the Fragment
Viewer. You can then select the fragments for assembling. Refer to “Managing fragments in the
Fragments list in the Contig Editor” on page 287 for information on managing and assembling
the fragments.

To open an existing Assembly Project in the database:

1. In Database Explorer, click on the Projects folder at the bottom-left.
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2. Expand the Local Database Projects folder and select Contig Assembly Projects.

3. Double-click on the ContigExpress™ program project in the list in the right pane to open

it.

* Vector NTI Express Designer - Database Explorer - [=]x]

it Curate over Conf I :

o ~ i ro

(P [Dva@u SEXEH 00O WE W
B projects | ¥ E—— o] [z |
=@ Local Database
| [ Designer Projects Name Description Author Modified

-0 Alignment Projects Contig Assembyl.cep Smruthi 2014-01-2411:23:31

£ ContigAssembly Projects
] Clening Projects
- GeneSynthesis Projects
[ (7] Workgroup Shared Database

Prav | Page 1 |ofL | Next>

Genars| Description
Contig Assembyl.cep

Auther: Smruthi

Modified Date: 2014-01-24 11:23:31.634
Created Date: 2014-01-2411:23:31.634

(& Resuits

1 1 Contig Assembly Projects
To load an existing project that has been saved as a .cep file:
1. Goto File » Open » Assembly Project.
2. In the Open File dialog box, select the project file you want, and click Open.
You can also import an existing project saved as a .cep file.
1. Go to File » Import » Assembly Project.
2. In the Import into Database dialog box, select the project file you want, and click Open.
The imported project will reside in the Database within the Contig Assembly project
folder.
Create a new 1. To create a brand-new ContigExpressTM program Project, go to File » New »
Contig Assembly ContigExpress Project.
Project Note: You can open more than one Contig Assembly project at a time in the

ContigExpress " program. Each Contig Assembly project is represented by a tab at the top
of the Project Editor pane.
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Open a Contig Assembly Project and add fragments to the project

2. In the Contig Assembly Project dialog box, enter a name and description for the project,
and click New.

Name: Contig Azsembly 1

Description:

New ] [ concet ]

Add the fragments You can add individual fragments to a Contig Assembly project in the Project Viewer and
Contig Editor, in one of the following ways:
e Import from file

— In the Project Viewer pane, right-click on the Fragments folder, and go to Import
Fragments » From File....

— In the Contig Editor pane, click Import Fragment(s) » From File... to select a
supported file type.

In the Open dialog box, browse to the location of the fragment files, and click Open.
Note: In both the panes, you can choose to add fragments without the chromatogram

from a file. To add fragments without the chromatogram, go to Import Fragments »
From File (without chromatogram) ...

The supported file types include
+  GenBank™ (*.gb)
» FASTA (*.fasta; *.txt)
* ABI (*.abi)
+ ABI (*.abl)
» Staden SCF (*.scf)
»  EMBL files (*.txt)
o Text files (*.txt)
* Phred files (*.phd.1; *.seq)
* Phrap ACE files (*.ace)
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Open a Contig Assembly Project and add fragments to the project

Import from database

— In the Project Viewer pane, right-click on the Fragments folder, and got to Import
Fragments » From Database....

— Inthe Contig Editor pane, click Import From DB to select DNA molecules from the
local database.

In the Select Fragments from Vector NTI Express Designer Database dialog box,
select the DNA molecule you want to add, and click OK.

Use the s S ,and to scroll through the fragment list.

Note: Press the Ctrl or Shift keys to select multiple files/molecules.

K = e —

< OFRAH Q@EYE 090 WE & W

R T TR - gep—

3 Peupect View

Import from folder

— In the Project Viewer pane, right-click on the Fragments folder, and got to Import
Fragments » From Folder....

— In the Contig Editor pane, click Import Fragment(s) » From Folder... to select
DNA molecules from the local database.

Note: Press the Ctrl or Shift keys to select multiple files/molecules.

In the Browse for Folder dialog box, select the folder which contains the fragments to be
added, and click OK. Click Make New Folder to create a new folder to hold the fragments
to be added.

279



1 9 Contig Assembly using ContigExpress™ program
Open a Contig Assembly Project and add fragments to the project

Export Fragments

Remove fragments

Rename fragments

280

Note: In both the panes, you can choose to add fragments without the chromatogram
from a file. To add fragments without the chromatogram, go to Import Fragments »
From Folder(without chromatogram) ...

< OFRAH Q@EYE 090 WE & W

Tt

e A T 7

B Peuject View

After you import the fragments, a dialog box appears, confirming the number of fragments
imported during import.

Use the Export Fragments feature in the Project Viewer pane or the Contig Editor pane to
export the fragment(s) and save them as .gb, .fasta, or .txt files. To export fragment(s):

1. Select one or more fragments in the Project Viewer pane or Contig Editor pane.

2. Right-click on the fragment(s) and select Export Fragments from the drop-down menu.

The fragments can be exported as a molecule or saved as .gb, .fasta, or .txt files.

You can remove fragments from a Contig Assembly project in one of the following ways:

* Right-click menu
Right-click on a fragment name in the Project Viewer pane or the Contig Editor pane, and
select Delete.

Note: In the Project Viewer pane or Contig Editor pane, you can delete multiple
fragments in a single right-click action.

* From the Fragment/s management button in the Contig Editor pane

In the Contig Editor pane, select a single or multiple fragments and click Remove
Fragment(s) at the bottom of the Contig Editor pane.

The above methods remove fragment(s) from the project only and do not delete them from the
database.

1. To rename a fragment, right-click on the fragment name in the Project Viewer pane or
Contig Editor pane, and select Rename.
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2. Inthe Rename dialog box, enter a new name for that fragment and click OK to implement
the change or Cancel to exit the dialog box.

Examine the ContigExpress’ program Project Explorer Window

The ContigExpress™ program opens to an empty Project Explorer and Project editor window
where you can view and edit fragments, assemble and dissolve contigs, and dismiss assemblies.
The window is similar to other Vector NTI™ Express Designer Software windows with a

Project View pane and the Contig Editor pane.

Project Explorer Project Editor

F S A% GEYH DU B W

ey A F [T —" 3
o= “Contig Assemly | Toz “Centg Assembly ;

0 ragment{s] in Contig Assembly 2

Mama Langeh el Largts

.3.1 Project View

Note: Most toolbar buttons have associated tool tips that explain the button function. Hover the
cursor over the button to display the tool tip for that button.

The ContigExpress™ program window consists of the following panes:

» Project View pane: Located at the left-hand side of the ContigExpress™ program
window. The Project View pane displays the Contig Assembly project and the fragments
and assemblies it is made of.

Fragment Viewer: Displays the sequence of the selected fragment as well as a

chromatogram of the fragment when the fragment is selected in the Project View

pane. The Fragment Viewer includes the following sub-panes:

* Sequence Pane

» Properties Pane

281
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Examine the ContigExpress™ program Project Explorer Window

— Contig Viewer: Displays the Contig Assembly in graphical form, with the
overlapping assembled fragment sequences and chromatograms when the contig is
selected in the Project View pane. The Contig Viewer includes the following
subpanes:

* Sequence Pane
* Properties Pane
* Alignment Pane

You can view the Fragments and Assemblies summary when you select the
Fragments and Assemblies folders, respectively, in the Project View pane.

» Contig Editor: Located at the right-hand side of the ContigExpress’" program window.
When you select a Contig Assembly project in the Project View pane, the Contig Editor
displays the Project Summary that includes the following:

— Edit project information
— Save project summary into disk

— Copy project information into clipboard

Edit project curormany into
information \ / disk Y
Project Summary 4 Copy project

information into
clipboard

Selecting a fragment within the Fragments folder in the Project View pane displays the
Fragment Viewer in the Contig Editor. Selecting a contig within the Assembly folder in
the Project View pane opens a Contig Viewer in the Contig Editor.

Contig Assembly Project

Project View pane

® Vector NTI Express Designer - Contig Express
Fie Edit View Curdfe Discover Design Confirm Tools Help

D@ @ QAaE¥*E 000w & =W
122 Contig Assembly 2 37

E
—
;

coparty Valus
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= onelor
= one11r
3 onE13R
3 oneise
= oneisr
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3 onesr
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= oness
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@ B Assembly3

21 Project View
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Fragment viewer

When you select a fragment within the Fragments folder in the Project View pane the
Fragment Viewer is displayed in the Contig Editor.

Viewing Fragments  To view a summary of the Fragments added to a Contig Assembly Project, select the Fragments
summary folder in the Project View pane.

Note: The Fragment list always contains the original fragments imported from files or the
database. The information on trimmed fragments is displayed under the assembled contigs.

By default, the Project Explorer is configured to display six columns listing the following:
» Fragment identification code of each fragment
» Current length
* Original length
* 5’ trimmed bases
* 3’ trimmed bases
» Fragment Status.

% Vactor NTI Express Designer - Contig Express

fle Edt View Cuate Discover Desgn Conrm Toos e
< OSSR SGE%EH Dd2dwo & = w
Iov “Coritg Astembly 1 :'t&

12 fragmenit(s] in Contig Assembly 1

- (1= Erem it | [imper Framm8 | [Assamity sestings |

Manage Fragments/Assembly Settings/Trim Settings

The following table includes the features within the right-click drop-down menu for individual
fragments in the Project Viewer pane as well as the Contig Editor:

Feature Sub-menu

Load Fred Quality Values

Discard Chromatogram
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Feature Sub-menu

Make Reverse Compliment

Trim Fragment Ends

Trim Vector Contamination

Call Secondary Peaks for the selected fragments

Set As Reference

Analyses » Analysis Monitor » Sim4 Analysis

Spidey Analysis

Alignment » AlignX - Align Selected Molecule(s)

AlignX - Open New Alignment Project

Assemble » ContigExpress -Assemble Selected Molecule(s)

ContigExpress - Open New ContigExpress Project

Send to GeneArt Assembly
Tools » BLAST Search

Viewing individual You can view the details of each Fragment added to a Contig Assembly Project in the Contig
Fragment details Editor. To view the details, select a Fragment in the Project View pane.
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Sequence
view
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The Contig Editor displays two views of the fragment selected in the Project View pane.

* Graphical view in the upper half of the Contig Editor
* Sequence view in the lower half of the Contig Editor
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The lower half of the Contig Editor has two tabs:

e Sequence
e Properties

Graphical view

The graphical view pane toolbar includes the following features:

+ Six toggle buttons to allow clutter-free viewing of the fragment chromatogram.
— Show/Hide A - trace: Click E to show/ hide the Adenine nucleic acid base
— Show/Hide C - trace: Click & to show/ hide the Cytosine nucleic acid base
— Show/Hide G- trace: Click = to show/ hide the Guanine nucleic acid base
— Show/Hide T - trace: Click & to show/ hide the Thymine nucleic acid base
— Show/Hide Two Strands: Click % to display only two out of the four nucleic acid
base strands at one time.

— Show/Hide Deleted Peaks: Click % to show/hide the trimmed/clipped traces of
fragment. The Show mode appears grey in color.

* Three Find buttons to find a particular strand.

aTG

— Find: Click # to find a particular fragment. In the Find dialog box, you can insert
sequence and click Find Next to look for a match. You can find ambiguous character
as well as Complementary sequence.

— Find Previous Ambiguous: Click # to find a previous ambiguous fragment.
— Find Next Ambiguous: Click # to find a next ambiguous fragment.
* Three Zoom buttons.
— Zoom In: Click @ to zoom in to the graphical view pane.
— Zoom Out: Click & to zoom out from the graphical view pane.
— Fit to Window: Click & to display the default view of the graphical view pane.
Note: To take a screenshot of the current view of the fragment in the graphical view pane,

right-click anywhere in the graphical view pane and select Camera. You can then ‘paste’ the
information in MS Word, MS Paint, or any other graphic-editing tool for future reference.

Print Report
You can print a report of the graphical view of the fragment chromatogram.

Go to File » Print; in the Print dialog box, select PDF Creator from the Select Printer Menu,
and click Print.

You can save the Print Report at a location of your choice on your computer.
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Fragment viewer

Sequence tab

The sequence view of a fragment is displayed in the lower half of the Contig Editor pane.

You can select a particular sequence of the fragment in the Sequence view pane and view the

corresponding chromatogram in the graphical view pane.
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Properties
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Use the right-click drop-down menu to perform tasks in the Sequence view pane.
1. Select a sequence in the Sequence view pane.

2. Right-click and select from:

a. Copy: To copy the selected sequence.
Note: Keyboard shortcut key to copy the selected sequence is Ctrl +C.

b. Paste: To paste the copied sequence

c. Delete: To delete the selected sequence

d. Select All:To select the entire fragment (if you have not selected a part of it)
Note: Keyboard shortcut key to select the entire fragment is Ctrl +A.

e. Clear Analysis Results: Activated when you perform analysis from the right hand
side toolbar pane

Print Report

You can print a report of the sequence view of the fragment chromatogram.

Go to File » Print; in the Print dialog box, select PDF Creator from the Select Printer Menu,

and click Print.

You can save the Print Report at a location of your choice on your computer.
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Properties tab

The Properties tab in the lower half of the Contig Editor, displays the general information of the
fragment selected in the Project View pane.

The General Information includes:

Name of the selected fragment

Length of the fragment

Description

Date on which the fragment was created

Date on which the fragment was modified
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~ General Infermation

To manage the fragments in the Contig Editor, use the features provided at the bottom of the

Name OME1TR+

Length 755

Description

Date Created | Mon Feb 10 16:28:32 SGT 2014

Date Modified | Mon Feb 10/ 16:28:32 SGT 2014
Sequence | Properties

fragments in the
Fragments list in
the Contig Editor

Contig Editor pane. You can choose from:

Import Fragment(s): to import fragments saved as files, in a folder, or in the local database
on your computer

Import from DB: to import fragments saved in your database

Remove Fragments: to remove one or more fragments added to a project
Trim Fragment Ends: to trim the 5" or 3" ends of a fragment

Trim Vector Contaminations: to trim the contaminated fragments

Assembly Settings: to take you to the Contig Assembly Setup dialog box to edit the
assembly settings. For more information on Assembly Settings, see “Assembly Settings”
on page 293.

Vector NTI™ Express Designer Software User Guide 287



Contig Assembly using ContigExpress™ program

Fragment viewer

* Assemble Fragments: to create an assembly from the fragments added to a Contig project.

Import From Filel [ImpnrtFrurn DBI [Remmre FI'EgI'HEI'ItlS:I] [Trim FragmentEndsl [TrimVE:tannntaminatiuns] [hssembl\,r.‘:’nettings] [hssemble Fragmentsl

Import From File ] [ Import From DB]
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Note: When there are no fragments selected in the Contig Editor, the Remove Fragment(s),
Trim Fragment Ends, Trim Vector Contaminations, and Assemble Fragments are
disabled. The Assemble Fragments button is also disabled when only one fragment is selected
in the Contig Editor.

Assembly Settings

Import Fragment(s)

Use this feature to add fragments, as files saved on your computer, to a Contig Assembly
project.

1. Click Import from File, and in the Open dialog box, browse to the location where you
have saved the fragment files.

Note: Compatible formats include GenBank™ (*.gb), FASTA (*.fasta*.txt), ABI (*.abi),
ABI1 (*.abl), Staden SCF (*.scf), EMBL files (*.txt), Text files (*.txt), Phred files
(*.phd.1; *.seq), and Phrap ACE files (*.ace).

2. Click Open to import the fragment files or Cancel to exit the dialog box.

3. Click OK in the pop-up message confirming the number of fragments added to the Contig
Assembly Project.

Export fragments

Use the Export Fragments feature in the Contig Editor pane to export the fragment(s) and save
them as .gb, .fasta, or .txt files. To export fragment(s):

1. Select one or more fragments in the Contig Editor pane.

2. Right-click on the fragment(s) and select Export Fragments from the drop-down menu.

The fragments can be exported as a molecule or saved as .gb, .fasta, or .txt files.

Import from DB

Use this feature to add fragments, saved in the database on your computer, to a Contig
Assembly project.

1. Click Import from Database, and in the Select Fragments from Vector NTI"" Express
Designer Software Database dialog box.

2. Use the , [epee], ,and to scroll through the fragment list.

3. Select the fragment from the list, and click OK to import that fragment into the Contig
Assembly Project or Cancel to exit the dialog box.
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4. Click OK in the pop-up message confirming the number of fragments added to the Contig

Assembly Project.
® Select Fragments from Yector NTI Express Designer Database [‘5_7‘
Type Subset I:l [~
Mame Form Length  Description ~
ApCY? Lingar G195 Homosspians adenylate cyclasa 7 (ADCY7), mANA
Adeno2 Linzar 25537 Adenovirus type 2, complete gzname -
ADRALA Linear 2308 Homo sapiens adrenergic, alpha-14, receptor (ADRALA), transcriptvariant 2, mRNA
BaculoDirectiLinear\CHA Linear 138370 (Invitrogen Vactor)
BaculoDirectiLinear\CHAICL... Linear 5770 linvitrogan Vector)
BaculoDirectilinear\DNA_v... Circular 139370 (Invitrogen Vector)
BBa_K174018 Lingar 2393 GENEART PMQ Plasmid Backbane
BLOCK-T-Polll-miRacZVali.. Circular 5759 lInvizrogen Vactor)
BLOCK-TPolll-mifLMNAYS... Circulsr 5753 linvitrogan Vactor)
BLOCK-TPolll-miflucValid.. Circular 5753 lInvitrogan Vector)
BFVL Circular 7345 bovine papillomavirus type 1
BRAF Linear 2510 Homa sapiens v-raf murine sarcom viral ancogene homalog 81 (BRAF), mRNA
oKz Lingar 2226 Homa sapiens cyclin-dependent kinase 2 (CDK2), transcript variant 2, mRNA.
ColEl Circular 6646 Plasmid ColE1, complste senome. ™

Remove Fragments
Use this feature to delete fragments from a Contig Assembly project.
1. 1In the Contig Editor, select one or more fragments.

2. Click Remove Fragment(s), and in the ‘Contig Assembly project name’ dialog box, click
Yes to confirm if you want to delete the selected the fragment(s).

3. Click No to exit the dialog box.

" s Doyouwant to delete the fragment 'ONE13R' ?
.

Trim Fragment Ends

Use this feature to trim the 5" or 3" ends of a fragment added to a Contig Assembly project.

Note: You can also access this feature from the right-click drop-down menu of individual
fragments.

1. In the Contig Editor, select one or more fragments, and click Trim Fragment Ends.

2. In the ContigExpress™ program - Fragment Ends Trimmer dialog box,

a. Use the 5" end tab to trim the 5 end of the fragment, and select or deselect the
following checkboxes:

Note: You can also change the default values if necessary.
e Trim __ consecutive off-scale bases removes the defined # of consecutive
bases that are below acceptable criteria

+ Trimming until __ 5" bases can be based upon chromatogram quality

« Trim at least _ 5’ bases is an arbitrary setting that may be based upon the fact
that your primers have “tails”

b. Use the 3’ end tab to trim the 3" end of the fragment, and select or deselect the
following checkboxes:
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Note: You can also change the default values if necessary.

* Trim until _ 3" bases % of maximum value removes bases whose peaks do
not meet the % value you define

* From position... trim first removes these bases if you can see that quality
well into the sequence is not good

e Trim until __ 3" bases... ambiguities trims poorly resolved bases

« Trim at least... removes bases that begin to be poorly resolved at the 3" end
Post trimming

* Define maximum... set the length of the fragment that must be left after
trimming

* Leading and trailing... removes poorly resolves nucleotides that may be left
after trimming

* Remove poly A/T... removes these nucleotides that may be present if the
sequence was flipped, producing a poly-T 5" end

3. Click,

* Calculate - to preview the trimmed results. Click OK to propagate trimmed results
to fragments

* Load settings... - to use pre-loaded Fragment Ends Trimmer Setup Files

» Save settings... - to save the new settings

* Select All Ends - to select all ends of the fragment

* Unselect All Ends - to unselect all ends of the fragment
If you have selected multiple fragments, use the following Sort By buttons to sort the
fragments:

* Name - to sort the fragments by their name

* % of trimmed base - to sort the fragments by the percentage of the trimmed base

* Number of trimmed bases - to sort the fragments by the number of trimmed bases

Click OK to implement the edits or Cancel to exit the dialog box.

e
5'end | 3 end | PostTrim
[F] Rerve blodks aFoff-scale peaks = than| 3 | onsecutvebzses
[¥7] scanningentire fragment, trim util 5'end (| 25 | bazes)contains < | 3 | ambiguities
[ scanningentire fragment, trim util 5'end | 25 | bases)contains< | 3 | baseswithav< | 10|
] Trim st least [ 50| bases
[ Calculate I [ Load settings. ] [ ‘Save sertings. ] [ Select All Ends J [ Unselect All Ends
Sart By
[s¢attrimmed base | [ Number of trimmed bases |
a
ONE10F
757 gocd bases.(1 ambiguities)
GTGGCGEEGATCCTCTAGAGTCG. . AGCTGCTGNTCGGCGAGTGAGEG
ONEL1R
754 good bases. (1 ambiguities)
CAATTNTCGATGATGGTTGAGAT. .. TAGTTTTTTTTTTTTAAAGTCTT
ONE13R
762 good bases, |57 ambiguities]
v
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Trim Vector Contaminations

Use this feature to trim from sequenced fragments any residues from your frequently used
cloning vectors that may have been amplified in the sequencing process.

Note: You can also access this feature from the right-click drop-down menu of individual
fragments.

1. 1In the Contig Editor, select one or more fragments, and click Trim Vector
Contaminations.

2. In the ContigExpress™ program - Fragment Vector Contamination Trimmer dialog box,
click,

+ Calculate - to preview the trimmed results. Click OK to propagate trimmed results
to fragments

» Settings... - to access the Fragment Vector Contamination Trimming Settings dialog
box. The vectors or polylinker sites you selected in the Local Database should be
listed in the List Pane at the left. The Edit Pane where you can edit the vector
sequence is on the right.

In the Fragment Vector Contamination Trimming Settings dialog box:

a. Edit the following Common Settings:

*  Minimum Vector overlap is the minimum number of bases in the fragment that
overlap with those on the clone. This setting must be 5 or greater.

» Remove additional bases from contaminated 3’ end refers to the additional
bases to be removed.

*  Minimum Vector overlap with ambiguities includes poorly resolved residues
» Remove additional bases from contaminated 3’ end

* Vector match threshold is the percentage required to match

b. Select one or more polylinkers from the Polylinker List and click
* Remove Polylinker(s) to remove the selected polylinker(s)

* Add Insertion Point to add an insertion point to indicate location where the
fragment was inserted in the vector

* Remove Insertion Point to remove the insertion point from the location where
the fragment was inserted as a vector.
» Select All to select all the insertion points
* Remove Selected to remove the selected insertion points
Note: To add a polylinker to the Polylinker List, go to Database Explorer » DNA/
RNA Molecules. Select a DNA molecule from the list in the right-hand side pane.
Right-click on the DNA Molecule name, and select ContigExpress » Polylinker to

ContigExpress. The DNA molecule will be added as Polylinker to the Polylinker
List in ContigExpress " program.

IMPORTANT! You can send only one vector at a time from the local database as a
polylinker.

c. Click
* Load settings... - to use pre-loaded Fragment Vector Trimmer Setup Files
» Save settings... - to save the new settings

* OK to implement the changes or Cancel to exit the dialog box
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3. If you have selected multiple fragments, use the following Sort By buttons to sort the
fragments:

* Name - to sort the fragments by their name

* % of trimmed base - to sort the fragments by the percentage of the trimmed
base

*  Number of trimmed bases - to sort the fragments by the number of trimmed
bases

4. Click OK to implement the edits or Cancel to exit the dialog box.

? ContigFxpress - Fragment Vector Contamination Trimmer |z|@]g|

[ Calculate ] [SEttlngs. . ] [SEIE:tAH CDntammatans] [ Unselect All CDntamlnatans]

Sort By

[%thr\mmad base] [Number of trimmed basas]

ONE10F
757 good bases,(1 ambiguities)

GTGGCGGGGATCCTCTAGAGTCG. . AGCTGCTGNTCGGCGAGTGAGGE

ONE11R
754 good bases, 1 ambiguities)

CAATTNTCGATGATGGTTGAGAT.. TAG AMAGTCTT

ONE13R

762 good bases,|57 ambiguities)
4

Calling Secondary Peaks for Fragments
If conflicting residues appear on a chromatogram, you can alter the nucleotides as you wish.

1. With one or more fragments selected in the Project Explorer List Pane, select Edit » Call
Secondary Peaks for Selected Fragments. The Call Secondary Peaks dialog box opens,
listing all selected fragments.

Note: You can also access this feature from the right-click drop-down menu of individual
fragments.

2. Select the check box for replacement options. The options include:
* Allow N’s to be replaced
* Allow edited bases to be replaced

3. Use the Threshold for secondary base calling scroll bar to adjust the threshold.
4. Click OK to continue.

Note:

* Because this operation applies only to fragments, if contigs are selected, they will be
skipped.
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If a fragment selected for secondary peak search is currently open in its Fragment
Window, initiating this operation in Project Explorer automatically forces the fragment
into the read-only mode in the Fragment Window to avoid possible inconsistencies in the
project after a successful search.

If any of these fragments were already changed in their respective windows, select Yes to
save the changes or No to lose the changes or Cancel to skip the fragment in question.

The Call Secondary Peaks for Selected Fragments dialog box looks like this:

Replacement options (all fragments) | | Threshold for secondary base calling

[ Allaw N's to be replaced [0 &

[[] 4llow edited bases to be replaced W ] P

g::‘:i 0 GIGGCGEEGA TCCICIAGAG TCGACCIGCA GGCATGCAAG CTICAGGGIT GAGATGIGIA 1

e 100 ATAGACAGIT TCAAAGCCAT GGITTACAGA CIGGGCCAAA AGCTGAGCAA ATTCTTGGIT €

SRt 200 ACAGTIGTAG GATGGAAACC GIGGIGARAG TTACAATICC GGCICIGAAC ARRBATGCTG C
300 AGTATARATG CACACCITIT CCRATATGCC GCCIGGIGIT CICAAIGGIC GAGITICEGI 1
300 GITIGARGGA TCAGTGAAGC CATCCACCAA CACACTTGIG GAGGAGGCAT GGARAGCTIC 1
500 CAGIGITTTG GCICITCATA TGCAACAGCC TGGACATCTG CICTATTGAT ATCITGAGAG
600 TGICITGCGI CAICIGATCC TCGGGAGGCA TATAAGCIGG G TCAGCIGEIA I
700 AGGATARGTA CIGCCGCITC CCGGAGAGIT TGGGIAGCIG CIGNICGGCG AGIGAGGS,

< x|

Use this feature to take you to the Contig Assembly Setup dialog box to edit the assembly
settings. The Contig Assembly Setup dialog box has the following tabs:

Assembly
Clipping
Overlap
Contig
Description
Lite Settings

Assembly

There are three main check boxes to control some important aspects of the sequence assembly
process, as shown in the table below:

Assembly Options

Use Quality Values When available, base quality values (QVs) are used to trim

poor-quality ends, compute overlaps between reads, construct
multiple sequence alignments, and generate a consensus
sequence. Use of such scores is optional; when they are
unavailable, assembly will still proceed. Default ON.
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Assembly Options

Detect Chimeric Reads Chimeric reads consist of pieces from different parts of the
sequence region, usually generated as artifacts. They are
identified based on overlap conflicts and are excluded from the
construction of contigs. The mechanism of detecting chimeric
reads can be enabled or disabled with “Detect Chimeric
Reads” check box. Default: ON

Use Forward-Reverse When reads from both ends of subclones are available,
Constraints constraints are satisfied if they lie on opposite strands of a
double-stranded DNA molecule and within a specified
minimum and maximum range. This corrects assembly errors
due to misplacement of reads containing repeat sequences
and minimizes occurrence of singletons. A few unmet
constraints are allowed. However, if a sufficient number of
constraints are not satisfied by a join AND they all suggest an
alternative one supported by the overlap information, the
alternative join will be made. For most small- and moderate-
sized projects, it is not necessary to use this feature, unless in
a situation involving large region of repeats. Default: OFF.

The Assembly Tab contains some detailed settings related to the use of forward-reverse
constraints. All these settings are disabled when Use Forward-Reverse Constraints is
unchecked, and are enabled and editable when checked.

Forward and reverse reads must be named identically up to the delimiter (default = dot), and
must contain paired suffixes thereafter (e.g., .s & .r or .x & .y). Suffixes may be added and
deleted. Only the letter immediately following the delimiter is recognized as the suffix. Other
letters following it, if any, do not contribute to the identity as forward versus reverse end
sequence; however, they do distinguish one forward/reverse pair from another, thus making two
sequence pairs with the matching reverse/forward end sequence. Minimum and maximum
distances may also be edited.

Note: Take care when defining file names at the sequencer, especially when a project is loaded
in batches over several days. Entries with misplaced suffixes (e.g.
<filename>F.<projectName>, instead of <filename>.F<projectName>) will be overlooked by
the constraints feature, although they may be included in an assembly.

e Min. Dist. — Minimum Distance between the forward and reverse reads. Default: 0.
e Max. Dist. — Maximum Distance between the forward and reverse reads. Default: 6000.

* Delimiter — the letter separating main part and suffix part in read names. In cases that there
are multiple occurrences of the designated delimiter, the rightmost delimiter is selected.
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The values of minimum and maximum distance are uniformly applied to all sequence pairs.

® x|
Assembly | Clipping | Overlap | Contig | Description | Lite Settings
Use Quality Values(QVs)where available
Detact Chimeric Reads
D Use Forward-Reverse Constraints
F/R Constraints
Forward | Reverse Delimiter
5 r

* ¥ Min. Dist.

Max. Dist.

Load... ] [ Save... ] [ Ok ] [ Cancel

Clipping

Sequence clipping based on quality and similarity is an essential step in the overlap
computation and assembly process and ensures validity and correctness. You can control and
fine-tune the clipping process through adjusting the parameters on the Clipping tab.

Note: The clipping is irreversible and iterative within each project. When multiple assemblies
are made within a project, each round of clipping applies to the sequences that had been clipped
in the last round of assembly. This implies that a later attempt to assemble may affect the
existing assemblies.

Use Automatic Clipping —Ends of sequencing reads are usually unreliable and low in QV
values. CAP3 comes with a mechanism to detect and clip these poor end regions based on
sequence similarities with or without QVs. Clipping is done before the computation of
overlaps. Note: trimming is available in the ContigExpress"" program, in addition to
CAP3 clipping, and can be carried out before loading input sequences into assembly
projects. Default ON.

Match Score Factor — Also used in calculating Similarity Score for computing overlaps,
but only editable in the Clipping Tab. Match Score Factor is a positive integer to award
each match between two bases from the pair of sequences being compared during the
banded Smith-Waterman alignment. Default: 2.

Mismatch Score Factor — Also used in calculating Similarity Score for computing
overlaps, but only editable in the Clipping Tab. Mismatch Score Factor is a negative
integer to penalize each mismatch between two bases from the pair of sequences being
compared during the banded Smith-Waterman alignment. Default: -5.

Gap Penalty Factor —Also used in the computation of overlaps, but only editable in the
Clipping Tab. Gap Penalty Factor is a positive integer to penalize each gap extended
during the banded Smith-Waterman alignment. Default: 6.

Quality Cutoff for Clipping — Quality Cutoff for Clipping applies to the clipping of a
poor end region for each read when QVs are provided. It is not used when QVs are not
available. The specified value is used to find the low-quality ends of reads, where the
quality value of a base is considered low if it is less than this value. Default: 12.
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Clipping Range — Clipping Range applies to the clipping of a poor end region for each
read regardless of whether QVs are available. The value is used to extend the ranges for
clipping further away from the ends based on the low-quality positions at each end as
determined with the Quality Cutoff for Clipping value. The larger the value of Clipping
Range, the more extensive the clipping for poor end regions. Default: 250.

Min Num Good Reads at Clip Position — This is the depth of good coverage at the clip

position. It applies to the clipping of a poor end region for each read regardless of whether
QVs are available. Depending on the actual depth of coverage, the Minimum Number of

Good Reads at Clip Position parameter determines the exact clipping position within the

clipping region. The larger this value is, the more extensive the clipping becomes. Default:
3.

© ||

Assembly | Clipping | Overlap | Contig | Description | Lite Settings

Usze Automatic Clipping
Match Score Factor 2
Mizmatch Score Factor -5
Gap Penalty Factor 6
Quality Cutoff for Clipping 12
Clipping Ranges 250
Min Number of Good Reads at Clip Position 3

[ ) e J[ox J[ cnee

Overlap

Overlaps between reads are computed immediately following sequence clipping. This step
serves as the basis for contig construction. In order to ensure the quality, each overlap is
evaluated with a few measures. You can change the rigor of overlap computation. The
parameters are explained below:

Overlap Length Cutoff — Minimum length required for the length in base pair of all the
overlaps. Default: 20.

Overlap Percent Identity Cutoff — Minimum percent identity of the overlap. Default:
0.80.

Overlap Similarity Score Cutoff —- Minimum similarity score for an overlap. The score is
computed as the sum of match, mismatch or gap scores for each pair of bases weighted by
QVs. Default: 900.

Base Quality Cutoff for Difference — Determines the minimum overlap quality by
examining the differences of the overlap at bases of high quality values. This is useful
only when QVs are available. The Base Quality Cutoff for Difference value defines “high
quality” bases. Default: 20.

Max QV Sum at Difference — Applies only when QVs are available. Each overlap is
given a “difference score” based on the QVs and the Base Quality Cutoff for Difference.
An overlap with a difference score over the Max QV Sum at Difference value is excluded
from contig construction. Default: 200.
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*  Max Clearance for Error Rate — Applies even and especially when QVs are not
available. If the error rate of the overlap is greater than the sum of those of the overlapping
fragments plus this value, the overlap is not used for assembly. The smaller the value, the
better the quality control of the overlaps. Default: 30.

* Band Expansion Size — This parameter specifies band expansion size. The program
automatically determines a minimum band of diagonals for an overlapping alignment
between two sequence reads. The band is then expanded, in each direction, by a number of
bases specified here. This affects the computation of both potential overlaps and true
overlaps. Default: 20.

*  Max Gap Length — This is the maximum gap length allowed in an overlap. Default: 20.

*  Max Num Word Matches — This parameter controls the fast method for finding potential
overlaps between a pair of sequences. For each word in one read, at most Max Num Word
Matches occurrences of the word in the other read are considered for non-gapped
extension. A larger value forces the program to consider more word matches at the
expense of time and computer memory. Default: 300.

*  Max Overhang Percent Length — This parameter controls the different overhang regions
before or after the aligned region. It is defined as 100 times the total length of the different
overhang regions divided by the length of the overlap. Overlaps with a value greater than
the maximum cutoff are not used for assembly. Default: 20.

? Contig Assembly Setup g|

Assembly | Clipping | Overlap | Contig | Description | Lite Settings
Overlap Length Cutoff 40

Overlap Percent Identity Cutoff 08

Overlap Similarity Score Cutoff 900

Base Quality Cutoff for Difference 20

Max OV Sum at Difference 200

Max Clearance for Error Rate 30

Band Expansion Size 20

Max Gap Length 20

Max Number of Word Matches 300

Max Overhang Percent Length 20

[ ) e J[ox J[ cnee

Contig

Contig Tab includes parameters affecting construction of contig and multiple sequence
alignments, thus the consensus sequences. QVs are used extensively during this process, if they
are available. If unavailable, the program assigns a QV of 10 for each base. Three of the
parameters, Match Score Factor, Mismatch Score Factor and Gap Penalty Factor, are editable
only on Contig Tab.

*  Match Score Factor —Match Score Factor is a positive integer to award each match
between the existing alignment and the sequence being added when calculating the score
of global alignments. Default: 2.

*  Mismatch Score Factor —Mismatch Score Factor is a negative integer to penalize each
mismatch between the existing alignment and the sequence being added when calculating
the score of global alignments. Default: -5.
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* Gap Penalty Factor —Also Gap Penalty Factor is a positive integer to penalize each gap
extended when calculating the score of global alignments between the existing alignment
and the sequence being added. Default: 6.

*  Min Num Constraints Correction — This is the minimum difference between the
numbers of constraints satisfied in the current assembly and in the alternative assembly. A
difference greater than this value, if the contig is also supported by an alternative set of
overlaps, results in the alternative join. Default: 3.

* Min. Num Constraints Linking — This is the minimum number of constraints for
reporting a link between two contigs. Default: 2.

| Contig Assembly Setup

| Assembly | Clipping | Overlap | Contig |Descri|:|h'on || Lite Settings |
Match Score Factor I:I
Mizmatch Score Factor I:I
Gap Penalty Factor I:I
Min. Num. Constraints Correction I:I
Min. Mum. Constraints Linking I:I
[ Load... ] [ Save... ] [ OK ] [ Cancel
Description

Use this tab to enter the description of the Contig Assembly project you are working on. Click:
* Load... to use an existing description from the Assembly Setup Files
* Save... to save the new description

* OK to implement the edits or Cancel to exit the dialog box

| Contig Assembly Setup

| Assembly | Clipping | Overlap || Contig | Description | Lite Settings

Write your project description here:

Load... ] [ Save... ] [ OK ] [ Cancel
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Fragment viewer

In ContigExpress' " program, you can create two different types of contigs, Full Contigs or Lite
contigs. On the Lite Settings tab, you can specify the type of contigs you want to assemble in

the project.

* In Full contigs mode, chromatogram data are retrievable and-sequence editing performed
in the Contig Viewer are reflected in the individual fragment files.

» Editing done on Lite Contigs is NOT reflected in the original fragment sequences (original
sequences remain unedited). Assembly in Lite Contig mode reduces memory consumption
and is, therefore, the preferred contig type for assembling large projects.

Lite Settings Parameters

Full Contigs only

Check this box to perform assembly in Full Contig mode. You
can retrieve chromatograms and maintain dynamic links
between the contigs and their component reads.

Lite Contigs only

Check this box to perform assembly in Lite Contig mode. All
linkage between the contigs and sequence reads will be lost
and no chromatogram is retrievable in the Contig Viewer.

Lite contigs if selected
more than <#> fragments

Creates Lite Contigs during the assembly process only if the
selected number of fragments is greater than the number
specified; otherwise creates full/ regular contigs.

@

Uze contig type
@ Full contigs only
O Lite contigs only

O Lite contigs if selected more than

Assembly | Clipping | Overlap | Contig | Description | Lite Settings

B

fragments

(oo ) e |

| [ concet

Assemble Fragments

Use the Assemble Fragments button to assemble the selected fragments into contigs using
Cap3. See “Perform an assembly” on page 300 for information on assembling fragments.
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Perform an assembly

Before performing an assembly, you can go through the Assembly Settings to set the correct
parameters for assembling fragments into contigs.

Assembly setup To see the assembly parameters available for control:

1. In the Contig Editor, right-click on a Fragment and select Assemble » Assembly
Setup....

Alternatively, select the Fragments main folder in the Project View pane, and from the
right-click drop-down menu, select Assemble » Assembly Setup....

The Assembly Setup dialog box ( Figure 6 ) appears. For more details about Assembly
Setup, see “Assembly Settings” on page 293.
® x|

Assembly | Clipping | Overlap | Contig | Description | Lite Settings

Usze Quality Values|[QVs) where available
Detect Chimeric Reads
I:‘ Use Forward-Reverse Constraints
F/ R Constraints
Forward | Reverse Lty
= r

* ¥ Min. Dist.

Max. Dist.

(o J[ e J[Cox J[ o= ]

Figure 6 Contig Assembly Setup dialog box

2. To proceed with the assembly using default values, click Default in the Contig Assembly
Setup dialog box. Click OK to implement the changes you made to the settings or Cancel
to exit the Contig Assembly Setup dialog box.

Perform the After you have selected the trimming and assembly settings, select the fragments you want to
assembly assemble in the Contig Editor, and click Assemble Fragments.

Assembly may take some time, depending on how many fragments you selected.

When assembly is complete, the assembled contig(s) and any unassembled fragments will be
listed in the Project View pane and can be viewed in the Contig Viewer.

Note: If a contig cannot be created from the fragments, an alert box will be displayed.

IMPORTANT! Although Vector NTI™ Express Designer Software does not have an exact upper
size limit for a ContigExpress'" program project, your project size may be limited by available
computer resources. If you do encounter an “out of memory” situation, you should consider
assembly in Lite Contig Mode (see “Lite Settings” on page 299). Often the “out of memory”
problem occurs due to the presence of too many assemblies in the ContigExpress'" program
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Project. In this case, you are advised to delete some of these assemblies as described below,
save the project, and restart the ContigExpress'" program. Limiting the number of assemblies in
a project is always a good idea with large projects. If you decide to use Lite Contig Mode but
don’t want to lose the link between your contigs and fragments, you can discard chromatogram
data (see “Lite Settings” on page 299) and trade the ability to invoke chromatograms for a
larger capacity.

To start an assembly:

1. In the Contig editor pane, select all the fragments from the demo project, by SHIFT+
CLICK on all the names on the list.

Note: You can also use the keyboard shortcut command Ctrl +A to select all the
fragments in the Contig Editor pane.

=1 Project View . SConbg Assembyl.cep X
= EJ ContigAssembyl.cep 12 fragment(s) in Contig Assembyl.cep
= £ Frasments
= ONELOF Name Lenzth Orizinal Lenzth STrimmed bazes 3Trimmed basas Status
& ONEL1R ONE1OF 758 758 o o
R ONET2R: OHEL1R 755 755 0 o
o ONE13R s13 213 0 o
SHLONETBL ONELSF 784 784 0 o
o ONEL/R ONE16F 767 767 0 o
Z 3:22 OHELTR 752 758 0 0
R ONE2R 747 747 0 o
B ONEIR 755 755 0 o
= ONE4R 756 756 0 o
Eraiy OHEER 770 770 0 0
&0 Assembiies ONEER 784 784 0 o
ONESR 758 758 0 o

2. Click Assemble Fragments at the bottom of the Contig Editor pane.

)

< O%SA% §E%EH OddWwe & =W
5 Frapent view e ey
12 fragrmessis] im Connig Asbembyltep

= Pesp— [ — F ———— [

W

= werkriem
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Note: You can also assemble fragments using the right-click menu of the fragments.
Select the fragments by SHIFT+ CLICK on all the names on the list, right click on any of
the fragment names and select Assemble Selected Fragments from the right-click drop-
down menu.

After the assembly process is finished, a summary dialog box displays the number of
contigs assembled ( Figure 7 ).

oPQowW® B W

=1 Project View

= £l Contig Assembyl.cep
= £ Fragments

12 fragment(s) in Contig Assembyl.cep

3 ONE1OF
3 ONE11R
3 ONE13R
03 ONE1SF
03 ONE1&6F
O3 ONE17R
3 ONEZR
O3 ONEZR
3 ONE4R
O3 ONESR
3 ONESR
3 ONESR

B El Assemblies
@ £ Assemblyl

Name Length Original Length 5Trimmed bases 3Trimmed bases Status

OME2R 747 747 o
DNE11R 755 755 (1]
DNE3R 755 755 L]
ONE4R 756 756 L]
ONE10F 758 758 o
OMESR 758 758 Q
DNE17R 759 759 L]
ONEBR 764 764 ]
ONE1&F 767 767 L]
ONEER 770 770 L]
ONE1SF 784 784 o
ONE13R 813 813 (]

.
- | ) 2 Contigs were assembled

Figure 7 Contig Assembly summary

Examine Assembly
Results

302

Once you have performed the Contig Assembly, the Project View pane in the ContigExpress'
program Project Explorer shows the new assembly, Assembly 1 (Figure 8 ).

™ Project View

= £ Contig Aszembly
CONE1OF
ONE11R
ONE13R
ONE1SF
ONE1EF
ONE17R
ONE2R
ONE2R
ONE4R
ONESR
ONESR
CONESR
=] Azzemblies
£ Aszemblyl

pooooQooOoODODOGD

Figure 8 Contig Assembly

An assembly can be made up of one or more contigs. Click Assembly 1 to select and expand it.
All of the project fragments and contigs are listed in the Project View pane. Assembly 1
includes two assembled contigs, with Contig 1 made from eleven fragments and Contig 2
composed of two. Unassembled fragments are shown below the contigs. Note that many of the
fragments that are included in contigs underwent trimming at their 5” or 3 ends or both. This
results from the operation of the assembly algorithm, although it can be turned off if so desired.
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Contig viewer

When you select a contig within the Assemblies folder in the Project View pane the Contig
Viewer is displayed in the Contig Editor.

To view a summary of the total number of assemblies created by the assembling process in a

Viewing
Assemblies Contig Assembly project, select the Assemblies folder in the Project View pane.
summary By default, the Project Explorer is configured to display five columns listing the following:

* Assembly Name

* No. of Contigs

* No. of Unused Fragments
* Created Date

* Modified Date

® Vector NTI Express Designer - Contig Express.
Fle Edit Curate Discover Design Confirm Tools Help

< OSSR §E%EH D92 wo #

Mt Project View %8 =Contig AssembyLcep 2

v

= @ ContigAssembyl.cep Assemblies in Contig Assembyl.cep
= [ Fragments
= onELOF Name -
= OHELIR Assemblyl 2
OR 0bECR Assembly2 1 E]
EXoncyor assembiy3 1 1
SR
o GNELTR
= onE2R
= onesm
SR
= onesr
= onesk
O onesk
ErTTE——
B @ Assambly1
El Contiz2
=] Contiz1
B UnusedFragments
= Gl Assembly2
® (B contig1
B Unused Fragments
£ Assemblyz

Mo of Contigs Ho.of Unused Fragments Created Date Modified Date
1 20140124 11:23:39 20140124 11:22:38
201401-2411:23:45 20140124 11:23:45
201401-2411:23:50 20140126 11:23:50

= Project View

I Work Flow

At the bottom of the Assemblies Summary pane, you will find the Dismiss Assemblies button.

Use this feature to remove or delete assemblies from a Contig Assembly project.
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Viewing Assembly
summary

To view the summary an individual assembly created by the assembling process in a Contig
Assembly project, select the Assemblyl folder in the Project View pane.

Note: You can view the summary of each assembly created by the assembling process by
selecting the name of that assembly in the Project View pane.

On selecting an Assembly in the Project View pane, the Contig Editor displays two panes. The
upper pane displays the Assembly Settings values used in performing an assembly while the
lower pane displays the summary of the Contigs (and the Fragments) in that Assembly in the

Contig Assembly Project.

The lower pane includes the following columns

* Name

* Length of the fragment

* Original Length of the fragment

e 5’ trimmed bases

« 3’ trimmed bases

® Vector NTI Express Designer - Contig Express

File Edit Curate Discover Design Confirm Tools Help
: =S — I ar £ 7! 17 7 smp * fmg
< O EE%s E@=E%EH 099w el 15
" Project View =a Contig AssembyLeep 2 -8
= [ ContizAssambyd.ce
a rfj ae o Assemblyl
= F] Frazmentes
= onelor Match Scare Factor: 2 ~
= Mismatch Score Factar : §
ONELIR Overlap Percent Identity Cutoff :0.8
= onELZR minsst3
= onglsF niterations 15
Gap Panslty Factor - 6
=}
et chimrat=0.28
2 oNELZR OueriapLength Cutafr: 40
O onezR Quality Cutaff Clipging : 20 =
Max N Sum at Difference : 200
=
open Min Num Canstraints Linking: 2
B8 joneaR Quality Similarity Score Cutaff : 300
= onNESR Max Clearance far Error Rate : 30
= onesR 8and Expansion Size : 20
Mstch Scora Factor: 2 =
=3 onESR ¥
B El Assamblies
& M Assemblyl Name Length Original Langth §'trimmad bases 3'trimmad bases
# @ Assembly2 = Contig2
@ E Assembly3 ONE13R+ 723 723 o o
ONE15F- 567 784 76 141
ONE1DF- &3 &3 o o
ONEL1R+ 686 698 o 12
ONE15F- 559 787 50 7
ONER- 719 757 38 o
ONEER+ 714 714 o o
ONE3R+ 683 704 5 16
ONE2R+ 705 705 o o
=l Contigl
ONE2R+ 717 715 o 2
ONEBR+ 718 718 o o
!.g Project View
It Work Flow |
Dissalva Contig
>

Use the Dissolve Contig feature at the bottom of the Assembly Summary pane to dissolve the

contig.
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You can view the details of each Contig in an Assembly added to the Contig Assembly Project

Viewing Contig
in the Contig Editor. To view the details, select a Contig in the Project View pane.

details

o Mecier W) Expross Dpsignes - Contig Express
= o e "y .
£ O S84 §S§EYEH Ddwe & W } Graphlcal
s I ecigtmtrioe: 1 E =%, :
S i L 58 HaR REK & view
u:‘_“."
" o
# o coeny
e
Sequence
view
5 ek e
| pesmm— e———

The Contig Editor displays two views of the contig selected in the Project View pane.

* Graphical view in the upper half of the Contig Editor displays a graphical representation
of the Contig Assembly
* Sequence view in the lower half of the Contig Editor shows the assembled fragment

sequences
The lower half of the Contig Editor has three tabs:
e Alignment

* Sequence
e Properties

Graphical view

The Contig Viewer Graphical Pane contains horizontal arrows representing the relative
positions of the fragments forming the contig. The arrowheads indicate whether the respective
fragment is in the direct or complementary strand, with the names of the fragments displayed

above the fragment lines.
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Contig Assembly using ContigExpress™ program

Contig viewer

Contig coverage bar

The Contig Coverage bar spans the length of the contig and contains segments of varying
patterns/colors that represent the amount and type of fragment coverage in that segment
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CINF15F- 1140 << 1706
1271

Contig Coverage Bar 1200 1600 2000 2400

The patterns and colors are:

* Single fragment — gray bar with slants
*  Two fragments in the same direction — red cross-hatching
* Two fragments in different directions — blue checkerboard

*  Multiple fragments in both directions — solid blue bar

The graphical view pane toolbar includes the following features:

» Three Zoom buttons.

— Zoom In: Click @ to zoom in to the graphical view pane.

— Zoom Out: Click & to zoom out from the graphical view pane.

— Fit to Window: Click & to display the default view of the graphical view pane.
+ Six toggle buttons to allow clutter-free viewing of the fragment chromatogram.

— View Chromatogram: Click to show/ hide the corresponding Chromatogram in
the Alignment pane in the lower half of the Contig Editor.

— Consensus Translation 1st frame: Click 5% to show/ hide the first frame
translation consensus in the Alignment pane in the lower half of the Contig Editor.

— Consensus Translation 2nd frame: Click 5% to show/ hide the second frame
translation consensus in the Alignment pane in the lower half of the Contig Editor.

— Consensus Translation 3rd frame: Click =% to show/ hide the third frame
translation consensus in the Alignment pane in the lower half of the Contig Editor.

— Show/Hide Two Strands: Click & to display only two out of the four nucleic acid
base strands at one time.

— Show/Hide ORF: Click to show/hide the Open Reading Frames of the
sequence. To execute this feature, you first need to click ORF Finder |%, on the
right-hand side of the Contig Editor. The ORF sequence is only displayed in the
sequence pane.

» Three Find buttons to find a particular strand.

aTG

— Find: Click #4 to find a particular fragment. In the Find dialog box, you can insert
sequence and click Find Next to look for a match. You can find ambiguous character
as well as Complementary sequence.

— Find Previous Ambiguous: Click # to find a previous ambiguous fragment.
— Find Next Ambiguous: Click g to find a next ambiguous fragment.

* Two Move buttons to find a move a particular Fragment.
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Scale

Contig viewer

— Move Fragment Left: Click & to move a particular fragment to the left of the
sequence.

— Move Fragment Right: Click = tomovea particular fragment to the right of the
sequence.

Note: To take a screenshot of the current view of the fragment in the graphical view pane,
right-click anywhere in the graphical view pane and select Camera. You can then ‘paste’ the
information in MS Word, MS Paint, or any other graphic-editing tool for future reference.

Alignment tab

The Contig Alignment Pane displays the nucleotide sequences of the fragments that form the
contig, with overlapping regions aligned appropriately and displayed relative to their positions
in the contig.

The consensus sequence is displayed below the fragments, and chromatograms for the
fragments are displayed. Translations can be identified and displayed. You can edit the
sequences here and see how your actions are reflected in the contig alignment and consensus.

Use the horizontal and vertical scroll bars in the Alignment Pane to view the fragment
sequences, overlapping regions, and consensus sequence.

Fragment

sequence = T —— |

Overlapping region

Chromatogram
data

Consensus
sequence

ONE4R +

ONESR +

LCCTACTACTGGECTGCTTCCTRARTGCE

{\aﬁ%ﬂﬂﬁuﬂegﬂﬁﬂmﬂgg

CRATTNICGATGATGGTIIGAGATGIGTATAAGAGACAGGCCTCAACCTACTACTGGGCIGCTITICCTARTGCE

CONSENSUS ‘CAATT:-ITCGATGATGGTTGAGATGTGTATAAGAGACAGGCCTCAACCTACTACTGGGCTGCTTCCTAATGCP

a +

Positions with Ns Ambiguities or gaps
are flagged with * are flagged with +

Vector NTI™ Express Designer Software User Guide 307



9 Contig Assembly using ContigExpress™ program
Contig viewer

Sequence tab
The sequence view of a contig is displayed in the lower half of the Contig Editor pane.

You can select a particular sequence of the contig in the Sequence view pane and view the
corresponding chromatogram in the graphical view pane.
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1 CCCTCACTCG CCGANCAGCA GCTACCCAZ2 CTCTCCGGEA AGCGECAGTA CTTATCCTCA CTCACCAGCE AGCTCTGATC CTGGGAGCCC TTTTCAARATA
CGEEAGTEAGC  GECTHNETCET  CEATGGCETTT  GAGAGECCCT  TCGCCGTCAT  GRATAGGAGT  GAGTGETCEC  TCGAGACTAC GRCCCTCGEE  RRRAGTTTAT

101 CCACGCTGACA CCCCICCICC ACCTITATATC CCICCCGACC ATCACATGAC CCAACACAAC TCICAGCCCAR TCGACACARR TCTGATGGIGC CCTAACATCT
CCICCGACTICT COCCGACCACC TCGAATATAC GGAGGECICC TACGTICTACTC CGITICIGITC AGACICGCIT ACCIGIGITT AGCACTACCAC GGATICTIAGA

201 CTCAAGATAT CARATAGAGCA GATGTCCAGE CTGTTGCATA TEAAGAGCCA ARACACTGET GCTCCATTST CTATTATGAG CTCARCARCC GTIGTTGGAGR
GAGTTCTATR GTTATCTCGT CTACAGGTCC GACAARCGTAT ACTTCTCGGT TTTGTGACCA CGAGGTAACA GATAATACTC GAGTTETTGG CACAACCTCT

301 ACGCTITTCCAT GCCICCICCR CRACTGIGIT GGIGGATGGC TTICACCIGAT CCITCAAACA ACAGGARCAC ATITIGCCIT GGGC-TICIC TCCAARTGIGR
TCGARRGCTIR CGGAGGAGET CTITCACACRR CCACCTACCG ARGTGGACTR  GCGAACTTIGT TIGICCITCIC TARRRCCCAR CCCG-ARRGRC  AGGETITACACT

401 ACCEARACTC GACCATTGAS RACACCAGGEC GGCATATTGE ARRRAGETGTE CATTTATACT ATGTTGEEGGE  TERAGTCTAT  GCCGAATECT  TRAGTGACAG
TEECITIGAG CTEGETAACTC TTGTGEICCE CCGTATRACC TTITTCCACAC GTARARTATGR TACARCCCCC ACTICAGATR CGGCTTACGR ATTCACTEIC

501 CAGCATTITIT GITCAGAGCC GGRATTIGTAR CTTTCACCAC GGITICCATC CTACAARCTIGT GIGIRARATC CCCRGCGGAT GCAGCCTARR GATTITTTIARC
GCICGTRARRRR CARCICICGE CCTTRRCATT CGARRCTIGGIC CCRRAGCTAC CGATGITGACR CRCRTTTTAGC GGECEICGCCTIA  CGICGGATIT  CTIRARRRRTIC

€01 AACCAAGAAT TIGCICAGSCT TIIGGCCCAG TCIGTARACC ATGECTITGA AACTGICTAT GARACTGACAR AGATGIGCAC TATICGGAIG AGITITIIGICA
TIGGTTICTTA ARACGAGTCEA AARACCGGEIC AGACATIIGE TACCEARACT TTGRCAGATI CITGACTIGIT TCTACACGIG ATAAGCCTAC TCARAARCAGT

7Ol AGGGATGGEEE TECAGRATCT CATCGCCAGC ATGTCACAAC CACCCCCTGC TGGATTIGAGR TICACCIGCA CGGCCCCCTIT CAATGGCTGE ATAAACGTACT
TCCCTACCCC ACGICTTACA CGTAGCGEICC TACAGIGIIC CIGGGGGACC ACCTAACTCT AACTGGACCT GCCGGGGGAR  CGITACCGACC TATTICATGA

801 AACTCAGATC CGCICACCCC ATAATCCCAT CTCCICGEIC TCTTAATGGA TTAGGAICGIT CCIGCCICIGC CGATICATIGE AG-CCATGCR TCTACTIGAAR
TIGAGTCTAC CCCACTGCCC TATTAGGCTA CGAGGACCCAC ACAATTACCT AATCCTACAR CGACCCGACAC CTAACTAACC TC-GGTACGT ACATCAACTT

801 GEAGTCAGAC ACTTAGCTGE CRRATGEGAC ATTGETAGTT TTTTTTITTITT ARAGTCTTGE GGGAGCEATA  AGCCCCTCAT CTACTTGATG TTTGTGACCR
COTOASTATE  TCAZTACACS  STTTAMCSTR  TAACCRT/AA  BAAAAAIARL  TTTrACAAST  SOCTOCCTAT  TOSSLCARTR:  CATEARSTAS  BAACASTOCT

| Alignment | sequence | Properties |

>

|

Use the right-click drop-down menu to perform tasks in the Sequence view pane.
1. Select a sequence in the Sequence view pane.

2. Right-click and select from:
a. Copy: To copy the selected sequence
Note: Keyboard shortcut key to copy the selected sequence is Ctrl +C.

b. Paste: To paste the copied sequence

c. Delete: To delete the selected sequence

d. Select All:To select the entire contig (if you have not selected a part of it)
Note: Keyboard shortcut key to select the entire sequence is Ctrl +A.

e. Clear Analysis Results: Activated when you perform analysis from the right hand
side toolbar pane

Properties tab

The Properties tab in the lower half of the Contig Editor, displays the general information and
assembly information of the contig selected in the Project View pane.
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Contig viewer

The General Information includes:
+ Name of the selected fragment
* Length of the fragment
* Description
» Date on which the fragment was created

» Date on which the fragment was modified

The Assembly Information includes:

* Belongs to Assembly
* No. of Fragments

oy, . = R

548 *Contig Assemby2.cep % - %
T l—|—* — [ &c | &G Hé— —H

xxg HFEZERKBRAASS X

OME10F- 1 << £50

ONE11R+ 240 x> 307

OMNELEF-372 =<872

ONE3R-463 << 1146

S—
ONEGR+982 =>1695

OME2R+1051>»1711

(T 1 1 T (R

<

%4

w General Information w Assembly Information

Name [ contig1 | BetongstoAssembly - [ Assemblyt |

Lensth [ 2312 | NoofFragmens: [T |

Description

Date Created | ManJan 27 11:08:55 5612014 |

Date Modifizd | Monlan 27 11:08:55 56T 2014 |

Alignment | Sequence Properties

Assemble by For workflows in applications such as comparative genomics or forensics, it is useful to include

Reference a reference sequence in the assembly. Such a sequence may be introduced into the
ContigExpress' " program in any supported file format and may or may not include a
chromatogram.

1. Add the reference sequence to the project in the Project View Pane and include it in the
assembly.

2. Inthe Contig Viewer, select the reference sequence in the Alignment Pane fragment
names list, and click Set as Reference from the right-click menu (this action is not
permitted unless the Viewer is in Edit mode.)
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Contig viewer

Export Contigs

310

Only one sequence may be designated as reference at any one time in a contig. The
selected sequence reappears in lower case letters and pink highlight. Generally, it no
longer contributes to the consensus calculation or any analysis derived from it (ambiguity,
protein translation, etc.). However if the reference constitutes single coverage anywhere in
the contig, it will define the consensus for that domain.

Note: If any fragment in an assembly lacks QV scores (e.g. a .gb file intended as a reference
sequence), QVs associated with all other fragments will be ignored during assembly. To avoid
such omissions first exclude the reference from assembly, then re-assemble the resulting contig
with the reference sequence.

Note: Fragment can be first selected as a reference before assembly. Right click on tree-pane
and select assemble by reference
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Use the right-click drop-down menu to export contigs as molecules or to different file types.

To export a contig:
1. Select a contig in the Project View pane.

2. Right-click on the selected contig and select Export Contigs from the drop-down menu.
You can choose to export the contig:
* Asamolecule
+ Toa GenBank™ file...
* To a FASTA file...
+ ToaEMBL file...
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Save and close a
Contig Assembly
Project

Delete and rename contigs

* To a Nucleotide sequence file...

—

OFPREAE QaE%E Oddwe & =W

s

xR M SHAA=SS

seue

1. To save the project, select File » Save As.
Name the project and select the Demo Projects folder as the destination.

2. To close your project, click & on the top right of your project tab.

The ContigExpress™ program reverts to its initial state, with an empty workspace. You
can open an existing project from the disk or start a new project:

* From File » New » ContigExpress Project
By clicking the ContigExpress™ program icon in the toolbar.

Delete and rename contigs

Delete a Contig
Assembly

Re-assemble
contigs

Most of these commands are located below the Contig/Fragment Tree.

To delete a particular Contig Assembly, select the Assembly name in the Project Explorer, and
click Dismiss Assembly.

You can select fragments in contigs and re-assemble them. Select the desired fragments from
the Fragment List in the Project Explorer, and click on Assemble Fragments.
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1 9 Contig Assembly using ContigExpress™ program
Display ORFs and translate the nucleotide sequence

Display ORFs and translate the nucleotide sequence

Display ORFs for 1. In the Contig Editor, click ORF Finder |§ to run the ORF finder tool to display ORF

the Sequence Finder pane.
OREFs are displayed for the direct and complementary strands. ORF finding criteria (for

example, minimum length, inclusion/exclusion of stop codon, and so on) can be adjusted
via the ORF finder dialog box from the ORF finder tool toolbar button.

. . " Tay s = B § =
=1 Project View ben *Contig Assembyl.cep £3 | J4@ *ABC O s, ORF Finder ‘ %,
o ATG N4&— N —
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1 GIGGECGEGEA  TCCTCTAGAG TCGACCTGCA  GGCATGCARG  CTTCAGGGIT  GAGATGTGTA  TRAAGAGR
101 ATAGACAGTT TCARRGCCAT GGTTTACAGR CTGGECCARR AGCTGAGCAR ATTCTTGETT  GITARAA|
201 ACAGTTGTAG GATGGRARCC GCIGETGARAG TTRCAATTCC GGCICTGRAC ARARATGCTG CIGTCAC
301 AGTATARATG CACACCTITT CCRATATGCC GCCIGETGTT  CTCRATGETC GAGTITCGET  TICACATT
401 GTTIGARGEA TCAGTGARGC CATCCACCAR CACACITGTG GAGGAGGCAT GGARAGCITC TCCRACA
501 CARGIGTITIG GCTCITCATA TGCARCAGCC TGGACATCTE  CTCTATIGAT ATCTIGAGAG ATGTTAG
601 TGETICTTIGCET  CATCTGATCC TCGEGAGGCAR TATRAGCTGE  AGGAGGGETE  TCAGCTGGTA  TTTGRRA|
701 AGGATARGTA CTGCCGCITC CCGGAGAGTT TGGETAGCTE  CTGNTCGECE  AGTGAGGE
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Edit the nucleotide sequence in the Sequence Pane

Translate the 1. Click Translation |,_% on the Fragment viewer toolbar.
Nucleotide The ContigExpress™ program shows the amino acid abbreviations above the selected
Sequence sequence.

Toe “cont Assembyl.cen

It e
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o Project View
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2. To translate the complementary strand of the selection, choose Complementary Strand
from the dialog box and click Run (add graphic) on the menu or toolbar.

Edit the nucleotide sequence in the Sequence Pane

You may freely edit a fragment in the Fragment Viewer only if it is not part of a contig. You
may also edit a fragment that is part of a contig but they are handled separately from the
fragments in the Fragment Viewer.

There are three ways to edit the fragment sequence. All are illustrated in Figure XXX.

ADD SCREENSHOT.

Figure 19.1 Editing a sequence in the Fragment Viewer

1. Nucleotide Deletion: In the Sequence Pane,
a. Select nucleotides 316 through 319.

b. Press the Delete key on your keyboard.
The selected symbols move under the row, with downward pointing arrows (4
taking their place.

¢. Move the cursor to the Chromatogram Pane.

There is a sequence above and one below the graph. Before editing, they were
identical. The sequence above the graph reflects all editing commands, the sequence
below always remains in its original form, thus giving a useful reference to track and
compare changes.

Note: The deletion results in each deleted nucleotide being replaced by a dash (-) in
this sequence.

2. Nucleotide Insertion: In the Sequence Pane,
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Contig Assembly using ContigExpress™ program
Edit a sequence in the Chromatogram Pane

a. Move the caret in the Sequence Pane to position 307, and type TTT.

Three Ts with upward pointing arrows (T) below them are inserted at the caret

position.

The arrows indicate that symbols were inserted in a sequence (“added to” the
sequence) into a position, not substituted for other nucleotides. The sequence above
the graph in the Chromatogram Pane also shows the insertion (in another color).

Note: A gap appears in the graph because there is no data to build chromatograms
for newly inserted symbols.

3. Nucleotide Substitution: Select nucleotide 303 and type G

The selected base is replaced by G, and A is shown below G to help track the change. The
chromatogram does not change because the G was not inserted; it just replaces the original
base call. Replace the bases one by one.

Edit a sequence in the Chromatogram Pane

314

1. Activate the Chromatogram Pane by clicking on the contig in the Project Viewer.

2. In the top, editable sequence in the Chromatogram Pane, select “T” at bp 11 and type C.
Like the Sequence Pane, T is replaced by C.

Note: All editing operations are reflected in both the Sequence and Chromatogram Panes.

The editing operations can be summarized as follows (NTs = nucleotides):

Action

How to Perform

Sequence Pane Result

Chromatogram Pane
Result

Delete

Select residues;
press Delete

Replaces NT with (---in red
color); original NT moves
below strand

(- - - -) Appear in upper,
editable sequence

Insert/
Replace

Place caret; type
new NTs

For Insert, (NT with green
color) appears below new
NTs; new NTs are colored

For Replace, (NT with blue
color) appears below new
NTs; new NTs are colored

A break appears in the
chromatogram

Replace

Select existing NTs
and type new NTs
one by one

New NT appear in sequence;
replaced NTs moved below
strand

New NT appears in
upper sequence; no
break or change in
chromatogram

Table 2 Editing operations for Sequence and Chromatogram Panes
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A Symbols and Formats: IUB (IUPAC)

Ambiguity Codes and ASCIlI Format

Format for ASCIl Sequence Files

An ASCII sequence file must obey the following rules:

It must be a plain (ASCII) text file.

The file must contain the nucleotide (amino acid) sequence arranged in lines. Each line
may contain the following:

Nucleotide (amino acid) symbols and white space, or

A number followed by white space and nucleotide (amino acid) symbols (therefore,
similar to GenBank ™" format), in which case the number will be ignored, or

A number only, in which case the number will be interpreted as a block of unknown
nucleotides (amino acids) of the corresponding length.

IUB Formats recognized by Vector NTI™ Express

The following characters, defined by the International Union of Biochemistry (IUB), are used
to represent nucleotides throughout Vector NTI™ Express Designer:

Symbol Meaning

>

adenine

thymine

cytosine

guanine

purine(A or G)

pyrimidine(C or T)
AorT
CorG
AorC
TorG

C,GorT
T, G, or A
C,AorT
C, G, orA

unknown nucleotide

ZI < I O w XXX 0 s < oo o 4
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Symbols and Formats: IUB (IUPAC) Ambiguity Codes and ASCII Format
IUB Formats recognized by Vector NTI™ Express

Amino acids are represented by standard 1- (or 3-) letter codes:

1-Letter Symbol 3-Letter Symbol Meaning
E Glu Glutamic acid
G Gly Glycine
H His Histidine
| Ile Isoleucine
L Leu ' Leucine
K Lys Lysine
M Met Methionine
F Phe Phenylalanine
P Pro ' Proline
S Ser Serine
T Thr Threonine
W Trp Tryptophan
Y Tyr ' Tyrosine
\Y Val Valine
B Asx Asparagine or Aspartic acid
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Primer Tm Calculations

General Information

Vector NTI™ Express Designer calculates and reports two different melting temperatures for
DNA/RNA oligonucleotides, Thermodynamic Tm (Therm. Tm) and %GC Tm .

Usefulness of Thermodynamic Tm Versus %GC Tm

Vector NTI™ Express Designer reports both the Thermodynamic and %GC Tm values,
regardless of the length of the oligo. However, generally only one of the reported ™ values
should be considered useful, depending on the length of the oligo as follows:

* Therm. Tm — useful for oligos that are greater than about 7-10 residues and less than about
35 residues long

*  %GC Tm — useful for oligos greater than about 35 residues long

Note: For oligos that are 7-10 residues or shorter (cutoff length depends on the base content of
the particular oligo being analyzed), Vector NTI™ Express Designer reports a Therm. Tm value
of zero.

Effects of Primer (Probe) and Salt Concentration on Tm
Calculations

Tm calculations are highly dependent on primer and salt concentrations; varying these
concentrations can greatly affect the Tm for any given primer. Therefore, it is important that
you adjust the primer and salt concentrations appropriately so that accurate Tm values are
generated.

Note: In Vector NTI™ Express Designer, the default parameters for primer and salt
concentration are 250 pM and 50 mM, respectively, for calculating Tm values. Other Tm
calculators commonly use a default probe concentration of 50 nM. Because of this, Vector
NTI™ Express Designer default parameter Tm values may not correspond to the default Tm
values calculated using other programs. Before comparing Vector NTI™ Express Designer Tm
values with those generated by other Tm calculators, make sure that the parameters are adjusted
appropriately.

%GC Tm Calculation

The %GC Tm calculationl does not rely on the thermodynamic properties of the oligo (i.e.
dHo, dSo and dG® values). The formula for %GC Tm is as follows:

Tm = 81.5 + 16.6(log[Na+]) + 0.41(%GC) — 675/probe length

Vector NTI™ Express Designer Software User Guide 317



Primer Tm Calculations
Thermodynamic Tm Calculation

Example:

Note: [Na+] is in molar units.

For oligo GTGCGAGGCAGCTGCGGTAA at 50mM salt:
Tm = 81.5 + 16.6(10og(0.05)) + 0.41(65) — 675/20
=81.5+16.6(-1.30) +26.65 — 33.75

=81.5-21.58 +26.65-33.75

=52.82°C

Thermodynamic Tm Calculation

318

Notes:

The Thermodynamic Tm calculation is based on the Nearest Neighbor theory of DNA/RNA
duplex stability. Briefly, this theory states that the overall duplex stability (and, hence, the
melting temperature) of an oligonucleotide can be predicted from the primary sequence based
on the relative stability and temperature-dependent behavior of every dinucleotide pair in the
oligo2. In practice, enthalpy (dH°) and free energy (dG®) values for each of the 10 possible
Watson-Crick DNA pairwise interactions are used to calculate pairwise entropy (dS°) values
via the following standard equation:

dG° =dH° - TdS®
Note: T is temperature in °K.
The pairwise dH® and dS° values are then summed to calculate overall values for the oligo

under consideration. The overall values are used in the following formula3 to calculate the
Thermodynamic Tm:

Therm. Tm = dH®- 273.15 + 16.6(log[Na+]) dS° + dSo° + R(In(c/4))

» dSo° is the entropy associated with helix initiation (-10.8 cal/mol per °K).
* Ris the Universal Gas Constant (1.987 cal/mol per °K).
+ cis the concentration of the probe, in molar units.
* The factor —273.15 corrects for absolute temperature so that the final Tm is in °C.
The pairwise dH° and dS° values for DNA used in Vector NTI"" Express Designer are taken

from reference 2. Those values, along with the corresponding dG° values at 25°C, appear in the
following table:

Interaction | dH® kcal/mol | dS° cal/mol per °K dG® kcal/mol
AA/TT -9.1 -24.0 -1.9
AT/TA -8.6 -23.9 -1.5
TA/AT -6.0 -16.9 -1.0
CA/GT -5.8 -12.9 -2.0
GT/CA -6.5 -17.3 -1.3
CT/GA -7.8 -20.8 -1.6
GA/CT -5.6 -13.5 -1.6

Table 3 DNA Nearest Neighbor thermodynamics
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Thermodynamic Tm Calculation E

CG/GC -11.9 -27.8 -3.6
GC/CG -11.1 -26.7 -3.1
GG/CC -11.0 -26.6 -3.1
XX/XX -6.0 -16.9 -1.0

Table 3 DNA Nearest Neighbor thermodynamics /continued)

Notes: »  All values refer to the disruption of a duplex at 1 M NaCl, 25°C and pH 7.

e The units for dH° and dG° are kcal/mol of interaction, whereas those for dS° are cal/°’K
per mol of interaction.

Example The oligo 5’-GTGCGAGGCAGCTGCGGTAA-3’ is parsed as follows:

dH™: &5 52 111 113 56 TE 110 14 5F T8 114 TE 58 I 118 110 &5 &0 84
ppppppp

dS*: 173 128 20T TR 135 08 288 26T 129 208 287 208 128 T TE 24 T3 165 M0
dGh 13 2o 3 34 14 16 31 31 20 16 30 16 24 30 3 X 13 18 13

e Total dH® =-164.7 kcal/mol

+ The total dS° reported by Vector NTI™" Express Designer is the sum of the pairwise values
above and the entropy associated with helix initiation (dSo®). Thus, for the example oligo
above:

» Total dS° =-405.7 + (-10.8) =-416.5 cal/mol per °K

The total dG® is the sum of the pairwise dG° values for the oligo plus a helix initiation free
energy term (dGo°) that is added to better reflect experimentally determined free energy values
for tested oligos. The value of the helix initiation free energy term (dGo°) depends on the base
composition of the oligo2 as follows:

* +5.0 kcal/mol for oligos containing any G-C base pairs
* +6.0 kcal/mol for oligos composed exclusively of A-T base pairs

Therefore, for the example oligo:

Total dGo = -43.7 kcal/mol (sum of the pairwise dGo values) + 5 kcal/mol (free energy term) =
-38.7 kcal/mol

The 3’ End dG® is calculated using the number of 3’ pairwise dG° values specified in the 3’ End
Length (bp) box, and is not further adjusted.

Using Vector NTI™ Express Designer’s default probe and salt concentrations (250 pM and 50
mM, respectively) and the values for dH° and dS° calculated above, Therm. Tm can be
calculated as follows:

ThermTm = dH —273.15+16.6(Log(Na))
dS° +dS,° +R(1n(§))
—164.7

= —— —273.15 + 16.6(L0g(0.05))
250 x 10~

—0.4165 + (0.001987)(111((T)D
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_ 1647
"~ Z0.4165 + (0.001987)(—23.49)

~273.15 + 16.6(~1.301)

_ ~164.7
" (-0.4165) - 0.04667

+(=273.15) - 21.60

_ 1647
L= Taeyy 29475

. = 355.57-294.75

... = 60.82°C

Vector NTI'" Express Designer adjusts the %GC and Therm. Tm values accordingly, based on
the input formamide concentration.

Oligos Containing IUB Ambiguity Characters

Vector NTI™ Express Designer can analyze oligos that contain IUB nucleotide ambiguity
characters (i.e. R, Y, W, S, M, K, B, D, H, V and N). In the case of ambiguity characters, Vector
NTI™ Express Designer uses average pairwise dH® and dS° values for calculating the Tm.

For example, for the dinucleotide pair CB, Vector NTI™ Express Designer averages the CC, CG
and CT thermodynamic parameters (Table <Blue><Emphasis> 3) to obtain average pairwise
dH® and dS° values for CB. It then sums the average pairwise thermodynamic parameters and
calculates the Therm. Tm values according to the equation described above (refer
Thermodynamic Tm Calculation on page 318).

In the case of %GC Tm, Vector NTI™ Express Designer applies the appropriate %GC
contribution represented by each ambiguity symbol to the standard %GC Tm formula (see
“%GC Tm Calculation” on page 317). For example, a B ambiguity symbol contributes only
two-thirds the amount of a G or C residue to overall GC content.
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RNA Oligos

RNA oligos use a different set of pairwise thermodynamic values than DNA oligos. Pairwise

RNA Oligos E

thermodynamic values for RNA are summarized in the following table:

Interaction dH® kcal/mol ds® cal/mol/K dG° kcal/mol
AA/UU -6.6 -18.4 -1.1
AU/UA -5.7 -15.5 -1.1
UA/AU -8.1 -22.6 -1.4
CA/GU -10.5 -27.8 -2.2
GU/CA -10.2 -26.2 -2.4
CU/GA -7.6 -19.2 -1.9
GA/CU -13.3 -35.5 -2.7
CG/GC -8.0 -19.4 -2.2
GC/CG -14.2 -34.9 -3.8
GG/CC -12.2 -29.7 -3.3
XX/XX -6.0 -16.9 -1.0

Table 4 RNA Nearest Neighbor thermodynamics

Notes: * All values refer to the disruption of a duplex at 1 M NaCl, 25°C, and pH 7.

e The units for dH° and dG® are kcal/mol of interaction, whereas those for dS° are cal/°K
per mol of interaction.

* The dS° value for RNA oligos is adjusted by —10.8 cal/°K per mol to reflect the entropy
associated with helix initiation, as it is for DNA oligos.

* The dG® value is adjusted by +3.4 kcal/mol to account for helix initiation. Note that this
adjustment is NOT dependent on the base composition of the RNA oligo as it is for DNA
oligos (refer Thermodynamic Tm Calculation on page 318).

For oligos designed using Vector NTI"" Express Designer’s PCR Primers, Sequencing Primers
and Hybridization Probes features, the oligo Tm, product Tag, and oligo percent binding
similarity are reported in the Text Pane of the Molecule Viewing window.

Primer/Probe Tm,
Tagpyand Similarity
Calculations

Primer/Probe Tm Values

Tms for designed primers/probes are reported is as follows in Vector NTI™ Express Designer:

*  Therm. Tm is reported if the oligo is less than or equal to 35 residues

*  %GC Tm is reported if the oligo is 36 residues or greater

For PCR products, Vector NTI™ Express Designer reports the %GC; the assumption being that
the majority of PCR products are larger than 35 residues.
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Tagpt Values

Tagp; Values

Notes:

The PCR product Tagy, (optimal annealing temperature for amplification of the fragment) in °C
is calculated using the following formula3:

Taopt = ((O.3)Tmprimer + (0'7)Tmpr0duct _ 149) oC

* Tmppe is the Tm of the less stable primer of the pair
*  Tmpoqyc i the Tm of the PCR product

Primer/Probe Similarity Values

References
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When designing PCR, sequencing or hybridization primers, Vector NTI™ Express Designer
reports the overall similarity in percent of an oligo to its binding site based on the oligo’s
nucleotide composition. For oligos containing IUB ambiguity symbols, three similarity values
are reported:

*  Minimum Similarity
¢ Maximum Similarity
* Average Similarity
For Minimum Similarity, all ambiguities are classed as complete mismatches (i.e., they are

assigned values of 0 at each position). For example, a 20mer containing 2 Rs and 2 Ns has a
Minimum Similarity of 80%.

For Maximum similarity, all ambiguities are considered identical to their cognate nucleotides
(i.e. they are assigned values of 1 at each position), so the Maximum Similarity is always 100%.

For Average similarity, Vector NTI™ Express Designer weights each ambiguous nucleotide
depending on whether it represents 2, 3, or 4 possible nucleotides. For example, Ns have a score
0f 0.25, Rs of 0.5, Bs of 0.33, etc. Therefore, for the 20mer described above, the Average
Similarity is 85%.
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Documentation and Support

Technical resources on the web

Technical resources for Vector NTI™ Express Designer Software are available online at http://
thermofisher.com/vectornti.

Annual support contract

For personalized technical support by telephone or email, you must have a paid annual software
maintenance and support contract. To purchase an annual support contract, email
bioinfosales@lifetech.com or contact Thermo Fisher Scientific customer support at
www.thermofisher.com/support.

If you have a paid annual support contract, you can contact us by email or phone:

* Email: bioinfosales@lifetech.com
* Phone:
— 800955 6288 (North America)
— +44 (0) 141 814 6318 (Europe, Middle East, Africa)

Other Thermo Fisher Scientific technical support

For additional Thermo Fisher Scientific technical support, visit at www.thermofisher.com/
support.

Limited Product Warranty

Thermo Fisher Scientific and/or its affiliate(s) warrant their products as set forth in the
Thermo Fisher Scientific’s General Terms and Conditions of Sale found on the Thermo
Fisher Scientific website at thermofisher.com/termsandconditions. If you have any
questions, please contact Thermo Fisher Scientific at thermofisher.com/support.

Vector NTI™ Express Designer Software and Support Product
License Agreement

For this agreement, see the Vector NTI™ Express Designer Installation and Licensing Guide
(Pub. no. MANO0007446), available online at http://thermofisher.com/vectornti.
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